PrintBoss
User Manual

www.wellspringsoftware.com

www.wellspringsoftware.com

ELECTRONIC COPY
# TABLE OF CONTENTS

**TABLE OF CONTENTS** ................................................................................................................................................................................................. 3

**ABOUT THIS USER MANUAL** ...................................................................................................................................................................................... 7

- **Symbol Key** ................................................................................................................................................................................................. 7
- **Manual Updates** ......................................................................................................................................................................................... 7

**INTRODUCTION** ............................................................................................................................................................................................... 9

- **PrintBoss Products** .................................................................................................................................................................................... 9
- **System Requirements** ............................................................................................................................................................................. 10
- **Printer Requirements** ........................................................................................................................................................................ 10

**INSTALLATION** .............................................................................................................................................................................................. 11

**SETUP** ........................................................................................................................................................................................................ 15

- **Standard PrintBoss Interfaces** .............................................................................................................................................................. 15
- **Printer Setup** ........................................................................................................................................................................................ 16
- **Configuration** ....................................................................................................................................................................................... 16
- **PrintBoss Driver Settings** .................................................................................................................................................................... 22
- **About PrintBoss** ..................................................................................................................................................................................... 24

**THE PRINTBOSS PRINTER DRIVER** ................................................................................................................................................................. 27

- **PrintBoss NT40** ................................................................................................................................................................................... 27
- **PrintBoss NT40 Port** ............................................................................................................................................................................ 27
- **PrintBoss 50** ......................................................................................................................................................................................... 27
- **Manual Installation of PrintBoss NT40 or 50 Driver** ............................................................................................................................ 28
- **PrintBoss / HP Compatible Installation** ........................................................................................................................................... 28

**CITRIX OR TERMINAL SERVER INSTALLS** ..................................................................................................................................................... 29

- **Warnings** ............................................................................................................................................................................................ 29
- **W2003 Servers and Above** ................................................................................................................................................................. 30
- **PrintBoss Settings** .............................................................................................................................................................................. 30
- **Printer Selection** ................................................................................................................................................................................ 32

**SOFTWARE UPDATES** .................................................................................................................................................................................... 33

- **Automated Online Updates** ................................................................................................................................................................. 33
- **Offline Manual Updates** .................................................................................................................................................................... 34

**BANK ACCOUNTS** ........................................................................................................................................................................................... 35

- **Create a Bank Record** ........................................................................................................................................................................ 35
- **Copy/Tag/Paste** ...................................................................................................................................................................................... 42
- **Adding Banks** ..................................................................................................................................................................................... 42
- **Bank List Maintenance** ........................................................................................................................................................................ 43
- **Adjust MICR Placement** ..................................................................................................................................................................... 45
- **Bank Security** ................................................................................................................................................................................... 45

**FORM FILES** .................................................................................................................................................................................................. 49

- **Standard Form Files** .......................................................................................................................................................................... 49
- **Create a New Form File** ..................................................................................................................................................................... 49
- **Modify an Existing Form** ................................................................................................................................................................. 51
- **Modify from the Document View** .................................................................................................................................................... 52
- **Insert an Object in the Document View** ........................................................................................................................................ 52
- **Form Editor** ...................................................................................................................................................................................... 54
- **Assignments** ..................................................................................................................................................................................... 55
- **Variables** ........................................................................................................................................................................................ 56
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form File Commands</td>
<td>56</td>
</tr>
<tr>
<td>PrintBoss Default Assignments</td>
<td>72</td>
</tr>
<tr>
<td>Multi-Line Variables</td>
<td>72</td>
</tr>
<tr>
<td>PrintBoss Conditional Commands</td>
<td>72</td>
</tr>
<tr>
<td>Date &amp; Time Format Masks</td>
<td>79</td>
</tr>
<tr>
<td>Delimiting Parameters</td>
<td>79</td>
</tr>
<tr>
<td>TEXT Command</td>
<td>81</td>
</tr>
<tr>
<td>Edit TEXT from a View</td>
<td>81</td>
</tr>
<tr>
<td>Form Editor</td>
<td>83</td>
</tr>
<tr>
<td>Substitute Functions</td>
<td>85</td>
</tr>
<tr>
<td>Security Features</td>
<td>89</td>
</tr>
<tr>
<td>Setting Up Security</td>
<td>89</td>
</tr>
<tr>
<td>Accessing Secured Areas</td>
<td>93</td>
</tr>
<tr>
<td>Other Security Options</td>
<td>93</td>
</tr>
<tr>
<td>Text Security</td>
<td>94</td>
</tr>
<tr>
<td>Signature Disks</td>
<td>95</td>
</tr>
<tr>
<td>PrintBoss Signature Disks, CDs, or USB drives</td>
<td>95</td>
</tr>
<tr>
<td>Duplacting PrintBoss Signature Disks</td>
<td>96</td>
</tr>
<tr>
<td>Adding a Password to an Existing PrintBoss Signature Disk</td>
<td>97</td>
</tr>
<tr>
<td>Creating Non-Encrypted Signature Disks</td>
<td>97</td>
</tr>
<tr>
<td>Adding a Signature to a Check</td>
<td>100</td>
</tr>
<tr>
<td>Using PrintBoss Signature Disks</td>
<td>100</td>
</tr>
<tr>
<td>Work/Archive Files</td>
<td>101</td>
</tr>
<tr>
<td>Configure Work/Archive Files</td>
<td>101</td>
</tr>
<tr>
<td>Open Document Work Files/Archives</td>
<td>103</td>
</tr>
<tr>
<td>Browse Work/Archive File Select</td>
<td>105</td>
</tr>
<tr>
<td>Work File/Archive Edit</td>
<td>106</td>
</tr>
<tr>
<td>Hand Checks</td>
<td>109</td>
</tr>
<tr>
<td>Creating/Editing Hand Check Specs</td>
<td>109</td>
</tr>
<tr>
<td>Printing Hand Checks</td>
<td>110</td>
</tr>
<tr>
<td>Setting Amount Conditions for Hand Checks</td>
<td>111</td>
</tr>
<tr>
<td>Deposit Slips</td>
<td>113</td>
</tr>
<tr>
<td>Creating/Editing Deposit Slips</td>
<td>113</td>
</tr>
<tr>
<td>Printing Deposit Slips</td>
<td>115</td>
</tr>
<tr>
<td>Faxing</td>
<td>117</td>
</tr>
<tr>
<td>Setup</td>
<td>117</td>
</tr>
<tr>
<td>Testing</td>
<td>119</td>
</tr>
<tr>
<td>Form Setup for Faxing</td>
<td>119</td>
</tr>
<tr>
<td>Manual Batch Faxing</td>
<td>120</td>
</tr>
<tr>
<td>Automatic Faxing</td>
<td>120</td>
</tr>
<tr>
<td>Fax Service</td>
<td>123</td>
</tr>
<tr>
<td>Ordering</td>
<td>123</td>
</tr>
<tr>
<td>Fax Setup</td>
<td>123</td>
</tr>
<tr>
<td>Form Setup for Faxing</td>
<td>127</td>
</tr>
<tr>
<td>Faxing</td>
<td>127</td>
</tr>
<tr>
<td>Manual Fax on Demand</td>
<td>127</td>
</tr>
<tr>
<td>Assignments</td>
<td>128</td>
</tr>
<tr>
<td>Variables</td>
<td>129</td>
</tr>
<tr>
<td>Fax Service Log</td>
<td>130</td>
</tr>
</tbody>
</table>
E-MAILING ............................................................................................................................................... 131
  SETUP ............................................................................................................................................... 131
  FORM SETUP FOR E-MAIL .................................................................................................................. 139
  E-MAILING ......................................................................................................................................... 140
  MANUAL E-MAIL ................................................................................................................................. 140
  ASSIGNMENTS ................................................................................................................................. 141
  VARIABLES ......................................................................................................................................... 142

FORM / BANK REQUEST LIST .............................................................................................................. 143
  SETUP .............................................................................................................................................. 143
  CONFIGURATION .............................................................................................................................. 144
  IMPLEMENTING REQUEST LIST FROM THE WORK FILE ............................................................. 144
  REQUEST LIST PROCESS .................................................................................................................. 148

POSITIVE PAY ......................................................................................................................................... 149
  SETUP IN PrintBoss ............................................................................................................................ 149
  ENTERING ACCOUNT/Routing NUMBERS ....................................................................................... 151
  OPERATION ......................................................................................................................................... 151
  COMMON SUBSTITUTE FUNCTIONS USED ....................................................................................... 152

ACH SETUP ............................................................................................................................................. 155
  BANK SETUP ....................................................................................................................................... 155
  PAYEE LIST SETUP ........................................................................................................................... 155
  FORM SETUP ..................................................................................................................................... 158
  CREATING THE ACH File .................................................................................................................. 161

FTP .......................................................................................................................................................... 163
  SECURITY ........................................................................................................................................... 163
  FTP SETUP ......................................................................................................................................... 163
  BANK SETUP ....................................................................................................................................... 164
  FORM SETUP ..................................................................................................................................... 165
  MANUAL UPLOAD OF COMPLETED FILE ............................................................................................ 166

CUSTOM INTERFACES .......................................................................................................................... 169
  PRINTING TO PrintBoss PRINTER DRIVER ...................................................................................... 169
  SETUP ............................................................................................................................................... 169

CAPTURING AND ASSIGNING TEXT .................................................................................................... 171
  METHOD 1: PrintBoss TRIGGER (USE OF PB#INFO …) ................................................................. 171
  METHOD 2: EXPLICIT VARIABLE ASSIGNMENT WITHIN THE ACCOUNTING SOFTWARE REPORT .......................................................... 172
  METHOD 3: CAPTURED FROM THE PRINTED DOCUMENT BASED ON COORDINATES................................. 172
  EXAMINING ASSIGNED VARIABLES ............................................................................................... 173

APPENDIX A: PRINTBOSS BANK LIST .................................................................................................. 175
  SAVED BANKS ................................................................................................................................. 184

APPENDIX B: FORM EDITOR .................................................................................................................. 185
  FORM EDITOR .................................................................................................................................. 185
  FORM FILE COMMANDS .................................................................................................................... 195
  PrintBoss CONDITIONAL COMMANDS & PARAMETERS .................................................................. 203

APPENDIX C: #TEXT FEATURES ........................................................................................................... 205
  SUBSTITUTE FUNCTIONS TABLE ....................................................................................................... 205
  SUBSTITUTE FUNCTION DESCRIPTIONS ............................................................................................ 206

APPENDIX D: SECURITY SETTINGS ......................................................................................................... 209
  GENERAL SETTINGS ....................................................................................................................... 209
  Basic User rights (standard security mode) ...................................................................................... 210
SECURITY REQUIRED (ADVANCED SECURITY MODE) ..............................................................................................210
ADVANCED USER RIGHTS (STANDARD SECURITY MODE) ....................................................................................210
ADVANCED USER RIGHTS (ADVANCED SECURITY MODE) ....................................................................................210

APPENDIX E: VARIABLES BY CATEGORY ........................................................................................................211

ACH VARIABLES ..............................................................................................................................................211
BANK VARIABLES .............................................................................................................................................211
EMAIL VARIABLES ...........................................................................................................................................214
FAX VARIABLES .................................................................................................................................................216
FORM VARIABLES .............................................................................................................................................218
MISCELLANEOUS VARIABLES .........................................................................................................................219
PAYEE LIST VARIABLES ................................................................................................................................219
POSITIVE PAY VARIABLES ..............................................................................................................................220
WORK FILE VARIABLES ................................................................................................................................221

FAQS ....................................................................................................................................................................223

TROUBLE SHOOTING .........................................................................................................................................225

SAGE 300 ERP ..................................................................................................................................................225
MICROSOFT DYNAMICS GP ............................................................................................................................226
QUICKBOOKS ..................................................................................................................................................226
NT/W2000/WXP WORKSTATIONS ..................................................................................................................226
W2003 SERVER ...............................................................................................................................................227
VISTA/WINDOWS 7/WINDOWS 8 OPERATING SYSTEMS ..................................................................................227
GENERAL .........................................................................................................................................................227

GLOSSARY ..........................................................................................................................................................229
ABOUT THIS USER MANUAL

This manual is a guide to the settings and options within the PrintBoss program. It applies to the current version of the software and does not cover features that may have only been relevant to older versions of the software. This manual also assumes that fairly recent versions of the Host Accounting Software are being used.

Documents viewed or printed from the VIEW NOTES button during PrintBoss installation are Host Accounting Software specific. These notes, referred to as Installation Notes, supplement this manual, as this manual is a generic guide for all interfaces.

SYMBOL KEY

✔ Important items

 الخارطة PrintBoss Enterprise Edition specific items

📖 Refer to another section of this manual for more detail

MANUAL UPDATES

Please check online at www.WellspringSoftware.com for an updated version of this manual.
INTRODUCTION

PrintBoss captures check runs, invoices, picking slips, and other accounting data printed from accounting software and combine it with digital forms (PrintBoss Form files). This allows the accounting documents to be printed on blank white paper or, in the case of checks, on blank check stock.

PrintBoss eliminates the need for multiple part forms. The software creates a database to print the original and all copies to the specified location or destination (printer, e-mail, fax, or PDF). Each copy can be printed with unique information including a legend (i.e. CUSTOMER FILE, ACCOUNTING FILE, etc.), a logo, or any other field available from the accounting software that might pertain to the specific copy of a document.

PrintBoss captures information from the Host Accounting Software in one of two ways:

- By printing directly from your accounting software to the PrintBoss Printer Driver and then printing to a Windows printer.
- By printing from the accounting software to a file that PrintBoss can automatically capture and send to a Windows printer.

Printing to the PrintBoss printer is preferable to printing to a file if possible. Our standard specifications and forms determine the best method for printing and distributing files for several accounting packages.

PRINTBOSS PRODUCTS

There are three PrintBoss editions:

- PrintBoss Select
- PrintBoss Standard
- PrintBoss Enterprise

The following is a brief description of each edition.

PrintBoss Select

PrintBoss Select is designed exclusively to print checks and Deposit Slips for Intuit QuickBooks/Quicken ONLY. It is a faster, more efficient way of capturing check runs from QuickBooks/Quicken and accurately printing MICR lines. This is a limited edition of standard PrintBoss and does not have the full feature set of the Standard or Enterprise products. Visit our web site for a list of features for this product at http://www.wellspringsoftware.com/Marketing/Software_FB.aspx.

PrintBoss Standard

PrintBoss is designed to capture check data and more from accounting packages. Some of the additional features of the standard edition of PrintBoss include:

- Archive copies
- Automatic selection of Bank Accounts
- Design custom forms with graphics
- Generate Positive Pay files
- Print to Email
- Print to Fax
- Print other accounting forms, such as Purchase Orders, Invoices, Picking Slips, and Deposit Slips. The available forms depend on the accounting package
- Use customized forms
- Work with Text Capture files

**PrintBoss Enterprise**

PrintBoss Enterprise has all the features of the standard edition plus more. It is designed to accommodate special needs in capturing graphics from accounting packages and working with terminal servers. Enterprise is available as an upgrade from the Professional PrintBoss program through Wellspring Software, Inc.

Additional features that are only available in the Enterprise edition will be noted throughout this manual.

**SYSTEM REQUIREMENTS**

PrintBoss is compatible with W2003 Server, W2008 and W2008 R2 Servers, W2012 Server, Windows XP, Vista, Windows 7, and Windows 8 operating systems. It is also compatible with 64-bit versions of these operating systems beginning with W2003. As a general rule, 64 MB of RAM should be available for use with PrintBoss. PrintBoss can be installed onto a work station or a network. Please see the license agreement to determine the restrictions.

**PRINTER REQUIREMENTS**

PrintBoss was designed to work with a Hewlett-Packard LaserJet printer. Any printer used with PrintBoss must be 100% HP compatible and use a PCL5e or PCL6 driver. If there are driver options for the printer model, please use one of these choices. PrintBoss is not compatible with PostScript printers.

PrintBoss is guaranteed to work with most of the Hewlett-Packard LaserJet printers. The suggested models include HPLJ4 and newer. Print speed requirements and budget should help determine the best Hewlett-Packard LaserJet model for your needs.

When considering a brand other than HP, determine if your bank requires MICR ink. If the bank does require this special magnetic ink (for reading the bank code on checks), make sure the brand and model of Laser printer you choose has MICR toner available. Not all models have MICR toner cartridges available in the market.

**NOTE:**

Printers other than Laser printers have a smaller printable area and may not be able to print full documents. This is particularly important for printing checks as models other than Lasers are often incapable of printing the MICR line. PrintBoss is not guaranteed to work with printers that are not Laser printers.
Chapter 3

INSTALLATION

PrintBoss can be installed locally on a single workstation (*Local Install*), or it can be installed to a shared network folder where multiple workstations access the one application. Both mapped drive letters and UNC paths will work to identify the location of the PrintBoss Directory. We recommend PrintBoss is installed on a shared folder if there are multiple users so bank information, forms, and other information can be shared. After installing PrintBoss to the shared folder (*Network Install*), each additional workstation only needs the *Workstation Install* steps.

- **✓** Unless the server is used as a workstation, installation to the server folder can be performed from a workstation.
- **✓** All PrintBoss users need **FULL CONTROL** of the PrintBoss Home directory. Simply having read and write permissions are not sufficient.
- **✓** If you have internet access, download the latest setup.exe from our web site. Use this setup program instead of the setup.exe file on the CD to ensure you are installing the most recent version of PrintBoss.

📖 Citrix & Terminal Server installations are referenced in Chapter 6.

The following pages contain tables with step by step installation instructions for the 3 basic install types – local, network, and workstation.
### STEP 1

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start the PrintBoss Installation</strong></td>
<td><strong>Start the PrintBoss Installation</strong></td>
<td><strong>Start the PrintBoss Installation</strong></td>
</tr>
<tr>
<td>✓ Log in as ADMINISTRATOR. Insert the PrintBoss CD-ROM in the CD-ROM Drive. Run X:\setup.exe (where X: is the CD-ROM drive). Select the Accounting Software to be used with PrintBoss. If the Accounting Software is not in the list, choose Custom. Select the directory where PrintBoss is to be installed. PrintBoss will default to C:\PrntBoss. Select to install icons for the Current User or for All Users of this workstation. Click on Next.</td>
<td>✓ Log in as ADMINISTRATOR. Insert the PrintBoss CD-ROM in the CD-ROM Drive. Run X:\setup.exe (where X: is the CD-ROM drive). Select the Accounting Software to be used with PrintBoss. If the Accounting Software is not in the list, choose Custom. Select the directory where PrintBoss is to be installed. PrintBoss will default to C:\PrntBoss. Change this to X:\PrntBoss (where X is the shared network drive). PrintBoss may use either drive mappings or the UNC path. Select to install icons for the Current User or for All Users of this workstation. Click on Next.</td>
<td>✓ Log in as ADMINISTRATOR. Run X:\PrntBoss\setup.exe (where X is the shared network drive). Select the Accounting Software to be used with PrintBoss. If the Accounting Software is not in the list, choose Custom. Select the directory for X:\PrntBoss (where PrintBoss is already installed). Choose the Workstation/Printer Driver/Special Host Tasks option from the active radio buttons. Select to install icons for the Current User or for All Users of this workstation. Click on Next.</td>
</tr>
</tbody>
</table>

### STEP 2

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Registration &amp; Activation of the PrintBoss Software</strong></td>
<td><strong>Registration &amp; Activation of the PrintBoss Software</strong></td>
<td><strong>Registration &amp; Activation of the PrintBoss Software</strong></td>
</tr>
<tr>
<td>Enter the Serial Number, Options, and Registration Code from the BLUE registration card that came with the software. Enter the Company Name, contact, and site that should become permanent within the PrintBoss software. Confirm the information and save the registration. ✓ If the workstation has internet access, click on the online activation option. If the workstation does not have internet access, choose to e-mail or fax the activation. PrintBoss will function for 30 days without activation (Evaluation Date).</td>
<td>Enter the Serial Number, Options, and Registration Code from the BLUE registration card that came with the software. Enter the Company Name, contact, and site that should become permanent within the PrintBoss software. Confirm the information and save the registration. ✓ If the workstation has internet access, click on the online activation option. If the workstation does not have internet access, choose to e-mail or fax the activation. PrintBoss will function for 30 days without activation (Evaluation Date).</td>
<td>This step is skipped. The software is already registered and activated.</td>
</tr>
</tbody>
</table>
### STEP 3

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation of Components</td>
<td>PrintBoss automatically selects the components that are needed. Leave the defaults.</td>
<td>PrintBoss automatically selects the components that are needed. Leave the defaults.</td>
</tr>
</tbody>
</table>

### STEP 4

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrintBoss Settings Saved</td>
<td>PrintBoss automatically selects the registry that is needed. Typically, this is the Local and User Registry.</td>
<td>PrintBoss automatically selects the registry that is needed. Typically, this is the Local and User Registry.</td>
</tr>
</tbody>
</table>

### STEP 5

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
</table>
| View Notes | Click on the VIEW NOTES button.  
✓ PRINT OUT THESE NOTES. They will guide you through steps specific for the accounting software. | Click on the VIEW NOTES button.  
✓ PRINT OUT THESE NOTES. They will guide you through steps specific for the accounting software. | This step is skipped. The document has already been viewed and printed. |

### STEP 6

<table>
<thead>
<tr>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
</table>
| Special Install Steps | If the SPECIAL INSTALL STEPS button is active, click on it.  
Follow the instructions per the NOTES printed in Step 5 that are specific for the accounting software. | If the SPECIAL INSTALL STEPS button is active, click on it.  
Follow the instructions per the NOTES printed in Step 5 that are specific for the accounting software. | If the accounting software is installed locally, then this step may be necessary. |
<table>
<thead>
<tr>
<th>STEP 7</th>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the PrintBoss Printer Driver</td>
<td>The installation automatically selects the best driver choice for this workstation. Usually, this is PrintBoss 50. Click on Finish. Restart the computer or restart the Print Spooler if the PrintBoss 50 driver was installed. For more information about the differences between the PrintBoss NT40 and PrintBoss 50 drivers, please see the support documents on our web site.</td>
<td>The installation automatically selects the best driver choice for this workstation. Usually, this is PrintBoss 50. Click on Finish. Restart the computer or restart the Print Spooler if the PrintBoss 50 driver was installed. For more information about the differences between the PrintBoss NT40 and PrintBoss 50 drivers, please see the support documents on our web site.</td>
<td>The installation automatically selects the best driver choice for this workstation. Usually, this is PrintBoss 50. Click on Finish. Restart the computer or restart the Print Spooler if the PrintBoss 50 driver was installed. For more information about the differences between the PrintBoss NT40 and PrintBoss 50 drivers, please see the support documents on our web site.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STEP 8</th>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup PrintBoss for the Accounting Software</td>
<td>Follow the Installation Notes to setup PrintBoss specifically for the Accounting Software.</td>
<td>Follow the Installation Notes to setup PrintBoss specifically for the Accounting Software.</td>
<td>This step is skipped. Setup is already complete.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STEP 9</th>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Accounting Software for PrintBoss</td>
<td>Follow the Installation Notes to setup the Accounting Software to interface with PrintBoss.</td>
<td>Follow the Installation Notes to setup the Accounting Software to interface with PrintBoss.</td>
<td>Follow the Installation Notes to setup the Accounting Software to interface with PrintBoss.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>STEP 10</th>
<th>LOCAL INSTALL</th>
<th>NETWORK INSTALL</th>
<th>WORKSTATION INSTALL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check for PrintBoss Updates Online</td>
<td>If the workstation has internet access, check for updates. Start the PrintBoss program (PB32 Program). Select HELP / ABOUT. Click on the button CHECK FOR PRINTBOSS UPDATES ONLINE. RUN the update. This update is accessible on the day PrintBoss is FIRST installed or if there is a current service contract.</td>
<td>If the workstation has internet access, check for updates. Start the PrintBoss program (PB32 Program). Select HELP / ABOUT. Click on the button CHECK FOR PRINTBOSS UPDATES ONLINE. RUN the update. This update is accessible on the day PrintBoss is FIRST installed or if there is a current service contract.</td>
<td>This step is skipped. The software should already be updated.</td>
</tr>
</tbody>
</table>

✓ Save the BLUE PrintBoss registration card in a safe place for backup purposes.
Setup

PrintBoss is designed to send virtually any Windows program information through the PrintBoss printer driver. This allows the information printed by the PrintBoss program to include additional user specific data (e.g. Company Name and Address and Bank Name and Address). PrintBoss can also add a MICR line.

**Standard PrintBoss Interfaces**

PrintBoss is shipped ready to interface with several software packages. Each standard interface has at least one check form made to fit the check stock that comes pre-bundled with PrintBoss. Some interfaces include additional forms. PrintBoss is capable of working with more than one Host Accounting Software program simultaneously.

- All of the PrintBoss standard check forms are designed to place the check at the bottom of letter sized stock.

**NOTE:**

Our standard check forms place the check at the bottom for two reasons:

- Banks prefer the MICR edge to be the clean edge of the paper (easier for processing by equipment).
- Most of our standard forms provide a mini copy of both the check and advice on the top portion of the page. This very popular option often eliminates the need to make additional copies of checks for record keeping.

Settings specific to each interface are described in the PrintBoss installation program under the **VIEW NOTES** button. These document files are stored in the PrntBoss\Docs directory.

The list of our standard interfaces includes the following Windows based products:

- 21st Century Accounting "C21" by Hilbert Software
- 21st Century US Payroll for Adagio by Hilbert Software
- Adagio by Softrak Systems
- Alere by TIW Technology
- CenterPoint by Red Wing
- DSS Payroll by Distinctive Software Solutions
- HAB, Inc.
- IDS (Integrated Data Services)
- Mark Systems
- Master Tax
- Microsoft Dynamics AX (Axapta)
- Microsoft Dynamics GP (fka Great Plains Business Solutions)
- Microsoft Dynamics NAV (Navision) (fka Attain)
- Microsoft Dynamics SL (fka Solomon)
- NetSuite
- Paymate by AK Microsystems
PrintBoss Enterprise is often required for Custom Programming needs.

For more information on our standard interfaces, visit our website at www.WellspringSoftware.com.

**PRINTER SETUP**

1. Open the PrintBoss Master Application.
2. Click on the **File** menu and select **Printer Setup**. This PrintBoss Printer Setup dialog opens.
3. Choose the default laser printer for documents printed through PrintBoss. **Do Not Select the PrintBoss printer itself (PrintBoss NT40 or PrintBoss 50)**. The PrintBoss printer should only be selected by the accounting software.
   a. Select **Use Windows Default** to use standard PrintBoss on a terminal server.
   b. Select a **Specific Printer** from the drop down menu to specify a printer other than the Windows default to use with standard PrintBoss in environments other than a terminal server or to use with the Enterprise edition of PrintBoss on a terminal server.
4. Click **OK** when you are finished. The OK button is only available when changes are made to the printer setup.

Each workstation using PrintBoss can select a different default printer. This selection is saved locally on the workstation and will not change the selection on other workstations.

** ✓ PrintBoss is very literal with the names of printers. If the printer name changes in any way, the PrintBoss program will consider the new name as a new/different printer.**

** Notices for Terminal Servers / Citrix Servers**

Often in a Terminal Server or Citrix environment the printer name includes the session number or indicator. This results in multiple names for the same printer. Each name is only available in the specified session. Applications such as PrintBoss generate an error when the selected printer name is not available. PrintBoss Enterprise can define the session indicators and truncate the printer name so the printer is recognized in all sessions. The other option is to save the printer choice in the PrintBoss Directory instead of the Terminal Server registry.

** CONFIGURATION**

The Configuration screens provide additional options for working with various accounting applications. Select **OPTIONS / CONFIGURATION** from the PrintBoss Master Application window to view or change these options.
Choose the settings recommended in the *Installation Notes* for your accounting software. A description of the settings on each tab follows.

**Settings**

Most of these settings are set automatically for the accounting software. If multiple users are working with PrintBoss on a network, the *Work Files Private Folder Name* should be set to *WinUserName* globally for each workstation. See *Private Folder Names* below.

**MICR Offset Adjustment & MICR Adjust Wizard**

The location of the MICR line is calculated by PrintBoss based on the directives passed in the #MICR command. Typically, this placement is accurate for a check printed at the bottom of an 11” page. Sometimes there are small differences in alignment from printer to printer. A separate adjustment can be made in the Configuration of PrintBoss to correct the alignment. Once the adjustment is made, it should not need to be changed unless the printer, printer driver, or operating system is changed. The adjustment of the MICR can be both vertical and horizontal. This setting is global for all forms and is workstation and user specific.

Select OPTIONS / CONFIGURATION from the PrintBoss Master Application window to access the adjustment settings. The adjustments may be completed with the help of the MICR Adjust Wizard or by manually adjusting the values.

**MICR Adjust Wizard**

Click on the *MICR Adjust Wizard* button to open a step by step adjustment wizard. This method does not require a preprinted symbol on the back of the check and can be used with Canadian style checks. Follow the steps for the wizard to satisfactorily adjust the placement of the MICR. Click on *Finish* to exit the Wizard. Upon completion, the MICR Offset Adjustment values will be modified.

**Manual adjustment**

Adjust the horizontal (Left/Right) and vertical (Top/Bottom) alignments independently of each other so the laser printed Transit Character overlays the Transit Character preprinted on the back of the check stock. (Hold printed copy up to the light to see if it is properly aligned). Increase the corresponding MICR offset values to move the laser printed characters to the Right or Down (Bottom) on the page. The values are in thousandths of an inch. The amount of the adjustment may vary from printer to printer. Decrease the MICR offset values to shift the laser printed character to the Left or Up (Top). Use negative numbers to move below zero.

See Chapter 8, *Bank Accounts*, for additional information about the MICR line.

**Non-MICR Offset Adjustment**

This setting adjusts the entire document, except the MICR line, to center documents on the page. The purpose of this setting is to adjust for small differences in printer driver margins and is not intended for significant shifts of form placement. The adjustment can be both vertical and horizontal. This setting is global for all forms and is workstation and user specific. You may need to adjust this setting if a new printer or new printer driver is used with PrintBoss.

Start by selecting the orientation of the page, either Portrait or Landscape. If the document needs to move Right or Down (Bottom), increase the corresponding Non-MICR offset. The values are in thousandths of an inch. The amount of the adjustment may vary from printer to printer. Decrease the MICR offset to shift the forms Left or Up (Top). Use negative numbers to move below zero.

**Private Folder Names**

**Work Files**

Every time PrintBoss processes a document it creates a work file. The work files are specific to a Form. If the PrintBoss application is on a shared drive, each workstation should have a unique work file folder name to prevent accidentally overwriting files.

Click on the Work Files drop down menu to change the selection from <COMMON> to something unique for each workstation. The {WinUserName} setting creates a folder using the Windows User Name of the person logged into the computer. You may also highlight the field and type a name. DO NOT put the arrows (< >) around the new name. PrintBoss creates a work file folder using the name you specified and saves it in the PrintBoss Work folder located in the PrintBoss Directory folder.
Repeat this step on each workstation that will use PrintBoss or check the Set Globally box.

<table>
<thead>
<tr>
<th>Private Folder Names</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Files</td>
<td>Archive Files</td>
</tr>
<tr>
<td>{WinUserName}</td>
<td>{WinUserName}</td>
</tr>
</tbody>
</table>

Checking the box changes the settings for the Private Folder Names of both the Work Files and Archive Files to [WinUserName].

**Archive Files**
Archiving is set on the Form and applies to all users.

When the Set Globally box is checked, this field will automatically be set to [WinUserName]. The folders generated by PrintBoss in the Archives subdirectory will automatically use the Window's system user name. This setting functions similar to Work Files. Otherwise, PrintBoss will save Archive Files in a Common folder.

**Allow temporary folder change when browsing work file or archive**
The default setting for browsing work files or archive files is to only display work files for the person logged into the workstation. Occasionally, a manager or Wellspring Software technician may need to review the work or archive files of other users. This option allows all work or archive files to be viewed from this workstation. This is faster than changing the configuration settings and returning to the work/archive file browse window.

**Set Globally**
This option, when checked, sets the Private Folder Names for both Work Files and Archive File for all users to [WinUserName]. This is required for Citrix or Terminal Server users. It also eliminates an extra step during the setup of each workstation.

**REQUEST LIST PRIVATE FILE**
This feature enables users to create unique Form/Bank Request Lists. The default value is <COMMON> so all users share the same list. If individual lists are created, the files are saved in the ReqLists subdirectory of the PrintBoss Home Directory.

See Chapter 19, Form / Bank Request List.

**ENABLE PRINTBOSS WINDOWS PRINTER DRIVER PROCESSING**
This option must be checked to activate the PrintBoss printer driver interface method. The only time this option is not checked (other than at the direction of Wellspring Software technical support) is when the text file interface is the only method used. All of our current standard interfaces use the printer driver interface method. Only custom interfaces use the text file method.

**Always Capture Settings**
When the Flag Trigger option is selected on the PrintBoss Driver Settings window, this section will not be visible.

Set this option according to the Installation Notes for your accounting software. Set the FORM field to Blank01 and the BANK field to NONE for interfaces that use the Flag Trigger method.

**Request List Determines Form/Bank**
Select this option when instructed by the Installation Notes for your accounting software. This option directs PrintBoss to use the entries in the Form/Bank Request List to determine the Form and Bank for a batch of documents. This option is overwritten by PB#INFO when it is selected. (See next paragraph).

**"PB#INFO" flag overrides above**
This box should be checked when using accounting software that utilizes both the Flag Trigger and Always Trigger methods.

**NT Capture Offsets**
The default values typically place data onto the forms correctly. If the data from the accounting software is not lining up within the form correctly, uncheck the Use Default Offset box to change the values. These values are in pixels. Adjust the values in increments of at least 10. Click the Defa. button to reset these values to their default settings for this workstation. Positive values move data down on the form while negative values move data up. This setting is workstation specific.
Internal

MISC LOCAL PROPERTIES

Suppress warning that PrintBoss is the Windows Default Printer
The PrintBoss printer driver should not be the Window's default printer. If the PrintBoss printer is set as the Window's default printer, the PrintBoss program will generate a warning message. This option should not be checked. Only check this option in special circumstances.

Save Printer Settings
This setting is checked by default and allows the PrintBoss program to retain information about specific printers and trays.

Suppress dialogs when appropriate
Check one or all of the following options to stop PrintBoss from pop-up a window or flashing in the taskbar when it is processing documents: Print Dialog; Archive; E-mail; Fax Service.

Local Drive Letter for Signature Disks
By default, PrintBoss expects the signature disks to be in the A drive of the workstation. Choose the default drive letter appropriate for your workstation.

Remote Signature Read Delay (Seconds)
Enter an amount in seconds to delay PrintBoss from reading the signature code until the device is loaded by the OS.

Print Status Screen Position
This option allows the user to select the position of the Print Status window. The choices are Top Right, Screen Center, or Bottom Right. The default value is Screen Center.

TextCapt Hst Last Used Count
The default setting for this feature is set to 5. It is used for troubleshooting.

Minimize PrintBoss on startup
Check this box to minimize PrintBoss after it is opened.

MISC APPLICATION PROPERTIES

When launched by Acct. Host, Terminate PrintBoss After Batch Print
Check this box to automatically close PrintBoss when it has been automatically opened by a print job. This will not close PrintBoss if the user manually opens the program.

Windows Print Job Limit
This setting allows PrintBoss to help ease the stress of a printer queue. This setting can be used to separate a single large batch into smaller print jobs by creating a pause between each job. The pause allows the first print job to begin processing before the second job is sent to the printer, minimizing the backlog in the printer memory.

Print Jobs till Prompt to Continue
This feature is available when the Windows Print Job Limit has been modified. Enter a value greater than 0 to have PrintBoss prompt the user to send more print jobs to the printer. This feature is often used when printing large batches and provides a prompt to allow the user time to refill a paper tray.

Delay Between Print Jobs
This feature is available when the Windows Print Job Limit has been modified. The value represents seconds and determines the length of the pause between each print job PrintBoss sends to the printer.

Print Jobs received within these secs are treated as one batch
PrintBoss can be set to "wait" to combine all pages into a single batch for accounting software that sends each page as a separate print job. This only works when the Append to Transfer File option is checked on the PrintBoss Driver Settings window.

Stop Before Print Job starts when invalid printer exists
PrintBoss will determine if a valid printer is selected before it starts the print job when this checkbox is selected.

Default printer choice for new users (or Terminal Server Clients) is "use Win Default"
There are times when you want to set the printer for the PrintBoss Printer Setup for all users to use the Windows Default printer. This is especially true for users in a terminal server environment using Standard PrintBoss. This option will set this default for all new users. Select this immediately after the initial installation to apply to all users.
**Force form pre-read for each page (helps for multiple forms per batch)**
Select this option when more than one PrintBoss Form is used within a single batch.

**Work/Archive File Compression ALWAYS (overrides each form’s setting)**
This option is only visible with Force form pre-read for each page is selected. Select this option to override the form’s settings and always compress Work and Archive Files.

**ReqList Examines all pages for form ID within a batch (not just first page)**
Some accounting software has the ability to send documents with different formats in the same print batch. Select this option to allow PrintBoss to match each document against the Form/Bank Request List to determine the correct Form and Bank for each document in the batch.

**DocRecip Length**
Use this option to extend the length of the DocRecip field in the Work File. The default length is currently 40 characters. PrintBoss allows a maximum of 60 characters for the DocRecip field in the Work File.

**BANK APPLICATION PROPERTIES**

**Method of Matching of Bank Code**
There are two different methods PrintBoss uses to match the Bank Code from the accounting software with the Bank Code in the PrintBoss Bank List (when a Bank Code is used). The most common method is **Enforce Exact Bank Code Match** and requires a character-by-character match for the entire string. The **Allow Partial Match** method looks for an exact match up to the colon (:) in the bank code and then any partial match after the colon. Partial matching is very unusual.

See Chapter 8, *Bank Accounts*.

**Allow for Selection when multiple Bank Codes match**
Occasionally, there may be more than one account with the same bank code. Check this option to allow the user to select from a list of the matching bank codes. This is a good feature to select even if you don’t expect to have matching bank codes to alert you in case a matching bank code has been inadvertently created. **This feature is required for Microsoft Great Plains Business Solutions products when there is more than one payroll account for the same company.**

**Allow bank accounts to be AP and Payroll**
Most accounting software will use the variables {ChkAcct}:{CompName} to allow PrintBoss to choose the correct bank account for each check in a batch. Some accounting software does not print the checking account ID for payroll checks and PrintBoss may substitute the word Payroll for the checking account ID. When the same bank account is used for both AP and Payroll, PrintBoss may generate a list of bank codes every time Payroll is printed after AP or vice versa. Often the Bank Code gets renamed each time. Select this option to use one bank account for both AP and Payroll. PrintBoss will match the company name only for the Payroll checks. The **Enable “Payroll” alias name** must be selected on the Bank Record as well. The alias is only available when **Allow bank accounts to be AP and Payroll** is selected on the Internal tab of the Configuration window.

**Auto Populate Bank List with Unused Records**
Select a value to automatically populate the Bank List in PrintBoss. The default is the number of bank records purchased. Ten bank records are provided with each PrintBoss license. This feature is often used with the unlimited bank module to limit the initial population of the bank list. The default for the unlimited bank module is 25.

**Change Bank Code Len**
The default Bank Code length is 50 characters. PrintBoss versions prior to version 5.x default to 30. Occasionally, the accounting software sends a longer bank code. In these cases, the bank code length may be increased up to a maximum of 60 characters. If the bank code length is set to a longer value and then decreased, any bank codes that are longer than the new value will be truncated. This action cannot be undone. The bank code length may be changed back to a longer length, but the actual bank codes in PrintBoss need to be edited to match their original names.

**Search Payee List using this method:**
The default method is ‘Standard Mode’ and matches by Payee Name and ID. The other two choices are:

- Matches on Payee
- Matches on Payee ID
Menus

**Enable Tool Bar**
Check this option to select the menu icons you want to appear as shortcuts on the Master Application window.

**Enable Master Menu Status Panel**
When this box is checked, the lower half of the Master Application window shows the Capturing Status dialog. This is a great feature for troubleshooting. When this box is not checked, the lower half of the Master Application window is suppressed. The value is checked by default.

**Enable Master Menu Status Tray ( Normally Unchecked)**
Select this option to display the Status Tray at the bottom of the PrintBoss Master Application window.

**Reset Window Sizes**
PrintBoss remembers the size and location of many of the windows in PrintBoss as the user naturally adjusts them. Click this button to reset all windows to their original default locations and sizes.

Legacy

Most of the settings on this tab are being discontinued. They are included for special cases where legacy installs of PrintBoss have relied on these features.

**Suppress Form’s Common Printer by Projecting onto Individual Copies**
PrintBoss had a Form/Printer Device setting in versions prior to 5.3. This setting can still be used if the legacy option is set to教导Method Form Printer. Version 5.3 and later can Suppress Form’s Common Printer and assign the selected printer to individual copies on the Multi-Parts & Printers tab of the Form Editor. The old Form Printer choice has been replaced with Default PrintBoss Printer on the form’s Multi-Parts and Printers tab.

**Show "Scan Scope Status" Button on Print Screen**
Set this option to Displayed to display the Scan Scope Status button on the PrintBoss Print Copies Dialog. This button is used to scan the status of the documents defined in the Scope. For example, it might display 3/15 next to the Original copy, indicating 3 of the 15 documents have been processed.

Select Suppressed to hide this button on the PrintBoss Print Copies Dialog. The Default setting for new installs is to suppress this button.

**"Stay On Top" Method for Document Printing Windows**
This option should typically remain at the Default (Bring to front) value. Click on the drop down menu if you prefer a different method.

**Virus Scanner Allowances**
The Virus Scanner Allowances include options for Alternate Workfile Delete Method and Millisecond Wait for files to open. These options should only be used when instructed by a Wellspring Software support technician. The ‘Alternate Workfile Delete Method’ is checked by default and the Milliseconds is set to 100.

**Hidden Files**
The following features are hidden and require the assistance of a Wellspring Software technician.

- Graphic Printing Module
  This should be Standard.

- Pitch Method used in printing when Pitch is specified
  This remains Precise Pitch.

- Include Host Blank Pages
  This should remain unchecked.
Show "Current Bank" on Master
This is typically not checked and the bank list appears as a drop down menu at the bottom of the Form Select window. When checked, the bank list appears as a drop down menu on the Master Application screen of PrintBoss and the list will not appear at the bottom of the Form Select window.

Allow Fragmented PB/INFO line
This option should be selected when the PB/INFO line or Trigger gets fragmented and is selected by default. It must be checked for all Sage Accpac ERP users.

Workaround for Novell bug
This should be checked for Novell clients/servers only.

**PrintBoss Driver Settings**

PrintBoss Driver Settings provide additional features for working with various host accounting applications. Select OPTIONS / PRINTBOSS DRIVER SETTINGS from the PrintBoss Master Application window to view or change these features. Choose the settings recommended in the Installation Notes for your accounting software. A description of the settings follows.

**PrintBoss Directory**
PrintBoss uses files (such as Form Files, Bank Lists, and Work Files) that are installed in the PrintBoss directory or its descendants. This PrintBoss directory is referred to as the PrintBoss Home Directory. The location of this directory is saved in the Local User Registry on each workstation that runs PrintBoss. Select About under the Help menu in PrintBoss to verify the location of your Home Directory.

The location of the Home Directory can create some confusion. If the PrintBoss program is started from another location (as per the properties of the shortcut icon that starts PrintBoss), it will still use the Home Directory that was originally recorded. This typically occurs when PrintBoss is initially installed locally and then all files are moved to a network location. PrintBoss still looks at the local directory as its Home.

To change the Home Directory, choose OPTIONS / PRINTBOSS DRIVER SETTINGS and change the PrintBoss Directory accordingly. Restart PrintBoss for the change to take effect.

It is strongly recommended that the Home and EXE directories listed on the HELP / ABOUT window match. When PrintBoss is automatically loaded by a print job, the executable listed in the Home Directory is used regardless of any shortcut settings.

PrintBoss cannot use two different HOME directories at the same time.

**Transfer File Settings**

Transfer Folder/File
The Transfer Folder/File option under Transfer File Settings should not be selected unless directed otherwise by a Wellspring Software, Inc., support technician. The transfer file is a temporary file that is generated by the PrintBoss printer driver and then renamed and finally deleted. The user must have permissions to create, rename, and delete this file in the Transfer folder. While the folder name is the same for all users, the actual file must be unique for each user or multiple users could overwrite each other's files. The default folder path and file name are \{ComAppData\..\Transfer\} \{WinUserName\}. This setting is the same for a Terminal Server or Citrix environment. Click OK when exiting this dialog.

There are other options for Terminal Server/Citrix environments. See Chapter 6, Citrix or Terminal Server Installs, for additional information.

Use Driver Port
This option should remain unchecked unless directed otherwise by a Wellspring Software, Inc., support technician for troubleshooting.

Append to Transfer File
This option should be checked for accounting software that sends each document as an individual print job. This allows PrintBoss to wait for additional documents to treat all of the documents as a single batch. Please see the Installation Notes specific to the accounting software to determine if this feature should be checked. If checked, the wait increment must be defined in seconds on the Internal tab of the Configuration window (OPTIONS / CONFIGURATION).
**Test Path**
This option confirms the location specified for the Transfer File Settings exists.

**Driver Log**
This setting should be set to "Never" unless directed by a Wellspring Software, Inc., support technician for troubleshooting.

**Load PB32.exe**
This option should be checked to automatically load the PrintBoss program when a transfer file is received from your accounting software. This box should NOT be checked for Citrix or Terminal Server installations when the users only have access to “Published Applications” on a Windows 2003 server.

See Chapter 6, *Citrix or Terminal Server Installs*.

**PB NT40 Driver Special Settings**
This section is not available on Vista, Windows 7, and Windows 2008 server and is unavailable by default and typically does not need to be edited. Check the Allow Editing box to access this section. Usually, this is only changed in Citrix or Terminal Server environments.

PB32Stub.exe is a small program that typically runs in the background allowing the PrintBoss program to automatically load when a print job is sent to the PrintBoss NT40 driver.

- **PB32Stub.exe should NOT run in a Citrix or Terminal Server environment with a "Published Application" on a Windows 2003 or earlier server.**

See Chapter 6, *Citrix or Terminal Server Installs*.

**PB32Stub.exe is Running**
Non-editable option indicates if PB32Stub.exe is currently active.

- "C:\Windows\system32\PB32Stub.exe exists"
  This is a non-editable option that indicates the availability of the PB32Stub.exe.

**Load PB32Stub.exe from Local Registry "Run"**
This will load PB32Stub.exe based on the Local Registry setting. This will typically load PB32Stub.exe for all users.

**Load PB32Stub.exe from User Registry "Run"**
This will load PB32Stub.exe based on the User Registry setting. This will typically load PB32Stub.exe for only the users who will run PrintBoss.

**Set All Users to load PB32Stub from User Registry**
This will globally allow all users to launch PB32Stub.exe based on User Registry settings. This option is traditionally the choice for Citrix and Terminal Server installations.

**PB 50 Driver Special Settings**
This section is unavailable by default and typically does not need to be edited. Check the Allow Editing box to access this option.

**50 Driver Spool Dir**
Users must have Read/Write permissions to this directory. The default setting is {ComAppData\..\Spool}. A button labeled Test confirms the actual path location. If sufficient permissions do not exist to this path and cannot be granted, there are several options.

- Set the 50 Driver Spool Directory to the same location indicated by the Transfer Folder/File (see Transfer File Settings). This only works if the Transfer File is set to the local computer.
- Set the 50 Driver Spool Directory to the {Program Files Dir} of the machine where PrintBoss resides. This should NEVER point to a directory not physically on the hard disk of the workstation.

PrintBoss will generate a reminder after clicking OK that changes to the driver spool will not take effect until the workstation is rebooted or the Print Spooler service is restarted.

See Chapter 6, *Citrix or Terminal Server Installs*.

**Configuration Settings Save Location**
This is set during installation to *Local_ User Registry (Standard)*.
See Chapter 3, Step 4 – Installation.

CAPTURE MODE

Capture Disabled
PrintBoss is deactivated when this option is selected.

Flag Trigger Required
PrintBoss looks for PB#INFO (or PBZINFO) in the data. This string has no spaces and is case sensitive – all capital letters. The string specifies the PrintBoss form used to capture the data passed from your accounting software and possibly other requirements such as the appropriate bank record to use.

See Chapter 24, Capturing and Assigning Text.

Always Capture
PrintBoss will attempt to process anything sent to the PrintBoss printer driver when this option is selected.

MISC SETTINGS

Suppress "No Flag in Document" warning
This option may be selected for accounting software that utilizes the PrintBoss Trigger or PB#INFO line to specify the appropriate form to use in PrintBoss. The warning that a document without the PrintBoss Trigger has been printed to the PrintBoss printer driver will not be generated when this option is selected. The document will simply be ignored. Nothing will print.

Operate in ASP mode
This is only for Application Service Provider installations. ASP installations are NOT the same as Citrix or Terminal Server installations. Please contact Wellspring Software, Inc., for licensing and details when installing PrintBoss for an ASP.

Printer List Settle Time
This allows the Windows Printers list to "settle" in an environment where printers are shared. This feature is especially helpful in Citrix or Terminal Server environments. The default value is 200.

Print Job Delete Secs
This option should only be used when instructed by a Wellspring Software support technician.

Render Method
The Render Method applies to the PrintBoss driver and only has an impact when the textcapt.hst file is created. For most accounting applications, this is set to Default. Original is sometimes used for Great Plains Dynamics and Special is sometimes used for Adagio. This option should only be used when instructed by a Wellspring Software support technician.

ABOUT PrintBoss

Click on the HELP menu and select ABOUT to review system information for your PrintBoss program.

CHECK FOR PrintBoss UPDATES ONLINE
This option allows a workstation that is connected to the internet to poll the Wellspring Software web site to check for a newer posted version of the software. If a newer version exists, options for updating are provided.

✓ A current service contract is required to download an update.
✓ An update will not and cannot overwrite or delete the bank files or the forms currently being used.
✓ Updates should only be run when all other users have CLOSED the PrintBoss program.

This option may be restricted by the security settings within PrintBoss.

See Chapter 11, Security Features.
**Version Info**
This section lists the version of the executable that is currently open. It also lists the version information for the PrintBoss printer driver installed on the workstation.

**License**
This section lists license information including the serial number and site location. Please see your license agreement for more detail.

**Directories**
This section lists the directories for the PrintBoss program executable that is currently open and the *Home* directory indicated by the settings.

The Accounting Hosts listed include the accounting software selected during a PrintBoss Installation along with any additional accounting software setup within PrintBoss after the initial installation. Most editions of PrintBoss can be setup to work with multiple accounting software packages.

Please see *PrintBoss Directory* under *PrintBoss Driver Settings* earlier in this chapter.

**List Current Users**
This button lists the current computers and users running this copy of PB32.exe.
The PrintBoss Printer Driver

The PrintBoss printer driver is the link between the accounting software and the PrintBoss application. The PrintBoss printer driver is designed to appear as a normal printer driver to the accounting software. However, this printer driver does not actually print anything. It simply passes the data printed by the accounting software to the PrintBoss application.

The PrintBoss printer driver should NOT be the Windows default printer, nor the accounting software’s default printer. This printer driver should only be selected for printing documents intended to be formatted or processed by the PrintBoss application.

✔ Do NOT rename or modify the properties of the PrintBoss printer driver.

PrintBoss NT40

This is the standard printer driver used with Windows XP, Windows NT, and older operating systems. This printer driver expects the accounting software is printing as if it were using a preprinted form. No graphics (including lines and boxes) will pass through this driver. This is a kernel mode printer driver.

PrintBoss NT40 Port

The PrintBoss NT40 Port driver is typically used when the accounting software is installed on a remote server and PrintBoss is installed locally. This driver needs to be installed BOTH locally and on the server that hosts the accounting software.

PrintBoss 50

PrintBoss 50 is the newest PrintBoss printer driver. It is NOT a kernel mode printer driver. For this reason, it is the default driver to install on VISTA, Windows 7, Windows 8, and 64-bit workstations, as well as Windows 2003, 2008, 2008R2, and 2012 servers, Citrix servers, and Terminal Services environments. Windows 2003 servers have a default group policy that does not allow kernel mode printer drivers. While this policy may be changed, the PrintBoss 50 driver does not require a change in the group policy.

⚠️ It is possible to pass graphics from the accounting software to the PrintBoss Form when using the PrintBoss 50 driver with PrintBoss Enterprise. This is only available with the Enterprise edition. Standard PrintBoss strips out all graphics similar to the PrintBoss NT40 printer driver.
**MANUAL INSTALLATION OF PRINTBOSS NT40 OR 50 DRIVER**

These drivers are usually installed during installation. Occasionally, the printer driver needs to be installed or reinstalled manually.

1. Navigate to the Windows Printers Control Panel.
2. Click on the **Add printer** wizard.
3. Choose to install a local printer.
4. DO NOT select **Plug & Play** to automatically detect a printer.
5. Select **nul:** (Local Port).
6. Click **Next**.
7. When asked for the printer driver, click on the **Have Disk** button.
8. Browse to the **PrintBoss** directory.
9. Open the appropriate folder (NT40 or NT50).
10. Select the **Pbnt2.inf** or **PB50Printer.inf** file from the folder.
11. Click **Open**.
12. Click **OK**.
13. Click **Next**.
14. Select **Replace the current driver** if asked this question.
15. DO NOT change the **Name** of the PrintBoss printer driver.
16. DO NOT **Share** the PrintBoss printer driver.
17. DO NOT set the PrintBoss driver as the **default** printer.
18. DO NOT print a test page.
19. Despite any Microsoft warnings about certificates or testing, complete the install of the printer driver.

**PRINTBOSS / HP COMPATIBLE INSTALLATION**

This older printer driver is necessary for W95 or W98 workstations. The setup program no longer offers this option during installation. However, it may be installed manually.

To install the **PrintBoss / HP Compatible** printer driver, follow these steps:

1. Navigate to the Windows Printers Control Panel.
2. Click on the **Add printer** wizard.
3. Choose to install a local printer.
4. DO NOT select **Plug & Play** to automatically detect a printer.
5. Leave the printer on the local port **LPT1**.
6. Click **Next**.
7. When asked for the printer driver, click on the **Have Disk** button.
8. Browse to the **PrintBoss** directory.
9. Open the **Win95** folder.
10. Select the **Printer.inf** file in the folder.
11. Click **Open**.
12. Click on **OK**.
13. Click **Next**.
14. DO NOT change the **Name** of the PrintBoss / HP Compatible printer driver.
15. DO NOT **Share** the PrintBoss / HP Compatible printer.
16. DO NOT set the PrintBoss / HP Compatible printer as the **default** printer.
17. DO NOT print a test page.
18. Despite any Microsoft warnings about certificates or testing, complete the install of the printer driver.

There should now be a PrintBoss / HP Compatible printer in the printer list. Please note there are specific settings within PrintBoss that must be used with this driver.

📖 See Chapter 4, **Setup**.
Citrix is a super-set of Terminal Server. For the remainder of this chapter, references to Terminal Server include Terminal Server and Citrix server. Their treatment and setup for PrintBoss are the same.

A Terminal Server is actually a PC that is connected to a LAN (Local Area Network). Clients that connect to the Terminal Server are running sessions on the Terminal Server and only the I/O (mostly keyboard, video, and mapped printers) is transmitted back and forth to the client stations. The functions are the same as if the user is actually sitting at the Terminal Server. As such, the PrintBoss printer driver must be installed on the Terminal Server and the PrintBoss Home folder located on the LAN server or, in unusual cases, on the Terminal Server if ONLY Terminal Server clients will be using PrintBoss. Since the PrintBoss Home folder is normally on the LAN server, only a workstation install is necessary on the Terminal Server.

The installation of PrintBoss is not much different than installation on any LAN workstation (see Chapter 3, Installation). The Setup.exe install program is run from an existing PrintBoss folder on the LAN or from a CD. It is important to run the setup while logged in as the Terminal Server Administrator. If this is the first install on the LAN, choose a destination folder that will be accessible for all PrintBoss users, both LAN workstations and Terminal Server clients.

Within an accounting application, documents intended to be printed by PrintBoss should be sent to the PrintBoss NT40 or PrintBoss 50 printer driver. The printer driver communicates with the PrintBoss application and will ultimately send the documents to the printer specified by each user from the PrintBoss application.

**NOTE:**

The printer choices are saved by user on a Terminal Server.

- Do NOT use PrintBoss with multiple operators using the same Windows User Name.
- Do NOT install PrintBoss in the Program Files folder W2008 servers and above.

**Warnings**

The Terminal Server may be setup 2 different ways to operate as a workstation. This setup has a significant impact on the settings in PrintBoss and how it is used.

**Desktop Terminal Server Session**

This method defines a shortcut that starts the Terminal Server session without identifying a specific application. Once the session starts, the operator sees a Windows Desktop on the Terminal Server as if sitting at the Terminal Server. The desktop includes the Windows Start menu, quick launch, taskbar, and tool tray along with any icons on the desktop. When the operator starts an accounting application and that application initiates a call to PrintBoss, it automatically loads PrintBoss and runs the batch of documents. This process is the same as a standard workstation install of PrintBoss.
Published Applications

This method identifies a specific application when the session is started. In fact when the window opens, the only application running is that specific application and there may be no other buttons within the session window (i.e. no other application can be launched from the Terminal server). This is sometimes referred to as a Published Application. This method is often used for security reasons, but it creates a problem for PrintBoss. Normally when a batch is printed to the PrintBoss printer driver, the driver loads the PrintBoss program (if it is not already running). In the case of a Published Application, the session does not allow other applications to start. You will need to start PrintBoss manually before printing documents.

The work around for this is to set PrintBoss to NOT load automatically which is the default setting. Open the PrintBoss program. Click on the OPTIONS menu and select PRINTBOSS DRIVER SETTINGS. Underneath the Transfer File Settings area there is a checkbox called Load PB32.exe. UNCHECK this option. In addition, select the Citrix setting that loads applications after printers are loaded or assigned. PrintBoss will open when a batch is sent to receive the documents.

**NOTE:**

For Windows Servers 2008 and above, PrintBoss can be auto launched by the host accounting system. No changes need to be made to PrintBoss to accommodate Published Applications.

W2003 Servers and above

Windows 2003 Servers and above have a default group policy setting that prevents the PrintBoss NT40 printer driver from installing. The PrintBoss 50 printer driver should install automatically under these circumstances.

- Users must have Full Control permissions to the Transfer Folder defined under OPTIONS / PRINTBOSS DRIVER SETTINGS. The folder selected by the setup program should have this permission, but it is worthwhile to check security.
- Users must have FULL CONTROL of the PrintBoss directory.
- Users should have “read” permissions to C:\Windows\System32\Spool\Printers directory. This only applies to W2003 Servers.

If an install of the PrintBoss NT40 printer driver on a W2003 server is necessary, follow these steps prior to installing PrintBoss. Please note these steps may also be necessary on the domain server as well.

1. Select START / RUN.
2. Type gedit.msc and click on OK.
4. Double-click Administrative Templates.
5. Double-click Printers.
6. Right-click on Disallow installation of printers using kernel mode drivers.
7. Select Properties and Disable this setting.
8. Restart the server for the setting to take effect.

PrintBoss Settings

Many of these settings are the same as a standard PrintBoss installation.

**NOTE:**

Log in to the Terminal Server as ADMINISTRATOR before installing PrintBoss. After completing the setup, individual users should be able to log in with all settings complete.
Options / Configuration

PRIVATE FOLDER NAMES
Check the Set Globally box in the upper right corner of this selection. This will set the work file and archive file private folder names to \{WinUserName\}.

ENABLE PRINTBOSS WINDOWS PRINTER DRIVER PROCESSING
This option should be checked.

ALWAYS CAPTURE SETTINGS
Set according to the Installation Notes for your accounting software.

“PB#INFO” FLAG OVERIDES ABOVE
This option should be checked.

Options / PrintBoss Driver Settings

PRINTBOSS DIRECTORY
This is the location of the PrintBoss directory, probably on the LAN server. Users will need FULL CONTROL of this directory.

TRANSFER FILE SETTINGS
The recommended Transfer Folder/File Name for Terminal Servers is \{ComAppData...\Transfer\\{WinUserName\}. This path determines the "All Users" location on the server and creates the Transfer folder under Wellspring\PrintBoss. It also MUST be in a location that is on the local hard drive of the Terminal Server. In some instances, Terminal Servers are configured so the local driver is a letter other than C. In those cases it would be appropriate to use that letter, such as M:\ProgramData\Wellspring\PrintBoss\Transfer. This is a global setting for all Terminal Server users on each Terminal Server PC. The Transfer File MUST be \{WinUserName\} (or some other dynamic derivative) on a Terminal Server, otherwise Print Jobs will get mixed between users.

APPEND TO TRANSFER FILE
This option is checked only if required per the PrintBoss Installation Notes for the accounting software.

LOAD PB32.exe
This should be checked for Desktop Terminal Server setups, or UNCHECKED FOR PUBLISHED APPLICATION SETUPS.

PB NT40 DRIVER SPECIAL SETTINGS
To limit the unnecessary loading of PB32Stub.exe for non-PrintBoss users:

- Check Set All Users to load PB32Stub.exe from User Registry
- Uncheck Load PB32Stub.exe from Local Registry ‘Run’

Check the box Allow Editing to make these changes.

PB 50 DRIVER SPECIAL SETTINGS
The default is \{ComAppData..\PrintBoss\Spool\}.

Users need Read permissions to this directory, but Full Control is preferred. Restart the Print Spooler (or restart your PC) once changes are made to this setting.

CONFIGURATION SETTINGS SAVE LOCATION
This should be set to Local_User Registry (Standard).

CAPTURE MODE
Either Flag Trigger Required or Always Capture should be selected, depending on the Installation Notes for the accounting software.
**Printer Selection**

Once PrintBoss is installed, each user may select a default LaserJet printer as the destination for PrintBoss documents. Select FILE / PRINTER SETUP on the PrintBoss Master Application window.

The Windows’ printer list often displays each printer with a session label. If a user logs in during one session, selects a printer with that session label, logs off, and then logs in at another time during a different session, the printer will have a different session label even though it is the same printer. PrintBoss will perceive the different label as a different printer. The original printer name will not be available and PrintBoss will generate an error message when opening the application. PrintBoss will then automatically select the Windows default printer.

A workaround is to select the option *Use Windows Default* in the Printer Setup window. PrintBoss will select the default printer for the user's session.

PrintBoss Enterprise users have an option to define the "label" for the session and have PrintBoss truncate this label or session "ID" when reviewing the list of printers. This eliminates the recognition conflict when the user logs into different sessions and allows the specific printer to be selected and retained for all sessions.
Software Updates

PrintBoss Software can be updated with a valid service contract. This is the same service contract that allows you to call Wellspring Technical Support for help. There are basically two ways to update your software.

1. Online through our web update.
2. Offline after a file download from our web site.

Automated Online Updates

Online updates are automated for your convenience. Call your IT department if you have trouble performing live updates through your firewall.

1. Open the PrintBoss Master Application window.
2. Click on the Help menu and select About.
3. Click on the Check for PrintBoss updates Online button at the top of the About window.
   a. This button is available for PrintBoss versions 5.x and above.
   b. The About window also contains useful information about your version and the location of the PrintBoss Home directory.
4. Click Yes to continue.
6. Click Continue if you receive a user account security warning.
7. Click Unblock if you receive a Block warning.
8. Other warnings may appear based on your internet browser software or setup. Answer appropriately to continue with the live web update.
10. Click Refresh to refresh your license file.
    a. PrintBoss will not allow you to continue when your License Date is expired.
    b. Please call Wellspring Software to renew your Service Contract before your License Date expires.
11. Click Continue with Update if you have a valid License Date.
    a. Please call Wellspring Software if you believe you have a current service contract and the License Date shows as expired.
12. The web will initiate 2 downloads.
    a. The first download is the updated PrintBoss software.
    b. The second download is the updated PrintBoss Help files.
13. PrintBoss will launch Setup.exe immediately after the Help files are downloaded and will automatically update your software.
14. Wait for the PrintBoss Setup/Update window. It should indicate PrintBoss has successfully updated. Press OK.

You can now open PrintBoss and begin using your updated software. Please call Wellspring Software Technical Support if you receive any errors during this process.
Offline Manual Updates

Offline updates are helpful when your firewall does not allow you to use the live update option. Even if you do not have internet access at work, you can use this method from any computer to download an updated version of PrintBoss and copy it to your local workstation at the office to initiate the update process.

1. Open a web browser and point it to www.wellspringsoftware.com. This opens the Wellspring Software web site.
2. Roll your mouse over the Support button and click Downloads.
3. Click on setup.exe and Save this file to your computer or removable media.
   a. DO NOT click on PBUpdate. This initiates a live web update and is available for PrintBoss versions prior to 5.0.
4. Copy the setup.exe file to a computer with PrintBoss if you did not download it from a computer with PrintBoss.
5. Double-click on Setup.exe and follow the prompts.
   a. Host Accounting System – Select your current accounting system from the list if it is not displayed.
   b. Install PrintBoss into this directory – Confirm this is the current location of your PrintBoss Home directory. This may be a server location or your local C:\ drive.
   c. Install Type – Select Update.
   d. Install "Programs\PrintBoss\<Icons>" for – Select All Users.
6. Click Next. Leave the defaults on the Select components to install screen.
7. Click Next. PrintBoss will copy installation files.
8. Choose settings to complete the setup.
   a. These settings are pulled from your current PrintBoss settings.
   b. Install Printer Driver – The driver you are currently using should already be selected.
   c. Update "Desktop icons calling PB32.exe" – Check this option.
   d. Update "Quick Launch" icons calling PB32.exe – Check this option.
9. Click Finish. PrintBoss will complete the installation.
10. Click OK on the PrintBoss Setup/Update window. It should indicate PrintBoss has successfully updated.

You can now open PrintBoss and begin using your updated software. Please call Wellspring Software Technical Support if you receive any errors during this process. Belligerent
Bank Accounts

Bank Accounts, or Bank Records, are typically setup in PrintBoss after the application is installed and provide options to work with your accounting software. Additional records can be purchased as needed.

PrintBoss provides a database, or Bank List, that stores information used to print checks. Bank data is not pulled from the accounting software’s database. The information stored can include the Bank Name, Bank Address, Bank MICR information, and Company Information for the account. The MICR information includes the bank routing number, account number, and check number. Since PrintBoss can store multiple bank accounts, there is normally some data from the accounting software that PrintBoss can use to select the correct bank record when a check is printed through PrintBoss. Once the account is selected, PrintBoss can use any of the fields in the bank record as the source for commands. In particular, the #MICR command is used to print the MICR across the bottom of the check.

Initially, PrintBoss provides 10 bank records for your convenience. More accounts can be added by purchasing and installing a Bank Module. Each module, or Bank Key, adds 5 blank bank records to the database in PrintBoss. When the number of purchased bank accounts reaches 80 (14 modules), the number of available records becomes unlimited. Contact Wellspring Software to purchase additional Bank Modules or visit our web site.

See Appendix A for a more thorough description of the fields on the PrintBoss Bank Edit window.

Create a Bank Record

Fill in the fields that will be used for printing checks. Sample data is provided for many of the fields. If you do not want to use or display a field, make sure it is blank.

**NOTE:**

Beginning in PrintBoss version 5.71.1, PrintBoss includes Wizards to assist in setting up Bank information as well as Logo and Signature files.

1. Click on the Edit menu and select Bank List from the main PrintBoss window. The PrintBoss Bank List opens. Initially, the Bank Code for each record starts with Unused.
2. Select the first available record.
   a. Select an Unused Bank if one is available.
   b. Click the plus button in the menu bar if you have unlimited banks and need to add a new record or if you rebuilt your table after deleting records.
3. Open the PrintBoss Bank Edit dialog.
   a. Double-click on the record; OR
   b. Click the Edit Bank button.
4. Enter data for the appropriate fields. The following steps include recommendations.
   a. Primary tab
i. **Bank Code** – Required. This should match the checking account code used in your accounting software.

ii. **Bank Prompt** – PrintBoss will leave the Record number in this field if it is not changed. Enter a prompt that will help you identify this account.

iii. **Bank Information** – Typically the Name and Address 1 fields are used. The Address 1 field usually contains the city and state of the bank. The other fields in this section are often blank.

iv. **Company Information** – Fill in the fields to be printed on the check face. Unused fields must be empty to prevent them from printing.
   1. **Name** – The company name is entered when a logo is not used.
   2. **2nd Name** – This field is available for a second name or d/b/a. This field is often blank.
   3. **Address 1** – Enter the street address for the company.
   4. **Address 2** – Enter the city, state, and zip or postal code for the company.
   5. **Address 3** – Optional; may contain country, phone, fax, or email information.
   6. **Address 4** – Optional; may contain country, phone, fax, or email information.

v. **Fractional Code** – enter the Transit number provided by the bank. Use the slash (/) symbol to represent the fraction symbol (–).

vi. **Next Check Number** – This field is ignored unless you are using accounting software, such as QuickBooks, that does not pass a check number to PrintBoss. If this is the case, enter the next check number from the check registry. PrintBoss will prompt the user to confirm or change this value at the beginning of each check batch. This field will NOT update the check registry in the accounting software.

vii. **Confirm Check # at start of batch** – See the Installation Notes you printed for your accounting software. Typically, this is set to Auto…

viii. **Include bank on Popup Bank Request List** – Optional. Typically, the word *Unused* is left at the beginning of the Bank Code for unused bank records and **Suppress if "Unused" in Bank Code** is selected from the drop down menu. This will remove all unused bank records from the popup Bank Request List when a Bank Code match is not detected by PrintBoss.

ix. **Password Required at start of batch** – Optional. This feature provides the ability to limit the use of this bank record.

x. **Account Auto Select Options** – Optional.
   1. **Always Confirm Auto Selection** – This feature is only available when the **Enforce Exact Bank Code Match** and **Allow for Selection when multiple Bank Codes match** options are selected at the bottom of the Options / Configuration / Internal tab in PrintBoss.
2. **Enable "Payroll" alias name** – This feature is only available when **Allow bank account to be AP and Payroll** is selected at the bottom of the Options / Configuration / Internal tab in PrintBoss.

b. **MICR tab**

i. **Routing Number** – Enter this value exactly as it is provided by your bank, including dashes.

ii. **Account Number** – Enter this value exactly as it is provided by your bank, including dashes. Use periods to represent spaces. Spaces, and not the periods, will display in the MICR Line.

iii. **Check Number** – Select the value indicated by the *Installation Notes* printed for your accounting software. Most accounting packages use CChkNo. QuickBooks and Quicken use BBBB BBB or BChkNo.

iv. **Include US Funds flag (45) on MICR line** – Select this option when the US Funds flag is required. This is typically for Canadian checks written on US Funds.

v. **Custom Format** – This field cannot be edited unless the **Custom radio button** under the **Check Format Type** section is selected. This is not recommended.

vi. **Check Format Type** – Choose **Standard 8.5" Business Checks** for most applications.

c. **Miscellaneous** tab (Optional)
i. **Miscellaneous Information** – Optional. These fields are available to accommodate special circumstances, such as adding a second logo to a check. The Values field can contain the path for a logo, special value, or text. The Description field can be edited to describe the item in the Values field.

ii. **Miscellaneous Flags**
   1. **2nd Signature Line** – Select this checkbox to add a second signature line to your checks for this bank record.
   2. **Miscellaneous Flags** – Optional. These fields are available to accommodate special circumstances and evaluate to True when checked. The Description field can be edited to describe the purpose of the flag.
   3. **Date/Amount Box** – Select this flag to use the older Date/Amount Box format instead of the newer Convenience Amount format. The newer format is often preferred by banks that scan the dollar amount.

iii. **Canadian Style Date/Amount** – Select this checkbox if you want the style of the date and amount on the check to follow the CPA format.

d. **Signatures & Logos** tab (Optional)
i. **File Name** – Enter the name, including the extension, or browse to select a Logo or Signature for the appropriate field. The graphic files associated with these file names should be stored in the Logos folder of the PrntBoss directory folder. These graphics are bank specific and will only print when this bank record is used. The field length is 40 characters.

ii. **Position** – Adjust the X (horizontal) and Y (vertical) position of the graphic. These measurements are in inches from the left and top edge of the page, respectively.

iii. **Options** – Enter an option to apply to the graphic. For example, /Watermark adds a medium watermark to the graphic when the variable associated with this option is added to the form (see Appendix A).

iv. **Range Condition** – Add a high and low dollar amount to determine when a signature should print on a check. Example: Enter 10000 in the Lo field and 9999999 in the Hi fields of Signature 2 to only print the signature file associated with this field when the check amount is greater than $10,000 and less than $10 million.

v. **Size** – Adjust the size of the Logo or Signature by inches (Width and Height) or Percent. You cannot use both at the same time.

vi. **Align Address** – PrintBoss version 5.736 and above include the options to align the address Below the logo or to the Right of the logo. This feature automatically works with newer PrintBoss Forms included with PrintBoss 6.0 or above.

e. **Security** tab (Optional) – See Bank Security later in this chapter.

f. **ACH Definition** tab (Optional) – See Ach Setup, Chapter 21, for more information.

i. **File Header Record Fields** - These are the field referenced in the SignOn tab of the ACH File Editor.

1. **Immediate Destination** – Enter the Routing number of the bank that will process the ACH file. The field name is {bACHImdDstNo}.

2. **Immediate Origin** – Enter the routing number for this bank record. Normally, this is the same value as the Immediate Destination unless the bank provides other instructions. The field name is {bACHImdOrgNo}.

3. **Immediate Destination Name** – Enter the name of the bank for the Immediate Destination. The field name is {bACHImdDstName} and may contain up to 23 characters.

4. **Immediate Origin Name** – Enter the company name. The field name is {bACHImdOrgName} and may contain up to 23 characters.

5. **File ID Modifier** – This field starts with A and should be incremented for each file printed in a single day. The field name is {bACHFileIDMode} and is only 1 character.

6. **Pre-Note Override if checked** – This field should only be checked the first time an ACH is created for this bank record for the bank to test and should be removed after testing. New recipients can be pre-noted in the Payee List.

7. The following is an image of the SignOn tab for the ACH File Spec where these fields are used:
ii. **Company/Batch Record Fields** – These are the fields referenced in the Header tab of the ACH File Editor.

1. **Service Class Codes** – Select the appropriate Service Class Codes from the drop down menu. The field name is \{bACHSvcClassCode\} and contains 3 characters. The choices are:
   a. 200 – Mixed
   b. 220 – Credits Only
   c. 225 – Debits Only
   d. 280 – Automated

2. **Company Name** – Enter the Company Name as it appears on this bank account. The field name is \{bACHCompName\} and contains 16 characters.

3. **Company Discretionary Data** – Enter one or more codes to identify this batch. This is for company use only and is optional. The field name is \{bACHCompDisc\} and contains 20 characters.

4. **Company Identification** – Enter a specific company identifier, usually “1” followed by the Employer Identification Number (EIN). The field name is \{bACHCompID\} and contains 10 characters.

5. **Standard Entry Class** – Select the appropriate code from the drop down menu. The field name is \{bACHStdEntryClsCod\} and contains 3 characters. The choices are:
   a. CCD – Corporate to corporate EFT
   b. PPD – Prearranged payment and deposit (consumer)

6. **Company Entry Description** – Enter a description for this batch that will be communicated to the receiver, such as PAYROLL or PURCHASES. The designation is established by the company. The field name is \{bACHCompEntry\} and contains 10 characters.

7. **Originating DFI Identification** – Enter the routing number with leading zeros. The field name is \{bACHOrgDFIID\} and contains 8 characters.

8. The following is an image of the Header tab for the ACH File Spec where these fields are used:

![Header tab image](image-url)

iii. **Balanced File** – Select this column when the bank requires a balancing entry for the credits (or debits) listed in the Detail section of the ACH file. The fields will then appear on the Balance Record tab of the ACH File Editor.

1. **Routing Number** – Enter the routing number with leading zeros as entered in the Originating DFI Identification field. The field name is \{bACHBalRout\} and contains 8 characters. A check digit is added by PrintBoss per the ACH Rules to create a 9 character field.

2. **Account Number** – Enter the account number for this bank record. The field name is \{bACHBalAcct\} and contains 17 characters.
3. **Account Name** – Enter the company name as it appears on this bank account. The field name is `{ACHBalName}` and contains 22 characters.

4. The following is an image of the Balance Record tab for the ACH File Spec where these fields are used:

   ![Balance Record Tab](image)

   iv. **Payee List** – PrintBoss provides the option of using a Payee List to provide the required ACH information used on the Details tab of the ACH File Editor. Alternatively, these fields may be assigned from data that is printed from the accounting system.

   1. (active) – Select the Payee List check box to activate this feature.
   2. **Browse button** – Select the folder “Browse” button to select the name of a Payee List. The Payee List is created under the Edit menu. Create a Payee List for this bank records before activating this option.
   3. **Add Record** – Click on the “add record” drop down menu to choose how to treat new records when there is no current match for the payee name. The choices are:
      a. Create Empty Record in List – Creates an empty record with only the `{DocRecip}` name from the check batch. The record will not be active in the Payee List.
      b. Ignore Payee
      c. Alert with option to Add/Ignore

   v. **More Info** – Click this button to view a list of fields that must be assigned from data printed from the accounting software or entered in the Payee List and well as optional fields to assign.

i. **ACH, PosPay, and PS16** – Select a predefined FTP account if you will be using FTP with any of these features. A separate FTP account can be selected for ACH, PosPay, and PS16 files.

ii. **Edit FTP Accounts** – This button provides access to the FTP Editor if the user has sufficient security to the FTP Editor.

5. Click **OK** to save changes to the information.

---

**NOTE:**

Changes made to Logos or Signatures in a bank record only apply to that bank record. If more than one bank record includes a logo or signature that requires an adjustment, the change needs to be made to each bank record.

---

**COPY/TAG/PASTE**

Occasionally, it is beneficial to copy part or all of the information from one bank record to another. This is accomplished using the Copy/Set Tags / Paste / Clear Tags buttons at the bottom of the Bank Edit dialog as follows.

**COPY**

1. Select the Bank Record you want to copy and click the **Edit Bank** button to open the Bank Edit dialog.

2. Click the **Copy** button. Almost all of the fields from the current bank (on all tabs) will be stored on an invisible clipboard. These fields cannot be Paste at this point.

3. Proceed to Set Tags.

**SET TAGS**

Start with the instructions for Copy above.

1. Open the destination or new Bank Record.

2. Click the **Set Tags** button to select all fields. Only fields that are tagged will be filled from the clipboard. Tagged fields are displayed in yellow. Notice PrintBoss will not tag the Check Number, Check Format Type, or Custom Format fields on the MICR tab. There are a couple of fields on the Primary tab that are not highlighted as well.

3. Hold the **CNTRL** key and **click** in a field to remove the tag. This will toggle off and on.

4. Proceed to Paste.

**PASTE**

Start with the instructions for Set Tags above.

1. Click the **Paste** button after you are finished removing or adding tags to the Bank Record fields.

2. Proceed with Clear Tags.

**CLEAR TAGS**

This button will turn off the highlight on all fields.

1. Click the **Clear Tags** button after you finish pasting fields. This will not clear the data in the fields.

2. Hold the **CTRL** button and **click** on a field to clear that specific field.

3. Click **OK** when you are finished.

---

**ADDING BANKS**

PrintBoss initially has 10 bank records. Additional bank records can be added by purchasing a Bank Module, previously called a **Bank Key**, from Wellspring Software. Each bank module adds 5 bank records.

There are two ways to activate additional Bank modules. The computer must have internet access to use either of these installation methods. Please contact Wellspring Software if you do not have internet access.

- Click **UTILITIES** from the main PrintBoss window and select **INSTALL MODULES / BANK LIST MODULES / INSTALL BANK MODULES**. Enter the codes provided with the bank module purchase.
Or use the online installation method from any computer that has PrintBoss installed. Enter the following URL into your web browser www.WellspringSoftware.com/downloads/demos.aspx. Click on the link for PBBanks.exe and select Run or Save.

**Bank List Maintenance**

PrintBoss has the ability to Import/Export bank lists beginning in version 5.31.1. The user must first login as Supervisor (Administrator) before using this feature.

**Import Bank List**

PrintBoss can import an Excel file saved as a *.csv file.

1. Open Excel.
2. Enter the column labels in Row 1.
   a. The labels need to exactly match the name and order of the PrintBoss bank list.
   b. You do not need to enter labels for columns if you don't have data. PrintBoss will enter default values automatically.
3. Enter or import the Bank Records by row.
   a. Do not leave blank rows.
   b. You cannot import more bank records than licensed in PrintBoss.
5. Open PrintBoss.
6. Login as Administrator.
   a. Click on the File menu and choose User Log-In.
   b. Enter the supervisor name and password. The defaults are:
      i. Operator Name – Administrator or Supervisor.
      ii. Password – ADMIN (This is the Master Password and may have been changed on the Security Settings window. It is case sensitive beginning in PrintBoss v.5.71.3).
7. Click on the Edit menu and select Bank List.
8. Click on the Tools button to the left of the Bank Code label.
9. Select Import.
12. Click Open.

PrintBoss will populate the Bank List with this data.

**Export Bank List**

1. Open the PrintBoss Master Application window.
2. Login as Administrator.
   a. Click on the File menu and choose User Log-In.
   b. Enter the supervisor name and password. The defaults are:
      i. Operator Name – Administrator or Supervisor.
      ii. Password – ADMIN (This is the Master Password and may have been changed on the Security Settings window. It is case sensitive beginning in PrintBoss v.5.71.3).
   c. Click OK to continue.
3. Click on the Edit menu and select Bank List.
4. Hold down the Shift or Ctrl key to select a range of bank records.
   a. Shift allows you to select contiguous records.
   b. Ctrl allows you to select non-contiguous records.
5. Right-click on the selected records and choose Export.
6. Click Yes to continue.
7. Enter a name and destination for the file.
8. Click Save.
DELETE BANK LIST RECORDS

Single Bank Records can be deleted by selecting a record and clicking the minus button in the menu bar or by right-clicking on a file and selecting delete. They selected record will always have the arrow in the left column.

Multiple Bank Records can be deleted using the Shift or Ctrl keys to select a range of records. Ranges are always highlighted in blue.

1. Open the PrintBoss Master Application window.
2. Click on the Edit menu and select Bank List.
3. Select a range of Bank Records. Use one of the following methods:
   a. Click on the first record in the range. Hold the Shift key and click the last record in the range. The range will be highlighted in blue. This method works for contiguous records.
   b. Click on the first record in the group. Hold the CTRL key and click each record you want to delete. The records in the range are highlighted in blue. This method works for non-contiguous records.
4. Right-click on one of the highlighted records and select Delete.

NOTE:

Be sure to right-click on a blue highlighted record before selecting delete. Otherwise, the wrong record will be deleted. In the example below, the record with the arrow will be deleted instead of the blue highlighted records.

REBUILD TABLE

The Bank List table will automatically try to Rebuild after records are deleted. This can only take place when no other user is using PrintBoss. When the table does not rebuild, the total number of records in the list does not update to reflect the true number of records. You can Rebuild the table manually when everyone is out of PrintBoss.

1. Open the PrintBoss Master Application window.
2. Click on the Edit menu and select Bank List.
3. Click on the Tools button to the left of the Bank Code label.
4. Select Rebuild Table.

PrintBoss will provide a confirmation window before rebuilding the table.

SORT BANK LIST RECORDS

There are two ways to sort records in the Bank List:

1. Click on the drop down menu in the men bar and choose a sort order.
   a. Natural Order – The order the records were originally numbered (Unused Bank011, Unused Bank012, etc.) or imported.
   b. Bank Code Order – This is an alpha-numeric field.
   c. Bank Prompt Order – This is an alpha-numeric field.
   d. Bank Name Order – This is an alpha-numeric field.
e. **Company Name Order** – This is an alpha numeric field.

2. Click on one of the darker gray labels to sort by that label. These labels match the last four choices in the drop down menu.

The sort order will return to Natural Order when you close the Bank List and reopen it.

**ADJUST MICR PLACEMENT**

The location of the MICR line is calculated by PrintBoss based on the directives passed in the #MICR command. Typically, this placement is accurate for a check printed at the bottom of an 11" page. Sometimes there are small differences in alignment from printer to printer. A separate adjustment can be made in the Configuration of PrintBoss to correct the alignment. Once this is made, it should not need to be changed unless the printer, printer driver, or operating system is changed.

The MICR Offset Adjustment is set in PrintBoss and can be both vertical and horizontal. **This setting is global for all forms and is workstation and user specific.**

Select **OPTIONS / CONFIGURATION** from the PrintBoss Master Application window to access the adjustment settings. The adjustments may be completed with the help of the MICR Adjust Wizard or by manually adjusting the values.

**MICR ADJUST WIZARD**

Click on the **MICR Adjust Wizard** button to open a step by step adjustment wizard. This method does not require a preprinted symbol on the back of the check and can be used with Canadian style checks. Follow the steps for the wizard to satisfactorily adjust the placement of the MICR. Click on **Finish** to exit the Wizard. Upon completion, the MICR Offset Adjustment values will be modified.

**MANUAL MICR PLACEMENT ADJUSTMENT**

An alternative method is to manually adjust the settings. Adjust the horizontal (Left/Right) and vertical (Top/Bottom) alignments independently of each other so the laser printed "Transit Character" overlays the Transit Character preprinted on the back of the check stock. (Hold printed copy up to the light to see if it is properly aligned). This adjustment may be completed with the help of the MICR Adjust Wizard or by manually adjusting the values.

These measurements are in thousandths of an inch to allow for very accurate placement. Start with larger numbers such as increments of 50 to be able to see the initial adjustment, then fine tune with smaller values. Decrease the MICR offset to shift the forms Left or Up. Once the value reaches 0, decrease into negative numbers if further adjustment is needed.

MICR adjustment settings are saved locally on the workstation. Even if PrintBoss is running from a shared drive, settings on each workstation can be adjusted without impacting the other workstations.

**MICR PLACEMENT RANGE**

As each piece of paper runs through the printer with slight variations, no two pages will print exactly the same. For this reason, a range of placement is acceptable according to the American Banking Association and the Canadian Payments Association.

**BANK SECURITY**

Security can be added to each Bank Record to define the users who may access the Bank Record. This process starts with enabling bank security.

**SETUP GENERAL SECURITY (OPTIONAL)**

Click on the **Options** menu on the PrintBoss Master Application window and choose **Security**.

1. Enter your **Master Password**. The default Master Password is **ADMIN**. The password is case sensitive beginning with PrintBoss version 5.71.3. If this has been changed, contact your Administrator. See Chapter 11, **Security Features**, for more information.
2. Click **OK**. The Security Settings window opens.
3. Click on the **Enable User Security in Banks** button at the bottom of the **General Settings** tab.
4. Select **Enable Bank User Security** and click **OK**. The name of the bank security button changes to **Disable User Security in Banks**.
5. Select the **Display ONLY primary fields in bank list browse**... option to hide sensitive information on the Bank List and encrypt key fields.
6. Click on the **Advanced User Rights** tab.
7. Click on the Plus sign (+) to setup users. Only the **User Name** is required for bank security.
8. Click **OK** to exit the User Edit window.
9. Click **OK** to exit the Security Settings window.

Once the bank security is enabled, log into PrintBoss as the Administrator.

**NOTE:**

It is not mandatory to create user accounts on the Security Settings window. Bank records can be secured by entering Windows Users names on the Bank Edit **Security** tab as described below.

**LOG-IN AS ADMINISTRATOR**

1. Click on the **File** menu and choose **User Log-In**.
2. Enter the **Operator Name** for the Administrator/Supervisor (the default is Administrator).
3. Enter the **Master Password** (the default is ADMIN). The password is case sensitive beginning with PrintBoss version 5.71.3. The log-in window will close after a successful log-in.

Next, add security to a Bank Record.

**SETUP BANK SECURITY**

1. Click on the **Edit** menu and choose **Bank List**.
2. Select a bank and click the **Edit Bank** button. Notice the Bank Edit window has a new **Security** tab.
3. Select the **Security** tab.
4. Click the **Users Listed Here** radio button.

![PrintBoss Bank Edit](image)

5. There are two methods for adding names to your security list:
   a. **PrintBoss Defined Users**
      i. The far right column lists the users defined in PrintBoss Security as described under **Setup General Security** above.
      ii. Select one or more name(s) from the right column and click the **Add Selected PB Users** button. The name will move to the left column.
   b. **Windows Users**
      i. Click on the **Add Windows Users** button at the bottom of the right column. The PrintBoss Windows User Addition window opens.
      ii. Enter the WinUserName of the person who should have access to this Bank Record.
      iii. Click **OK**.
6. Click **OK** when you are finished to close the PrintBoss Bank Edit window.

Only people in the **Users with Rights to this bank account** list will be able to open or edit this Bank Record.
FORM FILES

When PrintBoss captures a file or a print job from the accounting software, the PrintBoss Form File (.PBF) is the conductor that controls if and how all the data will be used. This includes:

- Add background graphics and text to the form
- Place data from the PrintBoss Bank Record
- Select and place graphic/logo/signature files
- Reformat and use data passed by the accounting software
- Add conditions
- Manage copies

STANDARD FORM FILES

Standard check form files are provided for several accounting software packages in order to expedite the installation and use of PrintBoss. These forms are installed automatically during the PrintBoss setup process based on the Host Accounting Software selected on the first installation screen. Additional forms can be added by running setup again and selecting a different Host Accounting Software at the top of the window and then selecting the Add Different Accounting Host Files radio button.

A list of accounting software supported by standard forms can be found in Appendix B of this manual as well as on the Support Documents page of our web site. Click the Host Accounting Software folder and select the PrintBoss Product Compatibility List to view this information.

CREATE A NEW FORM FILE

PrintBoss allows you to create new custom forms in addition to the standard forms included with PrintBoss. A form is created to work with the specific data layout received from the accounting software.

Please see the Installation Notes specific for the accounting software or Chapter 22, Custom Interfaces.

1. Open the PrintBoss Master Application window.
2. Click the Edit menu at the top of the screen and select Form Files to display the Form Select window (shown at right). The list is already populated with the standard forms available for your specific accounting software. As you add different accounting host files, additional forms will be added to the list.
3. There are two ways to create a new form
   a. Click the Create button to create a new form with all the appropriate PrintBoss structure minus the design scripts (the Object tabs are blank).
   b. Select an existing form close to your needs and select the Copy To button. This method is described further in the Modify an Existing Form section later in this chapter.
4. Select your new form and click the **Editor** button. The Editing Form dialog opens. This dialog, also known as the Form Editor, contains several tabs and many options that are described in more detail in Appendix B of this manual. The following are a few common options to review:

![Editing Form Dialog](image)

a. **Settings** tab
   i. **Description** – Enter a brief description of your new form. It is helpful to include the name of your accounting software, the function, and a number if you have other forms for the same function. Ex: QB_Chk4 w/CND opt. for QuickBooks check form 4 with Canadian option.
   ii. **Text / Image Capture Mode** – Adjust this setting to match the recommendation in the Installation Notes for your accounting software. A copy of the Installation Notes can be found in the Doc folder under the PrintBoss home folder.
   iii. **Form Width, Length** – Choose a paper size. The default is 8.5 by 11.0 Letter, Portrait.
   iv. **Copies** – Enter the number of copies you want to print in addition to the original form. These copies are defined on the Multi-Parts & Printers tab.
   v. **Auto-Archiving Completed Records** – Select your archiving option. The default is **Overwrite Work File at Start of Batch**.

b. **Special Controls** tab
   i. **Pre-process Assignments** – Select this option when you have a command in one of the Objects tabs that needs to be processed before the other commands. The current version of PrintBoss will warn you when this option is required.

c. **Block Mirrors** tab
   i. **Enable any mirrored blocks** – Select this option to create a copy of a section, such as the check and advice, and display that copy at a specified location on the page. The default is to select the advice and check beginning at 4.1 inches from the top of the page and extending to the bottom of the page and display a mirrored copy on the top section of the page. It may be helpful to view a standard check form as an example of this display.

d. **Multi-Parts & Printers** tab
   i. **Copies** – The copies you selected on the Settings tab will be displayed in this column.
   ii. **Print Time** – Select when you want the copy to print. The default is **Immediate**.
   iii. **Destination Printer/Device** – Select a destination printer if it is different from the printer set as the default for PrintBoss. Other options for the copy may also be selected, such as:
      1. Fax
      2. Positive Pay
      3. PDF
      4. Email
   iv. **Source Tray** – Select a source tray for the copy based on the selected printer.
v. **Copy Name** – Enter a name for the copy. This is optional, though the Copy Name may be used in a script.

e. **Comments** tab – Enter the date this form was created and document modifications made to this form after the initial creation.

f. **RunTime Objects** tab – Enter assignments (#Assign commands), grids (#Grid), text labels for grids (#Text), Company Address information (#Text), and Bank information (#Text) in this object script. The MICR Line (#MICR) is often placed here as well. RunTime Objects are processed before the other object scripts, so these items will be placed on the form before other items.

g. **Footer Objects** tab – Enter signature lines (#Line commands), signatures (#PIC), logos (#PIC), and miscellaneous text (#Text) in this object script. Conditions may be placed on these objects. These items are placed on the form after the RunTime Objects are processed.

h. **Misc** – This tab provides the option of importing a jpg or bmp file to embed in the PrintBoss form. Use the embedded image with a #PIC command on the RunTime Objects tab to place the embedded image on the form. The source graphic is not needed once the image is embedded in the form. This tab also includes special treatment of key fields during the creation of the PrintBoss Work File. These fall into the following two categories.

   i. **Key Flds Re-Calc Forward** – This section provides options that allow PrintBoss to carry forward or re-calculate values from selected fields under special circumstances. This area is primarily for use by a Wellspring Software Technician.

   ii. **Key Flds Re-Calc Backwards** – This section provides options that allow PrintBoss to process documents backwards immediately after they are processed forward for the purpose of counting or calculating values from the end of a group or file. This area is primarily for use by a Wellspring Software Technician.

i. **PDF** tab – This tab is only available when you select **PDF** as a copy on the Multi-Parts & Printers tab.

5. Click **OK** to save changes made on the Form Editor.

**MODIFY AN EXISTING FORM**

It is often advisable to start with an existing form that is similar to your needs. This form can be copied to a new name and modified.

1. Open the PrintBoss Master Application window.
2. Click the **Edit** menu at the top of the window and select **Form Files** to display the **Form Select** window.
3. Select the form to be copied, click the **Copy To** button, and enter a new **File Name**. The file name cannot exceed 8 characters.

4. Click **OK** to create the new copied form file.
5. Select your new form and click the **Editor** button to modify the form.
6. Click **OK** to save changes made on the Form Editor.

Details describing the options on the Form Editor can be found in Appendix B of this manual.

**NOTE:**

Be alert to properties of the original form that may impact the final results of the modified form, such as #RegionMove commands and font overrides that may not be apparent when viewing a form.
**MODIFY FROM THE DOCUMENT VIEW**

Both the *Form Editor* and the *Document View* can be used to modify a form whether it is a copy or a new form. Many users find the Document View more convenient for editing since the objects can be viewed immediately, though certain elements are not accessible through the View.

1. Open the PrintBoss Master Application window.
2. Click the *Edit* menu at the top of the window and select *Form Files*.
3. Select your form and click *View*. This opens the *View of Form* window. Clarity will depend on the monitor's size and resolution.
4. Double click on an object to edit its properties.
5. Click *OK* on the Properties window to save your changes.
6. Right click anywhere on the form to *Insert* a new object.

Across the top and down the left edge of the View are rulers to indicate coordinates on the page. As you move the cursor over the document, slight line indicators mark the matching coordinates on the rulers and a field above the ruler displays the numeric coordinates. The coordinates are measured in inches from the top left corner of the page.

A light blue border around the edge of the document indicates the margins or unprintable area of the page. This area adjusts according to the LaserJet printer selected within the PrintBoss program and the orientation of the form.

Above the ruler to the far left is a drop down menu to adjust the view’s magnification. This is similar to a zoom.

<table>
<thead>
<tr>
<th>Zoom</th>
<th>Copy Number</th>
<th>Matching Coordinates</th>
<th>Page Side Selector</th>
<th>Simulated Document Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>90</td>
<td>0</td>
<td>3.28, 0.74</td>
<td>Front</td>
<td>0.00</td>
</tr>
</tbody>
</table>

The Copy Number to the right of the Magnification Percentage allows you to select different copies associated with this form. Zero represents the original document. Use the up arrow to navigate to additional copies if there are multiple copies set for this form. The down arrow navigates back towards the original. Any conditional items based on copy number will be reflected in the View when the copy is selected. Copies are set and defined on the Form Editor.

The button to the right of Matching Coordinates appears when duplex printing is selected on the Special Controls tab of the Form Editor. This button indicates whether the view is of the *Front* or *Back* of the page. Click on the button to toggle between sides.

The Dollar Value field is located to the right to the Page Side Selector (or Matching Coordinates when duplex printing is not selected) and is used for testing objects that only appear based on a conditional Amount Range. Initially, the dollar value is set to 0.00. Enter an amount to test the AmntRange condition when it is used.

Please see *PrintBoss Conditional Commands* at the end of this chapter for more information.

**NOTE:**

All items inserted through the View will be placed at the bottom of the *Footer Objects* tab of the form. The location of these objects can only be adjusted in the Form Editor. Location and order can affect how the objects appear on a page.

**INSERT AN OBJECT IN THE DOCUMENT VIEW**

Right click anywhere on *View of Form* to access the following options:
**Edit Current Object**
This option opens the Properties dialog for the selected (highlighted) item in the View.

**Delete Current Object**
This option deletes the selected (highlighted) object from all copies and accounts that use this form. A prompt will confirm deletion or allow the user to cancel.

**Comment Current Object**
This option comments the selected object in the View without actually deleting it. An object cannot be viewed when it is commented. The command will remain on the objects tab of the Form Editor with a pipe symbol (|) in front so that it is not processed. A prompt will confirm this action or allow the user to cancel.

**Insert Object**
This option adds an object by opening the appropriate Properties dialog. A brief description of the use of each object follows.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode</td>
<td>Changes data into a barcode. See #Barcode for more information.</td>
</tr>
<tr>
<td>Block</td>
<td>Inserts a block on the document. Rectangle (#RECT) is more commonly used.</td>
</tr>
<tr>
<td>Canadian Date</td>
<td>Formats the document date value according to the Canadian format standard.</td>
</tr>
<tr>
<td>Graphic</td>
<td>Inserts a #PIC object to place a graphic file, such as a logo, on the document.</td>
</tr>
<tr>
<td>Grid – relative</td>
<td>Inserts a #GRID object with a standard 4-column advice format.</td>
</tr>
<tr>
<td>Grid – horizontal</td>
<td>Inserts a #HGRID object. #GRID is more commonly used.</td>
</tr>
<tr>
<td>Grid – vertical</td>
<td>Inserts a #VGRID object. #GRID is more commonly used.</td>
</tr>
<tr>
<td>Line</td>
<td>Inserts a horizontal line, such as a signature line, on the document.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Inserts a rectangle. Rectangles are often used with Security Back patterns to hide sensitive information, such as social security numbers.</td>
</tr>
<tr>
<td>Secure Seal</td>
<td>Inserts an encrypted seal containing information from the check file used as verification by the bank. The bank must have appropriate technology to decipher the encrypted seal.</td>
</tr>
<tr>
<td>Signature</td>
<td>Inserts a #PIC object to print an electronic signature file.</td>
</tr>
<tr>
<td>Text</td>
<td>Inserts a #Text object to print static text or text referenced by a variable.</td>
</tr>
<tr>
<td>Text – Multi-Line / Vertical</td>
<td>Inserts a #VText command. This is most frequently used to place the words Pay To The Order Of vertically on a check.</td>
</tr>
<tr>
<td>Text – secure</td>
<td>Displays check amount in blocks or with a pattern and is used to protect against fraudulent changes on a check.</td>
</tr>
</tbody>
</table>
**SHOW FORM OBJECTS**
This option displays the objects from the PrintBoss Form File in addition to the captured text from the accounting software when it is selected (check marked).

**SHOW BLANKED CAPTURED TEXT**
This reveals the raw data captured from the accounting software that has been hidden with a PrintBoss command such as #Assign, #RegionMove, or #BlockMove. This option is only useful when editing a work file or archive file.

**SHOW INFO PANEL**
This option opens a panel at the bottom of the View displaying the order and coordinates of both objects and captured data shown in the form. Either click on the desired object or data or use the slider bar to move quickly through objects and data in the order they were placed on the form. The field after the slider displays the order of the item, such as item 47 of 225. The matching coordinates field displays the coordinates of the selected item. The last field displays the text or description of the item.

<table>
<thead>
<tr>
<th>Slider</th>
<th>Order</th>
<th>Matching Coordinates</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>47 / 225</td>
<td>0.250, 2.913</td>
<td>Check</td>
</tr>
</tbody>
</table>

**VIEW RAW CAPTURE**
This option strips out all of the PrintBoss form elements and reveals only the data from the accounting software in its original format. This option is only useful when editing a form from the work file or archive file.

**VIEW REQUEST LIST CAPTURE GROUPS**
This option opens the Form / Bank Request List Manager and displays the request list entries. Edit or create the request list entries while viewing raw data from a work file to capture coordinates and values. This option is only available while using View Raw Capture.

📖 See Chapter 19, *Form Bank / Request List*.

**DISPLAY ASSIGNMENTS**
This option opens the form Assignments window containing a list of all available variable assignments for this form.

📖 See #Assign in the commands section later in this chapter.

**EXIT**
Exit the view of this form. If changes have been made, you will be prompted to save or abandon changes prior to exiting.

**EXIT THEN EDIT FORM**
This option leaves the View of the form and automatically opens the Editor of the form. You will be prompted to save or abandon changes prior to opening the Editor if changes have been made in the View of the form. This is helpful to quickly move from viewing a work file to working in the Form Editor.

**FORM EDITOR**

The Form Editor has several tabs and options for customizing forms or handling special needs. There are two ways to access the Form Editor after opening the PrintBoss Master Application:

1. Click on the Edit menu and choose Form Files. Then highlight a form and click the Editor button.
2. Right click anywhere on a View and choose Exit then Edit Form. PrintBoss will notify you to save changes before continuing if applicable.

The primary tabs that appear when you open the Editor include:

- Settings
- Special Controls
- Block Mirrors
- Multi-Parts & Printers
- Comments
- Design Time Objects
- RunTime Objects
- Footer Objects

**See Chapter 19, Form Bank / Request List.**
* Design Time Objects only appears in older PrintBoss Forms. It does not appear in most of Wellspring Software's currently distributed form files. It is primarily used for backward compatibility.

Other tabs may appear depending on the settings selected in the Form Editor. These include:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Location</th>
<th>Tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplex Printing</td>
<td>Special Controls tab</td>
<td>Page Back Objects</td>
</tr>
<tr>
<td>PDF copy</td>
<td>Multi-Parts &amp; Printers tab</td>
<td>PDF</td>
</tr>
<tr>
<td>Positive Pay copy</td>
<td>Multi-Parts &amp; Printers tab</td>
<td>Positive Pay / ACH File Editor</td>
</tr>
<tr>
<td>Check box under Access</td>
<td>Special Controls tab</td>
<td>Proprietary</td>
</tr>
</tbody>
</table>

The PDF and Positive Pay features are Destinations set for a copy on the Multi-Parts & Printers tab of the Form Editor, though Positive Pay opens in a new window rather than as a tab. Click on one of the Object tabs after selecting PDF to update the Editing Form window and display the new tab.

A detailed description of the Form Editor is in Appendix B of this manual.

ASSIGNMENTS

Assignments can be either Static or Dynamic. An explanation of these choices follows.

Static Assignments

Assign static values to a variable such as DocMisc or EmailCC to set a single value for ALL instances of this variable in the Form. For example, the office manager may need a copy of all invoices. The invoice form may contain an entry similar to the following:

```
#Assign EmailCC, "bob@yourcompany.com"
```

We recommend these assignments must be made at the top of the Runtime Objects tab of the PrintBoss Form (EDIT / FORM FILES / highlight the PrintBoss Form / EDITOR) for Email address assignments.

A File path and name may also be assigned in PrintBoss version 5.73.5 and above. For example:

```
#Assign DocMisc, "L:\PDF\{DocRecip}\*."
```

This assignment should be entered near the top of the Footer Objects tab as it contains variables that may have been assigned on the RunTime Objects tab.

The file path example can be used to create a shortcut in the DocMisc or DocMisc2 fields of the PrintBoss Work File to access all files at the listed path. The * are wildcards to display all files regardless of the name or file type. The DocMisc and DocMisc2 fields are limited to 60 characters based on the resolved path.

Dynamic Assignments

Dynamic assignments are the heart of automating PrintBoss features. There are 2 ways to create a dynamic assignment. Use one method or the other, not both.

INCLUDE IN SOURCE REPORT

Modify the PrintBossMisc or PrintBossMisc2 formula fields to represent a variable in the source report if there is a PrintBoss Trigger. We recommend PrintBossMisc2 be used for E-mail when using this method.

PICKED OFF OF CAPTURED REPORT BY PRINTBOSS

This method requires the desired field is displayed somewhere on the source report. PrintBoss can capture this information and blank it out (if desired).

1. Print a document to PrintBoss containing the desired field, such as E-mail address.
2. Click on the File menu and select Open Document Work Files on the PrintBoss Master Application.
3. Select the appropriate form and click Browse.
4. Select a document and click View.
5. Right-click anywhere in the View and select View Raw Capture.
6. Locate the fax number on the page. Double click on the text to open up the Captured Text Command Properties dialog.
7. Select the Click to Assign to Variable bar on the top right of the dialog.
8. Change the Variable Name from ReNameMe to EMailTo or the desired variable name. See Appendix E for a list of variables currently used in PrintBoss. Other names can be assigned, but do not have an existing function within PrintBoss.
9. Check the following fields:
   a. Add together fields in horizontal range
   b. Capture Raw Text Objects Only
   c. Left Trim
   d. Right Trim
   e. Blank Out After Capture (optional – hides fax number on printed document)

✓ Some reporting engines (such as the latest Crystal Reports) tend to break up text fields. A good practice is to click on the +/- button that follows the Horizontal field so it become to. Set the ending coordinate far enough to the right to pick up a 10-digit fax number.

10. Click OK. PrintBoss adds this assignment to the top of the RunTime Objects in the Form.
11. Right-click on the page and click on View Raw Capture to return to the formatted document.

12. Click Close to exit the View and select Yes to save these changes.

See Chapter 24, Capturing and Assigning Text, for more information.

### VARIABLES

There are several variables that may be Assigned in a Form File to define values for various PrintBoss functions. A list of all predefined variables and their purpose is included in Appendix E of this manual.

### FORM FILE COMMANDS

PrintBoss Form Files combine data from the accounting software, the PrintBoss bank record, as well as graphics and text to create a final document. The most common commands used to accomplish this task are described in this section. See Appendix B for a list of the remaining commands.

**NOTE:**

Type the # symbol followed by the command in the appropriate Object tab. Then double click on the text to open a dialog box displaying the parameters and options for the specific command.

```
#Assign 'VarName', 'Value' [, CaptXRange, CaptYRange [, Options]]
```

There are several different assign commands:

- #Assign
- #AssignLines
- #AssignmentsBlock
- #Assigns

Use the #Assign command to assign a value to a variable name. The other assign commands can be found in Appendix B of this manual.

#Assign uses two methods to assign a value. The first method is to enter a static value in the Variable Value parameter field. The command can be placed in any Object tab when using this method. If an assignment occurs more than once, the last assignment created is always the current one. Assignments are processed in the order they appear in the Objects tab.
The second method is to specify coordinates to capture value(s) from the data supplied by the accounting software. The #Assign command MUST be in the RunTime section when using this method. The assigned variable can only be referenced in Footer or Page Back Objects since the value is not supplied until the accounting software data is evaluated between the RunTime and Footer sections. Select the Pre-process Assignments box on the Special Controls tab when an assignment needs to be referenced in the RunTime Objects tab. This method is useful for repositioning or reformattting captured data passed by the accounting software. It can also be used to assign the DocNo, DocAmnt, DocRecip, DocDate, and DocMisc as well as adding conditional elements. One of the options for this command blanks out the original location of the data after it is captured.

All captured variables can be used in #Text commands, as components of conditional statements, and as components of loops and counters. In addition, they can be used in positive pay scripts, e-mails, fax messages, and as parts of dynamic file names for PDF and Positive Pay files. The dynamic file name feature is only available in the Enterprise edition of PrintBoss.

The following is a description of the parameters for the #Assign command.

**Variable Name**
The Variable Name can be a variable expected by PrintBoss, such as DocNo, or any arbitrary name.

**Value**
Only enter a static Variable Value when the CaptXRange and CaptYRange (Capture Coordinates) are not passed to PrintBoss. If CaptXRange and CaptYRange are passed, this parameter is usually left blank. When both the Variable Value and Capture Coordinates exist, PrintBoss will only use the Variable Value when no value is returned for the Capture Coordinates. For example:

```
#Assign "EmailTo", "Support@WellspringSoftware.com" – where EmailTo is the VarName and the email address is the Value. No coordinates are assigned.
#Assign "DocNo","", 7.100, 0.65 – where DocNo is the VarName, the Value is blank, CaptXRange is 7.100, and CaptYRange is 0.65
```

**CaptXRange, CaptYRange**
These are the coordinates of the captured data. You can determine the coordinates for a captured field through the work file.

1. Open the PrintBoss Master Application.
2. Click on the **File** menu in PrintBoss and select **Open Document Work Files**.
3. Select the desired work file and click on the **Browse** button.
4. Select a document and click the **View** button.
5. Right click anywhere on the View and choose **View Raw Capture**.
6. Double click on the object you want to capture. The Captured Text Command Properties dialog opens.
7. The beginning of the capture ranges are displayed as **Inches from Left** (X) and **Inches from Top** (Y).

8. Select the **Click to Assign to Variable** button to capture these coordinates. The Assign Command Properties dialog opens.

9. Enter a **Variable Name**.

10. The **Capture Coordinates** ranges are predefined from the selected data. You may adjust the +/- values or click on that button and change it to a to range.

11. Select the desired options, such as **Blank Out After Capture**.

12. Click **OK** on the Assign Command Properties dialog to save changes.

13. Click **Close** on the Text Command Properties.

14. Close the View and select **Yes** to save the assignments.

**NOTE:**

Capture ranges can be entered as inches with a decimal or thousandths of an inch with no decimal.
#Assign 'DocNo', ",", 7.100, .65

Or  
#Assign 'DocNo', ",", 7100, 650

Often the location may vary slightly based on the length of the string. You can assign a range using a dash:

#Assign 'DocNo', ",", 7.00-7.200, .65

Alternatively, a slash represents a Plus or Minus (+/-) amount:

#Assign 'DocNo', ",", 7.100/.1, .65

The #Assign command is usually entered by clicking on the Click to Assign to Variable button on the Captured Text Command Properties dialog mentioned above. This naturally pulls in all the coordinates and places the new command at the top of the RunTime Objects tab.

The following lists the most common options that may be used with the #Assign command.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Make only 1 assignment per capture field. This option is valuable when there are several capture fields close together that may overlap with this assignment range.</td>
</tr>
<tr>
<td>A</td>
<td>Add together fields in the horizontal range specified by the CaptXRange.</td>
</tr>
<tr>
<td>B</td>
<td>Blanks out the entire field after the assignment is captured. This prevents the data from displaying in an unwanted location on the document.</td>
</tr>
<tr>
<td>L</td>
<td>Left trim the captured field (eliminates any blank characters to the left of the captured field).</td>
</tr>
<tr>
<td>R</td>
<td>Right trim the captured field (eliminates any blank characters to the right of the captured field).</td>
</tr>
<tr>
<td>S</td>
<td>Trim choices applied after Segments appended.</td>
</tr>
<tr>
<td>W</td>
<td>Capture raw text objects only. This option only captures items from their original location – not items moved with a #RegionMove or #Block command that might share the same coordinates. This option is checked by default and should be used whenever assigning data captured from the accounting software.</td>
</tr>
<tr>
<td>Z</td>
<td>Use last captured value instead of first.</td>
</tr>
</tbody>
</table>

See Chapter 24, Capturing and Assigning Text.

#Barcode

#Barcode X, Y, Barcode Height, Options, "Barcode Value"

This command is used to print a Barcode.
The top left corner, center, or top right corner is defined with the X and Y coordinates. The Barcode Height is also assigned.

The following Symbologies can be specified as options.

<table>
<thead>
<tr>
<th>Symbology</th>
<th>Character Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code 3 of 9</td>
<td>alphanumeric</td>
</tr>
<tr>
<td>UPC Version A</td>
<td>numeric only</td>
</tr>
<tr>
<td>UPC Version E</td>
<td>numeric only</td>
</tr>
<tr>
<td>Postnet Code</td>
<td>numeric only</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>numeric only</td>
</tr>
<tr>
<td>Codabar</td>
<td>numeric only</td>
</tr>
<tr>
<td>Code 93</td>
<td>alphanumeric</td>
</tr>
<tr>
<td>Code 128</td>
<td>alphanumeric</td>
</tr>
</tbody>
</table>

The option of /SC prints the text characters below the barcode. This option is a check box in the Barcode Command Properties dialog.

The Barcode Value can be either a variable that references captured text or specific characters. For example:

```
#Barcode 6.7C, 1.000, 0.850, /SYM:C39, "{DocNo}"
#Barcode 6.7, 1.000, 1.000, /SYM:PNT, "34580"
```

The first example centers the Barcode at 6.7 inches horizontally and 1 inch down from the top with a height of 0.85 inches. The symbology is Code 3 of 9 and the variable DocNo defines the Barcode. The second example starts at 6.7 horizontally and 1 inch down from the top with a height of 1 inch. The symbology is Postnet Code and the Barcode value is 34580.

---

**#Block**

```
#Block X1, Y1, X2, Y2, Fill [, Options]
```

The Block command is used to place a block on the document. The top left and bottom right corners are defined. By default, a black rectangle is drawn on the form. Options include fill patterns, corner radius, and shaded edges (often used for the top legend row of a table). **This command has been replaced by #Rect.**

**X1, Y1**

These coordinates represent the location of the top left corner of the block in inches from the left and top edge of the paper. Coordinates can be entered in thousandths of an inch.

**X2, Y2**

These coordinates represent the location of bottom right corner of the block.

**OPTIONS**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/Rnnn</td>
<td>Corner Radius of nnn inches. For example, /R.1 is a 1/10” radius</td>
</tr>
<tr>
<td>/STnnn</td>
<td>Shade Top nnn inches</td>
</tr>
<tr>
<td>/SLnnn</td>
<td>Shade Left nnn inches</td>
</tr>
<tr>
<td>/SBnnn</td>
<td>Shad Bottom nnn inches</td>
</tr>
<tr>
<td>/SRnnn</td>
<td>Shade Right nnn inches</td>
</tr>
<tr>
<td>/SHDnnn</td>
<td>Shadow extends nnn inches from block</td>
</tr>
</tbody>
</table>

The following example prints a white box near the top of the page outlined in black with rounded corners.

```
#Block 3.25, .3, 4.75w, 1.0h, W_, /R.1
```
**Filler**

<table>
<thead>
<tr>
<th>Filler</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>Clear</td>
</tr>
<tr>
<td>W</td>
<td>White (prints Opaque)</td>
</tr>
<tr>
<td>S</td>
<td>Shade</td>
</tr>
<tr>
<td>B</td>
<td>Black</td>
</tr>
<tr>
<td>G/ or G0 ...G9</td>
<td>Gray scale shading from lightest to darkest</td>
</tr>
<tr>
<td>P1 or PH</td>
<td>Horizontal Line Pattern</td>
</tr>
<tr>
<td>P2 or PV</td>
<td>Vertical Line Pattern</td>
</tr>
<tr>
<td>P3 or PB</td>
<td>Backward Diagonal Pattern</td>
</tr>
<tr>
<td>P4 or PF</td>
<td>Forward Diagonal Pattern</td>
</tr>
<tr>
<td>P5 or PR</td>
<td>hCrosshatch Pattern</td>
</tr>
<tr>
<td>P6 or PA</td>
<td>Diagonal Crosshatch Pattern</td>
</tr>
</tbody>
</table>

**Color**
The color codes are too numerous to list. The codes display as numeric strings, for example 0255 is red.

---

**NOTE:**

Adding an underline following the fill descriptor will outline the block with a black line.

### #BlockMove

```
#BlockMove X1, Y1, X2, Y2 [, DestX, DestY [, DestX2, DestY2]]
```

This command is used to move or remove whole blocks of text captured from the accounting software. This operates the same as the #RegionMove command, except this sets X (or horizontal) boundaries while RegionMove includes the entire width of the page.

Every text object included in the block move needs to have its beginning coordinates inside the block. If only the beginning character of a long string occurs inside the block, the entire string will be treated as part of the block.

- This command must only be placed near the top of the RunTime Objects section. #Block and #RegionMove commands normally need to be processed prior to all other commands except #Assign.

---

![BlockMove Command Properties](image-url)
X1, Y1
These coordinates define the top left corner of the block to be moved or removed.

X2, Y2
These coordinates define the bottom right corner of the block to be moved or removed.

DESTX, DESTY
These coordinates define the top left corner of the destination. When these parameters are not provided, the text objects inside the block are removed (deleted).

DESTX2, DESTY2
These coordinates define the bottom right corner of the destination. The source block will be stretched or reduced to fit this destination block. When these parameters are not provided, the destination block will be the same size as the source.

#CanadianDate

#CanadianDate X, Y, Font Size, "date", "Mask", [Color[, Frame[, DateInMask[, SuppressLegends]]]]
This command formats a date in the style required by the Canadian Payments Association for their image ready standard called the "CPA Standard 006". This command places a letter under each numeral in the date indicating the part of the date it represents. A frame may be selected to appear around or behind the numerals. The word "Date" automatically prints to the left of the formatted date.

DATE 01252008

The Canadian Date command is automatically triggered by the Canadian Style Date/Amount flag on the Miscellaneous tab of the Bank Edit dialog for all standard PrintBoss forms.

#Grid

#Grid X1, Y1, X2, Y2[, Options]
The Grid command creates a frame and draws horizontal and vertical lines within the frame. The coordinates for each line are relative to the frame. Options provide further modifications with corner radius, shadow, edge shading, and line color. In most cases, #Grid is more effective than #HGrid or #VGrid commands since all the lines within the Grid are relative to the top left corner of the grid, allowing the grid to be easily moved or dragged. Use this command to create the advice grid and the Date/Amount grid on a check or the grid for an invoice or packing slip.
**X1, Y1**  
These are the coordinates for the top left corner of the frame in inches from the left and top edge of the paper. The coordinates may be entered in thousandths of an inch.

**X2, Y2**  
These are the coordinates for the bottom right corner of the frame.

**XA, XB...XZ**  
This parameter represents any number of lines drawn vertically down the frame. Each line is defined as the distance in inches from the left edge of the frame.

**YA, YB...YZ**  
This parameter represents any number of lines drawn horizontally across the frame. Each line is defined as the distance in inches from the top edge of the frame.

**OPTIONS**

- **Corner Radius**  
/Rnnn where nnn is the radius size. For example, /R.1 is a corner radius of 1/10th of an inch.

- **Shaded Edges**  
/STnnn (Shade Top), /SLnnn (Shade Left), /SBnnn (Shade Bottom) or /SRnnn (Shade Right) where nnn is the width of the edge shade in inches.

- **Shadow Width**  
/SHDnnn where nnn is the width of the shadow in inches.

- **Line Color**  
/0LC followed by a number representing a color. The color number can be 4 to 8 digits.

---

### #Line

**#Line X1, Y1, X2, Y2[, Fill [, Options]]**

The #Line command functions the same as the #Block command and is often used to draw signature lines on checks. A vertical line has identical X1 and X2 coordinates. A horizontal line has identical Y1 and Y2 coordinates. The Y coordinates are labeled as *Inches from Top* on the Line Command Properties dialog.
#MICR

#MICR "MICR string" [, Options [, X [, Y]]]

This command prints the special MICR line at the bottom of a check. Normally, the location is completely calculated by PrintBoss based on the length of the form. Options may be used to select middle or top check stock, or use the X and Y to explicitly place the MICR. The MICR string is most often pulled from the Bank List by using the following line in RunTime Objects:

#MICR "{BMICR}"

**MICR String**

This string must be entered accurately. Each character (including blank spaces) must be entered exactly as it appears on an existing check. There are three characters that appear on the MICR line of a check that cannot be reproduced with any computer keyboard key. Therefore, we have assigned replacement characters for the MICR line characters listed in the following table:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Represented By</th>
<th>Alternate Chars</th>
</tr>
</thead>
<tbody>
<tr>
<td>☞</td>
<td>Transit</td>
<td>[</td>
<td>: A</td>
</tr>
<tr>
<td>☞</td>
<td>On Us</td>
<td>/</td>
<td>&lt; C</td>
</tr>
<tr>
<td>☞</td>
<td>Dash</td>
<td>-</td>
<td>= D</td>
</tr>
<tr>
<td>☞</td>
<td>Amount</td>
<td>$</td>
<td>; B</td>
</tr>
</tbody>
</table>

The left portion of the MICR line is the Check Number. Since this changes from check to check, a variable needs to be entered instead of typing a specific number. The available variables are:

- \{BChkNo\} = Check number pulled from bank record with no leading zeros
- BBBB = 6 digit check number pulled from bank record – left zero filled
- BBBB = 8 digit check number pulled from bank record – left zero filled
- \{CChkNo\} = Check number captured from accounting software with no leading zeros
- CCCC = 6 digit check number captured from accounting software – left zero filled
- CCCC = 8 digit check number captured from accounting software – left zero filled

The following illustrates a common MICR string. Periods are used to represent spaces.

/\{CChkNo\}/ [123456789].123-12345/

**Options**

**T**

Places the MICR line for a top check (3.5" check).

**B**

This option places the MICR Line for a bottom check relative to the bottom of the form. This is the default value.

**Mn.nnn**

M places the MICR Line relative to a check section (i.e. perforation) that ends n.nnn inches from the top of the page. For example, an 11" page perforated into sections of 3.5, 3.5, and 4.0, with a check in the middle would be M:7.00. An 11" page perforated into sections of 3.67, 3.67, 3.67, with a check in the middle would be M:7.333.

**N**

No check number segment of the MICR line is printed. This is used for deposit slips.

**BR**

This option includes the MICR Line in the check copy (mirrored block) section usually located at the top of the page. The length of the Block Mirrors on the Form Editor may need to be adjusted to include the MICR Line in the source block. The MICR Line will display at full size and not reduced since the characters are not standard text.

**X and Y**

This is optional and is rarely used since PrintBoss automatically places a line. If the X is 0 or blank, PrintBoss will place the line relative to the placement of the Routing Number section of the MICR line. When a value for X is passed, the line is explicitly positioned according to the value of X. The same is true for Y. The vertical placement is relative to the bottom of the form when there is no value for Y.
Include in Mirror Blocks
The MICR line can be included in Block Mirrors and displayed in the check copy near the top of a check. Select the Include in Mirror Blocks option on the MICR Command Properties dialog and extend the End of source block on the Block Mirrors tab of the Form Editor to display the MICR line in the check copy. The MICR line will display at full size and not reduced since the characters are not text.

NOTE:
It is best to adjust the placement of the MICR line via the MICR Offset Adjustment fields in the Configuration Settings of PrintBoss. The settings in Configuration are workstation and user specific. Adjusting the placement in the form impacts all users.

#PIC

#PIC X, Y, "GraphicFileName" [Options [, SigDiskDrive]]
This command prints a graphic file at the location specified by the coordinates. It will accept graphic files with the formats of BMP, PCX, JPG, or SIG (Wellspring Software encoded signature file). Graphics can be added using variables, file paths, or as embedded files.

NOTE:
MICR toner is only available in black. If the bank requires MICR ink, all logos printed with the checks will print monochromatic regardless of any color used in the graphic file.

X, Y
These coordinates represent the location of the left top corner or the graphic, in inches, from the left top EDGE of the paper. Coordinates may be entered in thousandths of an inch. Variables referencing fields in the Bank Record may also be used (see graphic above for an example).

GraphicFileName
This is the name of the graphic file to print. If no path is provided, PrintBoss will look in the Logos folder of the PrintBoss Home directory. The file extension must be used to help PrintBoss determine the file type. The graphic file may also be added from the Embedded File Select list on the Misc tab of the Form Editor.
**OPTIONS**

Any of the following options can be selected:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>Forces image to be printed in 600 dpi instead of the default 300</td>
</tr>
<tr>
<td>REV</td>
<td>Reverse prints black to white and white to black</td>
</tr>
<tr>
<td>Show</td>
<td>Shows errors if they occur</td>
</tr>
<tr>
<td>Hide</td>
<td>Does not report file read access errors if they occur</td>
</tr>
<tr>
<td>Size:nnn</td>
<td>Adjusts the size according to this percentage (100=full size, 50=half size, etc)</td>
</tr>
<tr>
<td>SizeX:nnn</td>
<td>Adjusts the horizontal size to the specified value in inches.</td>
</tr>
<tr>
<td>SizeY:nnn</td>
<td>Adjusts the vertical size to the specified value in inches.</td>
</tr>
<tr>
<td>Watermark</td>
<td>Prints graphic with gray instead of black</td>
</tr>
<tr>
<td>Watermark:n</td>
<td>Same as Watermark except n is replaced by B, M, or L for Bold, Medium, or Light. The value is medium by default.</td>
</tr>
</tbody>
</table>

**SIG DISK DRIVE LETTERS**

PrintBoss checks the listed drive(s) for a security disk when a .sig file is selected. PrintBoss assumes the A:\ drive contains the disk when no drive letter is supplied. A series of drive letters may be entered and each specified drive will be scanned until the target sig media is found. Commas are not necessary between drive letters (ex: DEFG). The media may be a floppy disk, CD, or USB flash drive.

---

### #PrinterOverride

**PrinterOverride “Name of Windows Printer Driver”**

The PrinterOverride command overrides the printer set on the Multi-Parts & Printers tab of the PrintBoss form, including the default printer. This command assigns a specific Windows printer and often includes conditions. For example:

```
#\[C,1]\[Inu, "St. Louis", ÷{Location}÷\]PrinterOverride "HP Color LaserJet 4700 PCL 6"
```

This example assigns a specific printer only for Copy 1 when the string “St. Louis” is in the Location variable. This command can also be used in #IF/#ElseIf/#EndIf commands.

Enter the exact printer name as it appears in the Windows printer list. Double click on the #PrinterOverride command to select the printer name from a drop down menu to ensure an exact match.

---

### #ProcessPage

**#ProcessPage [Parameter]**

The page (or copy) will process when the parameter evaluates to True and skip when it evaluates to False. Often #ProcessPage will specify the document copy in the condition. For example:

```
#\[Copy, 4\]ProcessPage ![Empty, {EmailTo}]
```

PrintBoss will only examine this condition on the 4th copy and process the page if the variable EmailTo does not resolve to an empty value.

---

**NOTE:**

The Pre-process Assignments ‘Yes’ or ‘Special’ option MUST be selected on the Special Controls tab of the Form Editor to use the #ProcessPage command (EDIT / FORM FILES / <highlight form> / EDITOR / SPECIAL CONTROLS). We recommend selecting Special.
This command generates a rectangle with control over the size, thickness, and fill of the shape. This is often used to create a patterned rectangle behind a text object to prevent fraudulent changes to a document. A selection of patterns is provided for your use. The most common is the zigzag pattern.

This command is also used for Negative Printing. The Vertical Fade or Horizontal Fade are the best choices to use for the background. Overlay white lettering with a separate #Text command.

**Corner Radius**
This parameter defines the shape of the corners. No radius is a 90 degree corner. Larger values equate to softer edges.

**Outline Width**
Outline width, or Line Width, defines the width of the rectangle outline. The default width is .009 inches.

**Fill of Line**
A fill may be defined if the line has a discernible width. This is also called Outline Color Select.

**Color Background**
Define a background color for the shape. The background color, or Inner Fill Color Select, is behind the security pattern in the center of the rectangle. The default is black.

**Pattern**
There are several options for the pattern, or Security Back, in the center of the rectangle:

- 0 = none
- 1 = vertical fade
- 2 = horizontal fade
- 3 = zig zag fine
- 4 = zig zag medium
- 5 = zig zag course
- 6 = half circles fine
- 7 = half circles medium
- 8 = half circles course

For example:

#Rect 4.7, 9.8, 8.15, 10.34, 0.10, 0.020, B, W, 3 (shown in the graphic above)
The object masks the signature line as:

```
#RegionMove
#RegionMove StartRegion, EndRegion[, StartDestRegion[, EndDestRegion]]
```

This command is used to move or delete whole regions of text captured from the accounting software. Moved regions can be compressed or expanded proportionately by entering both a start and ending destination.

This operates the same as the #BlockMove command with the exception that the horizontal boundaries are the left and right edges of the page. For example, if the accounting software prints a check with an advice at the top of an 11” page, the #RegionMove can move the advice to the center of the page. If the accounting software is passing two advice sections, use this command to delete one of the advices in order to use the PrintBoss Block Mirror with its compression feature to print the secondary advice section.

**NOTE:**

This command must only be placed in the RunTime Objects section. This command, along with the #BlockMove command, should be used prior to other commands except #Assign.

**STARTRegion**

This parameter is also known as the Block Source Dimensions and defines the start of the region in inches from the top of the page.

**ENDRegion**

Define the end of the region in inches from the top of the page.

**STARTDestRegion**

This parameter is also known as the Block Destination Dimensions and defines the start of the destination of the selected region in inches from the top of the page. The text within the region will be deleted if this parameter is not defined.
**EndDestRegion**
Define the end of the destination of the selected region in inches from the top of the page. The source region will proportionately fit between the destination start and end when this parameter is defined. Otherwise, the region will be moved at its original size.

**#SecureSeal**


SecureSeal provides added security supported by some banks. This command prints an encoded graphic image on the check containing information such as the check amount, date, payee, and check number. If the graphic is altered or the information on the check does not match the information embedded in the graphic, the bank will not process the check.

For more information about Ensell’s SecureSeal, contact Fiserve at [www.imagesoft.fiserv.com](http://www.imagesoft.fiserv.com) or your bank.

**X, Y**
The coordinates represent the distance of the left top corner of the Secure Seal graphic, in inches, form the Left Top corner of the page.

**Seal Image**
The Seal Image parameter specifies the location of the file used to create the Secure Seal image. Templates for the image are stored in the SecureSeal folder of the PrintBoss Home directory.

**Check Information**
The next several parameters represent information originally printed on the checks. These include the following.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipient</td>
<td>The name of the recipient or payee of the check.</td>
<td>DocRecip</td>
</tr>
<tr>
<td>Number</td>
<td>Check number.</td>
<td>DocNo</td>
</tr>
<tr>
<td>Amount</td>
<td>The amount of the check.</td>
<td>DocAmnt</td>
</tr>
<tr>
<td>Date</td>
<td>The date on the check.</td>
<td>DocDate or RecDate</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Bank</td>
<td>The name of the bank from which the funds are drawn.</td>
<td>BName</td>
</tr>
<tr>
<td>Routing</td>
<td>Routing number of the bank.</td>
<td>BMicrRoutNo</td>
</tr>
<tr>
<td>Account</td>
<td>Bank account number for the check.</td>
<td>BMicrAcctNo</td>
</tr>
</tbody>
</table>

These variables allow the parameter information to adjust dynamically for each check in the batch. They also ensure the information on the check matches the information in the Secure Seal.

#SecureText

```#SecureText X, Y, "<Font>/<Size>/<Style>/<Color>", "<Text>" [, Options]```

This command is used to protect against fraudulent changes on a document. All current PrintBoss check forms include this security feature.

There are two options for the Secure Text Type: Custom and Standard Block-Numeric.

**CUSTOM**

This option can be used with both alpha and numeric text. It includes a patterned rectangle behind the text. There are a few patterns to choose from, but the default is ZigZagMed. The rectangle automatically sizes to fit the text.

**STANDARD BLOCK-NUMERIC**

As the name implies, this option can only be used with numeric amounts and is specifically used for the amount of a check. It is nearly impossible to modify the printed check amount with this option.

**TEXT**

Normally a variable is entered in the Text field to dynamically update the check amount information for each check in the batch.
This command tells PrintBoss to skip the processing of a page. A condition must be placed on this command or all pages will be skipped and nothing will be processed! The SkipPage command may be in either the RunTime Objects or Footer Objects tabs. *Pre-process Assignments* MUST be checked on the Special Controls tab of the Form Editor to use the #SkipPage command.

Unlike the #ProcessPage command, the SkipPage command only skips and places an “S” in the printed column of the work file or places a “s”, indicating an error. It does not provide a condition to process a page.

See *Conditional Commands* later in this chapter.

See Chapter 10, #Text Command.

This command prints text on incrementing lines. Each line may be a single character or it may be a phrase in a multi-line text object. One common use is on invoices, credit notes, etc. for the Sold To and Ship To labels in the address boxes. For example:

#VText 4.50c, 2.15, Arial/10, 0.130, "SHIP TO"

This command centers the characters at 4.50 inches from the left edge of the page. The top of the first character starts at 2.15 inches down from the top edge of the page. The top of each character thereafter is 0.13 inches below the top of the previous character.

Another common use is to print a captured address assigned to a multi-line variable called {Address}.

#VText 1.05, 8.1, Arial/10, .15, "{Address}"

Several lines of text can be entered into the VText command separated by commas to indicate line returns. Be sure to use a delimiter such as quotes around the series of text.
#VText 1.040, 8.245, Arial/10, 0.180, "Pay, To The, Order Of"

See the Multi-Line Variables section later in this chapter for more information.

**PrintBoss Default Assignments**

A few variables should always be assigned. They are stored in the PrintBoss work file database enabling helpful sorting and locating of records and are often used in conditions within a form. These variables are:

- DocAmnt
- DocDate
- DocNo
- DocRecip

These will automatically be assigned when a PrintBoss Flag Trigger exists in the document (PB#INFO ….). Otherwise, be sure to capture and assign these variables using the #Assign command.

See Chapter 24, Capturing and Assigning Text.

**NOTE:**

The {CChkNo} variable is usually automatically assigned the value of the {DocNo} variable.

**Multi-Line Variables**

Normally an assigned or captured variable is a single line of text. Assignments made using #AssignS may contain multiple lines of text with each line separated by a Carriage Return / Line Feed. A few commands accept and process multi-line variables as multiple lines, such as the #VText command. A few standard variables, such as EMailBody, EmailTo, EmailCC, and EmailBCC, also accept multiple lines.

A particular line of a Multi-Line Variable may be referenced by appending a line number enclosed in square brackets as part of the variable reference. For example, the following assignment can be used to capture an unknown number of address lines:

```
#Assigns AddressLines, 1.0-1.2, 8.0-9.5, BW
```

The third line can be printed as follows:

```
#Text 1, 1, Arial/12, "The third line of the address is: {AddressLines [3]}"
```

The zero element returns the total number of elements. Continuing with this example, the following loop prints all the address lines:

```
#Assign LastLineY, 7.9
#for n= 1 to {AddressLines [0]}
    #Text 1, {LastLineY+.18}, "Arial/12", "Address Line {n} = {AddressLines [{n}]"
#next n
```

**PrintBoss Conditional Commands**

Each PrintBoss command can be executed based on a condition that is evaluated at the time the line is processed. For example, a logo may be printed based on the existence of a logo file name in the bank record, or a second signature line on a check may only be printed if the check amount exceeds $1000. The condition statement is one or more condition expressions with each expression enclosed in brackets [ ]. The condition statement is inserted between the # character and the command name (for example: #[Copy, 1]Text …). In addition to conditions for commands, several commands accept Conditional Parameters, such as the #ProcessPage <condition> command. The conditional parameter is simply a condition statement that follows the same rules, but is used after the command. It is often helpful to enclose a Conditional Parameter in a delimiter, especially if the condition statement has multiple condition expressions.
A condition statement is comprised of a series of condition expressions chained together with an assumed AND or a symbol for OR. Normally, a condition statement is only one condition expression.

Each condition expression begins with a condition operator followed by a comma and as many parameters as defined by the operator.

More than one condition can be entered by chaining together the bracketed condition expressions. Multiple conditions are usually considered to be joined by AND, so usually all expressions must be true for the condition to be true.

**Ex:** #[Copy,12][AmtRange, 0, 200]Text 1,1, Arial/12, "Prints on Copy 1 and 2 if amount is less than 200"

#![Copy,0][Flagged, {BFlag2}]Text 1,1, Arial/12, "Prints on all Copies but 0 if banks Flag 2 is checked"

**ANY CONDITION PRECEDED BY AN EXCLAMATION MARK (!) HAS ITS LOGIC REVERSED.**

A double pipe symbol may be inserted between conditions to represent OR with the next condition. Parentheses cannot be used with conditions.

**Ex:** #[Inu, "Jones","{Comp}"]||[Inu, "ABC", "{Comp}" ]Text 1,1, Arial/12, "Jones or ABC in Company Name"

Very complex conditions may require several lines together that create variables in stages and then those variables can be used within other condition statements.

The following is a list of the most common conditional commands and their descriptions. See Appendix B for a list of the remaining commands.

**NOTE:**

Although it is helpful for us humans to see the condition names spelled out completely, only as many characters as is needed to make the condition unique are required. For example, Fi is enough to register as the FileExists condition, or As is enough to register as the Assigned condition, or E as the Empty condition.

This command returns a value of true if String1 is identical to String2 up to the length of String2. For example, comparing "12345" with "123" is true, but "123" compared to "12345" is false.

The Compare Options include:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>Exact match rather than stopping at the number of characters in String2</td>
</tr>
<tr>
<td>U</td>
<td>Converts all characters to upper case before comparing – Not Case Sensitive</td>
</tr>
<tr>
<td>T or R</td>
<td>Right trim both strings before comparing</td>
</tr>
<tr>
<td>A or B</td>
<td>Trim Both (or All) sides of each string before comparing</td>
</tr>
</tbody>
</table>

The following example prints the words "No Charge" if the value of the variable {Dept} is equal to "Accounting" and is not case sensitive:

# [=,'Accounting', {Dept}, U]Text 1,2.1, 'Arial/12', 'No Charge'

The following is a list of examples showing the effect of the Compare Options:

\[
\begin{align*}
[=,"12345", "123"] & \quad \text{true} \\
[=,"123", "12345"] & \quad \text{false} \\
[=,"12345", "123", "e"] & \quad \text{false} \\
[=,"123", "123 "] & \quad \text{false} \\
[=,"123", "123 ", t] & \quad \text{true} \\
[=,"ABC", "abc"] & \quad \text{false} \\
[=,"ABC", "abc", u] & \quad \text{true}
\end{align*}
\]
Same as = condition with a Compare Option of "e", "eu" or "u" (see the table above under the = condition).

Returns true if NumericValue1 is EQUAL to NumericValue2. The numeric values of the items are compared. For example: 0 == 0.00 is true.

Returns true if NumericValue1 is NOT EQUAL to NumericValue2. The numeric values of the items are compared. For example: 1 <> 0.00 is true.

Returns true if NumericValue1 is LESS THAN OR EQUAL TO NumericValue2.

Returns true if NumericValue1 is GREATER THAN OR EQUAL TO NumericValue2.

Returns true if NumericValue1 is LESS THAN NumericValue2.

Returns true if NumericValue1 is GREATER THAN THAN NumericValue2.

AmntRange, 'LoRange', 'HiRange'[, TestAmount]
Returns true if the Test Amount falls on or within the specified range. {DocAmnt} is used as the test amount when the Test Amount is omitted. There is no upper limit when the HiRange is omitted or set to 0.

The following examples print a second signature line on checks with a {DocAmnt} of 1000 dollars or above. The first expression makes use of the exclamation mark "!" to reverse the logic and the second drops the HiRange parameter to remove the upper limit.

This same logic can be used with a Hand Check, though the variable for the test amount must be entered. The following example prints the second signature line when it is flagged in the bank record and the amount is at least $0.01:

Another common use is to put a condition on a signature to determine when it prints. The following example will not print a signature when the check amount {DocAmnt} is below $0.01 and above $49,999.99.
Notice the condition was entered directly in the Pic Command Properties dialogue. The button at the end of the Condition field opens a list of the available conditions and their parameters. The condition can be tested in the Form Files’ View by entering an amount in the Simulated Document Amount field at the top of the View.

**Assigned**

Assigned, ‘<Name of assigned variable to test>’

Returns true if the variable is explicitly assigned (i.e. #Assign 'EmailTo', "support@wellspringsoftware.com") or assigned through capture coordinates (#Assign 'EmailTo', ' ', 1.5, 4.5). PB#INFO can also be used to assign the variable. DO NOT include braces around the variable name. Note the value of a variable can be blank, but the variable is still considered assigned.

The following example prints the company logo when CompName is assigned.

# [Assigned, 'CompName']PIC 0.30, 7.8, 'CompLogo.bmp'

**Captured**

Captured, 'Name of assigned variable to test'

Returns true if the variable captured raw data from the accounting software. This is different than the Assigned conditional command. Before a variable can be captured, a command must assign a variable name and define the coordinates used to capture a value. If the raw data never has a text object that falls within those coordinates, then NO data is Captured, but it is Assigned.

**Copy**

Copy, 'String of Digits'

Returns true if the form copy number is included in the string of digits, where 0 represents the original copy and 1 through 7 represents copies 1 through 7. Specify each copy number when more than one copy is to be considered. Separators are not required, but any character may be used to separate multiple copy numbers except an asterisk.

If an asterisk (*) appears after a character, the object is only printed in the mirrored block section. This is useful with the BLOCK command that draws a frame on 11” checks. The block should not be printed on the original, but it is nice to have a frame printed on the mirrored block on the top tear off copy.

See Block Mirror tab earlier in this chapter.
If a B appears after the copy number, the object only prints in the body of the document. It will not appear in the mirrored block section.

**NOTE:**

If no condition operator is specified inside of the condition braces, the COPY operator is assumed.

Examples:

<table>
<thead>
<tr>
<th>Conditional Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Copy, 23]TEXT 5.00, 9.00, &quot;TM/8&quot;, &quot;Duplicate Copy&quot;</td>
<td>Prints Duplicate Copy on copies 2 and 3</td>
</tr>
<tr>
<td>![COPY, 0*123]Block .250, 7.6, 8.25, 10.5, /R.1</td>
<td>Prints a frame on the mirrored block for copies 1, 2, and 3</td>
</tr>
<tr>
<td>![0*123]Block .250, 7.6, 8.25, 10.5, /R.1</td>
<td>Prints a frame on the mirrored block for copies 1, 2, and 3</td>
</tr>
<tr>
<td>![Copy, 1]TEXT 4.5, 10.5, '5', 'Customer File Copy'</td>
<td>Prints Customer File Copy on copy 1</td>
</tr>
<tr>
<td>![C.0]Text 4.4, 10.4, &quot;Arial/14&quot;, &quot;** COPY **&quot;</td>
<td>Prints <strong>COPY</strong> on all copies except the original</td>
</tr>
</tbody>
</table>

**Dates=, DATES>, DATES<**

These condition commands return true if date1 and date2 compare as indicated by the =, >, or < signs. If date2 is omitted, then the current date is assumed to be date2.

The Windows’ ShortDateFormat is the assumed format for the dates. An alternate format can be specified by appending a semicolon followed by a mask to the date string. For example:

```
[Dates=, "4/1/08; m/d/y"]  This statement evaluates to true when the current date is Apr 1, 2008.
```

**Empty**

This returns true if the StringToTest is empty. Use this condition command with the exclamation mark to reverse the condition. For example:

```
#![Empty, {BMisc1}]Pic 0.3000, 8.200, {BMisc1}  This command prints the logo specified in the Bank Misc1 field when BMisc1 is not empty.
```

```
#![Empty, ÷{Memo}÷]Text 8.137R, 8.813, 'Arial/9', ÷MEMO: {Memo}÷  This command prints the contents of the Memo field when it is not empty. The Memo field is an assigned field.
```

**False**

This indicates the expression is FALSE and is often helpful in debugging conditional statements.

**FileExists**

This returns true if the file specified by the FileName exists. It is often used with logos and signatures. PrintBoss will look in the Logos folder under the Home directory when no path is specified. The following example will print the logo file when it exists:

```
# ![File, '{PDir}\Logos\Logo.BMP'} PIC .4, 7.9, '{PDir}\Logos \Logo.BMP'
```

This condition command is most commonly used when logos are added directly to the Form File instead of through the Bank Record.
Flagged, 'StringToTest'

This returns true if the StringToTest begins with any of these characters: Y, y, T, t (as in Yes or True). It is often used with the 5 bank variable fields called {BFlag1} … {BFlag5}, though it will work testing any string that can return one yes or true value.

    #[Flagged,{BFlag1}] Line 4.7, 9.6, 8.149, 9.6, " This command prints a second signature line when the BFlag1 field is checked (flagged). The description for the BFlag1 field is 2nd Signature Line and it is located on the Miscellaneous tab of the Bank Edit window.

See Chapter 8, Bank Accounts.

In, 'StringFragment', 'StringToSearchIn'

This returns true if the StringFragment exists anywhere in StringToSearch. The search is CASE SENSITIVE. The following example whites out the dollar amounts when an exact match of the word Packing occurs anywhere in the assigned variable DocDesc:

    #[In, 'Packing', '{DocDesc}'] Block 6.5, 4.5, 8.25, 9.2, W

Inu, 'StringFragment', 'StringToSearchIn'

This returns true if the StringFragment exists anywhere in StringToSearch. This search is NOT case sensitive. The following example whites out the dollar amounts when the word Packing occurs anywhere in the assigned variable DocDesc, regardless of case:

    #[Inu, 'Packing', '{DocDesc}'] Block 6.5, 4.5, 8.25, 9.2, W

True

The condition is TRUE. This is often used in debugging conditional statements.

Type, 'Source Abbreviations'

This returns true when the document Type appears in the Source Abbreviation list and is useful when certain documents are to print only for specific types of source files.

<table>
<thead>
<tr>
<th>Source Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>Work Files</td>
</tr>
<tr>
<td>A</td>
<td>Archive Files</td>
</tr>
<tr>
<td>S</td>
<td>Samples in Utilities</td>
</tr>
<tr>
<td>H</td>
<td>Hand Checks</td>
</tr>
<tr>
<td>F</td>
<td>Form Editor</td>
</tr>
</tbody>
</table>

The following is an example of disabling a signature from printing when processing archive files:

    #[Type, WSHF]SIG 4.7, 9.8, 'Your_Sig.SIG'

Shorten the condition command with the reverse exclamation mark:
This condition sets an object to View, but not to print. This condition can be used to test the contents of a variable prior to printing.

**DATE & TIME FORMAT MASKS**

Many commands and functions allow the use of date format masks to define how a date is expressed or interpreted. In most cases, the date format is defined in the Windows Regional Settings for the Short Date if a date mask is not specified. Here is a list of the mask symbols:

<table>
<thead>
<tr>
<th>Mask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>Displays the day as a number without a leading zero (1 - 31).</td>
</tr>
<tr>
<td>dd</td>
<td>Displays the day as a number with a leading zero (01 - 31).</td>
</tr>
<tr>
<td>ddd</td>
<td>Displays the day as a three character abbreviation (Sun - Sat) using the strings given by the ShortDayNames global variable.</td>
</tr>
<tr>
<td>dddd</td>
<td>Displays the day as a full name (Sunday - Saturday) using the strings given by the LongDayNames global variable.</td>
</tr>
<tr>
<td>ddddd</td>
<td>Displays the date using Windows’ ShortDateFormat (no other symbol would be used with these 5 ds).</td>
</tr>
<tr>
<td>dddddd</td>
<td>Displays the date using Windows’ LongDateFormat (no other symbol would be used with these 6 ds).</td>
</tr>
<tr>
<td>m</td>
<td>Displays the month as a number without a leading zero (1 - 12). If the m specifier immediately follows an h or hh specifier, the minute rather than the month is displayed.</td>
</tr>
<tr>
<td>mm</td>
<td>Displays the month as a number with a leading zero (01 - 12). If the mm specifier immediately follows an h or hh specifier, the minute rather than the month is displayed.</td>
</tr>
<tr>
<td>mmm</td>
<td>Displays the month as a three character abbreviation (Jan - Dec) using the strings given by the ShortMonthNames global variable.</td>
</tr>
<tr>
<td>mmmm</td>
<td>Displays the month as a full name (January - December) using the strings given by the LongMonthNames global variable.</td>
</tr>
<tr>
<td>y or yy</td>
<td>Displays the year as a two-digit number (00 - 99).</td>
</tr>
<tr>
<td>yyyy</td>
<td>Displays the year as a four-digit number (0000 - 9999).</td>
</tr>
<tr>
<td>j</td>
<td>The Julian date displays the day of the year as a number without a leading zero (1 - 365).</td>
</tr>
<tr>
<td>jjj</td>
<td>The Julian date displays the day of the year as a number with leading zeros (001 - 365).</td>
</tr>
<tr>
<td>h</td>
<td>Displays hours without a leading zero 0 - 24 (0 - 12).</td>
</tr>
<tr>
<td>hh</td>
<td>Displays 2-digit hours with a leading zero 00 - 24 (or 00-12).</td>
</tr>
<tr>
<td>n</td>
<td>Displays minutes without a leading zero 0 - 59. Note that within a time expression, m will be interpreted as minutes as well.</td>
</tr>
<tr>
<td>nn</td>
<td>Displays minutes with a leading zero 00 -59. Note that within a time expression, mm will be interpreted as minutes as well.</td>
</tr>
<tr>
<td>s</td>
<td>Displays seconds without a leading zero 0 – 59.</td>
</tr>
<tr>
<td>ss</td>
<td>Displays seconds with a leading zero 00 – 59.</td>
</tr>
<tr>
<td>t</td>
<td>Forces 12 hour clock with a or p in place of t.</td>
</tr>
<tr>
<td>T</td>
<td>Forces 12 hour clock with A or P in place of T.</td>
</tr>
<tr>
<td>tt</td>
<td>Forces 12 hour clock with am or pm in place of tt.</td>
</tr>
<tr>
<td>TT</td>
<td>Forces 12 hour clock with AM or PM in place of TT.</td>
</tr>
</tbody>
</table>
**DELIMITING PARAMETERS**

Most PrintBoss commands require parameters. Each parameter in a list of parameters is always separated with a comma. If no delimiter is used to enclose a parameter, PrintBoss will trim leading and trailing spaces. In the following example, the final parameter will only be 8 characters long: “Test 123”.

```
#Text 4, 5, Arial/12,  Test 123
```

Often it is necessary or safer to delimit parameters in case there may be a comma within the parameter or if you want to retain leading and trailing spaces. This is especially true when you are delimiting variables, like an address, where you can’t be sure of the contents in the evaluated variable. Suppose the above #Text command includes 2 leading and 2 trailing spaces. The final parameter should be 12 characters long. This can be fixed with delimiters.

```
#Text 4, 5, Arial/12, "  Test 123  
```

The choice of delimiters is very important. If the `{CompName}` variable in the following line resolves to *O’Neil Decorating, Inc* and the delimiter chosen is a single quote, a problem would occur.

```
#Text 4, 5, Arial/12, '{CompName}'  This expression evaluates to O.
```

The CompName would stop at O due to the apostrophe in the name. A different delimiter needs to be used.

```
#Text 4, 5, Arial/12, «{CompName}»  This expression evaluates to O’Neil Decorating, Inc.
```

PrintBoss recognizes the following characters as delimiters. Delimiters are normally used in pairs, though different pairs may be used in the same expression:

<table>
<thead>
<tr>
<th>Delimiter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'</td>
<td>Single quote (apostrophe)</td>
</tr>
<tr>
<td>&quot;</td>
<td>Double quote (Shift + apostrophe)</td>
</tr>
<tr>
<td>~</td>
<td>Tilde (Shift + graves above left Tab key)</td>
</tr>
<tr>
<td>[ ]</td>
<td>Starting and ending square brackets</td>
</tr>
<tr>
<td>÷</td>
<td>Divide symbol entered in PrintBoss editors by pressing CTRL + Apostrophe</td>
</tr>
<tr>
<td>« »</td>
<td>Double arrows entered in PrintBoss editors by pressing CTRL + Comma for left arrows and CTRL + Period for right arrows</td>
</tr>
</tbody>
</table>

The last two choices are the safest since they are extremely unlikely to occur in a text string. A commonly used short cut is to omit the trailing delimiter if the parameter being delimited is at the end of a line.
The #Text command has many options and can be qualified in different ways that are unique compared to all other commands. Therefore, this command has a single chapter to explain the different options. This chapter is divided into three sections. The first section details the #Text command as accessed from the View of a form and the second section details the command when editing the textual scripts available in the Form Editor (normally in the Run Time Objects or Footer Objects sections). The third section describes Substitute Functions that can be used by either edit method.

EDIT #Text FROM A VIEW

To edit, insert, or delete text, it is often easier to use the Document View of a Form File.

1. Click on the Edit menu and select Form Files from the PrintBoss Master Application.
2. Select the desired form and click the View button. The View of the form opens. Clarity will depend on the monitor's size and resolution.

Data Present
The form is void of accounting data when viewed from the Form File. Bank account information displays depending on the form and based on the bank record selected from the drop down list at the bottom of the Form Select window. Close the view, select a new account from the drop down menu, and click View again to display information from a specific bank account.

- Any editing saved to a form in the View affects all bank accounts – not just the bank currently viewed.

Other elements in the View consist of text, grid, and other objects used to create the Form File and are generated by PrintBoss. This often includes logos, company information, bank information, signature lines, labels, and the format for the MICR line at the bottom of a check.

Delete Text
Deleting text or objects from the View removes that object from ALL documents that use this form. Click once on the text object to select it. The text will be highlighted. Right click and select Delete Current Object. PrintBoss will prompt you for a confirmation. The change is not permanent until you Close the view and confirm the changes should be Saved.

- Deleting text from the view will delete it for all copies and accounts that use this document.

Edit Text
There are two ways to select text in the form: 1) double click on the text or 2) click once to highlight, then right click and choose Edit Current Object. A dialog box opens with properties specific to this text item. Variable names
appear in the *Text* field enclosed in braces { } if the form text is the value of a variable. This is common with bank and company information.

Adjust the coordinates listed in the upper left area of the dialog box to change the placement of the text. These coordinates are in INCHES and measure from the left edge of the paper to the edge of the text, depending on justification (Left, Center, Right), and from the top edge of the paper to the edge of the text, depending on justification (Top, Middle, Bottom). The default justification is left and top. You may also drag text to the desired location.

**NOTE:**

Text may be dragged to change its location unless there is a variable in the *Left* or *Top* fields. See the graphic above for an example. The \{CompAdsLeft\} variable adjusts the left edge of the company address objects when a logo appears on the form. The distance from the left is specified by a \#Assign command.

The text dialog opens after text is dragged to verify the new location. Click *OK* to accept the change.

Click on the red question mark to the right of the *Type Face* field to change the style of the font and browse to any font available on your system. You may also type the name of a font. Adjust the point size and style of the font as desired. Available font properties include:

- Italics
- Bold
- Underlined
- Strikeout
- All Caps
- Color (If you do not have a color printer, the text will appear on the paper in a shade of gray)
- Reverse Print
- Mirroring
- Pitch Override for fixed pitched fonts only (Courier, Line Printer, Letter Gothic)
- Orientation
- Width
- Full Justification (Available when a Width is entered)
- Word Wrap (Available when a Width is entered)
- Work Wrap Line Spacing (Available when Word Wrap is selected)

A condition may be added to the text using the *Condition* field near the bottom of the dialog. Type the condition or choose one from the selector button to the right of the *Condition* field. Add "&&" after the condition to add another condition. It is often best to edit complex conditions in the Form Editor.
Please see Chapter 9, *Form Files*, for more detail on conditional commands.

**INSERT TEXT**

1. Right click anywhere in the View.
2. Select Insert an Object.
3. Click Text.

The Text Command Properties dialog opens with the coordinates of the point where you right clicked. Type your text in the *Text* field or enter a variable name in braces `{ }`. Typically the variable names are assigned in the RunTime Objects tab or through a PrintBoss PB#INFO trigger. Change the text properties as needed.

**NOTE:**

Objects inserted from the View are placed on the last line of the Footer Objects tab of the Form File (or the Back Objects tab if viewing the back of the form). Placements in other tabs or changes of order for proper formatting need to be made in the Form Editor.

It may be convenient to view a list of available variables when inserting a new Text field.

1. Close any open windows except View.
2. Right click in the View.
3. Select Display Assignments.

These steps open the *Form Assignments* window. Move the Form Assignments window to the side for reference. Drag a variable from the *Assignments made in form* list or the *Assigned Fields (Permanent)* list onto the View of the form. A *Text Command Properties* dialog opens for the variable. The coordinates in the dialog are based on the drag location of the variable. Edit and click OK to save your changes or click Cancel to undo.

**FORM EDITOR**

Though it is easier to Add/Edit/Delete text objects from the View of a form, sometimes it is advantageous to access the script behind the view. A #Text command defines text properties for every text object in the script. The scripts are editable by opening the form editor and examining the RunTime, Footer, Page Back, or Proprietary Objects tabs of the form. The basic syntax follows:

```
#TEXT X, Y, "FontDescriptor", "TextString"
```

Double click on an existing command or type #Text and double click on it and a line editor dialog will parse out the script and open the *Text Command Properties* dialog. The following describes the parameters the parser expects.

**X, Y:**

These coordinates represent the location of the top left corner of the text from the left and top edges of the paper in inches. These values may be entered in thousandths of an inch. If the X coordinate is followed with the letter L, C, or R (case does NOT matter), PrintBoss will justify the text to the Left, Center, or Right. The text is left justified by default. Type the letter T, M, or B after the Y coordinate to justify the text Top, Middle, or Bottom. The text is top justified by default.
Only enter the letter representing justification in the script. The *Text Command Properties* dialog has corresponding line justification buttons.

**Font Descriptor:**
The Font selection button on the *Text Command Properties* dialog in PrintBoss opens the *Windows Font* dialog. Once a font is selected, the descriptor is built automatically. The font descriptor can be typed in the script using the following components:

- 'Typeface/Point Size/Options'
- 'Arial/12/B'

PrintBoss allows a few abbreviated Type Faces.

<table>
<thead>
<tr>
<th>Font</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UV</td>
<td>Universal*</td>
</tr>
<tr>
<td>TM</td>
<td>Times Roman</td>
</tr>
<tr>
<td>CR</td>
<td>Courier</td>
</tr>
<tr>
<td>LP</td>
<td>Line Printer*</td>
</tr>
<tr>
<td>LG</td>
<td>Letter Gothic</td>
</tr>
</tbody>
</table>

* Not recommended as not available in newer printers.

The font options are:

<table>
<thead>
<tr>
<th>Font Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>Italics</td>
</tr>
<tr>
<td>B</td>
<td>Bold</td>
</tr>
<tr>
<td>N</td>
<td>Underline</td>
</tr>
<tr>
<td>K</td>
<td>Strikeout</td>
</tr>
<tr>
<td>U</td>
<td>All Caps</td>
</tr>
<tr>
<td>R</td>
<td>Reverse Print</td>
</tr>
<tr>
<td>@nnn</td>
<td>Rotation of fonts in degrees –360 …0 … 360. Often used to change the orientation of text for Deposit slips</td>
</tr>
<tr>
<td>+</td>
<td>Follows point size and specifies all mirrored blocks use original point size</td>
</tr>
<tr>
<td>Pnn.nnn</td>
<td>Overrides any Fixed or Proportional pitch with this pitch</td>
</tr>
<tr>
<td>Xnn.nnn</td>
<td>Sets width of text in inches when used with Full Justification (XJnn.nnn)</td>
</tr>
<tr>
<td>A</td>
<td>Word Wrap</td>
</tr>
<tr>
<td>E.nn</td>
<td>Specifies Word Wrap line spacing</td>
</tr>
</tbody>
</table>

**Text String:**
This is the actual string of text that prints and can be a variable name or specific text (i.e. 'Two Signatures Required'). The string should be delimited (see *Delimiting Parameters* at the end of Chapter 9). Take care to choose a delimiter that will not occur in the string, especially when the text is an assignment from captured data. Example: Don't use Single Quotes if the text could possibly contain an apostrophe.

One unique delimiter available to PrintBoss is Ctrl+ ' (apostrophe) and appears as a ÷ (old division symbol). This delimiter is recommended when the other options may appear in the text string.

Some examples of #Text commands commonly found in PrintBoss Form Files include:

```
#Text .3, 7.8, "Arial/14/B", ÷{BCName}÷  |This places the company name in the upper left of the check in a 14 point Bold Arial font.

#{C.0}Text 4C, 10.5, "Times Roman/10/I", "Original"  |This places the label "Original" centered at the bottom of the original document, but not on copies.
```
SUBSTITUTE FUNCTIONS

There are times when a text command needs to be limited, formatted, or altered to account for special circumstances. Substitute functions are available for the #Text command to accommodate those special situations. A list of substitute functions is available in the Form Editor by RIGHT clicking in an Objects tab and selecting List/Stuff Assignments. Click on the plus sign in front of Substitution Functions to view the list.

Substitute functions need to be enclosed in braces { }. Each substitute function name is immediately followed by a colon and any required parameters. Everything between and including the braces will be replaced with the evaluation of the function when it is encountered in a script.

Functions may be embedded in functions. Use caution. Confusion may occur with delimiting the functions and parameters. Sometimes it is preferable to create a value from a series of steps to eliminate confusion and make the command clearer. For example, consider a field with leading and trailing spaces that is captured to a variable called {Dept}. It may have the value: " SHIPPING ". Only the first 2 non-space characters of this field need to be printed (SH). The following two scripts accomplish this goal. The second is a bit longer, but it is clearer and safer.

```
#Text 4, 10.0, "Arial/12", "Dept Code: {SubStr: ÷{ TrimAll: '{Dept}\'}÷,1,2}"

OR:  #Assign DeptTrimmed, "{TrimAll: '{Dept}'}"
     #Assign DeptCode, "{Substr: '{DeptTrimmed}',1,2}"
     #Text 4, 10.0, "Arial/12", "Dept Code: {DeptCode}"
```

Descriptions of the more common substitute functions follow. See Appendix C for a list of the remaining Substitute Functions.

**Case**

Case: `<Str>`, `U/L/P`

Changes the case of all the text in the `<Str>` to one of the following:

- U – Upper Case
- L – Lower Case
- P – Proper Case (first character of each work is capitalized)

The `<Str>` is replaced with a variable assigned to text in the PrintBoss Form.

**CurrentDate**

CurrentDate: `mm/dd/yyyy`

Inserts the current date formatted according to the mask. If no mask is passed, the Windows Regional date mask will be used. See Chapter 9, Form Files – Date & Time Format Masks, for more format options.

**CurrentTime**

CurrentTime: `hh:mm:ss tt`

Inserts the current time formatted according to the mask. If no mask is passed, the Windows regional time mask will be used. See Chapter 9, Form Files – Date & Time Format Masks, for more format options.

**DocAmnt**

DocAmnt: `/HideDec /Zero /Width:nn /Commas /Trim`

This function is used to specifically format the document’s amount as recorded in the work file Amount column.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HideDec</td>
<td>Determines if a decimal appears or not</td>
</tr>
<tr>
<td>Zero</td>
<td>Number of zeros or places following the decimal</td>
</tr>
<tr>
<td>Width:nn</td>
<td>nn specifies maximum width of the value in characters</td>
</tr>
</tbody>
</table>
Commas | Indicates whether or not commas separate thousands
---|---
Trim | Trims the value

**FormatDate**

FormatDate: `'<DateInExpr>', 'mm/dd/yyyy' [, AddDays [, AddMonths [, AddYears [:/EOM/FOM]]]]`

This function is used to format a date. `<DateInExpr>` represents the date to format (or a variable referencing a date) followed by the appropriate format mask. The mask may change the order or the separators of the date. By default, the AddDays/AddMonths/AddYears parameters are 0. Insert positive or negative values for these parameters to shift the date accordingly. Include the `/EOM` option to return the end of month, or the last day of the month for the DateInExpr. FOM will return the first day of the month for the DateInExpr. If the DateInExpr is empty, the FormatDate will use the date displayed on your computer.

**FormatDate2**

FormatDate2: `<DateInExpr>', '<DateInExprMask>', 'mm/dd/yyyy' [, AddDays [, AddMonths [, AddYears [:/EOM]]]]`

Same as FormatDate, except this function includes identifying the DateInExprMask format for those cases where the input is different than the Windows' ShortDateFormat.

**FormatNum**

FormatNum: `<NumStr>', WholeDigits, DecimalDigits, 'LeftFill', 'RtFill', 'H/C`

This function formats the structure of a numeric value and is often used for Positive Pay. The following letters are used to represent HideDecimal/Commas:

- **H**: Hide decimal (used in Positive Pay Scripts)
- **C**: Comma is inserted as the thousands separator

These letters can be used separately or together. The following are examples of Hide Decimal and add Comma separately:

{FormatNum: '{DocAmnt}', 8, 2, '0', '0', 'H'}

In this example, the number of Whole Digits is 8, the number of Decimal Digits is 2, zeros are used to fill Left, zeros are used to fill right, and the decimal is hidden. If the DocAmnt is $123.40 it would appear as: 0000012340

Here is an example of a #Text using the FormatNum substitute function:

#Text 7.950R, 8.500, 'Arial/10/B', ÷**${FormatNum: '{DocAmnt}', 0, 2, '', '0', 'C}÷  |Here, the zero Whole Digits represents any number. Notice there is no Left Fill.

**Pad**

Pad: `<Str>', <Len> [, <Left/Rt,/Trunc> [, <PadChar>]]`

This function defines the length of the string and adds extra characters when the string is short. Spaces are the default characters when PadChar is not defined. This function is often used with Positive Pay.

The option parameter may specify L, R, or T for Leftpad, Rightpad, or Truncate. The Truncate will truncate it to the length `<Len>` specified.

For Example:

{Pad: '{DocNo}', 10, R, '0'} or
{Pad: '{DocNo}', 10, , '0'}

The `${DocNo}` is a variable for the document number. If the check number was 1234, it would appear as: 1234000000.
**RECAmnt**

RECAmnt: '#,###,##0.00'

This function displays the amount of the document at the time the work file was generated. The only parameter is the mask, and it is optional.

<table>
<thead>
<tr>
<th>Mask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Digit placeholders that are suppressed if not needed</td>
</tr>
<tr>
<td>0</td>
<td>Digit placeholders that will force a zero when no value is present</td>
</tr>
<tr>
<td>,</td>
<td>Thousands separator (suppressed if not needed)</td>
</tr>
</tbody>
</table>

**RECDate**

RECDate: 'mm/dd/yyyy'

Inserts the date the PrintBoss work file was created. The optional mask uses the characters defined in Chapter 9, *Form Files – Date & Time Format Masks*.

**RECTime**

RECTime: 'hh:mm:ss tt'

Inserts the time the PrintBoss work file was generated. The optional mask uses the characters defined in Chapter 9, *Form Files – Date & Time Format Masks*.

**StrExtract**

StrExtract: '<OrigString>', '<Delimiter>', '<Occurrence>[,<mode>]' OR
StrExtract: '<OrigString>', 'CDF', '<CommaDelimitedFldOccurrence>[,<mode>]' OR

This function extracts a substring from within a string. The original string is divided into substrings separated by the specified delimiter. The following example extracts asterisks from the string before printing the word amount.

Example:   #Text 0.675, 9.102, 'Arial/10', ÷{StrExtract:«{WordAmnt}», «**»,1} Dollars÷

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OrigString</td>
<td>This is the original string with substrings delimited by the delimiter.</td>
</tr>
<tr>
<td>Delimiter</td>
<td>Delimits the substrings. Often this is a comma or semi-colon, but it may be multiple characters. This parameter is Case Sensitive. See CDF note below.</td>
</tr>
<tr>
<td>Occurrence</td>
<td>Identifies the substring to select within the original string. If this value is negative, it will count occurrences from the right. An occurrence of -1 returns the last substring in the original string.</td>
</tr>
<tr>
<td>Mode</td>
<td>Enter any of the abbreviations L, R, B or U to indicate Left trim, Right trim, All trim, or Uppercase.</td>
</tr>
</tbody>
</table>

**CDF NOTE:**

A special type of string is called a *Comma Delimited String*. In this case, each substring is delimited by a comma, but the substring itself may also be delimited with double quotes. This enables the substring to contain commas. Enter CDF as the delimiter for a Comma Delimited String and PrintBoss will look for the double quote substring delimiters and treat them appropriately.

**StrTran**

StrTran: '<OrigString>', '<SearchKey>', '<ReplKey>[, 'Options']

This function replaces a substring (SearchKey) with another substring (ReplKey). A number entered in Options will limit the number of replacements starting from the left of the string. A negative number will count from the right. An option of -1 will replace the last occurrence in a string. The following example removes all the asterisks in the DocAmnt string by replacing the asterisks with nothing as symbolized by the two apostrophes.
**WordAmnt**

WordAmnt: `<Amnt> [, <Line1or2> [, <LineLength90> [, <CurrencyDollars> [, <Style A or B> [, <Language>]]]]]`

This function takes the numeric value of a variable and translates it into English or French text. PrintBoss places the returned text on line 1 based on the length provided, but it will wrap to line 2 if necessary. If an entry in the form specifies both line 1 and line 2, each line must use the same specified max line length. All parameters except `<Amnt>` have defaults, so any parameter may be left blank and the default value will be used.

**Example:** #Text 0.66, 9.10, 'Arial/10', ‡{WordAmnt: '{DocAmnt}', 1, 120, Dollars,A,F}‡

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amnt</td>
<td>Amount to be converted to a text expression</td>
</tr>
<tr>
<td>Line 1 or 2</td>
<td>Identifies the location for the returned text. Default is 1</td>
</tr>
<tr>
<td>LineLength90</td>
<td>Length of line based on characters in the line. Default is 90</td>
</tr>
<tr>
<td>CurrencyDollars</td>
<td>The currency phrase will use this value in the text. Default is Dollars.</td>
</tr>
<tr>
<td></td>
<td>This can be replaces with other denominations.</td>
</tr>
<tr>
<td>Style AorB:</td>
<td>Default style is A</td>
</tr>
<tr>
<td>Style A example:</td>
<td>Ten and 11/100 Dollars</td>
</tr>
<tr>
<td>Style B example:</td>
<td>Ten Dollars and Eleven Cents</td>
</tr>
<tr>
<td>Language</td>
<td>Translates numeric value to French (.F) of Spanish (.S). The default is</td>
</tr>
<tr>
<td></td>
<td>English (no indicator necessary).</td>
</tr>
</tbody>
</table>
Security Features

The PrintBoss security features allow an administrator to restrict access to specified functions within the program. Accessibility can be gained through password and user disk, and each user can have a different level of access.

Windows users need FULL CONTROL of the PrintBoss directory for the PrintBoss application to function properly. If there is a need to lock down access to the program, it should be set through PrintBoss security. Security settings are not required, but are available if desired. PrintBoss will function normally if security is not activated.

Security settings only need to be defined once for all workstations when PrintBoss is installed on a network. Multiple users can access PrintBoss simultaneously from different workstations when PrintBoss is installed on a shared network drive. If the PrintBoss application is installed locally on workstations, then security settings need to be defined for each workstation.

Setting Up Security

Security Access
The Administrator or Supervisor determines the restricted functions.

1. Open the PrintBoss Master Application.
3. Enter the Master Password or insert the original registration disk shipped with your copy of PrintBoss.
   a. Enter ADMIN (upper case) in the Master Password field for first time installations.
   b. OR Insert the registration floppy (older installations that have updated) into the drive and enter the correct drive letter in the Insert Distribution Disk in drive field.
4. Click OK. The Security Settings window opens.

There are three tabs on the Security Settings window, but the Basic User Rights tab changes name and function when the Security Method on the General Settings tab is changed to Advanced. The fields on each of these tabs are explained in more detail in Appendix D of this manual.

Set Basic User Rights (Standard)
A set of Basic User Rights can be created that applies to all PrintBoss users. Additional rights can be assigned to individual users. These users will need to be created on the Advanced User Rights tab and assigned a password. The restricted features will only be available to the user when they Log-In to PrintBoss.

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select Security.
3. Enter the Master Password.
4. Click on the Basic User Rights tab. This tab is available when Standard is selected as the Security Method on the General Settings tab.
5. Check only the features you want all users to access.
   a. All features are selected by default.
   b. Click the Uncheck All button to remove all checkmarks and then check only the features you want all users to access. You may also uncheck specific features you want to restrict without using the Uncheck All button.
6. Click OK when you are finished.

**SET SECURITY REQUIRED (ADVANCED)**

Advanced security adds another layer of security by requiring the user to insert an encoded floppy disk into the computer to access specified features. This method can only be used if the computer has a floppy disk drive.

1. Open the PrintBoss Master Application window and access Security.
2. Click on the Security Method drop down menu on the General Settings tab and choose Advanced.
3. Select the Security Required tab. This tab is only visible when the Advanced security method is chosen.
4. Check only the features you want to restrict from all general users.
   a. Enter a check in the User Logged In column to require a login to use the feature.
   b. Enter a check in the User Disk column to require the user insert an encoded floppy disk to use the feature.
   c. A check in both columns requires both a user login and insertion of an encoded floppy disk.
   d. Items NOT checked do not require a login or encoded floppy disk to access the feature.

5. Click OK when you are finished.

CREATE USER ACCOUNTS
The steps used to create user accounts are basically the same for both the Standard and Advanced security methods.

1. Open the PrintBoss Master Application window and access Security.
2. Click on the Advanced User Rights tab.

3. Click on the Plus sign (+). The User Edit window opens. The following is an example of the Standard security method.
Here is an example of the **Advanced** security method.

4. Enter a **User Name**. Enter the user's Windows User Name if you would like to enable *Auto Login* on the *General Settings* security tab.
5. Enter a **Password** for this user. Passwords are visible to anyone who has the Master Password to access Security.
6. Check the appropriate available features to provide secure access to this user.
a. These features will be available to the selected user after he/she successfully logs in to PrintBoss when the Standard security method is selected.
b. The Advanced security method indicates how the user can access these features when they are checked.
   i. L – Login required
   ii. D – Disk required
   iii. B – Both a login and distribution disk are required for access

7. **Advanced Only** – Create a user Disk if the letters B or D appear next to any of the features on the User Edit screen.
   a. Insert a floppy drive into your computer.
   b. Enter the drive letter for the floppy in the User Disk Floppy Drive field.
   c. Enter an expiration date for the floppy in the Valid Through field.
   d. Click the Write User Disk button to encode the floppy.
   e. Remove the floppy when you are done.

8. Click **OK** on the User Edit window when you are done.

## Accessing Secured Areas

Once security levels and users are defined, Users must log in to access those functions. Select File / User Log-In from the main PrintBoss Master Application window. Enter your User/Operator Name. Enter the correct password. If only a disk is required, make sure it is in the correct drive before selecting OK.

### Changing Users

When one PrintBoss user is finished and a second would like to access security on the same workstation, the current user does not need to log out. The new user just logs in. Only one user is ever considered logged in to PrintBoss on the same workstation. Select File / User Log-Out when all users are finished to exit the security features.

A user is automatically logged out of PrintBoss on a workstation when the PrintBoss application is closed. No user is logged in when PrintBoss is first launched unless the option to **Auto Login Matching Windows Users** is selected from the Security / General Settings tab and there is a match in the PrintBoss Advanced User Rights tab.

## Other Security Options

Other security options can be selected on the **General Settings** tab of the Security Settings window. Brief descriptions of these options are provided in the following table.

<table>
<thead>
<tr>
<th>Security Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress printing signatures in Archive Reprints</td>
<td>Prevents a secure signature (file with the extension of .sig) on a document from printing when the document is reprinted from PrintBoss Archives (File/Open Document Archives).</td>
</tr>
<tr>
<td>Master Password</td>
<td>Change the Master Password the first time you use Security and anytime the Supervisor position changes.</td>
</tr>
<tr>
<td>Auto Login Matching Windows Users</td>
<td>PrintBoss will automatically login a user when their Windows User name matches an entry on the PrintBoss Advanced User Rights tab (Options/Security).</td>
</tr>
<tr>
<td>Display ONLY primary fields in the bank list browse</td>
<td>Select this option to suppress account information on the PrintBoss Bank List (Edit/Bank List) and only display Bank Code, Bank Prompt, and Bank Name.</td>
</tr>
<tr>
<td>Signature Disk Log (Enterprise Only)</td>
<td>Select Logging Active and set the retention period for the log in days.</td>
</tr>
</tbody>
</table>

---

**PrintBoss**  93  **Electronic Copy**
TEXT SECURITY

Another way to help prevent fraudulent changes is to secure the text on the document. Typically, the text that needs the most security is the amount on a check. The following features discourage or make it impossible for anyone to change the check amount once the document is printed.

SECURE TEXT COMMAND

This special text command automatically formats text (alpha or numeric) in a graphical layout. There are two types of secure text: Custom and Standard Block Numeric.

The Custom option creates a rectangle behind the text object and can be used for alpha and numeric text objects. The Std Block-Numeric option is used for numeric text only. The words Pay Only are added and the numbers are formatted, shaded, and the word for each number is added. This is typically used for check amounts.

See Chapter 9, Form Files, for more information on the Secure Text and Rectangle commands.

RECTANGLE COMMAND

The rectangle command can display a pattern behind a text object or signature, making it difficult for anyone to modify it once printed. This same command can be used in front of text to mask it. One example is masking or hiding the first 5 digits of the social security number on the advice of a payroll check.

White text (or negative printing) can be used with this command to make it more difficult to modify the text. The Vertical Fade or Horizontal Fade pattern should be used with negative printing.
**Signature Disks**

PrintBoss can place digitally scanned signatures on checks during the print process. These signatures can be printed conditionally based on a number of variables. The most common conditions are bank account or dollar value of the document. PrintBoss reads BMP, JPG, and PCX file types.

Saving a signature file to a disk adds a level of security by requiring the disk be inserted in the computer to add the signature file(s) to checks. Wellspring Software offers a PrintBoss Signature Disk that provides additional levels of security to the signature printing process. First, the signature file type (SIG) can only be read by the PrintBoss software. Second, the file is encoded so it requires the secure disk/CD/USB be inserted in the computer to use the PrintBoss signature. The PrintBoss Signature Disk is the key to unlock the encoded signature file. The disk is also encoded so a standard Disk Copy will not duplicate the disk. This additional security level prevents the scanned signature file from being used fraudulently in other programs or by unauthorized personnel in PrintBoss.

**PrintBoss Signature Disks, CDs, or USB drives**

PrintBoss Signature Disks are custom created for specific files. These disks and signature files are encoded so the disk cannot be copied using a simple Disk Copy command nor can the signature file be read by standard graphics programs. The signature files have a .SIG extension. The disk may be a floppy, CD, or USB key.

✔ If two signatures are to print on the same check, both signatures must be encoded for the same PrintBoss Signature Disk.

Copy the actual signature files to the PrintBoss/Logos directory. PrintBoss reads the file and looks for the disk key to unlock the file at the point of printing or viewing. The signature can be viewed or printed when the encoding on the disk and signature file match. Otherwise, the signature file will not display or print.

**NOTE:**

Terminal Server and Citrix environments need the disk in the drive of the server or the user session must have the drive of the local workstation mapped.

Please contact Wellspring Software to order a PrintBoss Signature Disk.

**Duplicating PrintBoss Signature Disks**

The original PrintBoss Signature Disk and Security Master Password, along with access to the PrintBoss application, are necessary to make a copy of a PrintBoss Signature Disk.

1. Open the PrintBoss Master Application.
2. Click on the Utilities menu and select Install Modules.
3. Select the Signature Disk Duplication tab.
4. Enter the PrintBoss **Master Password** as defined under **Option / Security**.
5. Click on the active **1** button after entering the password. The 1 will fade and 2 will become active.
6. Insert the PrintBoss **Source Signature Disk**.
7. Enter the correct drive letter for the Source Signature Disk. This may be a floppy, CD, or USB flash drive.
8. Click on the active **2** button.
9. Insert a new blank disk. This does not need to be the same type of media as the original. If you are using the same type of media, remove the original disk before inserting the new disk.
10. Enter the correct drive letter for the **Destination** disk. This may be the same as the original disk.
11. For a signature CD**, select the **Store Encoded File in {PrntBossHome}\ SigDisks** check box.
12. To add a **Password** to the NEW signature disk, check **Use Password** on the right side of the screen. Enter the password in the field provided under the check box. This password will not impact the original disk.
13. Click on the active **3** button.
14. Click **Done** when you are finished.

The newly created signature disk has the required encoding. Signature files from the source disk may also be copied to the destination disk (except if it is a CD) through Windows Explorer, but are not required. Signature files do not need to reside on the disk since they are normally read from the PrntBoss\Logos folder and PrintBoss will verify the matching encoded disk.

**NOTE:**

**The encoded file is created from the specific CD, but no file is written to the CD during the duplication process. If you would like the signature files on the CD, burn the signature files to the CD before following the signature disk duplication process.**

**ADDING A PASSWORD TO AN EXISTING PRINTBOSS SIGNATURE DISK**

A password may be added to an encoded PrintBoss signature disk. Users will be prompted to enter the password before PrintBoss accesses the disk. Adding a password is similar to the process of duplicating a disk except the existing disk is used for both the source and destination.

1. Open the PrintBoss Master Application.
2. Click on the **Utilities** menu and select **Install Modules**.
3. Select the Signature Disk Duplication tab.
4. Enter the PrintBoss **Master Password** as defined under **Option / Security**.
5. Click on the active **1** button after entering the password. The 1 will fade and 2 will become active.
6. Insert the existing PrintBoss disk as the **Source Signature Disk**.
7. Enter the correct drive letter for the Source Signature Disk.
8. Click on the active **2** button.
9. Select the **Use Password** check box on the right side of the screen. Enter the **Password** in the field provided under the check box.
10. Enter the same drive letter for the **Destination** as the Source drive.
11. Click on the active **3** button.
12. PrintBoss will warn the source and destination disks are the same. The only change will be to add/edit the signature indicated.
13. Click OK.
14. Click Done when you are finished.

**CREATING NON-ENCRYPTED SIGNATURE DISKS**

PrintBoss reads BMP (bitmap), JPG, PCX and PICT files. Scan a signature and save it as one of these formats. PrintBoss can print color images in these file formats as long as you are using a color printer. Color signatures will print in shades of gray when printing to a printer using MICR toner.

Save the scanned file onto a disk and reference the file in the appropriate Form File or Bank record. Be sure to reference the entire path and filename, not just the filename. For example, enter `A:\my_boss.bmp` in the appropriate Form File or Bank record. There is a 40 character limit for the filename and path.

Make sure the disk with the signature file is in the specified drive before printing checks to PrintBoss. An error will pop up (unless this option has been turned off in the Pic Command Properties dialog for the form) when checks are printed or viewed and the signature disk is not in the specified drive.

**ADDING A SIGNATURE TO A CHECK**

Signatures must be referenced by the PrintBoss form in order to print on a check. Add a #PIC command referencing the signature file to each form that prints the signature (such as AP and Payroll). Add a second #PIC command when you need to print two signatures.

If the same signature is used for every bank account, the signature file name and path can be added directly to the #PIC command on the form. Otherwise, add the signature file name to the PrintBoss bank record and add the variable name associated with the field in the bank record containing the signature file name to the #PIC command.

PrintBoss provides sample signature commands near the bottom of the Footer Objects tab on all standard forms.

1. Locate the **PrintBoss Home directory**. You can determine the location by clicking on the PrintBoss Help menu and choosing About. The location for Home is listed under the Directories section towards the bottom of the window.
2. Copy your signature files, including *.sig encrypted signature files, into the Logos folder in the PrntBoss Home directory.
3. Open the PrintBoss Master Application.
4. Add the Signature File
   a. Bank Record
      i. Click on the Edit menu and select Bank List.
      ii. Select the appropriate Bank record and click the Edit Bank button.
      iii. Select the Signatures_Logos tab.
iv. Click on the browse button next to the Signature Properties field. PrintBoss automatically opens the Logos folder in the PrintBoss home directory. You may browse to a different location if your files are not in this folder.

v. Select the desired signature and click Open.

vi. Repeat for Signature 2 Properties if two signatures may appear on the check.

vii. The Position coordinates properly place signatures on the bottom stub of a check.

viii. Set a Hi Range Condition if desired. For example, enter 5000.00 if the signature should not print when the check amount exceeds $5,000.00.

ix. Set a Lo Range Condition if desired. For example, enter 5000.00 if Signature 2 only prints when the check amount is $5,000.00 or more.

x. Click OK to save the values and exit the PrintBoss Bank Edit window.

xi. Click Done to exit the PrintBoss Bank List.

b. Form File

i. Click on the Edit menu and select Form Files.

ii. Select your form from the list and click the Editor button.

iii. Select the Footer Objects tab.

iv. Scroll to the bottom of Footer Objects and locate the Sample Signature section.

1. Use the command starting with #PIC to add a signature file directly to the form. Remove the pipe symbol (|) if it appears before the # sign to activate the command.

2. Use the command starting with #FileExists if you added the signature file through the bank record.

5. Double click on the appropriate command in the Footer Objects window. The Pic Command Properties dialog opens.
6. Enter appropriate values into the fields.
   a. **Inches from Left** – Enter the inches from the left side of the page to begin the signature file.
      i. `{BSIGX}` is the default value and refers to the value entered in the X Position field in the Bank record.

      **NOTE:**

      Click the **Edit Bank** button at the bottom of the Pic Command Properties dialog to change this value. DO NOT enter a specific value in place of the `{BSIGX}` variable. This may adversely affect other signatures files using this same form.

      ii. `{BSIG2X}` is the default value associated with Signature 2 in the Bank record.

   b. **Inches from Top** – Enter the inches from the top of the page to the top of the signature file.
      i. `{BSIGY}` is the default value and refers to the value entered in the Y Position field in the Bank record.

      ii. `{BSIG2Y}` is the default value associated with Signature 2 in the Bank record.

   c. **Size Adjust** – Enter inches to adjust the width and height of the signature file to size the width differently than the height or enter a Percent value to adjust the width and height by the same ratio.
      i. **Wdt/Ht**
         1. `{BSIGWD}` and `{BSIGHT}` are the default values referencing the Wdt and Ht values entered in the Bank record.
         2. `{BSIG2WD}` and `{BSIG2HT}` are the default values associated with the width and height values for Signature 2 in the Bank record.

      ii. **Percent**
         1. Enter `{BSIGSIZE}` in both the Horizon and Vertical fields to reference the Percent value entered in the Bank record.
         2. Enter `{BSIG2SIZE}` in both the Horizon and Vertical fields to reference the Percent value associated with Signature 2 in the Bank record.

d. **Graphic File** – Enter the signature file name and path. Only the file name is required if the signature is located in the Logo folder of the PrintBoss Home directory.
   i. `{BSIGFile}` is the default value and refers to the file name entered in the Signature Properties field in the Bank record.
   ii. `{BSIG2File}` refers to the file name entered in the Signature 2 Properties field in the Bank record.

e. **Sig Disk Drive Letters** – Enter the letter(s) associated with the drive containing the signature disk if this is an encrypted file (*.sig). A series of letters may be entered if there is more than one possible choice, such as DEFG.
f. **Condition** – Enter any required conditions. The example above prints the signature file if it exists and if the check amount meets the range condition. The values for the range condition in this example are entered in the Bank record.

7. Click **OK** to save changes and close the Pic Command Properties window.

8. Click **OK** to save changes and close the Form Editor.

Typically, placement for the signature is relatively close to the signature line. Signatures from a disk in the computer will appear in the View if there are no conditions on the signature. Amount conditions can be simulated in the View by entering a value in the Dollar field at the top of the window. (See Chapter 9, *Form Files – Modify From the Document View*). Drag the signature to adjust placement or double click on the signature to edit the properties, including size. Location and size will display as variables for signatures stored in bank records. It is best to make these adjustments to the bank record, though the variables can be overwritten by numeric values. Numeric values will overwrite the variables for all bank records, not just the currently selected bank record.

Repeat the steps for a second signature file. Verify the coordinates for the second signature file are higher on the page so it does not print on top of the first signature.

See Chapter 9, *Form Files*, for more information on the #PIC Command.

**USING PRINTBOSS SIGNATURE DISKS**

Follow the instructions sent with the secured signature or refer to the instructions above in the *Adding a Signature to a Check Form* section.

Make sure the disk is inserted in the drive before checks are sent to PrintBoss. An error will pop up (unless that option has been turned off in the Pic Command Properties dialog for the form) when checks are printed and the PrintBoss Signature Disk is not in the specified drive. The error allows the disk to be inserted into the drive before continuing or allows the user to skip the use of the disk and signature(s). The checks will print without the signature(s) when the disk is skipped.
WORK/ARCHIVE FILES

PrintBoss captures documents to a work file. Documents stay in the work file until they are overwritten or archived. Work and archive files can be reprinted and sorted. PrintBoss also allows you to create reports to view or print lists of these documents.

CONFIGURE WORK/ARCHIVE FILES

Work and Archive files can be saved by user.

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select Configuration.
3. Locate the Private Folder Names section on the Settings tab.
   a. Work Files – The recommended setting for Work Files is {WinUserName}. PrintBoss will create folders by Windows User Name in the Work folder of the PrintBoss Home directory. This allows each user to track their own documents and prevents other users from accidentally overwriting the work files.
b. Archive Files – {WinUserName} is also the recommended setting for tracking Archive documents, but there are times when a Common folder is more advantageous for creating audit reports.

4. Select the Set Globally check box to save the {WinUserName} setting for all PrintBoss users. This applies to both the Work Files and Archive Files when they display the {WinUserName} setting.

5. Select Allow temporary folder change when browsing work file or archive when individual folders are used for users and a Supervisor or Wellspring technician needs to browse and view the files of another user. Browsing these files is explained later in this section.

**NOTE:**

The remaining settings on the Configuration window may vary based on the accounting software your organization is using. See Chapter 4, Setup, for an explanation of these settings.

6. Click OK when you are finished.

7. Click on the Edit menu and choose Form Files.

8. Select the desired form and click the Editor button.

9. Click on the Auto-Archiving Completed Records drop down menu on the Settings tab and choose an Archive method.
   a. None (Manual) – Work file documents are not archived or deleted automatically. Any changes to the work files need to be made manually.
   b. Archive Completed Records – Work file documents are automatically transferred to Archives after successfully printing.
   c. Archive Records w/Prompt – User is prompted to archive documents after they finish printing.
   d. Delete Completed Records – Work file documents are automatically deleted after successfully printing. They are not moved to Archives.
   e. Delete Completed Records w/Prompt – User is prompted to delete documents after they finish printing. Documents are not archived.
   f. Overwrite Work File at Start of Batch – This is the default setting for standard forms. Documents remain in the Work File until the next print batch is started. Then the existing documents are deleted and the new documents temporarily stored in the Work File. Documents are not archived.
g. **Archive Records after _ days** – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when the completed records will be automatically transferred to Archives. The largest available value is 299999.

h. **Archive Records after _ days w/ Prompt** – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when they will be prompted to archive completed records. The largest available value is 299999.

i. **Delete Records after _ days** – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when the completed records will be automatically deleted.

j. **Delete Records after _ days w/Prompt** – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when they will be prompted to delete completed work file documents.

k. **Archive Work File at Start of Batch** – Completed work file documents are automatically transferred to Archives at the start of the next batch printed to the same PrintBoss work file.

10. Click **OK** on the Form Editor to save your changes.

11. Click **Done** to exit the Form Select window.

**OPEN DOCUMENT WORK FILES / ARCHIVES**

Documents are temporarily stored in the Work File, depending on the Auto-Archive setting selected on the Settings tab of the Form Editor. These documents may be Printed, Browsed, Archived, Indexed, or printed in a Report list. Document Work Files and Archives work substantially the same way.

1. Open the PrintBoss Master Application.
2. Click on the **File** menu and select **Open Document Work Files**.
3. Select a form from the list and choose an action from the buttons on the right side of the window.
   a. **Print** – Reprint a selected document or all documents in the Work File. A range can be selected from the Scope. Select the **Allow Reprints** and **Original** check boxes or any other available copies before clicking the **Print Start** button.
   
   Select the **Close on completion** checkbox to automatically close this window after reprinting a document.

   b. **Browse** – View a list of the documents in the selected Work file and confirm their Printed status. Capital letters in the Printed column indicate successful printing. Lower case letters indicate printing was not successful.
The following is a list of print codes:

1. D – PDF
2. E – Email
3. F – Fax
4. O – Positive Pay
5. P – Print
6. S – Skipped (intentionally)
7. X – Fax Service; a / will be entered when the fax has been sent and will update to X if the fax sent successfully or x if it fails.

i. Select a document and click the View button to preview the entire document. See Chapter 9, Form Files – Modify from the Document View, to learn more about this feature.

ii. Click the Print button to print the selected document.

iii. Click on the drop down menu to the left of the View button or click on a dark gray column heading to sort the list. Sorting is only available when the Work or Archive File has been Indexed.

iv. Right-click on a document in the list to view additional choices:
   1. View – View the selected document(s)
   2. Print – Print the selected document(s)
   3. Edit – Open the Work File Edit window
   4. Hold Record – moves selected document(s) to a new work file with the same name and appended with ‘- HOLD’.
   5. Delete – Delete the selected document(s)
   6. Edit Form – This is a shortcut to open the Form Editor

v. Right-click on the Misc or Misc2 fields for a record in the Browse window to open a folder or file if one of these fields has been assigned to a file path or file path and name.

c. Delete – Delete documents in the selected Work or Archive File that meet one of the following conditions. This action cannot be reversed.
   i. Delete Only Completed Records (original and all copies printed).
   ii. Delete Records Created Between a specified data range.
   iii. Delete All Records.

d. Archive – Transfer or Delete records in the Work File that meet the selected condition. The conditions are similar to those listed for Delete above.
   i. Transfer moves the documents to the specified folder in the Archive folder of the PrntBoss Home directory. By default, the name of the Archive folder is the same as the Work File and Form name.
   ii. Delete permanently removes the selected records. This action cannot be reversed.

e. Index – Index the documents in the Work or Archive File for sorting.
   i. The two choices presented when no Index exists are: 1) Leave with no index; and 2) Index file. Choose Index file to sort the documents in the File Browse window.
   ii. The choices change when a Work or Archive File has been Indexed: 1) Disable Indexes; and 2) Rebuild Existing Index.
   iii. Select Pack Database on the Index Maintenance window to resize a file after many documents have been moved or deleted.
f. **Report** – Work/Archive Reports creates a list of reports that meet the specified criteria. This is a great auditing and search tool. Click the View/Print Report button after entering your criteria to View and Print a list of the results.

   i. **Order** – Enter a sort order if this file is Indexed. The example to the right uses Doc No. (Check No.) Order to sort.

   ii. **Bank** – Select a bank record to report on documents associated with a specific bank account. An asterisk (*) can be used as a wildcard to select all bank records or bank records that start with the same name.

   iii. **Date/Time Range** – Use the calendar buttons or type in the fields to specify a data range. Type in the far right fields to enter a time range. This is particular helpful for audit trails.

   iv. **Recipients** – The recipient range is alphabetical. Enter Lockhaven and Sloan to select all recipients that appear alphabetically between these two names.

   v. **Document Numbers** – This range is alpha-numeric.

   vi. **Document Amount** – This range is only numeric.

   vii. **Document Misc.** – This range is alpha-numeric.

   viii. A sample of the report results is displayed below.

4. Select the **Print** button to print this list.
5. Click **Close** to close the Batch print window.
6. Click **Close** to close the PrintBoss Work/Archive Reports window.
7. Click **Done** when you are finished with Work/Archive File Select

**BROWSE WORK/ARCHIVE FILE SELECT**

You can browse for Work or Archive files created by other PrintBoss users when *Allow temporary folder change when browsing work file/archive* is selected on the Configuration dialog under the Options menu.

1. Open the PrintBoss Master Application.
2. Click on the File menu and choose Open Document Work Files or Open Document Archives.

3. Click on the browse (folder) button at the bottom of the window.

**NOTE:**

The folder button is not present unless the ‘Allow temporary folder change when browsing...’ option is selected on the Settings tab of the Configurations Dialog under the PrintBoss Options menu.

4. Select a different user from the Browse for Folder list. Occasionally there are files under the main Work folder as well.
5. Click OK. The work/archive files for the selected user will display in the Work/Archive File Select list.

**WORK FILE/ARCHIVE EDIT**

The Work Edit window for Work and Archive Files contains useful information and functionality.

1. Open the PrintBoss Master Application.
2. Click on the File menu and choose Open Document Work Files or Open Document Archives.
3. Select a Form from the list and click the Browse button.
The fields are Read Only except for the Form, Misc (Fax Phone), and Misc2 (Email Address) fields.

5. A description of these fields follows.
   a. **Batch Date/Time** – Displays the date and time the work file was created.
   b. **Record Date/Time** – Displays the date and time the selected document was created.
   c. **Form** – Displays the Form used to process this document. Edit this field to display and print this data on a different form.
   d. **Bank** – Displays the name of the bank used to process this document. Changes to this field will not update the document.
   e. **Document Number** – Displays the check number.
   f. **Document Amount** - Displays the check amount.
   g. **Document Recipient** – Displays the Payee or Recipient if this is a check.
   h. **Printed** – Displays the status for each copy of this document. Upper case characters indicate the document was successfully printed or skipped. Lower case characters indicate a print failure. Blank indicates no printing was attempted.
   i. **Misc (Fax Phone)** – Displays the contents of the DocMisc field. Enter a fax number to refax or manually fax a document copy set to <Fax Service>.
   j. **Misc2 (Email Address)** – Displays contents of DocMisc2. This is often used for email addresses.
   k. **Status Log** – Displays status information for E-mail and Fax Service copies sent from PrintBoss.

6. Click **OK** when you are finished.
Hand Checks

PrintBoss Hand Checks are checks printed independently of the accounting software. They are used like a checkbook for paying charges such as COD amounts or purchases from a local store. Hand Checks print with the MICR, bank information, and company information, but require the date, payee, and amount to be filled in by hand.

There is no limit to the number of hand check specifications that can be created. Each file specifies a bank record, the PrintBoss form, and the method for numbering the checks. The creation, modification, and printing of hand checks are treated as a Utility.

NOTE:

Printing hand checks from PrintBoss will NOT update the accounting software’s database. For this reason, we suggest you use a different series of check numbers with hand checks.

Creating/Editing Hand Check Specs

1. Open the PrintBoss Master Application.
2. Click on the Utilities menu and select Hand Checks. A list of hand check specs defined by others may appear in the Hand Check Selection window. Otherwise, the list will be blank.
3. Select a hand check from the list or click the Create button and enter a Name for the hand check. Long names may be truncated based on the width of the Hand Check Selection window.
4. Click OK. The new name appears in the Hand Check Selection list.
5. Select your hand check and click the Editor button.
6. Fill in the following fields.
   a. PrintBoss Form – In almost all cases, this should be set to either the HandChk2 or HandChk3 form. HandChk2 has lines drawn to indicate where to write the payee name and amount while
HandChk3 does not. Payee information, date, and amount can be entered at the print stage on the **Print Individual Checks with Payee** tab.

b. **Use For Voided Checks** – Check this box if you are creating Void checks for your bank for testing.

c. **PrintBoss Bank Name** – Select an existing bank record from the drop down menu or choose {Request} to prompt for a bank when viewing or printing this hand check.

d. **Prompt** – Enter a description that is helpful to confirm the selection of this particular hand check. Reference to the bank is often helpful.

e. **Check Number** – Choose from the following:

   i. **Use Bank Acct. Next Number** – Check this option to use the Next Check Number field from the Bank Record in the PrintBoss Bank List. This is the recommended method. Remember that PrintBoss will NOT update the accounting software with these check numbers.

   ii. **Next Check Number** – Manually enter the next check number for this hand check. PrintBoss will increment the check numbers if you are printing more than one hand check. This field is not visible when Use Bank Acct. Next Number is selected. QuickBooks users must use this option.

f. **Send output to** – Choose from the following:

   i. **Printer** – Send the hand check(s) directly to the printer. No work or archive file is created. QuickBooks users must use this option.

   ii. **Work File** – Process the hand check(s) using the form’s settings for print time, copies, and archiving. This is the recommended setting.

See Chapter 9, *Form Files*, for more information on form settings.

7. Select **Preview** to view the check layout before printing.
8. Click **OK** on the Hand Check Manager window when you are finished making changes.

**NOTE:**

Typically there should be one Hand Check file created for each bank record that will print hand checks.

**PRINTING HAND CHECKS**

1. Open the PrintBoss Master Application.
2. Click on the **Utilities** menu and select **Hand Checks**. A list of hand check specs appears in the **Hand Check Selection** dialog. If the list is blank or the hand check needed is not in the list, return to *Creating/Editing Hand Check Specs* above for instructions on how to create a hand check.
3. Select the desired hand check and click **Print**. The specification fields are displayed in the Hand Check Manager dialog, though most of the specs cannot be edited.
4. Confirm the value in the **Next Check Number** field if it is displayed. This field is only available when the **Use Bank Acct. Next Number** is NOT checked. This can be changed through the Editor.

5. There are two tabs on this window. The second tab is suppressed when ‘Use For Voided Checks’ is selected in the Editor:
   a. **Print Series for Checkbook** – Enter the **Number** of blank hand checks to print. This is typically used to print Void checks for the bank.
   b. **Print Individual Checks with Payee** – Enter payee information, amount, date, memo, and advice notes for a single check before printing. These fields are optional.

6. Click **Preview** to view the check before printing. Preview will allow you to select a PrintBoss bank if {Request} was specified for this spec or the bank does not exist. Close preview to print the hand check(s).

7. Click **Print** to begin printing hand checks.

**SETTING AMOUNT CONDITIONS FOR HAND CHECKS**

Amount Range conditions can be used with Hand Checks as long as the Test Range is specified. (See Chapter 9, *Form Files, AmntRange conditional command*). For Example:

```
#Flagged, {BFlag1}]][AmntRange, 0.01, 0, {HChkAmnt}]Line 4.7, 9.5, 8.149, 9.5, B,
#AmntRange, 0.01, 0, {HChkAmnt}]Text 6.425C, 9.50 0, 'Arial/8', °Two Signatures Required for Amounts Over $10,000°
```

The first example prints a second signature line when the 2nd Signature Line check box is selected in the bank record and the check amount is at least $0.01. The second example prints the specified text when the check amount is at least $0.01. In both cases, the test amount is specified as the {HChkAmnt} variable since {DocAmnt} is not used on Hand Check forms.
Deposit Slips

Deposit Slips can be printed from a Form File or as a Utility. This section describes the Utility.

PrintBoss Deposit Slips are often printed independently of the accounting software. This is the more conventional sense of a deposit slip. The Deposit Slips can include the MICR, bank information, and company information from a PrintBoss bank record. The detail (description and amount) is hand entered on the screen.

Any number of deposit slip files may be created. Each file typically specifies the bank record and a form (Deposit1 or Deposit3). This process is similar to Hand Checks (see Chapter 14).

**NOTE:**

Printing deposit slips from PrintBoss does NOT update the accounting software’s database.

Creating/Editing Deposit Slips

1. Open the PrintBoss Master Application.
2. Click on the Utilities menu and select Deposit Slips. A list of deposit slip specs defined by others may appear in the Deposit Slip Selection window. Otherwise, the list will be blank.
3. Select a deposit slip from the list or click the Create button and enter a Name for the deposit slip. Long names may be truncated based on the width of the Deposit Slip Selection window.
4. Click OK. The new name appears in the Deposit Slip Selection list.

5. Select your deposit slip and click the Editor button.
6. Fill in the following fields.
   a. **Bank Information** – This information will update once you select a bank record from the **Bank Selection** drop down menu. The Bank Information fields are not editable.
   b. **Company / Account Information** – This information will update once you select a bank record from the **Bank Selection** drop down menu. These fields are not editable.
   c. **Bank Selection** – Choose the correct bank account for this Deposit Slip. This menu lists all the bank records from the PrintBoss Bank List.
   d. **Form Selection** – In most cases, this should be set to either the **Deposit1** or **Deposit3** form. Deposit1 prints a single deposit slip with a copy above the actual slip. The copy does not print the MICR line. Deposit3 prints a deposit slip with two copies – all of the slips print the MICR line.
   e. **Print Deposit Date** – Check this option to print a date on the deposit slip. This field can be edited once it is selected.

**NOTE:**

This Deposit Slip form is different than the forms used to print deposits directly from QuickBooks or other accounting systems. The form that is triggered from QuickBooks is QB_Dpst2 and is available in Top, Middle, and Bottom deposit formats.

f. **Print Copy** – This option is only available when **Printer** is selected as the output. A copy of the deposit slip is sent to the printer with the words **Deposit Slip Copy** printed on the second page where the MICR line appears on the first page.

g. **Send output to** – There are two options on this drop down menu.
   i. **Printer** – Send the deposit slip(s) directly to the printer. No work or archive file is created. The destination printer is defined by the selected form.
   ii. **Work File** – Process the deposit slip(s) using the form's settings for print time, copies, and archiving. A work file is created. This is the recommended setting.

See Chapter 9, **Form Files**, for more information on form settings.
7. **Description** and **Amount** entries made on the right hand side of this dialog do not carry over to the Print function when entered from the Editor. They are only for Preview purposes. They will print when entered from the Print function.

8. Select **Preview** to view the deposit slip layout before printing.

9. Click **Close** on the Deposit Slip Print Utility dialog when you are finished making changes.

**NOTE:**

There should be one Deposit Slip created for each bank account that prints deposits.

**PRINTING DEPOSIT SLIPS**

1. Open the PrintBoss Master Application.

2. Click on the **Utilities** menu and select **Deposit Slips**. A list of deposit slip specs appear in the **Deposit Slip Selection** dialog. If the list is blank or the deposit slip needed is not in the list, return to Adding/Editing **Deposit Slips** above for instructions on how to create a deposit slip.

3. Select the desired deposit slip and click **Print**. The specification fields are displayed in the **Deposit Slip Print Utility** dialog.

4. Confirm the **Bank Selection** is correct. This field determines the **Bank Information** and **Company / Account Information**.

5. Enter the appropriate **Descriptions** and **Amount** detail. PrintBoss will keep a running total at the bottom of the screen. The final total will be printed on the deposit slip.

6. Click **Preview** to view the deposit slip before printing.

7. Click the **Print** button to create the deposit slips.

8. Click **Close** on the Deposit Slip Print Utility dialog when you are finished.
Faxing

Setup

PrintBoss can fax documents using a computer's local fax modem board.

- Often there is confusion when a fax server is available to a PC. The purpose of the PrintBoss Fax is to fax to a local fax device. A fax server is a completely different situation. Normally, it appears to Windows applications as a printer driver. It has its own methods for determining the fax send number. If you want PrintBoss to print to a fax server, simply identify the fax server as the Destination Printer for one of the copies of a form. You will need to refer to the fax server documentation to determine how the server expects to assign a fax number.

- An alternative to using your own fax equipment is to use the Wellspring Fax Service described in the next chapter. The Fax Service allows faxing from any PC with an internet connection and does not require additional hardware.

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select Fax Settings / Local Fax Device. The PrintBoss Fax Configuration window opens.

NOTE:

The configuration fields are saved locally by User and PC.
3. Fill in the following fields.
   a. **Fax Class** – This should normally be Auto Detect.
   b. **Station ID** – Enter the number of the inbound fax machine in the office.
   c. **"Busy" Retry Count** – Enter the number of times PrintBoss will attempt to redial when the fax line is busy. Normally, the retry count is 3.
   d. **Dial Prefix** – Enter the dial prefix to dial outside the office if one is required. Add a ‘,’ after the prefix to pause if needed. Otherwise, this field is blank.
   e. **Seconds till Busy Retry** – Enter the number of seconds PrintBoss will wait before redialing if the fax line is busy. Normally, this is set to 30.
   f. **Modem Initialization String** – This field is normally blank.
   g. **Connection Wait** – Wait time, in seconds, to make a connection.
   h. **Alternate Dithering** – This is normally left blank.
   i. **Fax Header** – Select a fax header string to print at the top of the fax page. Choose a string from the drop down menu or create your own using the special variables listed below.
      i. $I = \text{Station ID}$
      ii. $SD = \text{Current Date}$
      iii. $ST = \text{Current Time}$
      iv. $SR = \text{Recipient}$
      v. $SF = \text{PrintBoss Form}$
      vi. $SN = \text{Document Number}$
      vii. $SP = \text{Current Page}$
      viii. $N = \text{Total Pages}$
   j. **Fax Resolution** – This field should be set to High or Standard. The High setting is recommended when graphics are included on the PrintBoss form.
   k. **Selected Device** – PrintBoss should recognize your TAPI compliant fax/modem and display the name in this field.
   l. **Treatment of Fax Errors** – This option directs PrintBoss to either pop up an error message or continue faxing the next document with no error message. Normally, this field is set to **Don’t show errors**. The **Popup Error Messages** option is often used for testing.
Combine pages with identical phone #'s when printing batches – This option directs PrintBoss Enterprise to compare all the documents in a batch to determine if any of the fax numbers are identical. All documents with identical fax numbers are sent in one fax call.

Print Status character of "S" (Skipped) when fax phone is blank – Check this option to skip a document when the fax number is blank and continue with the next document. PrintBoss will enter a capital S in the Printed column of the Work or Archive file to indicate the record was skipped and not faxed. The error will be recorded in the Status Log of the Work File Edit window for the document.

Wait for dial tone before dialing – Check this option to force PrintBoss to wait for a dial tone from the fax modem before it begins dialing.

Force Baud Rate (Special cases) – This option is used only by the instruction of a Wellspring Software technician.

Treatment of Fax Errors – Choose not to show errors or to allow popup error messages.

Treatment of landscape forms – Choose to print landscape forms either as a Compressed Portrait or as a full Landscape.

Left margin – The default setting is 40. Do not change unless instructed by a Wellspring Software technician.

Page Width – The default is 1660. Do not change unless instructed by a Wellspring Software technician.

Fax Test
- Test File – This field displays the path and file name of the test fax. Use the Open button to select a new test fax file. Every page faxed is converted to a .pfx file in the Fax subdirectory. One of these pages can be renamed and used as a test fax.
- Fax Test Phone Number – Enter the number of a local fax machine to test the fax. Most often this is an inbound fax number in your office.

Cover Page – Select the Cover Page check box to use or edit the following options.
- Cover Page File – PrintBoss has a default fax cover page. It is stored in the FAX subfolder of the PrintBoss Home directory. Use the Open button to select a cover page you created. Custom cover pages should be saved in the PrintBoss Fax subdirectory.
- Cover Page Font if Text File – Click on the Font button to change the font, size, and style of the text file listed in the Cover Page File field.
- Edit Cover – Select the Edit Cover button to open and edit the text file listed in the Cover Page File field.
- Cover Test – Select the Cover Test button to fax a test of the cover page to the number entered in the Fax Test Phone Number field.

Log File Active – Select the Log File Active check box to create a log for the documents faxed. PrintBoss saves the log to the default path and file name listed in the field. Use the Open button to select a different path and file name.
- Clear Log – Click this button to clear the existing log, deleting any previous fax logs.
- View – Click this button to view and edit the fax log.

Click OK to save your changes.

Testing

It is helpful to enter the number of the local fax machine in the Fax Test Phone Number field to test the fax options. Click the Fax Test button to fax the .pfx file shown in the Test File window. Check Cover Page to include a cover page. The cover page can be tested separately by clicking the Cover Test button. This will fax the file shown in the Cover Page File field. A sample test page file (FaxTest.pfx) and a sample cover page file (Cover.txt) are included with PrintBoss.

Form Setup for Faxing

The PrintBoss fax feature is enabled on a form-by-form basis. This only takes a few steps:

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and select Form Files.
3. Highlight the form you want to fax and click the Editor button.
4. Increment Copies by one on the Settings Tab. This new copy will be treated as the fax copy.
5. Select the Multi-Parts & Printers tab.
6. Set the Destination Printer/Device for the new copy to <PrintBoss Fax>. A fax button will appear at the top of the View for this form.

See Chapter 9, Form Files, Modify from the Document View.

7. Click OK.

**NOTE:**

The form must be set to “Text Only is captured…” on the Settings tab of the Editing Form. As a result, all graphics must be added through the PrintBoss Form. The file format for logos and graphics must be bmp with the background set to Transparent in the PIC Command Properties dialog. The PIC Command is the graphics command used to place logos and signatures on PrintBoss forms. Graphics often look better when the resolution on the PIC Command Properties dialog is set to 600.

See Chapter 9, Form Files, for more information on form editing and the #PIC command.

**MANUAL BATCH FAXING**

Printing documents from the accounting software will proceed as normal. Typically, the document Original and Copy are set to print/fax immediately. You may prefer to send the fax at a different time after the document is printed from the accounting software. For example, a batch can be faxed at the end of the day.

1. Follow the first six steps under Form Setup for Faxing above.
2. Select the Multi-Parts & Printers tab.
3. Locate the fax copy and set the Print Time to Batch.
4. Click OK and close the Form Select window.
5. Print documents from the accounting software.
6. Click on the File menu and select Open Document Work Files.
7. Select the appropriate work file and click Browse. The File Browse window opens.
8. Highlight the document you need to fax. Right-click on the document and choose Edit.
9. Type the full fax number in the Misc. (Fax Phone) field of the Work File Edit window. The 1 and the area code need to be included if the fax number is long distance. DO NOT include a prefix to access an outbound line. The Status Log at the bottom of the window will note the success or failure of the fax. Unsuccessful faxes will include an explanatory note.
10. Click OK when finished to return to the File Browse window.
11. Click on the Print button while the document is still selected. The Print Copies Dialog opens.
12. Select Allow Reprints.
13. Check the copy labeled <PrintBoss Fax> to select it.
14. Verify the report name and range under the Scope section. The End value should equal the number of documents in this batch if you are sending a fax for each document. The total number of records for this batch is displayed at the top of the Print Copies Dialog. Click the All button on the far right of the Scope to select all of the records.
15. Click the Print Start button in the top right corner of the dialog to begin faxing. A capital F will be entered in the Printed column of the File Browse window when the fax is successful. A lower case f will appear if the fax did not send successfully. Open the Work File Edit window to view explanations for failed faxes.

**AUTOMATIC FAXING**

Faxes can be sent automatically when PrintBoss receives the fax number from the accounting software. There are two ways PrintBoss can receive fax numbers from the accounting software:

1. Assign the fax number to the PrintBossMisc field of the PrintBoss Trigger formula in the accounting software crystal report. This method is used when the Capture Mode for the PrintBoss Driver Settings
under the Options menu is set to **Flag Trigger**. Review the *Installation Notes* specific for the accounting software setup for more information.

2. Assign the fax number captured from the accounting software data to the **DocMisc** variable in the form. This method is used when the **Capture Mode** for the PrintBoss Driver Settings under the Options menu is set to **Always Trigger**. Review the *Installation Notes* specific for the accounting software setup.

See Chapter 9, *Form Files*, for more information on Assignments.
Fax Service

Wellspring Software, Inc., offers a Fax Service that can be used with PrintBoss from any computer that has internet access. Faxes are sent from PrintBoss through the internet to a fax data center. The data center then sends the faxes to any number in the United States or Canada. Please note that overseas faxing is not available at this time.

Ordering

The fax service is a PREPAID service. Order prepaid pages from our web site using your Wellspring Software web account and password. If you do not have an account, you can create one online. This same account and password must be used with the PrintBoss program to allow PrintBoss to communicate with our server. You may choose to setup an automatic re-order quantity in PrintBoss so you always have the fax pages you need. All users can share one account or you may set up individual fax service accounts for each user. To create an account:

2. Click on SignIn in the top right corner of the Home page.
   a. Enter your Email Address or User Name along with your password and click Sign In OR
   b. Click the Create New Account link if you do not have an account
3. Select Order Now / PrintBoss Fax Service from the drop down menu at the top of the page.
4. Select the number of pages from the drop down menu near the bottom of the page and click Add to Cart. Remember, you may share fax pages with all PrintBoss users or set them up individually.
5. Check the Auto Reorder box on the first line and choose a Reorder Quantity to set automatic reorders.
6. You may also select to receive email confirmations for successful or failed faxes.
   a. Enter the email address to receive confirmations for this account.
   b. Select Email on Success, Email on Failure, or both.
   c. Click Save to save the email confirmation settings.
7. Sign Out when you are finished.

NOTE:
The price per page decreases with larger quantities of prepaid pages.

Fax Setup

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select Fax Settings /Wellspring Fax Service.
3. Fill in the following fields.
a. **Enable Fax Service** - This check box is workstation and user specific. It must be checked for the fax service to be activated. The name at the end of the check box legend identifies the active user.

b. **Account Information** – Enter the appropriate information for the identified user.
   i. **Used by All PrintBoss Users** – Check this option to force all PrintBoss users to share the same account information. This is independent of Misc Settings.
   ii. **User Name** – Enter the User Name. This must be the same name used to Sign In to the Wellspring web site to order prepaid fax pages. In most cases, this is an email address.
   iii. **Password** – Enter the Password. This must be the same password used to Sign In to the Wellspring web site.
   iv. A **User Name and Password must be entered and the account queried to view the following fields**:
      1. **Log File Image Treatment** – This option determines how the log file images are treated. The default value is Separate Files.
      2. **Log Retention** – This option determines how long PrintBoss will keep a record of each fax.
      3. **Blank Field** – This field is above the Pack button and displays the Wellspring Software web user ID after the account is queried.
      4. **Pack** – Click this button to pack the log table. Faxes older than the Log Retention period will be deleted.

c. *** Fax Service Account Status** – This section lists the status of the account selected to process faxes and relates to the account created on the Wellspring Software, Inc., web site to purchase the fax pages. You may have a single account for all users or create separate accounts for each user.
   i. **Account** – This button changes based on the status of the account.
      1. **Query Account** – Click this button to poll the Wellspring Software web site to update the fax service status for the account. This button is visible when you first enter the Fax Service window.
      2. **Refresh Account** – The **Query Account** button changes to Refresh Account after you click on it once. Click on this button to re-poll the web site and update the fax service status for this account.
3. **Confirm Account** – The **Query Account** or **Refresh Account** button updates to **Confirm Account** when changes are made to the Account Information section after the account has been queried at least once. This re-polls the Wellspring Software web site and updates the fax service status for this account.

ii. **Required PrintBoss S/N** – This field displays your PrintBoss serial number after the account is queried. This field is only editable from the web site.

iii. **Prepaid Pages** – This field displays the remaining prepaid pages in your account after the account is queried.

iv. **Edit Account** – Click this button to open the Wellspring Software web site to order additional prepaid fax pages or make changes to your account settings. PrintBoss automatically logs you in to the web site based on the information in the User Name and Password fields.

v. **Auto Reorder Qty** – Displays the Auto Reorder quantity set up on the Wellspring Software web site. This value can only be set on the web site or by calling Wellspring Software.

vi. **Auto Reorder Level** – Displays the **Prepaid Pages** level when the Auto Reorder Qty will be initiated. This field only displays when there is a value in the **Auto Reorder Qty** field and can only be set on the web site or by calling Wellspring Software.

vii. **Email Confirmations** – Displays the email address to receive confirmations for successful or failed faxes. You can choose one or both check boxes. These can only be set on the Wellspring web site by clicking on the **Edit Account** button.

1. **OK** – Confirms a fax was successfully sent.
2. **Failed** – Confirms a fax failed.

d. **Misc Settings** – These fields contain options for handling faxes.

i. **Used by All PrintBoss Users** – Check this option to force all PrintBoss users to share the same settings under Misc Settings. This is independent of the Account Information.

ii. **Assumed Area Code if none passed** – Enter the default area code PrintBoss should use if no area code is included with the fax number.

iii. **Pause prior to each fax in batches** – This feature allows PrintBoss to determine when to pause while processing faxes. There are 3 choices from the drop down menu.

1. **Never** – PrintBoss will not pause for any fax document.
2. **Invalid Phone Number** – This is the default value. PrintBoss will only pause during processing when the phone number is not properly formatted (10 digits or 7 digits with assumed area code). PrintBoss cannot tell if the phone number is no longer in service. If a number is no longer in service, the fax will fail. The failure will be indicated in the Fax Service Log (see end of this chapter).
3. **Always Pause** – PrintBoss will pause at every fax document when this option is selected. This is only recommended if your intention is to manually enter the fax number for each document.

iv. **Fax Header** – Edit this field to include header information at the top of each sent fax. You may use variables (items inside of brackets { } that change from document to document) as well as fixed text.

1. A sample header is included. You will want to edit at least the company name and number in this sample.
2. Other suggestions are provided in the drop down menu. You may edit any of these samples or create one of your own. Drag out the left or right edge of the dialog to lengthen the field and display a wider viewable area.

v. **Combine Pages with identical phone #s when printing batches** – PrintBoss Enterprise combines all faxes with the same phone number into one call when this option is selected. Only one cover page will be sent (if a cover is included). Standard PrintBoss will treat each page as an individual fax (separate call).

vi. **Print status character of “S” (Skipped) when fax phone is blank** – Select this option to enter a capital S in the **Printed** column of the work file when there is no fax number. Faxes that fail to send for whatever reason leave an error code of ‘x’ in the document work file. This lower-case error code prohibits the work file from being archived or deleted. Select this feature to allow PrintBoss to skip a fax and record a status of S in the work file. PrintBoss will treat the document as completed. The skipped record can be handled separately or ignored.
vii. Confirm fax success before moving Work Record to archive (or deleting) – Select this option to prevent a document from being removed from the Work File record until the fax is confirmed as sent successfully (or has an "S" for properly skipped).

viii. Include Cover Page when faxing batches – Select this option to include a cover page at the beginning of each sent fax.

ix. Fax Number Source – Select the variable(s) PrintBoss uses for the fax service.
   1. FaxSvcFaxNo – This is a unique variable to assign to the fax number.
   2. DocMisc – This variable is sometimes used for other data. It may be best to only select the FaxSvcFaxNo variable if you are not sure you are using DocMisc for something else.

x. Log File Poll Period – Select the interval (in minutes) PrintBoss polls the web site for updates on fax sent status. The default value is 4 minutes. The status can be viewed on the Fax Service Log under the Utilities menu.


e. Cover Page Fields Default Values – These settings apply to cover pages included with faxes unless their values are overwritten specifically in the PrintBoss Form File.
   i. Cover Page Fields used by all PrintBoss Users – Check this option to force all PrintBoss users to share the same Cover Page settings.
      1. PrintBoss includes a sample cover page that may be used as a default.
      2. The document selected here is used as the cover for all faxes unless an alternate cover is specifically designated in the PrintBoss Form File. Usually this is an html document with variable names that are filled at print time.
      3. Alternate cover pages can be saved in {PBDir}\FaxService\Cover Pages folder and accessed with the Open button at the end of this field.
   iii. Text Edit – Select this button to edit the Cover Page File using Notepad.
   iv. HTML Edit – Select this button to edit the Cover Page File using Word. Select Save As and choose the correct name with the format set to Web Page, Filtered (*.htm, *.html) when you are finished editing. DO NOT save as a regular Web Page or the variables may not work properly.
   v. To – Enter the appropriate variable for the To: name. The default value is {DocRecip}. This may be overwritten by values set in a PrintBoss Form.
   vi. From – Enter the appropriate value for the From: name. Typically this is your company name and is typed in the field. This may be overwritten by values set in the PrintBoss Form.
   vii. Re – Enter the appropriate value for the Re: subject. Text or variables may be used in this field. This may be overwritten by values set in the PrintBoss Form.
   viii. Cover Page Message – Enter a default message included on the cover page (if a cover page is included). You may edit this message or delete it and enter one directly on the Cover Page File. This field may be overwritten by values set in a PrintBoss Form.
   ix. Company Name/Address – Enter the appropriate default values for your company in these fields.
      1. Leave a field blank if you do not want to use it.
      2. These fields are referenced by the PrintBoss default Cover Page. You may edit the cover page so it does not reference these fields or enter the information directly into the cover page.
      3. These fields may be overwritten by values set in a PrintBoss Form.
   x. Test Fax Number – Enter the number of a local fax machine to test the fax. Most often this is an inbound fax number in your office so you can verify the fax looks the way you expect. Include the area code if it is different from Misc Settings / Assumed Area Code.
      4. Test Fax Settings – Click the Send Test Fax button. The Fax Service Send dialog opens.
         a. You may edit most of the fields before clicking the Send Fax button at the bottom of the dialog.
         b. The fields display the values entered in the Cover Page Fields section when the Cover Page Fields Default Values checkbox is selected.
         c. Click the Send Fax button to test the fax settings. The result will appear in the Fax Status section at the bottom of the page.
         d. Sent test faxes count toward your prepaid pages.
5. Click OK to save changes made to the Wellspring Fax Service Options dialog.

**FORM SETUP FOR FAXING**

The PrintBoss Fax Service feature is enabled on a form-by-form basis. This only takes a few steps:

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and select Form Files.
3. Highlight the form you want to fax and click the Editor button.
4. Increment Copies by one on the Settings Tab. This new copy will be treated as the fax copy.
5. Select the Multi-Parts & Printers tab.
6. Set the Destination Printer/Device for the new copy to <Fax Service>. A fax button will appear at the top of the View for this form.

See Chapter 9, Form Files, for more information on Modify from the Document View.

7. Click OK.

**FAXING**

Printing documents from the accounting software proceeds as normal. Typically, the document *Original* and *Copy* are set to print/fax immediately. Unlike faxing through a local modem, there is no delay in the fax service process. The faxes are sent out immediately through the internet. It may take 1 to 10 minutes for the fax to be sent from the fax service.

When the Print Time on the Multi-Parts & Printers tab of the Form Editor is set to Batch, documents can be faxed manually from the View or directly from the Work File. See Manual Fax on Demand below for step-by-step instructions on faxing from the Work File.

**MANUAL FAX ON DEMAND**

When Enable Fax Service is checked at the top of the Fax Service Options dialog, all document Views will have a Fax button at the top of the window near the Close button.

1. Open the PrintBoss Master Application.
2. Click on the File menu and select Open Document Work Files or Open Document Archives.
3. Highlight the desired work or archive file and select Browse.
4. Select the appropriate document from the list. There are two ways to proceed from this point.
   a. Click View.
      i. Click on the Fax button to manually send this document. There is a short delay while PrintBoss creates the cover page. The Wellspring Software Fax Service Send window opens.
ii. Enter a number in the Fax Number field if it is blank (default).
   1. A fax number will appear if either of the DocMisc or FaxSvcFaxNo variables is
      assigned in the PrintBoss Form.
   2. These assignments can be static (same value for all documents using this form)
      or dynamic. Dynamic variables capture a value for each document.

iii. Check the Cover Page option to include your default cover page.
iv. Click Send Fax when you are finished.
v. Click Close to close the View.

b. Click Print.
i. Select Allow Reprints.
ii. Select the copy identified as <Fax Service>.
iii. Adjust the Scope to include additional documents if desired.
iv. Click Print Start to send the fax(es).
 v. Click Done to close the Print Copies Dialog.

5. Review the File Browse table. The Printed column displays a capital X when the fax is sent successfully.
   A small case x displays when the fax was not sent successfully.
   a. Right click on a document and select Edit to view the Status Log.
   b. The Status Log records both e-mail and fax activity. Example:


   c. When the fax is still pending at the fax server, there will be a slash (/) in the Printed column of the
      Work File.

ASSIGNMENTS

Assignments can be either Static or Dynamic. An explanation of these choices follows.
Static Assignments

Assign static values to the DocMisc or FaxSvcFaxNo variables to set a single fax number for ALL sent faxes. For example, the office manager may need a copy of all invoices. The invoice form may contain an entry similar to the following:

```
#Assign FaxSvcFaxNo, "555-555-1212"
```

These assignments must be made in the Runtime Objects tab of the PrintBoss Form (EDIT / FORM FILES / <highlight the PrintBoss Form> / EDITOR).

Dynamic Assignments

Dynamic assignments are the heart of automatic faxing. There are 2 ways to create a dynamic assignment. Use one method or the other, not both.

**INCLUDE IN SOURCE REPORT**

Modify the PrintBossMisc formula to represent the fax number variable in the source report if there is a PrintBoss Trigger. It is important this formula format the number to include the area code.

**Picked Off of Captured Report by PrintBoss**

This method requires the recipient's fax number is displayed somewhere on the source report. PrintBoss can capture this information and blank it out (if desired).

13. Print a document to PrintBoss containing a fax number.
14. Click on the File menu and select Open Document Work Files on the PrintBoss Master Application.
15. Select the appropriate form and click Browse.
16. Select a document and click View.
17. Right-click anywhere in the View and select View Raw Capture.
18. Locate the fax number on the page. Double click on the text to open up the Captured Text Command Properties dialog.
19. Select the Click to Assign to Variable bar on the top right of the dialog.
20. Change the Variable Name from ReNameMe to FaxSvcFaxNo.
21. Check the following fields:
   a. Add together fields in horizontal range
   b. Capture Raw Text Objects Only
   c. Left Trim
   d. Right Trim
   e. Blank Out After Capture (optional – hides fax number on printed document)

✓ Some reporting engines (such as the latest Crystal Reports) tend to break up text fields. A good practice is to click on the +/- button that follows the Horizontal field so it become to. Set the ending coordinate far enough to the right to pick up a 10-digit fax number.

22. Click OK. PrintBoss adds this assignment to the top of the RunTime Objects in the Form.
23. Right-click on the page and click on View Raw Capture to return to the formatted document.
24. Click the Fax button on the top right corner of the View to test the assignment. The Fax Service Send dialog displays the address fields filled with the assigned values.
25. Click Send Fax to complete the test.
26. Click Close to exit the View.

📖 See Chapter 24, Capturing and Assigning Text, for more information.

Variables

There are several variables that may be Assigned in a Form File to define values for the cover page and fax number.

📖 See Chapter 9, Form Files, for more information on Assignments.

A list of the fax service variables and their purpose is included in Appendix E of this manual.
Fax Service Log

PrintBoss keeps a log of the faxes sent through the Fax Service. The Fax Service Send Log indicates the Status of the fax, Date and Time the fax was sent, the name of the PrintBoss user (Operator) who sent the fax, the name of the PrintBoss Form used to send the fax, if a Cover Page was included, and the number of Pages sent. This is the number of pages that will be deducted from your account. The log also displays the Document Number and Recipient of the fax if a Fax Service variable is defined.

1. Open the PrintBoss Master Application.
2. Click on the Utilities menu and select Fax Service Log.

The log Status indicates whether a fax is pending, sent, or failed. The frequency of the status updates is determined by the Log File Poll Period defined on the Wellspring Fax Service Options dialog.

3. Click the Update Status button at the top of the Fax Service Send Log to manually update the log.
4. Select Show Fax Errors Exist Flag on Master Application Screen to display failed faxes in red text in the lower left of the Master Application screen.

Right click on the red text to view options such as resend the fax or abandon the record.

5. Right click on a record to view a list of options for handling the record. The options include:
   a. Abandon Failed Record
   b. Resend
   c. View Cover Page
   d. View Body Page(s)
   e. Delete Record

6. Click on the Order Select drop down menu to choose a sort order for the log.
7. Click on Done when you are finished.
E-MAILING

PrintBoss can be configured to e-mail the documents it processes as PDF attachments. There are limitations to embedding documents in standard e-mails. PrintBoss solves these limitations by converting the image of the document to an Adobe PDF file and attaching the PDF to the e-mail. The Adobe Reader used for opening PDF files is free to download from [www.Adobe.com](http://www.Adobe.com) and is often installed with the operating system on most computers.

PrintBoss can e-mail on an individual basis (manual mode) or in batches (automatic mode).

- **Manual mode** – PrintBoss can e-mail any page viewed from a work or archive file.
- **Automatic mode** – One of the copies in the PrintBoss form is defined as the e-mail copy. PrintBoss can capture and assign fields from the accounting software (such as the EMailTo address) and automatically send batches of documents. This enables the work file to record e-mail attempts and successes.

The user sending the e-mail must have access to an SMTP mail server. PrintBoss does not use local e-mail software (i.e. Microsoft Outlook, Outlook Express, Netscape, Eudora, etc.), but works in parallel with it, making use of the same SMTP mail server as the mail program.

> PrintBoss Enterprise has an option to use Microsoft Outlook Outbox instead of the SMTP server.

**NOTE:**

The content of the To, CC, or BlindCC fields can each include multiple addresses. Each address must be separated by a semicolon (or a line feed when the address is in a multiline variable in PrintBoss).

**SETUP**

1. Open the PrintBoss Master Application.
2. Click on the **Options** menu and select **E-mail Settings**. The E-mail Settings dialog opens.
3. The first tab is the **SMTP / Mail Hosts** tab. Choose the settings for saving the options set on this tab.
   a. **Save Settings** – The settings button at the top of each tab identifies how settings are saved for the tab. Click on this button to change the Save Settings.

   i. **Save settings independently for this Windows User [User Name], and to this PC [Computer Name]** – The first choice is whether to save settings on the local workstation or terminal server or to save settings to a common location. Settings saved locally can only be changed at the local workstation (or terminal server) while logged in as the user. These settings are saved in the Current User registry.

   ii. **Save as defined in Common Settings file. ["<PBDir>\Email\Settings\file name.ini"]** – E-mail settings may be saved to a common file located in the PrintBoss Directory. The advantage of this choice is the file may be edited by an administrator for these users. The Common Settings file may contain sections unique to each user (Save Settings in Section named by Windows User Name) or contain one group of settings that applies to all users (Save Settings in Section named "Common Users") who chose the Common Settings selection.

   iii. **Change Save Section in the Common Settings File** – This button is available when Save as defined in Common Settings file is selected.
1. **Save settings in Section named by Windows User Name** – Settings are saved in a common File, Hosts.ini, by Windows User name.

2. **Save settings in Section name "Common Users"** – Settings are saved in a common file, Hosts.ini, in one section named Common Users.

   iv. Settings will not be saved until you click **OK** at the bottom of the E-mail Settings dialog.

b. **Enable E-mail Module** – This setting enables the e-mail function for this workstation (or user in a Terminal Server or Citrix environment).

c. **Send mail to Outlook Outbox** – Select this check box to send e-mail through your Microsoft Outlook Outbox.

   i. This feature is only available for PrintBoss Enterprise users.

   ii. The Host SMTP information will be replaced with the selected **Outlook Profile**.

   iii. Choose **Use default profile** when you have only one Outlook Profile or to use your primary Outlook Profile.

   iv. Select the third choice (**blank field**) and enter the profile name when you have more than one Outlook Profile. The variable {EmailProfile} can be used to dynamically assign an Outlook profile in the PrintBoss form.

   v. Temporarily select **Request profile** when you are not sure of the profile name and Outlook will provide a list of profiles. This enables you to identify the desired profile name to enter in the third choice. A list only appears when you have more than one Outlook profile. Otherwise, the only choice is Outlook. When the ‘Automatic E-mail Pause’ setting on the Misc. tab of the PrintBoss E-mail Settings option is set to Pause, the ‘Choose Profile’ dialogue only appears after clicking the ‘Send E-mail’ button.

   vi. **Seconds between emails** allows a value greater than zero if the system requires a delay between sending emails. This feature should only be used at the advice of a Wellspring Software technician.

   vii. **Alert if Image Attachment Issues** can be selected when either sending a large number of attachments or combining emails with a large number of attachments to receive a warning when the Outlook attachment limit is reached.

d. **Host SMTP Information** – This choice is available when **Send mail to Outlook Outbox** is not selected. Enter the values for your e-mail program.
i. **URL (name or dotted numeric address)** – Enter the URL. The URL can either be the 4-segment dotted numeric address or the URL name (e.g. mail.yourcompany.com).

ii. **Get Host Capabilities** – Click this button to verify the URL is correct. The User ID and password are not necessary for authentication. When successful, it returns a list of authentication methods the server supports and confirms the URL address.

iii. **Test Connection** – Click this button to verify the User ID and Password are valid. The Password is not necessary when your e-mail account does not have a password.

iv. **User ID** – Enter your User ID. The User ID is the name of your e-mail account. It is also the same as the name you use to log in to your e-mail account.

v. **Password** – Enter your password if it is required to send outbound e-mails. This field accommodates 30 characters. Leave this field blank if your system does NOT require a password. Otherwise, the e-mail will not work.

vi. **Port** – Leave the default value. This is normally set to 25.

vii. **Authentication Method** – Leave on the Default value unless instructed by a Wellspring Software support technician.

viii. **SSL Type** – This option is only available in PrintBoss Enterprise. Select the SSL type that matches the security on your SMTP server.

ix. **Use POP3 login before sending** – Use this option to avoid SMTP Relay Errors when the authentication is needed to process the relay.

e. **Gmail SMTP Information** – This choice is available when ‘smtp.gmail.com’ is entered in the URL field or when a User ID contains a Gmail account. Beginning with PrintBoss version 6.01, this button is always available.

   i. **URL (name or dotted numeric address)** – Enter smtp.gmail.com.

   ii. **Get Host Capabilities** – Click this button to verify the URL is correct.

   iii. **Test Connection** – Click this button to verify the User ID and Password are valid.

   iv. **Gmail Setup Notes** – It is important to read these notes as Account Permissions in Gmail need to be changed to use your gmail account with SMTP. In PrintBoss version 6.01 and above, this feature can also Prefill some of the fields for Gmail.

   v. **User ID** – Enter your Gmail email address.

   vi. **Password** – Enter your Gmail password. This field accommodates 30 characters.

   vii. **Port** – Set to 587.

   viii. **Authentication Method** – Change to the Default value.

   ix. **SSL Type** – This is not applicable to Gmail.

   x. **Use POP3 login before sending** – This is not applicable to Gmail.
f. **Office 365 Information** – This choice is available beginning in PrintBoss version 6.01 and requires the Enterprise edition to use the SSL Type.

![SMTP Information](image)

i. **URL (name or dotted numeric address)** – Enter smtp.office365.com.

ii. **Get Host Capabilities** – Click this button to verify the URL is correct.

iii. **Test Connection** – Click this button to verify the User ID and Password are valid.

iv. **Office365 Setup Notes** – Read these notes for information on entering the settings for Office 365. In PrintBoss version 6.01 and above, this feature can also Prefill some of the fields for Office 365.

v. **User ID** – Enter your Office 365 User ID (required). This is often your email address.

vi. **Password** – Enter your Office 365 password (required). This field accommodates up to 30 characters.

vii. **Port** – Set to 587.

viii. **Authentication Method** – Change to the Default value.

ix. **SSL Type** – Select TLS 1.2 from the drop down menu.

x. **Use POP3 login before sending** – This is not applicable to Gmail Office 365.

g. **E-mail Info** – Click this button at the bottom of the E-mail Settings window to view information on e-mail fields and options.

h. **Send Test** – Click on the Send Test button after entering settings on all tabs to test the e-mail. The E-mail Send dialog opens. The address and message fields display the settings entered on the tabs.

4. **Default Addresses**
   a. **Save Settings** – Select the method for saving settings on this page. See Save Settings in Step 3 for more information.
   b. "**From" Address" – Enter your default return address. This is typically the user's e-mail address, e.g. my-name@my-company.com. All outgoing e-mails require a From Address, though this field is only required for SMTP. Outlook uses the selected Profile when sending through Outlook.
      i. The corresponding variable, EmailFromAddress, will overwrite the default entry when it is assigned in the Form File.
   c. "**From" Name" – Enter your full name. The From Name is an optional field for the user's actual name (e.g. John Smith).
i. The corresponding variable, EmailFromName, will overwrite the default entry when it is assigned in the Form File.

d. "Reply to" Address – Enter a reply address. This is the address responses are sent to when the recipient presses Reply after receiving the e-mail. PrintBoss will use the address in the From Address field when Reply To is blank.
   i. This field can be assigned dynamically in the form or as a static address in E-mail Settings. The corresponding variable, EmailReplyAddress, will overwrite the default entry when it is assigned in the Form File.

e. To Address – Check the box to the right of the field to activate it. The To Address is a required field containing the e-mail address of the recipient.
   i. This field can be assigned dynamically in the form or as a static address in E-mail Settings. The corresponding variable, EmailTo, will overwrite the default entry when it is assigned in the Form File.
   ii. PrintBoss will pop up a window to enter an e-mail address when both this field and the EmailTo variables are blank.

f. CC Address – Check the box to the right of the field to activate it. The CC Address allows you to send a copy of this e-mail to another recipient.
   i. This field can be assigned dynamically in the form or as a static address in E-mail Settings. The corresponding variable, EmailCC, will overwrite the default entry when it is assigned in the Form File.

g. Blind CC Address – Check the box to the right of the field to activate it. The Blind CC Address allows you to send a copy of this e-mail to another recipient without divulging the name or e-mail address of this recipient.
   i. This field can be assigned dynamically in the form or as a static address in E-mail Settings. The corresponding variable, EmailBCC, will overwrite the default entry when it is assigned in the Form File.

5. Misc. Settings
   a. Save Settings – Select the method for saving settings on this page. See Save Settings in Step 3 for more information.
   b. E-mail Phone Book – PrintBoss can maintain an address book of e-mail addresses. The following options apply to the E-mail phone book.
      i. Open Phone Book – Click this button to open and edit the PrintBoss phone book.
ii. **E-mail Phone Book File** – Displays the location and name of the phone book.
   1. Click on the ellipse button at the end of this field to set the location of the E-mail Phone Book. The default name is PBEmail.PEM.
   2. This file may be uniquely identified and can be private to an individual user or shared by a group of users.
   3. The phone book is only used to manually e-mail individual documents. It is not used in automatic e-mail mode.
   4. The e-mail addresses need to be supplied in the document by defining the variable EmailTo for automatic e-mails. *(See section on Automatic E-mail)*.
   5. This e-mail phone book is completely independent from other address books.

iii. **Change Address Field Length** – Click this button to change the maximum length of e-mail addresses stored in the phone book.

   1. The default length for an e-mail address is 60 characters.
   2. Enter a character width (length) from 30 to 250 characters.
   3. Any characters over the length you specify (e.g. 80) will be truncated.
   4. This feature only applies to the e-mail addresses in the E-mail Phone Book file.

   ![Address Field Width Select](image)

   c. **Combine pages into a single email** – This option is only available in PrintBoss Enterprise. There are three choices.

   i. **Never combine** – This is the default setting.
   ii. **Email address is same as prior page** – Select this option to combine documents with the same e-mail address into one concatenated PDF attachment when printing a check batch with e-mails.
   iii. **Same Email address AND same DocNo** – Select this option to combine documents with the same e-mail address and the same document number into one concatenated PDF attachment when printing a check batch with e-mails.

   d. **Email Temporary Work Folder** – Leave at the default value of {PrintBoss Home Directory}\Email. This should only be changed with the help of a Wellspring Software technician.

   e. **Print status character of "S" (Skipped) when "EmailTo" address is blank** – Select this option to enter a capital S in the Printed column of the work file when the document has no E-mail To address.

   i. E-mails that fail to send for whatever reason leave an error code of "e" in the document work file. This lower-case error code prohibits the work file from being archived or deleted automatically.
   ii. This feature allows PrintBoss to skip an e-mail and record a status of S in the work file. PrintBoss will treat the document as completed.
   iii. The skipped record can be handled separately or ignored.
f. **Use “DocMisc2” as EmailTo address if EmailTo is unassigned** – This option is for those using Crystal Reports with the PrintBoss Trigger. When an email address is entered in the DocMisc2 field, select this option to use the email address in DocMisc2.

g. **Automatic E-mail Pause** – Select an option to set a pause when using the Automatic e-mail mode (see introduction to this chapter).
   i. The default setting is **Never**.
   ii. **Bad Address** – Pauses at a document with a bad e-mail address and provides the opportunity to enter a correct address prior to continuing with processing.
   iii. **Always** – Opens the e-mail dialog for every document, requiring the user to click a button to send each e-mail. This choice is sometimes used temporarily during initial setup and testing.

h. **PDF Attachment Resolution** – Select the resolution of the PDF files created as attachments to the e-mail.
   i. The default value is **216 dpi - Color**. This option is the most robust.
   ii. The size of the PDF file can be reduced by selecting one of the black and white (B/W) options.
   iii. Be sure to test the quality of the resolution before you permanently reset this value.

   P. i. **PDF Attachment Security** – PrintBoss Enterprise provides added security for PDF attachments.
   i. **View Only** – Allows the recipient to open and read the PDF file attachment, but not print or edit. The Print feature will not be available in the Adobe Reader application. Any copies made of the document will carry the same security.
   ii. **Un-changeable in a PDF editor** – Allows the recipient to open and print the PDF attachment, but prohibits edits to the original attachment.
   iii. **PDF Attachment Password** – Enter a password that will be required to open the PDF file. The password applies to all PDF attachments and can be assigned as a static value in this field or a dynamic value in the Form File.

6. **Subject & Message Body**

   a. **Save Settings** – Select the method for saving settings on this page. See **Save Settings** in **Step 3** for more information.

   b. **Default Email Subject** – Enter a default subject for all e-mails.
      i. This can be overwritten at the point of sending the e-mail by assigning the EmailSubject variable in the Form File.
      ii. Example – the following assignment could be entered in RunTime Objects:

         #Assign EmailSubject, "Invoice Notice from Wellspring Software, Inc."

   c. **Email Body/Message** – Enter the path and name of the file containing the body of the e-mail message.
      i. It is common to use a standard message for all e-mails in a batch of documents as defined by this setting.
ii. Click on the ellipse button \( \square \) and enter a path and filename to change the location of the body text. Normally, the files are stored at \( \{ \text{PBDir}\backslash \text{EmailBody}\backslash \{\text{WinUserName}\} - \text{Body.txt} \).

iii. The corresponding variable, EmailBody, will overwrite the default entry when it is assigned in the Form File.

iv. Example – the following assignment could be entered in RunTime Objects:

\[
\#\text{Assign EmailBody, "Thank you for your order."}
\]

v. The E-mail Body may be a text (.txt) or HTML file. Both file types can use the PrintBoss variable tags, such as \{DocNo\}, to dynamically update information for each e-mail when the documents are processed.

1. **Text Editor** – Click on this button to open a Notepad file to edit a .txt E-mail Body message. This button is only available when the E-mail Body/Message is a .txt file. Changes to the text file must be saved and will not show in the E-mail Body window until you click **OK** at the bottom of the E-mail Settings dialog or by pressing the **Refresh** button.

2. **HTML Editor** – Click this button to open your default HTML editor to edit an .htm or .html E-mail Body/Message. This button is only available when the E-mail Body/Message is an .htm or .html file. Typically the editor is Microsoft Word. Changes to the HTML file must be saved as a filtered web. Click the information button \( \square \) for more details.

7. Click **OK** at the bottom of the E-mail Settings window to save changes made on any tab. Some changes will not display until **OK** is clicked.

---

**FORM SETUP FOR E-MAIL**

The PrintBoss E-mail feature is enabled on a form-by-form basis. This only takes a few steps:

1. Open the PrintBoss Master Application.
2. Click on the **Edit** menu and select **Form Files**.
3. Highlight the form you want to e-mail and click the **Editor** button.
4. Increment **Copies** by 1 on the **Settings** Tab. This new copy will be treated as the E-mail copy.
5. Select the **Multi-Parts & Printers** tab.
6. Set the **Destination Printer/Device** for the new copy to < Email >.
7. Click **OK**.

You may also want to setup ProcessPage commands at the top of the Footer Objects tab of the Form in order to determine when to process the new E-mail copy vs printing a copy. Verify the copy numbers on the Multi-Parts & Printers tab and then follow the steps below:

1. Open the PrintBoss Master Application.
2. Click on the **Edit** menu and select **Form Files**.
3. Highlight the form you want to e-mail and click the **Editor** button.
4. Select the Footer Objects tab.
5. Enter the following ProcessPage command at the top of the Footer Objects tab for Email:
   a. \#[Copy,1]ProcessPage «[!Empty, {EmailTo}]»
   b. The Copy number, i.e. Copy, 1, should be the email copy. Replace the 1 with the correct copy number.
   c. The ‘!’ is ‘Not’. The page will process when the variable \{EMailTo\} is Not Empty.
   d. The \{EmailTo\} variable should be assigned as explained in the ‘Assignments’ section later in this chapter. If the email address variable is added to the DocMisc2 field in the PrintBoss Trigger, verify the ‘Use “DocMisc2” as EmailTo address if EmailTo is unassigned’ checkbox is selected on the Misc. Settings tab or the E-mail Settings dialog under the Options menu on the PrintBoss Master Application.
6. To add conditionally print a copy when \{EmailTo\} is Empty, copy the ProcessPage command and change the copy number and remove the ‘!’ condition as follows:
   a. \#[Copy,2]ProcessPage «[Empty, {EmailTo}]»
   b. Verify the correct copy number. This may be set to Copy, 0 to print an original versus a copy.
7. Click OK on the Form so save these changes.

See Chapter 9, Form Files, Modify from the Document View for more information.

E-MAILING

Printing documents from the accounting software proceeds as normal. Typically, the document Original and Copy are set to print/e-mail immediately.

When the Print Time on the Multi-Parts & Printers tab of the Form Editor is set to Batch, documents can be e-mailed manually from the View or directly from the Work File. See Manual E-mail below for step-by-step instructions on sending e-mail from the Work File.

MANUAL E-MAIL

When Enabled E-mail Module is checked at the top of the E-mail Settings dialog, all document Views will have an E-mail button at the top of the window near the Close button.

1. Open the PrintBoss Master Application.
2. Click on the File menu and select Open Document Work Files or Open Document Archives.
3. Highlight the desired work or archive file and select Browse.
4. Select the appropriate document from the list. There are two ways to proceed from this point.
   a. Click View.
      i. Click on the E-mail button at the top of the window to manually send this document.
      ii. There is a short delay while PrintBoss creates the PDF file to attach to the e-mail.
      iii. The E-Mail Send dialog opens.
iv. The To, CC, and BCC fields contain the values entered in the E-mail Settings window unless the variables EmailTo, EmailCC, and EmailBCC are assigned in the Form. Fields that are not required, such as CC and BCC, may be blank.

v. The assignments can be static (same value for all documents using this form) or dynamic. Dynamic variables can capture a different value for each document.

vi. Click on the drop down menu to the right of the field to select an address from the ‘Email Phone Book’. The Email Phone Book is set up on the Misc. Settings tab.

vii. Click **Send E-mail** to complete the process.

viii. **Close** the E-Mail Send dialog when the Status displays **Successfully Mailed**.

ix. **Close** the View when you are finished.

b. Click **Print**.

   i. Select **Allow Reprints**.
   
   ii. Select the copy identified as <EMail>.
   
   iii. Adjust the Scope to include additional documents if desired.
   
   iv. Click **Print Start** to send the e-mail. PrintBoss will only stop on the E-Mail Send dialog when ‘Automatic E-mail Pause’ is set to ‘Always’ or ‘Bad Address’ on the Misc. Settings tab of the E-mail Settings option.

   v. Click **Done** to close the Print Copies Dialog.

5. Review the File Browse table. The **Printed** column displays a capital E when the e-mail is sent successfully. A small case e displays when the e-mail was not sent successfully.

   a. Right click on a document and select **Edit** to view the **Status Log**.
   
   b. The Status Log records both e-mail and fax activity. Example:

   9/15/2009 04:30:40P Copy=2 Emailed Successfully to Paula@wellspringsoftware.com

**Assignments**

Assignments can be either Static or Dynamic. An explanation of these choices follows.

**Static Assignments**

Assign static values to the EmailCC or EmailBCC variables to set a single address for ALL e-mails. For example, a department may need a copy of all invoices. The invoice form may contain an entry similar to the following:

```plaintext
#Assign EmailCC, "department@my-Company.com"
```

These assignments must be made in the RunTime Objects tab of the PrintBoss Form File (EDIT / FORM FILES / <highlight the PrintBoss Form>/ EDITOR).

**Dynamic Assignments**

Dynamic assignments are the heart of automatic e-mailing. Normally, the To address changes with each document. There are 2 ways to create a dynamic assignment. Use one method or the other, not both.

**INCLUDE IN SOURCE REPORT:**

If you have control over the information sent to PrintBoss, define a field in the source report to pass the e-mail address. It is important that this is just ONE field. You may need to create a variable in the source report that uses a combination of text and database fields. The value of the resulting field must be similar to the following example:

```plaintext
PB#Assign EmailTo, support@WellspringSoftware.com
```

Note this is the value of the field after it is evaluated. The actual content might be similar to the following, although the actual syntax and field names are dependent on your report writer:

```plaintext
"PB#Assign EmailTo, " + CustomerDBF.MiscInfo
```

See Chapter 24, Capturing and Assigning Text.
**Picked off of captured report by PrintBoss:**

This method requires the customer's e-mail address is displayed or printed somewhere on the source report. PrintBoss can capture this information and blank it out (if desired).

1. Send a document to PrintBoss containing an e-mail address field.
2. Click on the **File** menu and select **Open Document Work Files** on the PrintBoss Master Application.
3. Select the appropriate form and click **Browse**.
4. Select a document and click **View**.
5. Right-click anywhere in the View and select **View Raw Capture**.
6. Locate the e-mail text on the screen. Double click on the text to open up **Captured Text Command Properties** dialog.
7. Select the **Click to Assign to Variable** bar in the top right of the dialog.
8. Change the **Variable Name** from ReNameMe to EmailTo (or EmailCC or EmailBCC).
9. Check the following fields:
   a. Add together fields in horizontal range
   b. Capture Raw Text Objects Only
   c. Left Trim
   d. Right Trim
   a. Blank Out After Capture (optional – hides e-mail addresses on printed document)

✔ Some reporting engines (such as the latest Crystal Reports) tend to break up text fields. A good practice is to click on the +/- button that follows the **Horizontal** field so it become *to*. Set the ending coordinate far enough to the right to pick up a long e-mail address.

10. Click **OK**.
11. Click **Close** on the Capture Text Command Propertied dialog.
12. Right-click on the page and click **View Raw Capture** to deselect this option and return to the formatted document. PrintBoss will add this assignment to the top of the RunTime Objects in the Form.

Test the assignment by clicking on the E-mail button in the top right corner of the View. The E-Mail Send dialog displays the address fields filled with the assigned values.

**Variables**

There are several variables that may be Assigned in a Form File to define values for an e-mail.

📖 See Chapter 9, *Form Files*, for more information on Assignments.

A list of the e-mail variables along with a description of each is included in Appendix E of this manual.
FORM / BANK REQUEST LIST

The Request List determines the Bank Account and PrintBoss Form used when printing. This is only necessary for accounting software that does not use a trigger or text capture file. (A Request List is NOT used with Accpac for Windows).

PrintBoss scans the list of entries in the Request List for an automatic match of predefined characteristics against the contents of each print job. For example, a particular word appearing at a defined location on the page might be enough to identify the document.

If one record matches, PrintBoss uses the form and bank identified in the Request List record. If more than one record matches, PrintBoss provides a list of all the matches to allow the user to choose from the entries. When no match occurs, PrintBoss generates an Unrecognized Doc Alert, a default Form and Bank, or a pop up containing the entire Request List, depending on how the Request List is setup.

This is a very powerful tool that automates your work flow and avoids erroneous selections from the list of forms or banks. Set up requires a good understanding of the data provided by your accounting software.

SETUP

Request List entries are automatically imported for the standard Host Accounting Software selected during the installation of PrintBoss. Editing the Request List is only necessary for custom interfaces or forms you create.

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select Form / Bank Request List. The Form / Bank Request List Manager opens.
NOTE:

This feature is not available with PrintBoss Select.

3. **Import Existing Request List File**
   a. Click the Import button to import an updated request list record. These are stored by specific accounting software in the `ReqList` folder of the PrntBoss Home directory. Only accounting software chosen during installation or setup will appear in this list.
   b. Select the appropriate *.prq file and click Open. The new record will appear at the bottom of the list.
4. **New / Edit** – It is easier to create a new or edit an existing Request List record from the Work File. Please see Implementing Request List from the Work File later in this chapter.
5. Click Done to save your changes.

**CONFIGURATION**

Your Configuration and PrintBoss Driver Settings may need to be changed to use the Request List.

1. Open the PrintBoss Master Application.
2. Click on the Options menu and select PrintBoss Driver Settings.
3. Select Always Capture in the Capture Mode section.
4. Click OK to save your changes.
5. Click on the Options menu and select Configuration.
6. Check the Request List determines Form/Bank field in the Always Capture Settings section in the bottom left corner. This will gray out the Form and Bank choices.
7. Select the "PB#INFO" flag overrides above check box.
8. Click OK to save your changes.

**IMPLEMENTING REQUEST LIST FROM THE WORK FILE**

**Auto Pick** reviews documents printed through PrintBoss for specific traits. When these traits match conditions in a record in the Request List, PrintBoss processes the document with the form and bank specified in the Request List record. The entire Request List pops up when no matches are found. The Request List also pops up when more than one match is found, but it will only include records that match.

1. Print a document from the accounting software and select the appropriate Request List record or Form File so the document Work File can be examined.
a. Verify the Auto-Archiving feature in the Form Editor is set to None or Overwrite Work File at Start of Batch before printing to ensure the document stays in the work file for viewing.

2. Click on the File menu and select Open Document Work Files from the PrintBoss Master Application.

3. Select the appropriate Work File and click Browse.

4. Select a current record in the list and click View.

5. Right click anywhere on the View form and select View Raw Capture. The view will change to show only the data passed from the accounting software minus the PrintBoss formatting.

6. Right click again and select View Request List Capture Groups. The Form / Bank Request List Manager opens.

7. Stretch and move both the View and the Request List Manager to see both screens as much as possible.

8. Determine if there is an existing entry that matches your data.
   a. Click the Test For Matches button on the Request List Manager to test if there are any existing entries that match. Otherwise …
   b. Select the Request List record desired or add a new record.

9. New/Edit Record
   a. Click on the plus button to add a new blank record in the list. Otherwise, select an existing record.
   b. Click the Edit button while the record is selected. The Request List Editor opens.

10. New Record
    a. Check Active in the top left corner of the window. The fields are now available to edit.
    b. Prompt – Enter a word or phrase users will recognize as the form and bank combination.
       i. AP is often used to designate accounts payable activities.
       ii. PR is often used to designate payroll activities
c. **Form** – Choose the appropriate PrintBoss Form from the drop down menu. If you need to create a custom form, exit the Request List Editor, create the new form, then return to this window and continue.

d. **Bank** – Choose the appropriate BankCode from the drop down menu.
   
   i. If you need to create a new Bank record, exit the Request List Editor, create the new Bank record, then return to this window and continue.
   
   ii. `{ChkAcct}::{CompName}` – Choose this entry when the accounting software passes the checking account name and company name. QuickBooks has this capability.
   
   iii. `{DocBank}` – Choose DocBank when the accounting software only passes one set of data to identify the bank record, such as checking account name or company name. Peachtree has this capability.
   
   iv. `{None}` – Choose None when the form is not a check (e.g. Invoice).
   
   v. `{Request}` – Choose Request when you would like PrintBoss to provide a list of all Bank Records and allow you to choose from the list.

e. **Notes** – Enter notes to describe the purpose of this Request List entry, record special conditions, or log changes. This is an optional field. Click on the top or bottom edge of the Request List Editor dialog and drag to expand the Notes field.

11. **New/Edit Record**
   
a. Check **Auto Pick Enabled** to define conditions. PrintBoss will automatically select this Request List record when the conditions are met during printing and this box is checked.
   
i. Review existing Request List records for samples on how to setup conditions.
   
   ii. You may skip this step and the Conditions if you prefer to choose from a list instead of using automatic selection.

b. **Conditions**
   
i. Check **Condition 1** to activate it.

1. **Left and Right Rectangles** – Click on the rectangle button to enclose two or more conditions in parentheses. You will need to select a Right Rectangle at some point as well.
   
a. Click once for a single parenthesis.
   
b. Click twice for double parentheses.
   
c. A third click will remove the parentheses.

2. **Not** – Click on the short rectangle to the left of the **Text** field to reverse the condition.

3. **Operator** – Select a statement about the captured field from the drop down menu to determine how PrintBoss reads the condition. Fld is an abbreviation for Field. The most common choices are:
   
a. Fld and Text Exactly Equal
   
b. Fld Begins with Text
   
c. Text Within Captured Fld
   
d. Field Not Empty

4. **Text** – Enter the specific text PrintBoss will find at the specified coordinates. This field is only available when you choose an operator that uses text.

5. **Comment** – Enter a note to help identify this condition. This field is optional.

6. **Field Capture Coord.**
   
a. **X** – Enter the horizontal coordinate for the left side of the field.
   
i. Review the Raw Data on the document. Look for data or parts of data that will ALWAYS appear on this document (e.g. a specific word such as *Invoice*, or a check number, or a dollar amount beginning with asterisks).
   
   ii. Click on the data element to give it focus. Return to the Request List Editor.
iii. Hold down the Ctrl key and click in the X field. PrintBoss will automatically enter the coordinates of the selected data.

NOTE:
The Ctrl and click feature is only available in PrintBoss versions 5.21.9 and above.

b. +/- ; to button – This is a toggle button used to set a range for the coordinate.

i. +/– – Enter a range value in the field. A value of 0.100 will cause PrintBoss to look 0.100 inches before the X value and 0.100 inches after the X value to find the data in the specified area.

ii. To – Enter an end value for the range. PrintBoss will look from the X value to this value to find the data in the specified area.

c. Y – Enter the vertical coordinate for the top of the field. This works exactly like the X coordinate. You can Ctrl + Click on both the X and Y coordinates while a field is highlighted on the View.

7. Trim – Trim the field to remove blank spaces. The choices are:
   a. No Trim (default)
   b. Left Trim Field
   c. Right Trim Field
   d. All Trim Field (trims both the left and right side)

8. Occurrence – Select the occurrence of the text within the specified area. Some data, such as asterisks, may appear more than once. The choices are:
   a. 1st Occurrence (default) – evaluates to the first occurrence within the coordinates and stops. PrintBoss will not examine the rest of the string.
   b. All Occurrences – evaluates the entire string for a match.
   c. Append Occurrences – concatenates all the fields before evaluating the string for a match.

9. Substr Start – Choose a starting point for the occurrence in the string. Normally this is left at the default value of zero, representing the beginning of the range. You may enter a different value. For example, PrintBoss will start evaluating at the 5th character when a 5 is entered in this field.

10. Len – Enter a length for the substring to set a shorter end point for evaluating the string. This field is only available when a value is entered in Substr Start. PrintBoss will evaluate the remainder of the string from the start of the substring when a value of zero is entered.

   ii. Check Condition 2 to activate it.

   iii. An And button will appear between the two conditions. This indicates the next condition must ALSO be true for a match. Click the button to change to OR for either condition to be true to constitute a match.

      1. Single parentheses are often added at the beginning of one condition and the end of the second when OR is selected in between.

   iv. Continue filling in the fields for Condition 2.

      1. The rules are the same for all 4 Conditions.
      2. You only need to setup more than two conditions when two is not enough to make this entry unique or you have a special condition.

   c. Click the Test Document Being Viewed button at the bottom of the Request List Editor to test whether the Request List record matches the open Form File.
   d. Make adjustments as necessary until you receive the ReqList Record MATCHES!!! message.
   e. Click OK on the Request List Editor when you have a successful match.
   f. Click the Test for Matches button at the top of the Form / Bank Request List Manager window to test the number of entries that match the open Form File.

      i. You should only have 1 match.
      ii. If there is more than one match, change or add a condition to the current Form / Bank Request List record to make it unique.

12. Click DONE on the Form / Bank Request list Manager when you are finished and Close the View.
Repeat as often as necessary to create a list of all required form and bank account combinations. DO NOT create more than one entry for the same Form File. The Notes field can be used to track updates to the record.

There are four conditions you can use to make a Request List record unique. It is very important to make each request list entry as unique as possible to avoid multiple matches when Auto Pick is enabled.

✔️ It is very important to make each Request List entry as unique as possible to avoid multiple matches when Auto Pick is enabled.

**REQUEST LIST PROCESS**

Click **Done** once all of the Request List records are complete. The next time a document is printed through PrintBoss, PrintBoss will evaluate the document for matches to the defined conditions and automatically select the appropriate Form and Bank combination to process the file.

PrintBoss may open the Bank List to choose a bank the first time you print using that account. This happens when the Bank Code does not exactly match the information from the accounting software. A check box at the bottom of the popup list will update the Bank Code to match the data passed from the accounting software. This allows PrintBoss to automatically pick the correct Bank Record the next time you print to that account.
An increasing number of banking institutions are offering a service often called Positive Pay. This is a specially formatted file listing all valid checks written on the bank account. The file is sent to the bank and only checks identified in this file are cashed by the bank. If the bank receives checks that are slightly different, the bank will not accept the checks. This feature is offered for fraud prevention.

PrintBoss can generate a Positive Pay file for each check in a batch. The form must be edited to add and assign a copy to enable this feature. The copy is designated as a Positive Pay file. The structure of the Positive Pay file is designed to match individual bank requirements. Rarely are requirements the same for different banks.

The Positive Pay specifications become part of the Form File. The specifications can be exported to a PrintBoss Positive Pay file (extension of ".ppp" in the PosPay subdirectory of PrintBoss). This file can then be imported into another form. Note that the .ppp files imported and exported from within the PrintBoss Form Editor are NOT the actual Positive Pay files sent to the bank. They are simply the scripts PrintBoss uses to create the file.

**SETUP IN PrintBoss**

1. Open the PrintBoss Master Application.
2. Click on the **Edit** menu and select **Form Files**.
3. Highlight the appropriate form and click the **Editor** button.
4. Increase the number of **Copies** by 1 on the **Settings** tab.
5. Click on the **Multi-Parts & Printers** tab and select **<Positive Pay File>** as the **Destination** for the new copy. A page symbol will appear in the column to the right of the Destination column.
6. Click on the page symbol to open the Positive Pay Editor.
7. It is usually easier to import an existing Positive Pay spec and modify it to meet the specifications of the current bank. Click on the **Import** button on the **Master** tab of the Positive Pay Editor. The browse opens to the PosPay folder in the PrintBoss Home directory.

8. Select the **SampleBankSpec** included with PrintBoss and click **Open** if you do not have another positive pay spec to use. Otherwise, choose your positive pay spec.

9. Enter a **File Name** and path for this Positive Pay file. This field is limited to 80 characters. The Enterprise edition of PrintBoss allows macro characters to be used in the file name to create a dynamic file name when a batch of checks is printed.

10. Select **Confirm Path/Filename at runtime**. (This can be skipped in the Enterprise edition).

11. Choose a **New File Name Generation** method. The default is **Start of Batch**. The choices are:
   a. Start of Batch
   b. Each new page
   c. Each new DocNo – Select this option when using variables in the file name. The use of variables in file names is only available in the Enterprise edition of PrintBoss.

12. Select the **File Type**. The default of **Standard** should always be used when creating Positive Pay files.

13. Choose **Append Overwrite Method**. The default is **Overwrite existing File**. The choices are:
   a. Overwrite existing File
   b. Append to existing File
   c. Prompt for Overwrite, Append, Cancel

14. **Max Detail Lines Per File** allows you to enter a maximum number of detail lines when required by the bank. This feature is only available in the Enterprise edition of PrintBoss. PrintBoss will automatically increment the file name using the {##} variable when the max detail lines are exceeded.

15. You may select the **Exclude records with zero amount** option.

16. Select **Auto add CR/LF to each script** only when you are creating a new Positive Pay File and would like PrintBoss to automatically add this carriage return/line feed command at the end of each script.

17. Only select one of both of the FTP options after FTP is setup. See Chapter 22, FTP, for more information.
   a. **Allow FTP Upload** – Only select this option when FTP has been setup for ACH. This feature is only available when Security is enabled.
   b. **Upload when complete** – Select this option to automatically upload the FTP file once it is created by PrintBoss. Only select his option after FTP has been setup. This feature is only available when Security is enabled.

18. The **Comments** field is optional and for your use.

19. The **SignOn** tab is provided for the rare occasion when a sign on or introduction to the Positive Pay file is required by the bank.

20. Fill in the **Header** section when a header is required by the bank. This information usually includes:
   a. Account number
   b. Company name
   c. Batch date

21. Fill in the **Details** section according to the bank's specifications. This section is always required for a Positive Pay file and often includes:
   a. Account number
   b. Check number
   c. Check amount
   d. Check date
   e. Check recipient

22. Fill in the **Footer** section according to the bank's specifications. This section is often required and provides a summary of the batch. This may include:
   a. Batch count
   b. Batch amount sum
   c. Batch date

23. The **SignOff** tab is provided for the rare occasion when a sign off is required to indicate the end of the Positive Pay file. This tab can also be used to display a File Count or File Amount value.

24. Click OK at the bottom of the Positive Pay Editor to save changes and close the window.

25. Click OK on the Editing Form window.

**NOTE:**

The following are tips for the Header, Details, and Footer sections.
Entering Account/Routing Numbers

There are 3 ways to enter an Account Number or Routing number into a Positive Pay spec.

1. Explicitly type the Account or Routing number into the spec. This is the most direct method, but it becomes a problem when more than one bank account is used by the same form since these values will not change dynamically.

2. Enter the Account or Routing number into one of the five MISC fields on the bank record. An advantage to this method is that you can type the number exactly as the bank wants it to appear. On rare occasion, the display of these values on the MICR line is not the way the bank wants them expressed in the PosPay file. The down side is remembering to keep the MISC field current in the bank record.

3. Use the calculated fields, {BMicrAcctNo} and {BMicrRoutNo}, in PrintBoss. The values of these fields are calculated each time they are accessed by examining the full MICR line and pulling out the appropriate sections. The advantage is no additional support is needed. The disadvantage is that on rare occasion the format of the account number in the Positive Pay file needs to be a little different than the MICR line.

Operation

Once the Positive Pay file is configured, it is treated as another printer. Select the Multi-Parts & Printers tab in the Form Editor and set the Print Time to print Immediate or as a Batch. Click on the File menu, select Open Document Work Files and select the form name to print when the Print Time is set to Batch. Print the whole file or set a range in the Scope to print only part of the file.

The work file may also be used to reprint or test print portions of the file. Be sure to check Allow Reprints as well as the copy marked Positive Pay when reprinting checks from the work file.

NOTE:

The Printed column in the Browse list of the work file indicates the status of the printed documents. Positive Pay copies display the letter O (for pOsitive pay) when printing is successful. The capital O turns into a small case “o” when the copy has been reprinted.

It is important that the form’s Auto Archiving method on the Settings tab is NOT set to Overwrite Work File at Start of Batch when the Print Time for the Positive Pay copy is set to Batch on the Multi-Parts & Printers tab of the Form Editor. You could potentially overwrite a work file before the Positive Pay copies have been printed to a file.

See Chapter 9, Form Files.
COMMON SUBSTITUTE FUNCTIONS USED

There are a number of functions in PrintBoss that are helpful when setting up the Header, Details, and Footer sections. A list of these functions can be accessed by right clicking in the scripting areas and choosing List / Stuff Assignments.

A few of the most commonly used functions are defined in Chapter 10, #Text Command, under Substitute Functions. These include: CurrentDate, CurrentTime, FormatNum, Pad, RECDate, and RECTime. See Chapter 10 for the complete explanation of these functions.

In addition, there are several substitute functions specific for Positive Pay files. Descriptions of these functions follow.

**BatchAmnt**

{BatchAmnt}

This function provides the sum of all the checks in a batch and is usually placed in the Footer tab of the Positive Pay File Editor.

Example: "{FormatNum: '{BatchAmnt}', 8, 2, '0', '0', Hide}"  
This function formats the batch amount to 8 digits to the left of the decimal, 2 digits to the right of the decimal, fill left with zeros, fill right with zeros, and hide decimals.

**BatchChkNoSum**

{BatchChkNoSum}

This function provides the sum of the check numbers in a batch and is usually placed in the Footer tab of the Positive Pay File Editor.

**BatchCount**

{BatchCount}

This function provides the number of checks in a batch and is usually placed in the Footer tab of the Positive Pay File Editor.

Example: "{FormatNum: '{BatchCount}', 10, 0, '', '', Hide}"  
This function formats the batch count to 10 digits to the left of the decimal, 0 digits to the right of the decimal, fill left with spaces, no fill right, and hide decimals.

**CommaDelimit**

{CommaDelimit: .prepend(<string>)[<ForceQuotesY/N>]}

This function prepares a string for a csv file and encloses commas occurring in the string in double quotes as well as quotes occurring in the string in double quotes. This allows all the data in the field to display. Otherwise, the field will cut off at the comma our double quote. The function can be used in the Detail or Footer tab of the Positive Pay File Editor and only applies to files that are saved to a csv format. An option allows forcing a field without quotes to be encapsulated in double quotes if double quotes may occur in the field for uniformity in displaying the data.

Example: "{CommaDelimit: '{DocRecip}'}"  
A name enclosed in quotes in the DocRecip field will evaluate properly instead of cutting off part of the line. The name Robert "Bud" Shipman displays in full instead of stopping after the name Robert. The same example would work if there was a comma in the DocRecip field, such as James King, III.
CR/LF

{CF/LF}
This function adds a carriage return / line feed at the end of each Positive Pay tab that is used. This is the same as using: Chr(13)+Chr(10). Unlike most of the other functions, there are no double quotes around CR/LF.

CSV or TSV

{CSV: <<-<string>>+[,<ForceQuotesY/N>]}  
{TSV: <<-<string>>+[,<ForceQuotesY/N>]}
This function creates a complete line for csv fields and encloses commas occurring in the string in double quotes as well as quotes occurring in the string in double quotes. Unlike the CommaDelimit and DBQuotes functions, quotes are not used to offset this function. An option allows forcing a field without quotes to be encapsulated in double quotes if double quotes may occur in the field for uniformity in displaying the data.

TSV works the same as CSV to create a tab delimited file.

Example:  {CSV: <<-{DocRecip}>,'Y'}  |Forces all DocRecip fields to be enclosed in double quotes. Note there are no quotes surrounding this function. The ‘Y’ at the end removes the last comma or tab.

DBQuotes

{DBQuotes: '<string>'}
This function is similar to the Comma Delimit function, but it only looks for double quotes in the string and applies to Positive Pay files saved to the .txt format. The function can be used in either the Detail or Footer tab of the Positive Pay File Editor.

Example:  '{DBQuotes: '{DocRecip}'}'  |The name Robert "Bud" Shipman will display fully in the Positive Pay file using this function. Otherwise the name would display as Robert only.

FileAmnt

{FileAmnt}
This function returns the sum of all checks in a file and is usually placed in the SignOff tab of the Positive Pay File Editor.

FileBatches

{File Batches}
This function returns the sum of all batches in the Positive Pay file and is usually placed in the SignOff tab of the Positive Pay File Editor.

FileChkNoSum

{FileChkNoSum}
This function provides the sum of all check numbers in the Positive Pay file and is usually placed on the SignOff tab of the Positive Pay File Editor.

FileCount

{FileCount}
This function returns the number of records in a file and is usually placed in the SignOff tab of the Positive Pay File Editor.
**PosPayFileCounter**

\{\text{PosPayFileCounter: '{ZeroFillDigits}'}\}

This function adds a unique file creation number for those banks who require this feature and is normally added to the Header tab of the Positive Pay File Editor. The value after the function indicates the number of characters in the file counter. PrintBoss will automatically increment the counter by 1 every time a Positive Pay file is printed.

Example: "\{\text{PosPayFileCounter: '8'}\}" This function creates a unique file creation number filled with zeros up to 8 characters.

**PosPayFileExt**

\{\text{PosPayFileExt}\}

This function provides the extension of the current positive pay file that is created by PrintBoss.

**PosPayFileName**

\{\text{PosPayFileName}\}

This function provides the name that is being used for the current positive pay file.

📖 See Chapter 10, Text Command, for additional information on Substitute Functions.
ACH Setup

ACH file specifications are established by NACHA – The National Automated Clearing House Association. PrintBoss 5.65.1 and above contains a file with the standard NACHA specifications for use with PrintBoss. This file is accessed through the Positive Pay feature in PrintBoss Select.

Company (originator) specific data is stored on the ACH Definition tab of the Bank Records in PrintBoss. Receiver specific data can be stored in a Payee List in PrintBoss and associated with a bank record.

Bank Setup

This is outlined in Chapter 8, Bank Accounts, under item 4 of the Create A Bank Record section.

Payee List Setup

PrintBoss Select can use data required to create the Detail records for the ACH file from the Payee List. This section covers setting up the Payee List.

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and choose Payee Lists.
3. Click Create to start a new Payee List.
   a. Enter a File Name for the list. There are no requirements for the File Name.
   b. Click OK to create the list entry.
4. Select the list you created and click the Editor button. The Payee List Browse opens.
5. Entries can be made one at a time in the list by clicking on the + sign, or imported from a csv file. This section covers exporting a template to a csv file and importing back into the Payee List when completed. The first step is to create 1 record in the list to export the column headings.
   a. Click the plus sign (+) to create the first record. The Payee List Edit window opens.
b. Select Active in the top right corner. Enter the first Payee as it was entered in the accounting software.

c. Click O.K. to save this record.

6. Right click on the gears in the top left corner of the Payee List Browse grid and choose Export. PrintBoss will indicate 1 record is selected.

7. Click Yes.

8. Enter a name and location to save this file. PrintBoss will save it as a Comma Delimited (*.csv) file.

9. Navigate to the save location and open the *.csv file.

10. Enter values in the following fields. Many of these fields are associated with the Detail tab of the ACH File Editor:

a. **Payee** – Enter the payee name as it appears in the accounting software. PrintBoss uses this field to match the payee name on the check. DocRecip must be assigned in the PrintBoss form to match on the Payee field. PrintBoss stops once it finds an exact match. Duplicates will be ignored.

b. **Payee ID** – Enter an ID for this payee. Alternatively, the Payee ID can be used by PrintBoss to match an ID on the check advice. DocPayeeID must be assigned in the PrintBoss form to match on the Payee ID field. When both Payee ID and Payee are used, PrintBoss will use Payee ID first and only use Payee when not match is found for Payee ID.

c. **Active** – Enter Y to activate this record. N denotes an inactive record.

d. **Email** – Enter a primary email to send a notification of payment to the recipient.

e. **Email2** – A second email field is provided if a second recipient is necessary.

f. **Payment Type (PYMNTTYPE)** – The Payment Type is a numeric value based on the type of file selected. The values are:

   i. 0 – N/A This type is never used for ACH, but may be selected when the Payee List is only used to store email addresses for emailing documents through PrintBoss.

   ii. 1 – ACH Always select this type for ACH files.

   iii. 2 – PS16 Only select this type when instructed by a Wellspring Software technician.

g. **Payee Misc (MISC)** – The Payee Misc field is provided for any additional information for PrintBoss to retrieve and include in a file or email.
h. **Mode1** – Enter the **Mode** for Account 1 to determine the amount of the ACH transfer. The most common choice is 1, Remainder of Check, to pay the entire amount of the check. This choice requires no additional Amount/Percent entries. The choices are:
   i. **Inactive** – Enter 0 (zero).
   ii. **Remainder of Check** – Enter 1.
   iii. **Percent** – Enter 2.
   iv. **Set Amount** – Enter 3.

i. **Amt1** – Enter a fixed **Amount** or **Percent** for Account 1 for this payee. Leave blank if Remainder of check is selected for the Mode. The field name is `{ACHAmount}` and contains 10 characters, 8 dollar places and 2 cents places.

j. **BnkID1** – Enter the routing number for Account 1 for this payee. This matches the **Bank ID** field on the Payee List. The field name is `{ACHRecvBankID}` and contains 9 characters, 8 for the routing number and a check digit added by PrintBoss in accordance with ACH Rules.

k. **BnkAct1** – Enter the account number for Account 1 for this payee. This matches the **Bank Account Num.** field on the Payee List. The field name is `{ACHRecvBankAcct}` and contains 17 characters.

l. **Name1** – Enter the **Individual/Company Name** for this payee as it appears on Account 1. The field name is `{ACHRecvName}` and contains 22 characters.

m. **ID1** – Enter the **Individual/Company ID** for this payee if there are two or more identical names. The field name is `{ACHRecvID}`, contains 15 characters, and is optional.

n. **Prenote (PRE1)** – Only select **PreNote** (Y) if this account is added after the PreNote file has passed the bank.

o. **Print Check (PREPRNT1)** – This option is only available when Prenote is selected. A value of T (True) is entered to print a check when for this Prenote. Otherwise, the value is F (False).

p. **TransCode1** – Enter a code to identify if the **Account Type**. The field name is `{ACHTransCode}` and contains 2 characters. The values are:
   i. 22 = Checking
   ii. 32 = Savings

q. **Disc1** – Enter an optional 2-digit code for this account that is meaningful only to the originator. The field name is `{ACHRecvDisc}`, contains 2 characters, and is optional.

r. The following is an image of the Details tab for the ACH File Spec where these fields are used:

11. Only enter Account 2 or Account 3 if the amount of the check is to be divided between more than one bank account.
12. Save changes to this file and click Yes to keep the features.
13. Return to PrintBoss **Select**, click on the Edit menu, and choose Payee Lists.
14. Select the appropriate Payee List and click Editor.
15. Click on the gears in the top left corner of the Payee List Browse grid and select Import.
16. Select the appropriate csv file and click Open. The list will populate with the csv entries.
17. Select a record and click the up arrowhead to make changes to the selected file.
Click the Done button when you are finished.

**Form Setup**

In addition to the Bank and Payee Lists, the PrintBoss Form needs to be setup to print the ACH file. First, we will add a copy to the PrintBoss form to create the ACH file.

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and choose Form Files.
3. Select the appropriate PrintBoss form and click the Editor button. The Editing Form window opens.
4. Select the Settings tab.
5. Increase the number of copies by 1. For example, if the current Copies value is zero, type 1 in the field.
6. Select the Multi-Parts & Printers tab.
7. Click on the Printer & Tray Selections Saved In… drop down menu and select <Form> to save these changes for all users.
8. Locate the new copy, click on the Destination Printer/Device drop down menu, and select <Positive Pay File>. This feature supports ACH files in addition to Positive Pay files.
9. Click on the Source Tray drop down menu and choose ACH Sample. This is the NACHA file that comes with PrintBoss.
10. Change the File Path and Name if needed.
   a. Click on the page symbol to the left of the Source Tray for the <Positive Pay File> copy to open the Positive Pay / ACH File Editor. The following is an image of the Master tab.
1. **File Name** – Set the destination path and file name for the ACH file in the *File Name* field. The browse button at the end of this field can be used to navigate to a location and will save the path when a file name is entered.

2. **Confirm Path / Filename at runtime** – Select this option to verify the destination location or file name before PrintBoss saves the ACH file.

3. **New File Name Generation** – The default is to generate a new file at *Start of Batch*. This is the recommended setting.

4. **File Type** – The file type should be set to ACH.

5. **Append Overwrite Method** – The default is *Overwrite existing File*. The choices are:
   a. Overwrite existing File
   b. Append to existing File
   c. Prompt for Overwrite, Append, Cancel

6. **Exclude records with zero amount** – This option is typically not used with ACH files.

7. **Auto add CR/LF to each script** – This feature adds a carriage return to the end of each script and should ALWAYS be checked for ACH.

8. **Import** – Click this button to import the ACH Sample to embed in the PrintBoss form.

9. **Export** – This feature is used to save a file created as embedded in form. It is usually not used with ACH.

10. **Allow FTP Upload** – Only select this option when FTP has been setup for ACH. This feature is only available when Security is enabled. See Chapter 22, FTP, for more information

11. **Upload when complete** – Select this option to automatically upload the FTP file once it is created by PrintBoss. Only select his option after FTP has been setup. This feature is only available when Security is enabled. See Chapter 22, FTP, for more information

12. **Comments** – Provides comments associated with the ACH file.
   a. Click the *Import* button and select *ACH Sample* to embed this file into the current form.
   b. The ACH Sample can be used in more than one PrintBoss Form. Contact Wellspring Support if you need a different File Path or Name for each Form.

11. There are 7 tabs associated with the ACH File. The first 5 have been described previously in this document. The last two are as follows:
   a. **Footer** – The Footer tab contains fields for the “8” record(s) and apply specifically to a batch.
i. **ACH Service Class Code** – The information for this field is entered in the ACH Definition tab of the PrintBoss bank record. The variable name is `{bACHSvcClasscode}`.

ii. **Batch Count** – Generates the total number of entries for the preceding batch. The variable name is `{BatchCount}`.

iii. **ACH Batch Hash** – This variable generates a value from the routing numbers entered for each detail record in the batch. The value provides a check against inadvertent alteration of data contents. The variable name is `{ACHBatchHash}`.

iv. **Batch Amount** – Generates the sum of all check amounts for the preceding batch. The variable name is `{BatchAmnt}`.

v. **ACH Company ID** – The information for this field is entered in the ACH Definition tab of the PrintBoss bank record. The variable name is `{bACHCompID}`.

vi. **Originating DFI ID** – The information for this field is entered in the ACH Definition tab of the PrintBoss bank record. The variable name is `{bACHOrgDFIID}`.

vii. **Batch Number** – PrintBoss generates a sequential number for each batch in the file beginning with 0000001. The variable name is `{FileBatches}`.

b. **SignOff** – The SignOff tab contains fields for the “9” record and applies to the entire file.

i. **File Batches** – Generates the total number of batches in the file. The variable name is `{FileBatches}`.

ii. **ACH Block Count** – Generates the correct number of lines to create complete blocks of 10 lines or 940 characters. These appear as rows of 9 at the end of the file. The variable name is `{ACHBlockCount}`.

iii. **File Count** – Generates the total number of entries in the file. The variable name is `{FileCount}`.

iv. **ACH File Hash** - This variable generates a value from the routing numbers entered for each detail record in the file. The value provides a check against inadvertent alteration of data contents. The variable name is `{ACHFileHash}`.

v. **File Amount** – Generates the sum of all check amounts in the file. The variable name is `{FileAmnt}`.

12. Changes should not be made to the ACH file without consulting a Wellspring Software technician as these variables are defined by NACHA.

13. Click OK to save changes to the Editing Form.

Additional setup may be needed in the Form including:

- Setting up E-mail.
- Assigning ACH fields in the Form instead of using the Payee List.
- Adding Process Page commands to determine when to print the ACH file when live checks are included in the print batch from the accounting system.

Please contact Wellspring Software’s Technical Support for assistance with additional Form setup.
CREATING THE ACH FILE

The ACH file is created automatically during the print process. No further steps are necessary.
**FTP**

FTP is a File Transport Protocol used to securely transmit files. The Enterprise edition of PrintBoss version 6.0 and above includes the convenience of an FTP upload tool.

**SECURITY**

There are 2 settings under the Basic User Rights tab on the Security Settings dialog under the Options menu in PrintBoss. They are:

1. Allow FTP selection – The FTP tab is not available on the bank record when this setting is not selected.
2. Edit FTP List – The FTP feature is not available under the Edit menu when this setting is not selected.

Verify both settings are selected before proceeding with the FTP Setup.

**FTP SETUP**

FTP is setup under the Edit menu in PrintBoss as follows:

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and select FTP Accounts.
3. Click on the + sign in the menu bar to add a new record. The Online Accounts window will open.
4. Fill in the left fields as follows:
   a. **Account Name** – This is a user selectable field. Enter a descriptive name that will help you recognize this account. For example, Trust Bank. This field holds up to 25 characters.
   b. **Domain URL** – Enter the URL provided by the financial institution. This field holds up to 40 characters.
   c. **Login ID** – Enter the Login ID provided by the financial institution. This field holds up to 74 characters.
   d. **Login Password** – Enter the Login Password provided by the financial institution. This field holds up to 30 characters.
   e. **Port** - Enter the Port provided by the financial institution. This field holds up to 4 characters.
   f. **Passive Mode** – Select if directed by the financial institution.

5. Select the TLS Support value provided by the financial institution if applicable.
6. Select the SSL Method provided by the financial institution if applicable.
7. Click Test Account Connection to confirm the setup is correct.
8. Click OK to save these changes.

---

**Bank Setup**

FTP is associated with a file type in the PrintBoss Bank Record. A separate FTP account can be associated with ACH, Positive Pay, or PS16 files.

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and choose Bank List.
3. Select the desired bank record and click on the Edit Bank button in the menu bar.
4. Select the FTP tab.
5. Click the drop down menu for one of the following file types:
   a. ACH
   b. PosPay (Positive Pay)
   c. PS16

6. Select the appropriate FTP account.
7. A different FTP can be selected for each file type.
   a. Use the Edit FTP Accounts button to immediately access the FTP Account Browse window to make changes to one of the FTP accounts.
   b. The FTP Account button will be grayed out if security to Edit FTP List is removed for the user under Security Settings in PrintBoss.

8. Click OK to save these changes.

**FORM SETUP**

The PrintBoss Form needs to be setup to use FTP In addition to the Bank and FTP Accounts lists. These steps should only be followed after a Positive Pay, ACH, or PS16 file has been setup on the PrintBoss Form.

See Chapter 20, *Positive Pay* or Chapter 21, *ACH Setup* for information on setting up a copy in the Form.

1. Open the PrintBoss Master Application.
2. Click on the Edit menu and choose Form Files.
3. Select the appropriate PrintBoss Form and click the Editor button. The Editing Form window opens.
4. Select the Multi-Parts & Printers tab.
5. Locate the <Positive Pay> copy and click on the page symbol to the left of the Source Tray column. This opens the Positive Pay/ACH File Editor.
6. Select ‘Allow FTP Upload’
7. If you would like PrintBoss to automatically upload the file once it is complete, also select the ‘Upload when complete’ checkbox.
8. Click OK to save this change.

NOTE:
The ‘Allow FTP Upload’ and ‘Upload when complete’ checkboxes are not available unless an actual file is selected from the Source Tray drop down menu on the Multi-Parts & Printers tab of the PrintBoss Form. The <Embedded in Form> selection will not work.

MANUAL UPLOAD OF COMPLETED FILE

The following are instructions to manually upload a completed file.

1. Open the PrintBoss Master Application.
2. Click on the Utilities menu and select FTP Uploader.
3. Select an FTP Account Name from the first drop down menu.
4. Click ‘Connect and List’. PrintBoss will provide a list of completed FTP files. These all have a ‘upl’ extension.
5. Select a *.upl file from the list. The file will only upload if the Account Name in the file matches the Account Name selected from the first drop down list on the FTP Loader. For example, the image above displays ‘Bank of America’ as the Account Name. The selected *.upl file must have been created with the ‘Bank of America’ account name in order to upload.
6. An ‘Upload Complete’ message will appear in the lower left corner of the FTP window when the file finishes uploading. The actual file name may be hidden in any message returned from the bank if the bank’s policy is to hide this information. Do not be concerned if the file name does not display.
7. Close the window by clicking on the red button with the white ‘x’ when finished.
CUSTOM INTERFACES

PrintBoss can be configured to work with just about any Windows package that prints documents as long as the printing operation is able to select the PrintBoss Printer Driver or can print to a text file.

PRINTING TO PRINTBOSS PRINTER DRIVER

Now that a custom interface method is established, there are still a few questions that must be answered. The first is how the check number will be determined when the document is a check. It is very helpful to send the check number from the accounting software. If this is not possible, the check number can be set in the PrintBoss Bank List record.

See Chapter 8, Bank Accounts – Next Check Number.

When a print job is received, a fundamental decision needs to be made by PrintBoss – what PrintBoss form should be used to process the incoming data? The following steps walk through a typical setup using the PrintBoss Printer Driver and the PrintBoss Request List to determine the form and bank combination used by PrintBoss.

SETUP

9. Open the PrintBoss Master Application.
10. Click on the Options menu and select PrintBoss Driver Settings.
11. Set the Capture Mode to Always Capture.
12. Select the Block all Non-captured pages option if it is available. This only appears in older versions of PrintBoss.
13. Click OK.
14. Click on the Options menu again and select Configuration.
15. Select the Request List determines Form/Bank option under the Always Capture Settings section.
16. Click OK.

CREATE A PRINTBOSS FORM FILE – SEE CHAPTER 9 FOR MORE INFORMATION

1. Click on the Edit menu and select Form Files.
2. Click the Create button to create a new Form.
3. Enter a File Name of not more than 8 characters for the form and click OK. This new form should be highlighted in the Form Select list.
4. Click the Editor button.
5. Verify Copies is set to 0 on the Settings tab and the Auto-Archiving Completed Records is set to None (Manual). This will make it easier to test the interface. When everything is correct, these settings may be changed.
6. PrintBoss Enterprise users may choose to allow PrintBoss to capture graphics from the accounting software. All graphic elements (lines, boxes, shading, logos, etc) are automatically stripped out by the
standard edition of PrintBoss. Select the Text AND Graphics are captured option under Text / Image Capture Mode on the Settings tab to accept graphics.

**DEFINE a BANK – SEE CHAPTER 8 FOR MORE DETAILS**

1. Click on the Edit menu and select Bank List if this document requires bank account information.
2. Create a new bank record or edit an existing record.
3. Set the Check Number variable on the MICR tab to \{CChkNo\} if the check number will be passed from the accounting software. Otherwise, set it to \{BChkNo\}. The bank account information will only appear on the printed document if these fields are referenced in the Form, usually through #Text commands.

**DEFINE a FORM / BANK REQUEST LIST – SEE CHAPTER 19 FOR MORE DETAILS**

1. Click on the Options menu and select Form / Bank Request List.
2. Add a new entry.
3. Enter a Prompt. This should be something the user will understand to represent the form and bank combination.
4. Select the custom form you created from the drop down menu of the Form field.
5. Select the appropriate bank for the Bank field (or NONE if this is not a check).
6. Repeat as often as necessary to create a list of all the required form and bank account combinations. DO NOT create more than one entry for the same Form.

**PRINT a TEST CHECK**

1. Return to the accounting software and print a check (or other document) to PrintBoss. Make sure the PrintBoss Printer Driver is selected as the destination printer for the accounting software. The Request List should pop up.
2. Choose the appropriate Form / Bank record.
3. Edit the Form / Bank Request List conditions to automatically pick the correct entry in the future.

⚠️ See Chapter 19, Form / Bank Request List.

**EDIT THE PRINTBOSS FORM – SEE CHAPTER 9, FORM FILES, FOR MORE DETAILS**

It is easier to make final adjustments to the Form File once you print data to the work file.

1. Click on the File menu and select Open Document Work Files.
2. Select the work file for your form and click the Browse button.
3. Select a document in the work file and click View.
4. Double click any object in the View to see its coordinates. Edit the form as necessary.
5. Assign any text objects that will be moved or reformatted. Assign at least the following variables.
   a. DocAmnt
   b. DocNo
   c. DocRecip
   d. DocDate

⚠️ See Chapter 24, Capturing and Assigning Text.

**Hints**

It is usually easier to blank out a second advice that may be printed from your accounting software and use the PrintBoss Block Mirrors function instead.

RegionMove commands are normally used to align the advice and check sections to print properly. For this reason, the order the source check is received (Advice-Check, Check-Advice, Advice-Check-Advice) is not important since it can always be arranged to fit PrintBoss’ standard check stock. It is better to use a separate Region Move command for each section for flexibility in positioning data.

It is relatively easy to capture fields on the check to assign variables and place each variable on the final document with #Text commands. A common exception is the advice detail that can be placed accurately with the RegionMove command.
CAPTURING AND ASSIGNING TEXT

There are MANY times when text is captured from the accounting software and formatted or specifically placed on the PrintBoss Form before it is printed. For example:

- The check number in a check is added to the MICR line.
- The bank account data on a check is used to automatically select a bank record in PrintBoss.
- An E-mail address or a fax number is captured and used in sending the document.
- The value of a check is examined to determine the appropriate signature(s) to print on the check.
- Distribution methods are defined so PrintBoss can conditionally e-mail, fax, or print.

This chapter explains in general the three methods for assigning data, although these methods are fundamental to many tasks in Form design. All the methods assign the value of the captured text to an arbitrary variable name in PrintBoss. The variable name can be used in various ways by enclosing it in braces and adding it to expressions in a PrintBoss Form. For example:

```
#Text 7, 1, Arial/14/B, "{DocNo}"
```

This expression prints the document number in the top right corner of the page, assuming it is captured and assigned.

METHOD 1: PRINTBOSS TRIGGER (USE OF PB#INFO ....)

The PrintBoss Trigger is only used for passing four very common pre-defined variable names, DocNo, DocAmnt, DocRecip, and DocMisc, to PrintBoss. It can ALSO communicate the name of the Form and the Bank Code for PrintBoss to use. This method requires the ability to edit the accounting software report content in order to properly add the PB#INFO expression. The syntax follows:

```
PB#INFO <Form>, <Bank>, <DocNo>, <DocAmnt>, <DocRecip>, <DocMisc>
```

The PB#INFO MUST BE CAPITALIZED. Delimiters such as quotes, double quotes, or brackets are not required, but are recommended for some of the variables to avoid confusion when a comma occurs in the data, such as the thousands separator in the amount.

Only the first parameter, Form, is required. So the simplest use of this command might be:

```
PB#INFO MYFORM
```

Here is an example of a line that would print from the accounting software:

```
PB#INFO MyChk1, "Checking 1", "100456", "1,456.23", "Acme Electric", "527-0012"
```

Of course, this is the expression after it is evaluated and all the variables are replaced with data. The evaluation occurs after the report is printed from the accounting software. The actual content might be similar to the following, although the actual syntax and field names are dependent on your report writer:
"PB#INFO MyChk1, “+ 
  [“+ dbf.BankCode + “],” + 
  [“+ dbf.CheckNo + “],” + 
  [“+ dbf.Amount + “],” + 
  [“+ dbf.Payee + “],” + 
  [“+ dbf.VendorEmail + “],” + 

The five assigned variables used in this method can be referenced in any PrintBoss script.

**METHOD 2: EXPLICIT VARIABLE ASSIGNMENT WITHIN THE ACCOUNTING SOFTWARE REPORT**

Define a field in the source report to pass the assignment to PrintBoss if you have the ability to edit the accounting software report. It is important that the variable is just ONE field. This usually means you must create a variable in the source report that uses a combination of text and database fields. The resulting field must be similar to the following example:

PB#Assign FaxSvcFaxNo, 636-527-0012

This is the field after it is evaluated and the text and database fields are replaced with data. The actual content might be similar to the following, although the actual syntax and field names are dependent on your report writer:

"PB#Assign FaxSvcFaxNo,” + CustomerDBF.ContactFaxNo

This expression must be on a line all by itself, though it can be any font size or color and occur anywhere on the page. For example, a series of assignments can be printed very close together using a 4 point font. Once PrintBoss sees each line, it will automatically assign the value to the suggested variable name and remove the expression before printing.

The variables assigned in this method can only be referenced in the RunTime Objects section of PrintBoss when Pre-Process Assignments is checked on the Special Controls tab of the Form.

**METHOD 3: CAPTURED FROM THE PRINTED DOCUMENT BASED ON COORDINATES**

This method requires the value that needs to be captured and assigned by PrintBoss is displayed somewhere on the source report. PrintBoss can blank out the data after it is captured (if desired).

Verify the value appears in the document sent by the accounting software before setting up the assignment. This may entail opening the accounting system's report writer, finding the field in its databases, and inserting it somewhere on the report. It is very important that the data ALWAYS appears at the same location from page to page. This usually means inserting the field into the Header or Footer sections of the report.

Print a document to PrintBoss once the value appears in the report. The PrintBoss Form must be clearly defined. See the Custom Interfaces chapter for more information if this is not clear.

After PrintBoss has received a print job, open PrintBoss and select FILE / OPEN DOCUMENT WORK FILES. Select the desired work file and click the Browse button. There may be only one document in the work file, but that is all that is needed.

1. Select a document and click View.
2. Right click anywhere in the view and select View Raw Capture. You are now only viewing the actual text printed from the accounting software.
3. Locate the text field on the screen containing the desired captured value.
4. Double click on the field to open the Captured Text Command Properties dialog.
5. Select the Click to Assign to Variable bar in the top right of the dialog.
6. Replace ReNameMe in the Variable Name field with your own variable name. For example: MyVar
7. A description of some of the options follows:
a. **Capture Coordinates** – This section allows you to set a range for the capture coordinates to account for small deviations in the location of the data.
   i. Some reporting engines (such as the latest Crystal Reports) tend to break up the text fields into smaller contiguous fields. A good practice is to click the +/- button for the **Horizontal** field to change the coordinate range. This toggle button changes from +/- to "to". Set the ending coordinate far enough to the right to pick up the longest imaginable value without overlapping unrelated fields.
   ii. The "to" range is often used in conjunction with **Add together fields in horizontal range**.

b. **Add together fields in horizontal range** – Select this option when the data field is fragmented. Use this in conjunction with changing for coordinate range from +/- to "to".

c. **Trim choices applied after segments appended** – This option is only available after Left Trim, Right Trim, or both are selected along with Add together fields in range. The trim is not applied until after the fields are appended.

d. **Make only 1 assignment per capture field** – This option is used when capture fields overlap more than one data source. PrintBoss captures the first data that occurs within the capture coordinates.

e. **Capture Raw Text Objects Only** – This option is often checked to allow PrintBoss to only capture Raw Text objects and not graphics or added text.

f. **Left Trim and Right Trim** – These options removed leading and trailing spaces.

g. **Upper Case** – This option converts captured text to Upper Case. Capture text can also be converted to Upper Case by using a #Text command.

h. **Blank Out After Capture** – Select this option to hide the raw data after it is captured. The data can be display elsewhere on the Form by using a #Text command.

i. **Substr of Value** – Select a starting character in the field and a length if the field is actually a long string and you only need to use part of the data.

8. Click **OK** when you are finished assigning properties to your variable. Variables assigned in the View are automatically inserted at the top of RunTime Objects tab in the Form.

9. **Close** the Properties dialog.

10. Right click on the raw view and deselect **View Raw Capture** to return to the formatted view.

11. Right click anywhere on the View and choose **Insert an Object / Text** if you would like to add the captured data to a different location. The **Text Command Properties** dialog opens.

12. Enter your variable in the **Text** field enclosed in brackets. For example: {MyVar}. You may change properties and add conditions as needed. Commands added to the View are automatically inserted at the end of Footer Objects tab in the Form.

13. Click **OK** when you are finished.

14. **Close** the View when you are finished and click **Yes** to save changes.

The variables assigned in this method cannot be referenced in RunTime Objects of PrintBoss unless **Pre-Process Assignments** is selected on the **Special Controls** tab of the Form. Assigned variables are not always printed. Sometimes they are used for the Email or Fax Service functions of PrintBoss.

---

**EXAMINING ASSIGNED VARIABLES**

It can be very helpful to review a list of all the variables that have been assigned in a Form. Right click on a View from either the Form Editor or the work file Browser and select **Display Assignments**. The **Form Assignments** dialog opens. The assignments that are currently defined will show up grouped by category. Note that some of the categories such as **E-mail Fields** or **Fax Service Fields** have variables that may not be assigned. They are listed because they are pre-defined and will be used in a specific way by PrintBoss if they are assigned.

View variables assigned in a specific script by clicking on the plus sign in front of **Assignments made in form**. The subcategories will identify where the variables are assigned, such as **Assigned in Form’s Runtime Section** or **Assigned in Captured text**. Navigate to the designated script or back to the accounting software report (in the case of **Captured text**) to make adjustments to these assignments.
APPENDIX A: PRINTBOSS BANK LIST

The following detail describes the fields on the tabs of the Bank List. Rarely will all of the fields in a bank record be used. Each field in the PrintBoss bank record can be referenced in the PrintBoss form as a variable. The data in a field will not be used unless the PrintBoss Form references the associated variable. You only need to reference the fields you want to use. Place and hold your cursor over a field in the PrintBoss Bank Edit window to view a pop up indicating the field's variable name. Variable names are NOT case sensitive. A #Text command is typically used to reference a variable in a form or the variable may be used as part of a Condition.

See Chapter 9, Form Files.

One of the fields that are required is the Bank Code. Enter the exact name used for this account in the accounting software if your accounting software can print data that can be used for a bank code (see the Installation Notes printed during the PrintBoss installation). This code is used to synchronize your accounting software with PrintBoss. Do not leave the Bank Code field empty.

NOTE:

PrintBoss prompts the user to select an account from a list when printing checks from accounting software that can print data used for a bank code when no entry in the PrintBoss list matches the code from the accounting software. A check box in the lower right of the prompt indicates PrintBoss will update the selected bank code to match the bank code sent from the accounting software. This box is checked by default.

Follow these steps to view the tabs:

1. Click on the Edit menu on the main PrintBoss window and select Bank List.
2. Select a Bank Record (any line in the list) and click the Edit Bank button.

The PrintBoss Bank Edit window opens on the Primary tab.

Primary

This tab contains the company and bank information printed on the checks. The Next Check Number field is usually not relevant. Please check the Installation Notes specific to the accounting software to determine if this field should be used.

Bank Code

This field identifies the desired bank account. Either the accounting software or the Request List identifies the appropriate bank account by matching this code. PrintBoss requires an exact match of the database code with the code passed from the accounting software (though it is not case sensitive) to automatically select the bank account.

There is an option in PrintBoss to allow Partial Matches. This is not recommended, but is available for special cases – usually legacy PrintBoss installs. To activate this setting, navigate to the main PrintBoss window and click on OPTIONS / CONFIGURATION. Select the Internal tab. The name of the setting is Method of matching a Bank Code and is found near the bottom of the screen. Change the setting to Allow Partial Match of Bank Code that follows colon:. Once this is selected, the Bank Code must match exactly up to the colon, if a colon exists.
match is not case-sensitive. Following the colon, there must be a character-by-character match with the PrintBoss Bank Code until all characters in the Bank Code are used. The following chart illustrates successful matches:

<table>
<thead>
<tr>
<th>Bank Code in PrintBoss</th>
<th>Bank Code from Accounting System</th>
<th>Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Checking</td>
<td>Main Checking</td>
<td>Yes</td>
</tr>
<tr>
<td>Main Checking</td>
<td>Main Checking:ABC</td>
<td>Yes</td>
</tr>
<tr>
<td>Main Checking</td>
<td>Main Checking:XYZ</td>
<td>Yes</td>
</tr>
<tr>
<td>Main Checking</td>
<td>Main Check</td>
<td>No</td>
</tr>
<tr>
<td>Main Checking:A</td>
<td>Main Checking</td>
<td>No</td>
</tr>
<tr>
<td>Main Checking:A</td>
<td>Main Checking:ABC</td>
<td>Yes</td>
</tr>
<tr>
<td>Main Checking:A</td>
<td>Main Checking:XYZ</td>
<td>No</td>
</tr>
</tbody>
</table>

Notice the first three scenarios are all a match for PrintBoss. If there are bank codes that are very similar, set the Configuration / Internal setting to *Enforce Exact Bank Code Match*.

There may be an instance where more than one account with the exact bank code is passed from the accounting software, such as multiple payroll accounts for the same company. In this case, check the box labeled *Allow for Selection when multiple Bank Codes match* on the Internal tab of the Configurations Dialog. This box is found in the *Bank Application Properties* section. Enabling this check box alerts you to duplicates and possible mistakes even if you do not expect to have identical bank accounts.

The variable associated with the Bank Code field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Code</td>
<td>{BCode}</td>
<td>Code used to define record. This should match the bank name in your accounting software.</td>
<td>30-60</td>
</tr>
</tbody>
</table>

**ALIAS**

PrintBoss can work with more than one accounting software package using the same bank account, but the accounting software packages may need different Bank Codes. Instead of entering all of the information twice, you may use the ALIAS option. The Alias option allows two different Bank Codes to be used with the same bank account. This option will only work if both accounting packages use the same variable for the check number (see the *Installation Notes* printed during the PrintBoss installation for each accounting software package). If the check number variable must be different, two separate bank list entries need to be created in the PrintBoss bank list. An Alias will use one entry within the PrintBoss Bank list. This is important when considering the purchase of Bank Modules.

See the *MICR* section later in this chapter for more information about the check number variable.

**Bank Prompt**

The Bank Prompt provides a user friendly definition for the account. This field is often used to give the account a nickname. It should not be left blank, but it can be filled with the same value as the Bank Prompt field. The variable associated with the Bank Prompt field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Prompt</td>
<td>{BPrompt}</td>
<td>Name given for user recognition. PrintBoss will automatically copy the information entered in the Bank Code field when this field is left blank</td>
<td>25</td>
</tr>
</tbody>
</table>

**Bank Information Normally Printed on Check**

Enter the bank information that should be printed on the check. This does not need to match the information in the accounting software database. Leave a field blank if it is not needed. There are some interfaces that do not use the bank information from the bank list. See the *Installation Notes* that were printed during the PrintBoss installation or the *Comments* tab of the Form Files Editor for more detail.

The variables associated with the fields in the Bank Information section are:
**Field Name** | **Variable Name** | **Additional Description** | **Length**
--- | --- | --- | ---
Bank Name | {BName} | Name of bank | 40
Bank Address 1 | {BAds1} | Address Line 1 of bank (usually city, state) | 40
Bank Address 2 | {BAds2} | Address Line 2 of bank (often left blank) | 40
Bank Address 3 | {BAds3} | Address Line 3 of bank (often left blank) | 40

**COMPANY INFORMATION NORMALLY PRINTED ON CHECK**
Enter the company information you would like printed on the checks. This does not need to match the information in the accounting software database. Leave a field blank if it is not needed. There are some interfaces that do not use the company information from this list. See the Installation Notes printed during the PrintBoss installation or the Comments tab of the Form File Editor for more detail.

The variables associated with the fields in the Company Information section are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Name</td>
<td>{BCName}</td>
<td>Company Name as it is to appear on the checks</td>
<td>60</td>
</tr>
<tr>
<td>Company Name 2</td>
<td>{BCName2}</td>
<td>2nd Company Name as it is to appear on the checks. This field is optional</td>
<td>60</td>
</tr>
<tr>
<td>Company Address 1</td>
<td>{BCAds1}</td>
<td>Company Address Line 1</td>
<td>40</td>
</tr>
<tr>
<td>Company Address 2</td>
<td>{BCAds2}</td>
<td>Company Address Line 2</td>
<td>40</td>
</tr>
<tr>
<td>Company Address 3</td>
<td>{BCAds3}</td>
<td>Company Address Line 3. This may be used for a telephone number, fax number, or email address</td>
<td>40</td>
</tr>
<tr>
<td>Company Address 4</td>
<td>{BCAds4}</td>
<td>Company Address Line 4. This may be used for a telephone number, fax number, or email address</td>
<td>40</td>
</tr>
</tbody>
</table>

**FRACTIONAL CODE**
The fractional code is the group of bank numbers that is often printed in a small font near the bank information on the check or near the check number. Not all banks require this information. Often, this information is represented as a number over a second number, similar to a fraction. PrintBoss places the first number next to the second with a slash (/) between. This method is perfectly acceptable to the American Banking Association and Canadian Payments Association.

**Contact your bank if you do not know the fractional code.** The variable associated with the Fractional Code field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fractional Code</td>
<td>{BFrac}</td>
<td>Fractional Code</td>
<td>20</td>
</tr>
</tbody>
</table>

**NEXT CHECK NUMBER**
This field is only relevant for accounting software that does not pass a check number to PrintBoss, such as QuickBooks. It is seldom used except for QuickBooks/Quicken. PrintBoss will increment this number by 1 for each document that is processed by PrintBoss with this bank account, even if this field is not used. PrintBoss will pop up the check number for the bank record during printing when the Confirm Check # at start of batch is set to Auto.. and the Check Number on the MICR tab is set to a value beginning with "B" or the Confirm Check # at start of batch is set to YES.. If the pop up number is edited, the PrintBoss bank record will be updated. Editing this field will not update the accounting software. The variable associated with the Check Number field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Check Number</td>
<td>{BChkNo}</td>
<td>Next Check Number Counter (only used if Check # is not sent from the accounting software)</td>
<td>10</td>
</tr>
</tbody>
</table>

**CONFIRM CHECK # AT START OF BATCH**
This is set to Auto... Confirm. For accounting software that passes the check number to PrintBoss, setting this field to Yes.. is IRRELEVANT since editing the number in the PrintBoss Bank List will NOT impact the actual check.
number used on the document. We recommend setting this option to No. Rely on Chk# from host accounting for accounting software that prints check numbers.

**INCLUDE BANK ON POPUP BANK REQUEST LIST**

For interfaces that use the PrintBoss Request List to prompt the user to select a bank, this option can restrict an account from appearing in the list. Often, this option is used when adding a bank account prior to the actual start date for use. The options are:

- **Suppress if "Unused" in BankCode** – Suppresses this record from the Select Bank Account popup list when the word Unused appears in the Bank Code field. This is the default.
- **Suppress this bank** – Suppress this record from the Select Bank Account popup list. It will still appear on the Bank List and on the Bank Select for non-matched Bank Codes list when a bank field is passed to PrintBoss and a match is not found on the Bank List.
- **Include this bank always** – This bank will always appear in the Select Bank Account popup list.

See Chapter 19, *Form Bank / Request List*, for more information.

**PASSWORD REQUIRED AT START OF BATCH**

A password may be added to a bank account either for security purposes or as an additional confirmation that the correct account has been selected. There are 3 options to require a password. No selection indicates no password is required.

- **When picking Popup Bank Request List**
  This option requires a password to be entered when a bank is selected from the Select Bank Account list.

See Chapter 19, *Form Bank / Request List*, for more information.

- **During Un-Matched Bank Selection**
  This option requires a password to be entered when selecting a match from the Select Bank Account list when no match is found by PrintBoss.

- **Everytime bank is auto-picked**
  This option requires a password to be entered any time a bank account is automatically selected by PrintBoss. This option is primarily used for security purposes.

**ACCOUNT AUTO SELECT OPTIONS**

This section contains options for PrintBoss when it is automatically selecting a bank account.

- **Always Confirm Auto Selection**
  This option requires the user to always confirm the selected account when it is auto selected and is usually selected when two or more bank accounts have identical Bank Codes. This setting is grayed out unless the *Allow for Selection when multiple Bank Codes match* option is enabled at the bottom of the Internal tab on the Configuration dialog. Once both bank accounts exist and a request is made for the shared Bank Code, a popup allows the operator to make a selection. The popup occurs even when only one bank is identified. This allows the operator to select the single account or cancel and identify another account that will share the code.

- **Enable "Payroll" alias name**
  Some accounting software only prints the Company Name for a bank code match in the Payroll module, while AP typically prints Bank ID and Company Name. The difference in the bank code matching when only one bank account is used for both AP and Payroll triggers PrintBoss to constantly rename the Bank Code. Select this option to allow PrintBoss to "ignore" the Bank ID when looking for a match on a Payroll account and only use the Company Name for a match. The Bank ID or checking account name is normally assigned to "Payroll" in these situations. This option is often selected for QuickBooks users.

**MICR**

This tab holds the MICR information for the selected Bank record. There are Routing Number, Account Number, and Check Number fields.
Obviously, it is important the MICR line is accurate. Enter the Routing Number and Account Number exactly as they are provided by the bank. Use periods to represent spaces and a single dash ( - ) to represent the three dash MICR symbol (see Substitute Characters later in this section).

The PrintBoss variable {CChkNo} is normally used to capture check numbers passed from accounting software. The {BChkNo} variable is normally used for accounting software that does not pass check numbers, such as Quicken and QuickBooks. The {BChkNo} variable will use the check number from the PrintBoss bank record.

**STANDARD FORMAT FIELDS**
Instead of entering the MICR line directly, each component may be entered separately. One advantage is PrintBoss will automatically suggest proper placement of special characters based on American Banking Association (ABA) standards. These provide a starting suggestion and may still be adjusted.

At the very bottom of the MICR tab is the same MICR line in the actual MICR font characters. This is a visual confirmation of the components entered above. The MICR characters will update to reflect any changes made on the MICR tab.

**Routing Number**
Enter the correct routing number for the bank account. Do not use any substitute characters. The variable associated with the Routing Number field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing Number</td>
<td>{BMICRRoutNo}</td>
<td>Routing Number from bank</td>
<td>9</td>
</tr>
</tbody>
</table>

**Account Number**
Enter the account number. Use a period to designate a space. It is very common to have a leading space (period). Use a dash if there is a three dash character in the account number. The variable associated with the Account Number field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Number</td>
<td>{BMICRAcctNo}</td>
<td>Account Number from bank</td>
<td>20</td>
</tr>
</tbody>
</table>

**Check Number**
One portion of the MICR line is the Check Number. A variable needs to be entered since this value changes from check to check. The available variables are:

- {BChkNo} Check number pulled from bank record.
- {CChkNo} Check number printed from accounting software.
- {DocNo} Check number passed from accounting software (Does not appear in drop down menu).

✔ **Often {DocNo} and {CChkNo} are interchangeable.**

BBBBBB Check number pulled from bank record with the number of digits specified by the number of letters. Left filled with zeros. You can choose 6 or 8 digits.

CCCCCCC Check number passed from accounting software with the number of digits specified by the number of letters. Left filled with zeros. You can choose 6 or 8 digits.

Select the appropriate variable from the drop down menu. See the *Installation Notes* specific for the accounting software for a recommendation.

- **Include US Funds flag...**
- See *Character 45* below.

**CHECK FORMAT TYPE**
The check style only determines the order of the components for the MICR line on the check. This does not impact the actual style of the check form. Select the appropriate style for the check stock that is going to be used.

- **Standard 8.5” Business Check**
  Standard interfaces use this style. Usually this is for a check between 7” and 8.5” wide.

- **Small 6” Wallet Size Type 1:**
  This option is for a wallet-sized check with the check number on the far right of the MICR line.
Small 6" Wallet Size Type 2:
This option is for a wallet-sized check with the check number in the middle of the MICR line.

Deposit Slip:
This option is for printing deposit slips that do not have a check/document number. Only the bank routing number and account number will appear.

Custom (Enter MICR line directly):
The MICR line may be edited directly instead of editing the individual components. This allows any formatting required by your bank. This option enables the "Custom Format" field at the bottom of the window. The MICR characters will adjust accordingly.

CUSTOM FORMAT
This section displays how the MICR line will appear when printed. The field updates to reflect changes made in the individual components. On rare occasions, it is better to modify the line directly rather than use the individual components. This requires selecting the Custom option under Check Format Type.

Each character (including blank spaces) must be entered exactly as it is received by the bank. A common MICR string would be similar to the following:

/{BChkNo}/[123456789[123-12345/]

The variable associated with the MICR Line is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>MICR Line</td>
<td>{BMICR}</td>
<td>MICR Line (See #MICR in Chapter 8)</td>
<td>--</td>
</tr>
</tbody>
</table>

SUBSTITUTE CHARACTERS
Whether the MICR line is entered directly or through the individual components, substitute characters and check number variables must be used. Substitute characters replace the special MICR characters with keyboard strokes. Check number variables are used to place the correct check number on each check.

Four characters that may appear in the MICR line of a check cannot be reproduced with any computer keyboard key. Therefore, we have assigned replacement characters for the MICR line characters as listed in the following table:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Represented By</th>
</tr>
</thead>
<tbody>
<tr>
<td>[</td>
<td>Transit</td>
<td>]</td>
</tr>
<tr>
<td>/</td>
<td>On Us</td>
<td>/</td>
</tr>
<tr>
<td>-</td>
<td>Dash</td>
<td>-</td>
</tr>
<tr>
<td>$</td>
<td>Amount</td>
<td>$</td>
</tr>
</tbody>
</table>

MODULUS 9
On occasion, a bank will request a modulus 9 character to follow the check number. PrintBoss will perform the modulus 9 calculation and insert the digit when it sees an asterisk (*) at the end of the check number. To add the modulus 9 calculation to the MICR line, simply insert an asterisk immediately following the check number variable. This can be done by typing in the Check Number field or, if you have the Custom check format type selected, directly in the Custom Format field.

CHARACTER 45
The new Canadian Payments Association regulations suggest a "Character 45" in the MICR line of accounts printing checks drawn on US Dollars. Select the Include US Funds flag… option to add this character.

Miscellaneous
This tab provides miscellaneous variables that can be customized for specific needs.
**MISCELLANEOUS INFORMATION**

The Misc fields are optional and may contain a string, numeric value, or a logo file path and name. The description for each of these fields is editable to add a reminder for the contents of the field. Roll your mouse over the Values field to view the name of the associated variable. The following table outlines all the variables in this section:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Logo</td>
<td>{BMisc1}</td>
<td>Often used to place a 2nd Logo on a check</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 2</td>
<td>{BMisc2}</td>
<td>Miscellaneous Field 2</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 3</td>
<td>{BMisc3}</td>
<td>Miscellaneous Field 3</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 4</td>
<td>{BMisc4}</td>
<td>Miscellaneous Field 4</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 5</td>
<td>{BMisc5}</td>
<td>Miscellaneous Field 5</td>
<td>40</td>
</tr>
</tbody>
</table>

**MISCELLANEOUS FLAGS**

The Miscellaneous Flags return a value of TRUE when checked. The first flag, {BFlag1}, is assigned to the 2nd Signature Line on the Form. Check the flag to enable a second signature line on checks for this specific bank record. Misc Flags 2 – 5 are user definable and have description fields that may be edited as a reminder of their purpose. Roll your mouse over the Values field to view the name of the associated variable. The following table outlines all the variables in this section:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Signature Line</td>
<td>{BFlag1}</td>
<td>Use for a 2nd signature line – YES if checked</td>
<td>--</td>
</tr>
<tr>
<td>Misc Flag 2</td>
<td>{BFlag2}</td>
<td>Miscellaneous Flag 2 – returns TRUE if checked</td>
<td>--</td>
</tr>
<tr>
<td>Misc Flag 3</td>
<td>{BFlag3}</td>
<td>Miscellaneous Flag 3 – returns TRUE if checked</td>
<td>--</td>
</tr>
<tr>
<td>Misc Flag 4</td>
<td>{BFlag4}</td>
<td>Miscellaneous Flag 4 – returns TRUE if checked</td>
<td>--</td>
</tr>
<tr>
<td>Misc Flag 5</td>
<td>{BFlag5}</td>
<td>Miscellaneous Flag 5 – returns TRUE if checked</td>
<td>--</td>
</tr>
</tbody>
</table>

Miscellaneous Information and Flags are independent of each other.

**SPECIAL ITEMS**

Check the Canadian Style Date/Amount box if this bank account requires the newer Canadian format (often referred to as the CPA06 style). This activates conditional formatting in standard PrintBoss Forms. For additional information regarding Canadian check requirements, please see our web site's SUPPORT DOCUMENTS page for Canadian Customers.

**Signatures & Logos**

This tab allows the assignment of bank account specific signature and logos.

If unique placement, resizing, or conditional use based on a required amount is needed, use the appropriate fields to assign properties to the specified file. Entering values in these fields alone has no affect on the forms. Commands must explicitly reference the variables associated with these fields in order to activate the conditions in a form. Hold your cursor over a field to view a pop up hint showing the variable name associated with the field. The variable name can be used in a form to reference the field.

📖 See Chapter 9, Form Files, for further information.

**LOGO PROPERTIES**

PrintBoss can read logo files in BMP, PCX, and JPG file formats. PrintBoss will assume the location of a file entered in this field is the LOGOS folder under the PrintBoss HOME DIRECTORY. Otherwise, the full path and file name need to be entered. Use the browse button (folder icon) to select a file and enter the correct path and file information. The variable associated with the Logo Properties field is:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo Properties</td>
<td>{BLogoFile}</td>
<td>Logo file name, Ex: Mycompany.jpg</td>
<td>40</td>
</tr>
</tbody>
</table>
NOTE:

Logos will not view or print when the file path and name exceeds 40 characters.

**Signature and Signature 2 Properties**

PrintBoss can read signature files in BMP, PCX, SIG, and JPG file formats. PrintBoss will assume the location of a file entered in this field is the LOGOS folder under the PrintBoss HOME DIRECTORY. Otherwise, the full path and file name need to be entered. Use the browse button (folder icon) to select a file and enter the correct path and file information. The variables associated with the Signature Properties fields are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signature Properties</td>
<td>[BSigFile]</td>
<td>Signature File Name, Ex: JohnSmith.sig</td>
<td>40</td>
</tr>
<tr>
<td>Signature 2 Properties</td>
<td>[BSig2File]</td>
<td>Second Signature File Name; this signature will appear on the top signature line</td>
<td>40</td>
</tr>
</tbody>
</table>

NOTE:

Signatures will not view or print when the file path and name exceeds 40 characters.

**Position**

These coordinates are used to place files of any size on a form. Coordinates are measured from the edge of the paper to the top left corner of the file, not the graphic, by default. A different justification can be set in the associated command (i.e. #PIC). The variables associated with the Position fields are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo X</td>
<td>{BLogoX}</td>
<td>X Coordinate for logo</td>
</tr>
<tr>
<td>Logo Y</td>
<td>{BLogoY}</td>
<td>Y Coordinate for logo</td>
</tr>
<tr>
<td>Signature X</td>
<td>{BSigX}</td>
<td>X Coordinate for signature</td>
</tr>
<tr>
<td>Signature Y</td>
<td>{BSigY}</td>
<td>Y Coordinate for signature</td>
</tr>
<tr>
<td>Signature 2 X</td>
<td>{BSig2X}</td>
<td>X Coordinate for signature 2</td>
</tr>
<tr>
<td>Signature 2 Y</td>
<td>{BSig2Y}</td>
<td>Y Coordinate for signature 2</td>
</tr>
</tbody>
</table>

**Options**

These fields are for additional options available for the file, such as size or watermark.

See Chapter 9, *Form Files*, for further information on the #PIC command.

The variables associated with the Options fields are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo Options</td>
<td>{BLogoOp}</td>
<td>Optional properties for logo file</td>
</tr>
<tr>
<td>Signature Options</td>
<td>{BSigOp}</td>
<td>Optional properties for signature file</td>
</tr>
<tr>
<td>Signature 2 Options</td>
<td>{BSig2Op}</td>
<td>Optional properties for signature 2</td>
</tr>
</tbody>
</table>

**Range Condition**

Typically used for signatures, this option can indicate a low and high dollar amount to limit when the signature prints. The variables associated with the Range Condition fields are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo Hi</td>
<td>{BLogoHi}</td>
<td>Maximum $ for AmountRange condition – typically used only if the logo is an additional signature</td>
</tr>
<tr>
<td>Logo Lo</td>
<td>{BLogoLo}</td>
<td>Minimum $ for AmountRange condition – typically used only if the logo is an additional signature</td>
</tr>
<tr>
<td>Signature Hi</td>
<td>{BSigHi}</td>
<td>Maximum $ for AmountRange condition (optional)</td>
</tr>
</tbody>
</table>
Size
PrintBoss is able to resize a file down to 10% and up to 300% of the original size. These fields indicate a change in either the specific size in inches using width (Wdt) and height (Ht) or a percent. Either percent or inches should be used – not both. The variables associated with the Size fields are:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo Width</td>
<td>{BLogoWd}</td>
<td>The Logo Width in inches</td>
</tr>
<tr>
<td>Logo Height</td>
<td>{BLogoHt}</td>
<td>The Logo Height in inches</td>
</tr>
<tr>
<td>Logo Percent</td>
<td>{BLogoSize}</td>
<td>Logo size adjusted by Percent from 10% - 300%</td>
</tr>
<tr>
<td>Signature Width</td>
<td>{BSigWd}</td>
<td>The Signature Width in inches</td>
</tr>
<tr>
<td>Signature Height</td>
<td>{BSigHt}</td>
<td>The Signature Height in inches</td>
</tr>
<tr>
<td>Signature Percent</td>
<td>{BSigSize}</td>
<td>Signature size adjusted by percent from 10% - 300%</td>
</tr>
<tr>
<td>Signature 2 Width</td>
<td>{BSig2Wd}</td>
<td>The Signature Width Size in inches</td>
</tr>
<tr>
<td>Signature 2 Height</td>
<td>{BSig2Ht}</td>
<td>The Signature Height Size in inches</td>
</tr>
<tr>
<td>Signature 2 Percent</td>
<td>{BSig2Size}</td>
<td>Signature size adjusted by percent from 10% - 300%</td>
</tr>
</tbody>
</table>

Security
Security can be added to each Bank Record to define the users who may access the Bank Record. This process is outlined in Chapter 8, Bank Accounts and is separate from the Password section on the Primary tab.

ACH Definition
The ACH Definition tab may be used to enter data to be used in creating an ACH file for this bank record according to the NACHA Operating Rules and Guidelines.

File Header Record Fields
These fields are used in the SignOn tab of the ACH File and are defined in the bank record. They apply to every record in the file.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate Destination</td>
<td>{bACHImdDstNo}</td>
<td>Contains a space followed by the 9 digit routing number of the ACH Operator or receiving point where the file is being sent.</td>
</tr>
<tr>
<td>Immediate Origin</td>
<td>{bACHImdOrgNo}</td>
<td>Contains a space followed by the 9 digit routing number of the ACH Operator or sending point that is sending the file.</td>
</tr>
<tr>
<td>Immediate Destination Name</td>
<td>{bACHImdDstName}</td>
<td>Optional. The name of the ACH receiving point; 23 characters.</td>
</tr>
<tr>
<td>Immediate Origin Name</td>
<td>{bACHImdOrgName}</td>
<td>Optional. The name of the ACH sending point; 23 characters.</td>
</tr>
<tr>
<td>File Mode ID</td>
<td>{bACHFileIDMode}</td>
<td>Increments beginning at A for multiple files in a day; 1 character.</td>
</tr>
<tr>
<td>Pre-Note Override</td>
<td>{bACHPreNote}</td>
<td>Global override of the PreNote setting. This should only be used once, the first time an ACH batch is processed. The values are N or Y.</td>
</tr>
</tbody>
</table>

Company Batch Record Fields
These fields are used in the Header tab of the ACH File and are defined in the bank record. They apply to every record in a batch.
### Saved Banks

Banks are saved in a file located at the root of the PrintBoss Home directory. The main bank file is Banks.pbb. You may also see Banks.smt and Banks.nsx. A history of changes is also kept at the root of the PrintBoss Home directory. There files are numbered sequentially beginning with Banks000.pbb. It is prudent to keep a backup of the most current version of Banks.pbb in the event your server or computer crashes.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Class Codes</td>
<td>{BACHSvcClassCode}</td>
<td>Identifies type of ACH file; 3 characters.</td>
</tr>
<tr>
<td>Company Name</td>
<td>{BACHCompName}</td>
<td>Name of the Company or Payee; 16 characters.</td>
</tr>
<tr>
<td>Company Discretionary Data</td>
<td>{BACHCompDisc}</td>
<td>Optional. Allows Company to include codes of significance only to them to enable specialized handling of all entries in the batch; 20 characters.</td>
</tr>
<tr>
<td>Company Identification</td>
<td>{BACHCompID}</td>
<td>An alphanumeric code used to identify the Originator; 10 characters.</td>
</tr>
<tr>
<td>Standard Entry Class</td>
<td>{BACHStdEntryClsCod}</td>
<td>This field holds various predefined character abbreviations representing standard descriptions. Ex: CCD (Corporate Credit or Debit).</td>
</tr>
<tr>
<td>Company Entry Description</td>
<td>{BACHCompEntry}</td>
<td>Provides a description for the purpose of the transaction. Ex: Payroll; Water Bill; etc., up to 10 characters.</td>
</tr>
<tr>
<td>Originating DFI Identification</td>
<td>{BACHOrgDFIID}</td>
<td>Bank routing number plus ABA number with no leading space; 8 characters total.</td>
</tr>
</tbody>
</table>
APPENDIX B: FORM EDITOR

The following detail applies to PrintBoss Form Files. Form Files capture data from accounting software and use scripts to add additional objects or format captured text.

FORM EDITOR

The Form Editor has several tabs and options for customizing forms or handling special needs. Some of the tabs only display when they are selected. The following provides descriptions for the options available on each of the primary tabs on the Form Editor.

**Settings**

This tab contains general settings for the form including the form size and orientation, the number of copies, archiving options, and whether the form will require a keystroke acknowledgment to start printing. The order copies of the form will print is determined here as well.

**DESCRIPTION**

This field contains a brief description of the purpose of the form and often identifies the accounting software associated with the form. This information is kept when a new form is copied from an older form.

**FORM DATE**

The date & time the original form was created. This information is kept when a new form is copied from an older form.

**INTER FORM DELAY**

This field inserts a pause between each page processed with the form. The length of the pause is measured in seconds. Zero indicates no pause.

**FORM NEXT NUMBER**

This field is used to provide independent numbering on the form. This is NOT recommended for checks. This field is typically used for other types of forms, such as invoices. Once the option is activated (check the box), a next number can be designated. Each time a document is created with this form, PrintBoss will increment the number by one. There is no confirmation dialog for the number.

The number can be used in the form by referencing the variable {FormNextNumber} in a command. More information about variables is provided in the Form File Commands section later in this chapter.

**CAPTURED TEXT TREATMENT**

This section allows PrintBoss to format the font of the text captured from the accounting software, changing the original font. These settings are global for all of the data from the accounting software using this form. This DOES NOT override #TEXT commands.
X, Y Text Offset
This option provides a global offset of the placement of all the data from the accounting software. This is typically used for centering data on the page.

Font Override
This option designates a specific font style to be used for the data from the accounting software in place of the font passed with the data. This does not override #TEXT commands.

Point Adjust
This field increases or decreases the original font size by the number indicated: 0 = original size, 2 = increase the original size by 2 points. A negative number decreases the original size. The Point Adjust field will be ignored when there is a font description in the Font Override field.

Ignore Text Between
PrintBoss will remove any incoming data on the page within the vertical coordinates of this option. The full width of the page is assumed. The coordinates measure in inches from the top edge of the page.

TEXT / IMAGE CAPTURE MODE
This field is typically set to Text Only is captured. The alternate method is Text AND Graphics are captured. The following options are available when Text AND Graphics are captured.

Graphic Image
This option is only available for PrintBoss Enterprise edition using the PrintBoss 50 driver and allows graphic images to pass to PrintBoss.

Graphic Text
This option allows graphic text to pass through to PrintBoss. This is often necessary for printing from PDF file formats, such as QuickBooks Online.

Adj.
This option only applies to the Graphic Text option. PrintBoss will automatically switch to Captured Text option when Adj. is selected and the source is from an NT40 work file.

Captured Text
This is the typical capture by PrintBoss. Checking only this box is the same as using the Text Only option for the capture mode.

Default
Clicking this box sets the check boxes back to their default settings (Graphic Image & Captured Text checked, Graphic Text unchecked).

FORM WIDTH, LENGTH
This is the measurement of the form's size in inches followed by the standard paper size option. The paper size option can be changed if it does not match the data sent from the accounting software.

SIZE/ORIENTATION ALERTS
PrintBoss has a feature to alert the user when the page size and orientation do not match the information passed by the accounting software. The choices are: Suppress Alerts (no alert will be provided), Orientation Mis-Match, and Orientation or Size Mis-Match.

PRINTER PAPER SIZE
When PrintBoss prints this form, it will NOT tell the printer what paper to select when this options is set to Default. The other options will tell the printer to use the specified paper size.

COPIES
Enter a value from 1 to 7 in this field to set the number of COPIES PrintBoss should generate: 0 = 1 original and no copies, 1 = 1 original AND 1 copy (2 pages), etc. PrintBoss can generate the original plus up to 7 copies.

If at least 1 copy is designated, the order of the copies needs to be set. Click on the drop down menu for the field after copies and select Documents to print the original and all of the copies for the first page prior to the second page. Copy Type prints the originals for all pages first, then copy 1 for all pages, then copy 2 for all pages, and so on for as many copies as are specified for the form.
**Special Handling**

- **No Special Handling**
  PrintBoss will not pause between copy types

- **Pause Printing Between Copy Types**
  PrintBoss will pause between copies to allow paper to be changed when Copy Type is selected and this option is checked. The user will be prompted to confirm the paper has been changed before printing the next copy type. This is typically used when only one paper tray is available and check copies are printed on blank paper. Another common use is with Invoice type documents where each page requires a different paper color and the paper needs to be changed in the tray after each copy.

  This option is only available when printing one or more copies and *Copy Type* is selected.

- **Send as a single print job**
  PrintBoss will send all of Copy 1, then all of Copy 2, etc., but it will not pause the process to change paper. This is often helpful when sending a print job to a printer with a stapling function or when using Copy Type to streamline the sending of Emails or Faxes.

**Forms Per Page**
Enter a value to determine the number of forms printed on a single piece of paper. This might be more than 1 when printing wallet sized checks. A value of zero is not valid and will generate an error message.

**Ask 1st Page**
This option is only available when printing more than one form per page. The feature is most commonly used when printing 3 checks per page and the last check run only printed one or two checks on the last page. PrintBoss prompts the user to enter the number of checks to print on the first page of the run to allow all portions of the page to be used.

**Orientation**
No orientation request is sent to the printer when this option is set to Default. Choose portrait or landscape to send an orientation command change to the printer. This command overrides the default of the printer at time of printing.

**Work/Archive File Compression**
This feature is rarely used. It allows for slight compression of the work and archive files to save space.

**Work Files Indexed at Creation**
Indexing the work file automatically prepares it to be sorted in an order other than generation. Generation is the order the work file batch was sent by the accounting software.

**Archive Files Indexed at Creation**
Indexing the archive file automatically prepares it to be sorted in an order other than generation. Generation is the order the archive file batch was sent by the accounting software.

**Default Print Order**
If either the archive or work files are indexed at creation, this option will designate the order the documents should be printed. The default value (Natural Order) is the order generated by the accounting software. The other choices are Recipient, Amount, Doc Number, Misc Field, Bank, Misc2 Field, and Payee ID.

**Immediate Print Dialog Method**
Typically, this field is set to start printing without a prompt. A prompt may be preferred to confirm printer availability. In this case, select *Prompt to start printing*. PrintBoss will open the *Print Copies Dialog* and wait for the user to click on the *Print Start* button before the print job is sent to the printer.

**Collapsed When Opened**
Select this checkbox to collapse the bottom portion of the Print Copies Dialog from the Scope down when it is opened by PrintBoss.
**Auto-Archiving Completed Records**

Every time PrintBoss processes a batch of documents, the records are sent to a work file. Any copies of the form set to *Immediate* in the Multi-Parts & Printers tab will print immediately. This option controls what happens to the work file both before the batch begins and after the batch is processed.

*None (Manual)* – The work file for this form is appended each time data is sent to PrintBoss and will grow indefinitely.

*Archive Completed Records* – The files are transferred from the work file to an archive file of the same name when all copies of each record have been successfully processed. *Archive Records w/Prompt* prompts the user before transferring the records.

*Delete Completed Records* – The work file records are all deleted when all copies of each record have been successfully processed. Historical information is not available once the work file is deleted. *Delete Records w/Prompt* prompts the user before deleting the records.

*Overwrite Work File at Start of Batch* – Each time a new batch of data is sent to PrintBoss the new batch overwrites the previous work file for the form. All documents in the current work file, regardless of the status, are overwritten. Files not processed (printed, faxed, emailed, etc.) are lost. The resulting work file always contains the latest batch of documents sent to PrintBoss.

*Archive Records after _ days* – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when the completed records are automatically transferred to archives. The largest available value is 299999. *Archive Records after _ days w/Prompt* prompts the user before transferring the records.

*Delete Records after _ days* – PrintBoss displays a *Days till Archiving* field when this option is selected to allow the user to input when the completed records will be deleted. The largest available value is 299999. *Delete Records after _ days w/Prompt* prompts the user the records are deleted.

*Archive Work File at Start of Batch* – Completed work file documents are automatically transferred to Archives at the start of the next batch printed to the same PrintBoss file. The resulting work file always contains the latest batch of documents sent to PrintBoss.

If no choice is of particular interest, the recommended option is *Overwrite work files at start of batch*. This setting requires little maintenance and is easier to troubleshoot when the need arises.

**Special Controls**

This tab gives note to special requirements for the form.

**Minimum PrintBoss Version Required for this form**

This field identifies the oldest version of PrintBoss that can successfully use this form. Older versions of PrintBoss do not have all of the features accessed by this form. An error message will appear if this form is accessed by an older version warning PrintBoss should be updated to allow full functionality of the form.

**Requires input from PB50 printer driver**

Features on some forms may require the use of the PB50 printer driver to work correctly instead of the NT40 printer driver. This option will be checked when the PB50 printer driver is required for full functionality of the form.

**Log File Mode**

This field is usually set to No Logging. Change the setting to *Text Log* to create a text file that will record each printing/processing action of a document page. Each line will include the date, time, and operator name.

**Log File Name**

This field displays the name of the file created when the *Log File Mode* is set to *Text Log*. The default value may be changed.

**Wellspring Stock No**

This field displays the Wellspring paper stock item number to use with this form. Click on the link for the Wellspring Software web site to order additional checks and paper stock. The link opens to the check stock page of the online store.
**Zero Fill Check Number**
This field will add the designated number of zeros to the left of the check number for all accounts that use this form.

**Documents Per Input Page**
This field indicates the number of documents passed by the accounting software on a single page. Often this is used with wallet style checks. Enter the height of the document in the Input Document Height field. The value in this field is 1 when only one document per page is passed.

**Input Document Height**
Indicate the height of each document when more than one document per page is passed from the accounting software. This field is not available when there is only one document per page. (See Documents Per Input Page above).

**Enable Printing on back of Page**
This is the duplex printing option in PrintBoss and allows printing on the back of a form. A duplex printer is required to use this option and the duplexer option on the printer must be activated. An additional tab called Page Back Objects will appear in the form editor when this option is checked. Commands entered on this tab will appear on the reverse side of the form.

If this feature is activated while using a printer that does not have an activated duplexer, the back page will print as a separate page.

**Pre-process Assignments**
Click on the drop down menu and select Special to cause PrintBoss to process the assignments in the Runtime, Footer, Page Back, and Design Objects tabs before processing the rest of the document.

✔ This must be active when there is a #PaperBin, #SkipPage, or #ProcessPage command in use.

Activation of the Pre-process Assignments feature may slow the printing process slightly.

**Scan Form for {BankChkNumInc}**
Select this field to include the {BankChkNumInc} variable in the pre-processing of assignments when Pre-process Assignments is active. This variable increments the ‘Next Check Number’ in the PrintBoss bank record.

**Suppress Confirmation of Check Num.**
Check this field to suppress the Check Number Confirmation pop up for the form. This is especially helpful when using two accounting packages – one that passes check numbers and one that does not. This setting can always be checked on the forms for the accounting packages that DO pass check numbers.

**Flip Top to Bottom when Printing**
Check this setting to print the bottom edge of the document first. This is often used when the bottom margin of the printer is too large for correct placement of the MICR line. Check paper needs to be rotated 180 degrees in the paper tray for this to work.

**Access**
This feature is used to limit some tabs from appearing in the Form Editor. Most notably, the Design Objects and Proprietary tabs are not currently used on standard forms. RunTime, Footer, and Page Back Objects tabs can also be disabled. This button requires an access code to enable or disable tabs. The Access Code is the same as the Security Master Password.

**Standard Shade**
Adjust the shade often used in many graphic objects, such as the legend area of a grid, with this option. It may be desirable to lighten or darken shaded areas when using some printers.
**Security Stamp String**
This field is an additional security feature. Select a security stamp from the drop down menu and reference the (SecurityStamp) variable in the form (usually with a #Text command) to place the security stamp information on each document using this form.

**Work File Name Suffix**
Select or enter a suffix to attach to each work file name (optional).

Dynamic components can be used as the suffix in the Enterprise edition. For example, enter {YYYY_MM} in this field for the Ca_ap1 form to date stamp the work file. A new work file will be created each month stamped with the year and month: Ca_ap12007_09.

**Archive File Name Suffix**
Select or enter a suffix to attach to each work file name (optional). This function works in both the Standard and Enterprise editions of PrintBoss.

---

**Block Mirrors**
This tab defines an area of the form and copies it to another area of the same page. Define the top and bottom edge of an area (or Block). The entire width of the page is automatically included in the defined area. The mirrored copy can be the same height or it can be resized either smaller or larger. Check Enable any mirror copies to use Block Mirrors.

This feature is most frequently used to duplicate a stub section or, as in many standard interfaces, to copy the check and stub sections into the mini copy at the top of the page.

**Suppress Block Mirror on these copies**
Enter a copy number, such as 1, to suppress Block Mirrors on that copy. This is often used when Overflow is printed with the check batch.

**Start of Source Block**
Enter the top edge of the area to be copied.

**End of Source Block**
Enter the bottom edge of the area to be copied.

**Destination Size**
Enter the height of the destination area to place the copy. PrintBoss will compress or stretch the original block to fit within the designated space.

**Top of Destination 1**
Enter the top edge of destination area where the mirrored copy should start.

**Top of Destination 2**
Enter the top edge of a 2nd destination where the mirrored copy should start. (Optional. Enter zero to disable).

**Top of Destination 3**
Enter the top edge of a 3rd destination where the mirrored copy should start. (Optional. Enter zero to disable).

**Text Font Size Calculation In Dest Block**
This section adjusts the font size in the mirrored copy section. By default, the font size is reduced (or enlarged) using the same percentage applied to the whole block. This default value is displayed in gray and cannot be edited. Often, the text is hard to read when the block is a reduced. This setting allows you to increase the font size a little for readability. The down side of increasing the font is at some point the lines of text will start overlapping each other or the outline of the destination block. A bit of trial and error will allow you to pick a reasonable compromise between readability and staying true to the original block.
FORCE Font Size to This Percent of Original
Enter a different percent to override the automatic sizing when text is difficult to read. It can be helpful to separately control the reduction percentages between captured text and text that is part of the form design in PrintBoss.

Captured
Adjust the size of captured fonts as a percent of the original size. This field is not available if the capture font has an override that indicates no compression in copies (indicated as a + after the font size in the captured font description).

#Text
Adjust the size of text items placed with #Text commands. This will not impact any items that have a font description forcing no compression in the copies.

See Chapter 10, #Text Command, for more information.

Multi-Parts & Printers
These settings relate to individual copies of the form.

Copies
This is a list all of the copies activated for this form, including the original. (See Settings / Copies). Copies are numbered sequentially.

Print Time
Select whether a copy (or original) prints immediately, is sent to a batch in the work file to be processed later, is never prints.

Destination Printer/Device*
Define the destination or printer for the selected copy. The destination choice defines the Source Tray selections.
Destination options include printers as well as other PrintBoss functions such as Fax, Positive Pay, PDF, and E-mail. When PDF is selected as a destination, a new PDF tab will appear in the Form Editor once another tab is selected.

See Chapter 20, Positive Pay, Chapter 18, E-Mailing, and Chapters 16 and 17 on Faxing and Fax Service, respectively. Also see section on PDF later in this section.

Blank
A page symbol will appear in the blank column between Destination Printer/Device and Source Tray when Destination Printer/Device is set to <Positive Pay>. Click on the page symbol to open the Positive Pay/ACH File Editor.

Source Tray*
Choose the appropriate paper tray for the selected copy. The tray options are defined by the printer selected in the Destination Printer/Device column. The tray names are sent by the selected printer driver and do not always correspond to the tray names on the hardware. Test each tray to find the one desired. Note that anytime the printer is changed (like in the Destination Printer/Device column or by changing the PrintBoss Default printer) the tray selection will be reset to Default.

This field also allows the selection of Embedded or an existing Positive Pay File when Destination is set to <Positive Pay File>.

NOTE:
Selection of a manual tray will result in a physical prompt from the printer hardware for each document. Find a tray selection that pulls from the correct tray without the prompt. This can still be the manual feed tray.
**COPY NAME**
This field is provided as a label for the different copies and can be used as a reminder. The copy name will appear in the *Print Documents* dialog. This value can also be referenced by a command in the form using the {CopyName} variable. For example, #Text can use this variable to print Original or Packing Slip on the associated documents.

**PRINTER & TRAY SELECTIONS SAVED IN..**
PrintBoss allows the settings on the Multi-Parts & Printers tab to be saved by Form or User. *Form* is a global setting that shares the features marked with an asterisk ( * ) on this tab with everyone using this PrintBoss license. If one person in the group changes the destination of a form to a new printer, all users will print to the new destination. *Locally* is also a global setting, but it allows each user to save their own settings. If an individual changes the print destination, no one else is affected.

A third option, *Independent*, allows individual users to choose between the global Form settings or their own Local settings. When Independent is selected, a second drop down menu appears to allow the user to choose the Form setting or Local setting for each situation.

**FORM PRINTER/DEVICE**
This feature appears in versions of PrintBoss prior to 5.3 and is available after 5.3 as a setting on the Legacy tab under Options / Configuration.

Set the printer/device for this form. Any copy whose *Destination Printer/Device* is set to *<Form Printer>* will use this value as its destination. If the value of this field is set to *<Default PrintBoss Printer>*. PrintBoss will use the printer selected under *File / Printer Setup* from the main screen of the PrintBoss application. The drop down menu will list all printers available to this workstation or user.

The default Destination Printer/Device setting for most forms is *<Form Printer>* and the default Form Printer/Device is *<Default PrintBoss Printer>*. In this case, the printer selected under *File / Printer Setup* will determine the printer for all copies of the form.

NOTE:
PrintBoss is very literal with printer names. If a printer name changes by a single character, PrintBoss will see it as a new printer.

**Comments**
The Comments tab contains notes associated with this form – often a version number or customization reminders.

**Design Time Objects**
This edit group allows backward compatibility of forms. It is no longer used in the creation of new forms.

This tab may appear in older forms. However, it does not appear in most of Wellspring Software's currently distributed form files. It will no longer appear in new forms when clicking on *Create* in the Form Select window.

NOTE Regarding Runtime & Footer Tabs:
Virtually all commands defined later in this chapter can be entered in either the RunTime or Footer tab. The result of the command can be affected by whether it is placed in the RunTime or Footer tab. This is due to the order the scripts are processed. PrintBoss processes the RunTime script first. #Assign statements telling PrintBoss the location of data elements coming from the accounting software are often included in the script. Then PrintBoss processes all the data that is captured from the accounting software, including the actual values of the assigned variables. Finally, it processes commands in the Footer Objects. Any commands that use one of these assigned/captured values will need to be placed in the Footer section. If they were placed in the RunTime section, they would be blank since the data is not captured at that point.

**RunTime Objects**
This edit group allows the user to implement any of the PrintBoss commands listed later in this chapter. These commands provide the ability to create any form design the user may require.
Assignments made in this tab can only be used in the Footer or Page Back Objects tabs unless the Pre-process Assignments option is selected on the Special Controls tab.

See Chapter 9, Form Files, for more information on #Assign.

**Footer Objects**

This group of design objects is processed at the end of printing the form. The same commands are available in this group but they are processed after all of the other commands.

Variables assigned in the RunTime Objects tab can be referenced here (see #Assign in Chapter 9).

**Proprietary Objects**

Occasionally the Proprietary Tab may appear. This is similar to the RunTim Objects tabs and holds commands that need to be processed prior to the Footer Objects Page. Often this tab will contain scripts used with ACH.

**Misc**

The Misc tab allows users to import and manage jpg or bmp files to use in the background of a PrintBoss form. A #Pic command must reference this file in the RunTime Objects section of the form in order to view or print the graphic. The graphic is selected by clicking on the button at the end of the Graphic File option on the Pic Command Properties window.

This tab also includes special treatment of key fields during the creation of the PrintBoss Work File. These fall into the following two categories.

**KEY FIELDS RE-CALC FORWARD**

This section provides options that allow PrintBoss to carry forward or re-calculate values from selected fields under special circumstances. This area is primarily for use by a Wellspring Software Technician.

**KEY FIELDS RE-CALC BACKWARDS**

This section provides options that allow PrintBoss to process documents backwards immediately after they are processed forward for the purpose of counting or calculating values from the end of a group or file. This area is primarily for use by a Wellspring Software Technician.

**Page Back**

This tab only appears when the Enable Printing on Back of page option is enabled on the Special Controls tab. This script uses commands the same way as Footer Objects, but all items will appear on the reverse side of the page.

A printer with duplexing capabilities is necessary for this page back feature to function properly. If duplexing is not activated, the page back information will be printed on a separate page.

**PDF**

This tab only appears when the Destination Printer/Device in the Multi-Parts & Settings tab is set to PDF.

**DESTINATION FILE NAME**

Enter a path and filename to store the PDF file.

Example: C:\PDF\Invoices\inv.pdf

- Click the information button to view instructions for creating dynamic file names. It is often helpful to include the date and time as part of the file name or path. Variables from the form can also be used, enabling values like Company Name or Invoice Number to be part of the file name or path. Counter characters may also be used at the end of a file name to dynamically increment a sequential number.

Example: C:\PDF\Invoices\{YYYYMMDD} \{DocNo\}
CONFIRM DESTINATION FILENAME AT RUNTIME
Enable this option to provide a pop up window displaying the current destination for the file. The prompt will allow the destination to be changed before printing the documents.

NEW FILE NAME GENERATION
This option determines when a new PDF file name is created.

- **Start of Batch**
  Create a new PDF file at the beginning of each batch.

- **Each New Page**
  Create a new PDF file for each page.

- **Each New DocNo**
  Create a new PDF file for each new document number. This option assumes the form is utilizing the {DocNo} variable. This option should be used whenever variables are used in the PDF File Name. The use of variables in the File Path or Name is only available in the Enterprise edition of PrintBoss.

APPEND OVERWRITE METHOD
Select the appropriate option to Overwrite existing File automatically, Append to existing File automatically, or prompt the user to choose Overwrite, Append, or Cancel. Note the Append option is only available for PDF and Tiff files.

FILE TYPE
The default file type is PDF. However, Tiff, JPG, and BMP files can also be created. The File Properties section changes to display options for the chosen file type. The Append option is only available for PDF and Tiff files.

PDF FILE PROPERTIES

- **Resolution of PDF File**
  Choose the resolution of the PDF in DPI (Dots Per Inch). Typically, the best resolution for a black and white document is 300 dpi (the default setting). Higher DPI values will generate a larger PDF file. Choose the 216 dpi - Color setting if there is color in the PDF file. The best choice for most cases is 216 dpi - Color.

- **Searchable Text PDFs**
  Select this option to create a searchable PDF file. PDF readers, such as the Adobe PDF Reader, will be able to search for specific text in this file.

  **NOTE:**
  Selecting the ‘Searchable Text PDFs’ feature will remove any hyperlinks from the document.

- **Embed TrueType Fonts**
  Select this option to permanently embed TrueType Fonts into the PDF file. This increases the size of the file, but it maintains the look and size of the fonts. Otherwise, a substitute font may be used and the text could appear smaller. This option is only available when the Searchable Text PDFs option is selected.

SECURITY
PrintBoss Enterprise users may activate additional security that is recognized by all PDF readers.

- **View Only**
  Select this option to only open and read PDF files. No printing.

- **Un-changeable in a PDF editor**
  Select this option to prevent anyone from opening the file in a PDF Editor and making changes.

- **Password to open PDF**
  Enter a password that must be used to open and read the PDF file. One password is assigned to all PDF files. No variables can be used here. A dynamic password may be assigned in the Form’s Footer Objects section. The use of a Variable to define a dynamic password is only available in the Enterprise edition of PrintBoss.
TIFF FILE PROPERTIES

Compression Method
Choose a compression method if you need to reduce the size of the TIFF file. The default value is No Compression All Colors. The choices are the standard compression methods for a TIFF file.

Changes to the Compression Method also affect the color depth of the file. The best color depth is True Color (24bit). Higher color depth will generate larger TIFF files. Some color depth choices are not available with certain Compression Methods.

Resolution (DPI)
Choose the resolution of the TIFF in DPI (Dots Per Inch). Typically, the best resolution for black and white documents is 300 dpi. Higher DPI values will generate larger TIFF files. The default value is 150.

JPEG FILE PROPERTIES

Quality
Choose a Quality setting if you need to reduce the size of the Jpeg file. The default value is 75 with 100 as the best. Click on the right arrow to access a slider bar to choose a different quality level. The slider moves in increments of 5.

Resolution (DPI)
Choose the resolution of the Jpeg in DPI (Dots Per Inch). Typically, the best resolution for black and white documents is 300 dpi. Higher DPI values will generate larger Jpeg files. The default value is 150.

BMP FILE PROPERTIES

Resolution (DPI)
Choose the resolution of the BMP in DPI (Dots Per Inch). Typically, the best resolution for black and white documents is 300 dpi. Higher DPI values will generate larger BMP files. The default value is 150.

Positive Pay
Positive Pay is no longer a tab on the Form Editor. Instead, a separate window can be opened by clicking on the page symbol to the right of the <Positive Pay File> Destination.

See Chapter 20, Positive Pay, for additional information.

FORM FILE COMMANDS

Form File commands are used to accomplish various tasks in PrintBoss. These commands are entered on the Object tabs for the Form Editor. The following is a description commands not included in Chapter 9.

#AssignLines

#AssignLines <VarName>

This is used to assign several lines of data at one time. This is very similar to the #Paragraph command. It appends all lines after the #AssignLines command until another #command is encountered. It is recommended that a #Rem command be placed at the end of the paragraph of lines after the #AssignLines command.

For example:

#AssignLines EmailBody
Thank you for your order from Wellspring Software, Inc.
The invoice for your order is attached to this e-mail for your convenience.
The original paper invoice is being mailed.
Please call us with any questions.
#Rem – end of EmailMsg

Once assigned, the variable is actually a multiple line variable. See the Multi-Line Variables section in Chapter 9.
#AssignmentsBlock

#AssignmentsBlock X1, Y1, X2, Y2 or #AssignmentsBlock Y1, Y2

This command is used to capture a group of assignments made in a specification or report. It allows variable names and values to be assigned dynamically from the host. The first text object on any line within this block becomes a variable name and the following text objects become the value (more than one object is appended together). All text within the block can be blanked out after capturing.

For example, assume the following lines are in the defined block:

```
DocNo         1234
DocRecip      John Smith
DocAmnt       $1,200.00
```

PrintBoss reads the first text object in each line (i.e. DocNo, DocRecip, and DocAmnt) as the variable names and the second text object in each line (i.e. 1234, John Smith, and $1,200.00) as the variable values.

#Assigns

#Assigns 'VarName', 'Value' [, CaptXRange, CaptYRange [, Options]]

The parameters for #Assigns are identical to the #Assign command (without the ending “s”) and is used to assign a multi-line variable. There are 2 methods to assign a value, though they differ from the #Assign command.

The first method is to simply provide the value by entering the Value parameter. Each time an additional #Assigns command occurs with the same VarName, an additional line is added to the multi-line variable. For example:

```
#Assigns EmailBody, "Thank you for your order from Wellspring Software, Inc."
#Assigns EmailBody, "The invoice for your order is attached to this e-mail for your convenience."
#Assigns EmailBody, "The original paper invoice is being mailed."
#Assigns EmailBody, "Please call us with any questions"
```

The second method to assign a value is to supply coordinates to capture data. Of course it is expected that the vertical range includes a region large enough to capture more than one line. If the option Add together fields in horizontal range is checked, each ROW of text objects will be added together and treated as a single element in the multi-line variable. For example, to capture a variable for the payee lines in a check that occur between 8 and 9.5 inches down the page, the following command might be used:

```
#Assigns PayeeAds, "", 1.183/.0100, 8000-9.500, LRB1WS /This command captures several lines of text at once. These lines can be printed as a group using the VText command.
```

The first value range defines the CaptXRange and the second defines the CaptYRange. The letters and number represent various options for the captured text. For example, B indicates the raw data is blanked out after capture.

See Chapter 9, Form Files – Multi-Line Variables, and Form File Commands – for more information.

#BMP

#BMP X, Y, "GraphicFileName", [Options]

This command prints a graphic on the document and operates the same as the #PIC except that it expects a .BMP file type. It has been replaced in favor of the #PIC command. See #PIC in Chapter 9 for more information.

#Disable / #Enable / #SetEnable

The #Disable and #Enable command pair allow for deactivation of sections of commands. When #Disable is encountered, all commands following it will be ignored until #Enable occurs. At least one of the 2 commands will logically have a condition. (See Conditional Commands in Chapter 9). It is not necessary to have matching pairs.

The #SetEnable [Condition] is an alternate way to enable or disable the processing of commands. For example, #SetEnable [true] is equivalent to #Enable and, likewise, #SetEnable [false] is equivalent to #Disable.
Here is a simple example of using these commands to create blocks of commands (in this case just one text command) that run based on a condition. It must be unconditionally enabled so all further lines will be processed normally.

```plaintext
#SetEnable [Copy, 0]

#Text 1, 10, Arial/12, ‘This is my message for Copy 0’

#SetEnable [Copy, 1]

#Text 1, 10, Arial/12, ‘This is my message for Copy 1’

#Enable
```

Use of the #If / #Endif commands is recommended instead of using #Enable / #Disable / #SetEnable when reasonable. These newer commands are clearer and can be nested more logically.

```plaintext
#Else

See #If / #ElseIf / #Else / #Endif.

#ElseIf

See #If / #ElseIf / #Else / #Endif.

#Enable

See #Disable.

#EndIf

See #If / #ElseIf / #Else / #Endif.

#FileErase

#FileErase <FileName/Path>

This command will erase the file(s) specified by the FileName/Path. The FileName may include an * (asterisk) or ? (question mark) as a wildcard(s). It is mainly used internally by PrintBoss, but is available if needed.

```plaintext
#For N =

#For N = <starting number> TO <ending number> [STEP n.nn]

This command provides a loop to repeat the number of times indicated by the starting and ending numbers. Designate the end of the loop with a #Next N command. By default, each loop will increment the value of n by 1. Append the phrase STEP to the end of the line followed by the desired increment to change the step. All three entry values (Starting Number, Ending Number, and Step) may be decimal numbers (i.e. 1.456). The loop will end at the matching #Next command when the value of n is greater than the ending number after it is incremented by the STEP.

```plaintext
#ForceWinPrintJob

#ForceWinPrintJob

This command forces the Windows print job to end and a new print job to start with a specified page. Typically, a condition is placed on this command. Otherwise, a new print job would be forced with every single page. An example of using this command is to start a new Print Job with each new invoice number so all the pages of the same invoice number can be stapled by an advanced printer that supports stapling by print jobs. The Pre-process Assignments option must be set on the Special Controls tab of the Form Editor for this command to work. For example:

```plaintext
#[Copy,0][!=e, ÷{DocNo}÷, ÷{Prev.DocNo}÷]ForceWinPrintJob
```
See Chapter 9, *Form Files* – Conditional Commands.

**#GoToMarker / #Marker**

The GoToMarker command jumps FORWARD in the RunTime Objects, Footer Objects, or Page Back Objects tabs without considering ANY commands in between this command and its Marker. Even #Enable/#Disable and #If/#Endif commands are ignored. The GoToMarker must be used in conjunction with a #Marker command to identify where PrintBoss should jump. The GoToMarker should not be used to jump into or out of matched pairs of #If / #Elseif / #Else/#Endif commands.

**#HGrid**

#HGrid X1, Y1, X2, Y2, Ya, Yb ...Yz [, Options]

This command creates a frame and then draws horizontal lines to fit into the frame. Options provide further modifications with corner radius, shadow, and edge shading. This is command had been largely replaced by the #Grid command.

**X1, Y1**

These are the coordinates for the top left corner of the frame in inches from the left edge and top of paper. The coordinates may be entered in thousandths of an inch.

**X2, Y2**

These are the coordinates for the bottom right corner of the frame.

**Ya, Yb...Yz**

This parameter represents any number of lines drawn horizontally across the frame. Each line is defined as the distance in inches from the top of the page.

**OPTIONS**

**Radius**

/Rn

where nnn is the radius size. For example, /R.1 is a corner radius of 1/10 of an inch.

**Edge Shading**

/STnnn (Shade Top), /SLnnn (Shade Left), /SBnnn (Shade Bottom) or /SRnnn (Shade Right) where nnn is the width of the edge shade in inches.

**Shadow**

/SHDnnn where nnn is the width of the shadow in inches.

**Line Color**

/LC followed by a number representing a color. The color number can be 4 to 8 digits.

**#If, #ElseIf, #Else, #Endif**

#If [Parameter]

#ElseIf [Parameter]

#Else

#EndIf

Blocks of code can be conditionally processed based on the parameters that follow #IF and #ElseIf commands. There must be a matching #Endif whenever a #If [Parameter] occurs. Optionally, any number of #ElseIf [parameter] sections can follow the original #IF. Finally, a single #Else may occur after the #IF and all #ElseIf, but before the #Endif.

#If/#Endif structures may be nested. They may not stretch from one section to the next, such as going from the RunTime to the Footer section.
Use of the #If / #Endif is encouraged over the #Enable/#Disable/#SetEnable, and neither constructs should pass across the boundaries of the other type. For example:

```c
#If «[FileExists, "{BLogoFile}\"]»
    #If «[Inu, ÷/AB÷, {BLogoOp}]»
        #Pic {BLogoX}, {BLogoY}, "\{BLogoFile}\", "\Size:{BLogoSize} \",,DEFGA
        #Text 0.35, [LastLineYEnd+.03], "Arial/12/B", ÷{BCName}÷
    #Else
        #Pic {BLogoX}, {BLogoY}, "\{BLogoFile}\", "\Size:{BLogoSize} \",,DEFGA
        #Text [LastLineXEnd+.05], 7.750, "Arial/12/B", ÷{BCName}÷
    #Endif
#Else
    #Text 0.350, 7.750, "Arial/13/B", ÷{BCName}÷
#Endif
```

Notice there are delimiters around the parameter. These are created automatically by PrintBoss when you double click on the #IF to enter the parameter(s). The delimiter can be added manually by clicking Ctrl+. This keyboard shortcut only works within the PrintBoss software.

Two or more parameters can be used. Each parameter needs to be enclosed in square brackets [ ]. Two or more parameters default to ‘and’. For example:

```c
#If «[Empty, "\{DDInfo1}\"][!In,'DD','\{CChkNo}\"]»
```

This can be changed to an ‘or’ by adding two pipe symbols || between the parameters as follows:

```c
#If «[Empty, "\{DDInfo1}\"]||[!In,'DD','\{CChkNo}\"]»
```

See PrintBoss Conditional Commands in chapter 9.

### #Lines

**#Lines X1, Y1, X2, Y2, ... Xn,Yn [/Wn.nnn] [/C<color>]**

This command draws a line from point X1, Y1 to Xn, Yn, passing through all the points in between. The width and color are set as options.

### #LineSet

**#LineSet StartingY, LineSpacing**

This command is useful in formatting a series of commands with coordinates that follow one after another. Use this command prior to the first line to define the starting Y coordinate as well as the consecutive line spacing. This is especially helpful in eliminating blank lines from an address used in conjunction with conditional #Text statements.

This command overrides any internal variable, such as {LineY}. The variable{LineY+} will use the current coordinate and increment it internally by the LineSpacing amount.

The following example uses the #LineSet to place the Bank Fractional Code directly under the last non-blank bank address line.

```c
#LineSet 7.9, .15
#Text 3.8, {LineY+}, 'Arial/12', '{BName}'
#If[Empty, BAds1]Text 3.8, {LineY+}, 'Arial/12', '{BAds1}'
#If[Empty, BAds2]Text 3.8, {LineY+}, 'Arial/12', '{BAds2}'
#If[Empty, BAds3]Text 3.8, {LineY+}, 'Arial/12', '{BAds3}'
#Text 3.8, {LineY+}, 'Arial/12', '{BFrac}'
```

### NOTE:

It is more common to use the {LastLineY+n.nnn} variable instead of using this command.
This command calls a Hewlett-Packard printer macro using Windows *Passthrough* printer escape sequence. If $X$ and $Y$ are passed as non-zero, then the cursor control commands will be executed to place the cursor prior to calling the macro.

See #GoToMarker.

This command indicates the end of a loop.

See #For $N =$.  

This command conditionally selects the source paper bin based on dynamic values and overrides the value set in the *Multi-Parts & Printers* tab of the Form. For example:

#PaperBin 261

NOTE: The *Pre-process Assignments* property on the Special Controls tab of the Forms MUST be selected to use the #PaperBin command (EDIT / FORM FILES / <highlight form>/ EDITOR / SPECIAL CONTROLS).

The command expects the numeric ID of the tray in the PaperBin parameter. To determine the numeric ID of the tray: Select FILE / PRINTER SETUP in PrintBoss. Choose the printer (this may be temporary, and when finished, set back to the desired default printer.) Click on the *Printer Setup* button at the bottom of the screen. Find the *Source* field, select the appropriate tray, and click OK. Notice the PrintBoss Printer Setup screen shows the selected *Paper Source* tray with a number preceding it in parentheses. Take note of this number to enter in the command as the PaperBin number.

If PaperBin number (or Tray ID) evaluates to 0, the command is ignored and the tray is selected based on the parameters specified in the *Multi-Parts & Printers* tab or the printer's default tray.

This command places a paragraph of text without printing each line as a separate #Text command. The paragraph command ends as soon as the program encounters the next #. A good practice is to use the remark #REM or #ParagraphEnd command to end a paragraph.

The properties of the font in the paragraph are set like the #Text command.

The paragraph will NOT automatically word wrap. Lines appear exactly as they are entered in the command. Set a *Width* to the paragraph to cause lines to append and apply word wrap. New paragraphs within the text will occur after blank or indented lines. Be sure to start the text in the first column in the editor if the width is set to initiate word wrap. If the width is enabled, the justification box may also be checked to force the right edge of paragraphs to align.

For Example:

#Paragraph 3.500, 5.500, "Arial/10", .167, N,
This is the first line of the paragraph.
This is the second line of the paragraph.

Add \//XJ2.00 immediately after the font size to right justify and set a width of 2 inches. The N indicates the Strict Paragraph End Flag is not checked.

#PassThru

#PassThru X, Y, PassThroughString

The character string is passed directly through to the printer. The Windows’ printer driver does nothing to the string. If the X or Y parameters are non-zero, the cursor position will be set to the X and Y location prior to the PassThru and then the cursor position will be popped. If the ASCII character number 127 appears in the string, it will be replaced with ASCII character 27 to allow Escape sequences in the string.

This is rarely used and its operation differs between printers due to differences in the way the Windows PassThrough escape sequence was built into the printer drivers.

#PCX

#PCX X, Y, “GraphicFileName” [, Options]

The PCX command prints a graphic on the document. It operates the same as the #PIC except that it expects a PCX or SIG file type. See #PIC in Chapter 9 for details on the operation of this command.

#Pie

#Pie <CenterX>, CenterY>, Radius, Start Degree, End Degree [, Options]

This command creates a circle (or part of a circle) in the Form. Zero degrees points to 12 o’clock.

For example:

#Pie 5.00, 4.00, 1.00, 0, 180

The object appears as:

The center point would be 5 inches from the left and 4 inches from the top of the page.

OPTIONS
/F<FillString> – This option defines the contents of the pie shape.

#Polygon

#Polygon X1, Y1, X2, Y2, X3, Y3, X4, Y4, …. (up to 20 different points) [/F<FillString>]

This command creates a polygon on the Form. Each point of a polygon is a different coordinate. The last coordinate connects with the first coordinate, enclosing the polygon. The command can have up to 20 different coordinates.

For example:

#Polygon .75, 1.15, 2.45, 5.00, 7.00, 6.35

The object appears as:
Anything that follows #Rem is a remark or comment. Though any line without a # is a comment, there are times, like at the end of a paragraph, when it is helpful to enter #Rem to end a command.

See #Disable / #Enable / #SetEnable.

#SIG

#SIG X, Y, "GraphicFileName" [, Options]

#Sig prints a signature graphic on a document. This command is virtually the same as #PIC, except the #SIG Hide File Errors option is forced to true and cannot be changed. Use of #PIC instead of #Sig is recommended.

#SubCopyCount

#SubCopyCount SubCopyNo

The SubCopyCount command was created to print multiple copies of a specified PrintBoss Form Copy. For example, Copy 0 on the PrintBoss form needs to be printed multiple times based on a value that is printed on form. Copy 1 always needs to be printed 3 times. The commands may look like the following:

#\[C,0\]SubCopyCount \{SubCopyNo\} – Print the number of copies for Copy 0 based on the value assigned to \{SubCopyNo\}.

#\[C,1\]SubCopyCount 3 – Always print 3 copies of Copy 1.

The variable \{SubCopyNo\} is usually assigned on the RunTime Objects tab of the PrintBoss form. This value may change with each document.

NOTE:

This is an Enterprise only feature.

#VGrid

#VGrid X1, Y1, X2, Y2, Xa, Xb ... Xz [, Options]

This command creates a frame and then draws vertical lines to fit into the frame. Options provide further modifications with corner radius, shadow, line color, and edge shading. This is command had been largely replaced by the #Grid command.

This command creates a frame and then draws vertical lines to fit into the frame. This command is useful when creating the background columns for the detail section of an invoice. Options provide further modifications with corner radius, shadow, and edge shading. This is command had been largely replaced by the #Grid command since the internal dimensions of the #Grid are relative, making it easier to move the grid.

X1, Y1:
These are the coordinates for the top left corner of the frame in inches from the left edge and top of paper. The coordinates may be entered in thousandths of an inch.
X2, Y2:
These are the coordinates for the bottom right corner of the frame.

Xa, Xb ... Xz:
This parameter represents any number of lines drawn vertically across the frame. Each line is defined as the distance in inches from the left edge of the page.

For example, the VGRID command could be used as follows to create a box the width of the check with four columns:

```
#VGRID 0.250, 0.500, 8.250, 4.000, 2.000, 4.000, 6.000
```

This command produces a frame with three vertical lines inside. The first vertical line is at 2 inches from the left edge of the page, the second vertical line is at 4 inches from the left edge of the page, and the third vertical line is at 6 inches from the left edge of the page.

**PrintBoss Conditional Commands & Parameters**

The following table lists the conditions available for use with the form commands.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Parameters</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>'String1', 'String2'</td>
<td>Compares only as many characters as in string2</td>
</tr>
<tr>
<td>=u</td>
<td>'String1', 'String2'</td>
<td>Same as &quot;=&quot; , with Upper case CompareOption (not case sensitive)</td>
</tr>
<tr>
<td>=e</td>
<td>'String1', 'String2'</td>
<td>Same as &quot;=&quot; , with Exact match CompareOption (case sensitive)</td>
</tr>
<tr>
<td>=ue</td>
<td>'String1', 'String2'</td>
<td>Same as &quot;=&quot; , with Upper case and Exact match CompareOptions</td>
</tr>
<tr>
<td>==</td>
<td>'NumericValue1', 'NumericValue2'</td>
<td>Compares 2 numeric values</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>'NumericValue1', 'NumericValue2'</td>
<td>Compares 2 numeric values</td>
</tr>
<tr>
<td>&lt;=</td>
<td>'NumericValue1', 'NumericValue2'</td>
<td>Compares 2 numeric values</td>
</tr>
<tr>
<td>&gt;</td>
<td>'NumericValue1', 'NumericValue2'</td>
<td>Compares 2 numeric values</td>
</tr>
<tr>
<td>AmntRange</td>
<td>LoRange, HiRange, TestAmount</td>
<td>Confirms DocAmnt is within the range</td>
</tr>
<tr>
<td>Assigned</td>
<td>'&lt;Name of assigned variable to test&gt;'</td>
<td>True if assigned by #Assign or PB#Assign (Do Not Include Braces!)</td>
</tr>
<tr>
<td>Captured</td>
<td>'&lt;Name of captured variable to test&gt;'</td>
<td>True if successfully captured from raw data (Do Not Include Braces!)</td>
</tr>
<tr>
<td>Copy</td>
<td>'String of Digits'</td>
<td>True if current copy is in string of digits</td>
</tr>
<tr>
<td>Dates=</td>
<td>'&lt;Date1&gt;', '&lt;Date2&gt;'</td>
<td>True if dates are equal</td>
</tr>
<tr>
<td>Dates&gt;</td>
<td>'&lt;Date1&gt;', '&lt;Date2&gt;'</td>
<td>True if Date1 is greater than Date2</td>
</tr>
<tr>
<td>Empty</td>
<td>'StringToTest'</td>
<td>True if StringToTest is empty</td>
</tr>
<tr>
<td>False</td>
<td>'StringToTest'</td>
<td>Always false, helpful for debug purposes</td>
</tr>
<tr>
<td>Condition</td>
<td>Expression</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>FileExists</td>
<td><code>&lt;FilePathName&gt;</code>'</td>
<td>True if the specified file name exists</td>
</tr>
<tr>
<td>Flagged</td>
<td><code>&lt;Bank Flag Name&gt;</code>'</td>
<td>True if expression starts with T,Y,t,y (True or Yes)</td>
</tr>
<tr>
<td>In</td>
<td>'StringFragment',</td>
<td>True if Fragment is anywhere in SearchIn, case sensitive</td>
</tr>
<tr>
<td></td>
<td>'StringToSearchIn'</td>
<td></td>
</tr>
<tr>
<td>Inu</td>
<td>'StringFragment',</td>
<td>Same as In, but not case sensitive</td>
</tr>
<tr>
<td></td>
<td>'StringToSearchIn'</td>
<td></td>
</tr>
<tr>
<td>InsideOfCreation</td>
<td></td>
<td>True when adding record to work file</td>
</tr>
<tr>
<td>InsideOfForwardCalc</td>
<td></td>
<td>True when re-calculating key fields forward</td>
</tr>
<tr>
<td>InsideOfBackwardCalc</td>
<td></td>
<td>True when re-calculating key fields backward</td>
</tr>
<tr>
<td>InsideOfRender</td>
<td></td>
<td>True when rendering or processing from work file</td>
</tr>
<tr>
<td>PreLoadLoop</td>
<td></td>
<td>True when Pre-process Assignments is selected on the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Special Controls tab of the Form Editor</td>
</tr>
<tr>
<td>True</td>
<td></td>
<td>Always true, helpful for debug purposes</td>
</tr>
<tr>
<td>Type</td>
<td>'SourceTypeName'</td>
<td>True if current source is in SourceTypeList</td>
</tr>
<tr>
<td>View Only</td>
<td></td>
<td>Sets an item to View, but not to print</td>
</tr>
</tbody>
</table>

**NOTE:**

Although it is helpful for us humans to see the condition names spelled out completely, only as many characters as is needed to make the condition unique are required. For example, *Fi* is enough to register as the `FileExists` condition, or *As* is enough to register as the `Assigned` condition, or *E* as the Empty condition.
SUBSTITUTE FUNCTIONS TABLE

There are times when a text command needs to be limited, formatted, or altered for special circumstances. Substitute functions are available for the #Text command to accommodate those special situations. A list of substitute functions is available in the Form Editor by RIGHT clicking on an Objects tab and selecting List/Stuff Assignments. Click on the plus sign in front of Substitution Functions to view the list. A table of these functions follows.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case:</td>
<td>'&lt;Str&gt;','U/L/P'</td>
</tr>
<tr>
<td>Chr:</td>
<td>'&lt;ASCII Value&gt;'</td>
</tr>
<tr>
<td>CityStateZip:</td>
<td>'City State Zip string'</td>
</tr>
<tr>
<td>CurrentDate:</td>
<td>'mm/dd/yyyy'</td>
</tr>
<tr>
<td>CurrentTime:</td>
<td>'hh:mm:ss tt'</td>
</tr>
<tr>
<td>Delete:</td>
<td>'&lt;Str&gt;', &lt;StartingCharIndex&gt;, &lt;NumToDelete&gt;</td>
</tr>
<tr>
<td>DocAmnt:</td>
<td>/HidDec /Zero /Width:nn /Commas /Trim</td>
</tr>
<tr>
<td>Eval:</td>
<td>'&lt;Numeric Str&gt;[. &lt;Num of Decimal Places&gt;]'</td>
</tr>
<tr>
<td>FormatDate:</td>
<td>'&lt;DateInExpr&gt;', 'mm/dd/yyyy' [ AddDays [, AddMonths [, AddYears [. EOM]]]]</td>
</tr>
<tr>
<td>FormatDate2:</td>
<td>'&lt;DateInExpr&gt;', '&lt;DateInExprMask&gt;', 'mm/dd/yyyy' [ AddDays [, AddMonths [, AddYears [. EOM]]]]</td>
</tr>
<tr>
<td>FormatNum:</td>
<td>'&lt;NumStr&gt;', WholeDigits, DecimalDigits, '&lt;LeftFill&gt;', 'RtFill', 'HideDec/Commas'</td>
</tr>
<tr>
<td>If</td>
<td>'&lt;Condition&gt;', '&lt;TrueStr&gt;', '&lt;FalseStr&gt;'</td>
</tr>
<tr>
<td>Length:</td>
<td>&lt;value&gt;</td>
</tr>
<tr>
<td>Mod:</td>
<td>&lt;Value&gt;,&lt;Divisor&gt;</td>
</tr>
<tr>
<td>Pad:</td>
<td>'&lt;Str&gt;', &lt;Len&gt; [., &lt;Left, Rt, and/or Trunc&gt; [, &lt;PadChar&gt;]]</td>
</tr>
<tr>
<td>Pos:</td>
<td>'&lt;Substr&gt;', '&lt;LookInStr&gt;', [., &lt;Occurrences&gt; [. Uppercase]]</td>
</tr>
<tr>
<td>PutDashInZip:</td>
<td>'&lt;ZipCodeString&gt;'</td>
</tr>
<tr>
<td>RECAmnt:</td>
<td>'#,#.#.#0.00'</td>
</tr>
<tr>
<td>RECDate:</td>
<td>'mm/dd/yyyy'</td>
</tr>
<tr>
<td>RECTime:</td>
<td>'hh:mm:ss tt'</td>
</tr>
<tr>
<td>StrExtract:</td>
<td>'&lt;OrigString&gt;', '&lt;Delimiter&gt;', &lt;Occurrence&gt; [. '&lt;mode&gt;']</td>
</tr>
<tr>
<td>StrStuff:</td>
<td>'&lt;OrigString&gt;', 'CDF', &lt;CommaDelimitedFldOccurrence&gt; [, '&lt;mode&gt;']</td>
</tr>
<tr>
<td>StrTran:</td>
<td>'&lt;OrigString&gt;', 'SearchKey', 'ReplKey', ['Options']</td>
</tr>
</tbody>
</table>
**Substitute Function Descriptions**

The following is not a complete list. See Chapter 10, *Text Command*, for descriptions of the more common Substitute Functions.

**Chr**

*Chr: '<ASCII Value>'*

Sometimes it is necessary to insert a specific ASCII character regardless of the font used. This function inserts these ASCII characters and is often used for carriage returns in Positive Pay.

**CityStateZip**

*CityStateZip: 'city state zip string'*

This function is used to clean up data when all three fields are included in a single text string. It removes extra spaces (over three consecutive spaces) and adds a comma after the city if necessary.

**Delete**

*Delete: '<Str>', <StartingCharIndex>, <NumToDelete>*

Sometimes it is necessary to delete some of the characters in a string. This function deletes characters starting at a specific location for the number of characters indicated. This is most often used to eliminate extra spaces in the middle of a string that repeat at the same location.

**DocWordAmnt**

*DocWordAmnt: <Line 1 or 2> [, <LineLength90> [, <CurrencyDollars> [, <Style A or B> ]]]*

This function calls the *WordAmnt* function using the current DocAmnt as the amount to be converted to words. See *WordAmnt* function for a description of the parameters. There are several different syntaxes for this command depending on whether Line 1 or 2 is part of the function name or the first character. An example of each syntax is displayed below.

- {DocWordAmnt: 1,90}
- {DocWordAmnt1: 90}
- {DocWordAmnt1.90}
- {DocWordAmnt1, 90, “Canadian Dollars”}

**Eval**

*Eval: '<Numeric Str>'[ [, <Num of Decimal Places>]*

This function evaluates mathematical equations. The second parameter sets the number of decimal places to which the answer is carried. Zero is the default when the *Num of Decimal Places* parameter is missing. For example:

```
#Assign X, ÷{Eval:"2.85+({n}*0.2)"},3÷
```
This function assigns the X value for placing detail on a deposit slip. The value is calculated to 3 decimal places. This assignment is included in a #For loop where \{n\} is defined as 1 to 27. The loop starts at 1 and increments on each pass until it reaches 27.

\[
\text{If}
\]

\[
\text{If: } '<\text{Condition}>'', '<\text{TrueStr}>'', '<\text{FalseStr}>'
\]

This function is used to define both results when a condition is evaluated. For example:
If: "[Flagged,\{BFlag2\}]", "Canadian Funds", "US Funds"

\[
\text{Length}
\]

\[
\text{Length: } <\text{Value}>
\]

This function returns the length of everything AFTER the colon, including spaces. For example:
#\{V\}Text 0.2, 0.00, Arial/10, \{Length: \div\{InvNo\}\}
This line would display the number of characters and spaces in the \{InvNo\} string.

\[
\text{Mod}
\]

\[
\text{Mod: } <\text{Value}>, <\text{Divisor}>
\]

Use this function to determine the number of times a task is performed. For example, to place three details on a single line test the counter against a divisor or 3:
#Text 0.2, 0.00, Arial/10, \{Mod:\div\{rowcounter\}\}
If the evaluation above returns a value of zero, a CR/LF can be inserted.

\[
\text{Pos}
\]

\[
\text{Pos: } '<\text{SubStr}>'', '<\text{LookinStr}>'\[,<\text{Occurrences}>\[,\text{Uppercase}\]\]
\]

This function returns the position of a substring within a string. For example:
#\{View Only\}Text 8.200R, 6.825, 'Arial/12', \{Pos:'$',\div\{Deposit\}\}]
Returns the character position of the first instance of a dollar sign in the string Deposit and displays it in the view at the specified coordinates.

\[
\text{PutDashInZip}
\]

\[
\text{PutDashInZip: } '<\text{ZipCodeString}>'
\]

This function inserts a dash into a zip code. This is usually used when the accounting software database sends a zip code with the complete 9 digit American zip code minus the proper formatting.

\[
\text{StrStuff}
\]

\[
\text{StrStuff: } '<\text{OrigString}>'', '<\text{StrToStuff}>'', <\text{StartCharIndex}>
\]

This is used to “stuff” a character or characters (StrToStuff) into a string (OrigString) before the specified number of characters starting from the left. If the StartCharIndex is 1, the character(s) will be stuffed in front of the OrigString. If the StartCharIndex is negative, PrintBoss will locate the insertion point by counting characters from the right.
SubStr

SubStr: '<Str>', '<StartCharNo>', <Length>

This function pulls a designated number of characters from a string. The following example removes asterisks after the check amount:

#Text 8.00R, 8.7, "Arial/12", «{SubStr: ÷{DocAmnt}÷,2,}»|Canadian Style cheque

Trim

Trim: '<Str> [, <Left/Right/Both>]'

This function eliminates spaces at either end of a string based on L, R, or B as a second parameter. The default is R when no second parameter is entered.

TrimAll

TrimAll: '<Str>'

This function trims the spaces from both ends of the string. It is the same as using the Trim function with the option of B for both.
Appendix D: Security Settings

General Settings

Security Method
The recommended security is the Standard method. The Advanced method allows User Disks and User Logins to be used to access secured features. The Advanced method may be selected by default in older versions of PrintBoss that had security activated and then upgraded to the newer version.

Suppress Printing Signatures in Archive Reprints
Check this option to prevent a secure signature (file with the extension of .sig) on a document from printing when the document is reprinted from the Archive files.

Master Password
The Master Password is used to access the security settings within PrintBoss. The initial password is ADMIN and it is case sensitive beginning with PrintBoss version 5.71.3. A dialog box will confirm any changes to this field. This password is also used for duplicating signature disks. This password is NOT linked to logging in to PrintBoss as a user. It is recommended that an administrator user account be defined with a different password to have full access to the PrintBoss program once security has been activated.

Confirm Master Password
This confirmation dialog box only appears if the Master Password is changed. If the confirmation does not match the new password exactly, the security window will not close. An error message will warn that the two passwords do not match and that both must be re-entered. The password is CASE SENSITIVE.

Drive Where User Disk Resides
This option is only available when the Advanced security method is selected. Indicate the system wide drive letter for user disks.

Auto Login Matching Windows Users
PrintBoss will automatically login a user based on their Windows User name if there is a match in the PrintBoss users list (on the Advanced User Rights tab) when this option is selected.

Display Only Primary Fields in Bank List Browse and Encrypt Key Fields in the Bank List
Select this check box to only display primary bank fields (Bank Code, Bank Prompt and Bank Name) in the Bank List (EDIT / BANK LIST) and encrypt key fields so they cannot be viewed or copied.

Enable User Security in Banks
Access to each bank account can be controlled by the Administrator when bank security is enabled. This button will read Disable User Security in Banks when the security is enabled.
**Signature Disk Log**

- **Logging Active**
  Select this check box to activate a log file for your signature disk(s).

- **SigDisk Log Retention in Days**
  Set the retention period for the SigDisk log file.

**Basic User Rights (Standard Security Mode)**

Determine security by menu function. Check all functions you want all users to access. Functions that are not checked require specific permission assigned to a user on the Advanced User Rights tab. Otherwise, the function is not available to the user.

**Security Required (Advanced Security Mode)**

This tab is only available when Advanced is selected as the Security Mode on the General Settings tab. Select the menu functions that require security. There are two types of access – password and user disk. No security is required to access a function if there is no check in either the User Logged In or User Disk columns. Functions checked in the User Logged In column require the user to login to PrintBoss with a password to access the function. Otherwise, it will not be available on the menu. Functions checked in the User Disk column require an encoded disk be used for access. Select check boxes in both columns to require User Login along with the use of a disk.

**Advanced User Rights (Standard Security Mode)**

The administrator can define users on this tab and assign access to specific features not available to all users. Click the Plus (+) button to add a user. Enter the User Name and Password in the User Edit dialog box. All features that are grayed out are automatically available to all users. Select additional options to assign to the current user. The Uncheck All button will deselect all optional features (those that are bold). The Check All button selects all optional features. Click OK to save changes after selecting the appropriate features.

**Advanced User Rights (Advanced Security Mode)**

The administrator can define users and assign access to specific features not available to all users. The type of access (password and disk) is also defined. Click the Plus (+) button to add a user. Enter the User Name and Password in the User Edit dialog box. All features that are grayed out are automatically available to all users. Check features on the list to provide access for this user. An L next to a field indicates a user password is required for access. A D next to a field indicates a user disk is required for access. A B next to a field indicates BOTH a user login AND a user disk are required for access. If this user only needs a password for access, click OK.

**Write a User Disk**

If this user needs a User Disk, enter the destination drive and set the expiration date for the disk. Enter a password in the field under the User Name to password protect the disk. Place a floppy disk in the drive and Write User Disk.

**Reading a User Disk**

The user name and expiration date of a user disk may be verified. Open Security in PrintBoss and enter the Master Password. The security method should be set to Advanced on the General Settings tab. Select the Advanced User Rights tab and either edit a current user or add a new user by clicking on the plus symbol. Put the disk in the floppy drive and choose Read User Disk. The user properties will appear in the User Edit window. Click OK after reading the disk. You may edit the user properties or click Cancel to exit without saving changes.
**Appendix E: Variables By Category**

**ACH Variables**

The following is a list of variables associated with the ACH function of PrintBoss, but not included in the Bank List or the Payee List.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACH Check Amount {ACHChkAmnt}</td>
<td>Provides the remaining amount to be paid by check. The value is zero when there is no remaining amount</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Effective Entry Date {ACHEfctvDate}</td>
<td>This optional field allows a date to be assigned in the form. Otherwise, the date the file is created is used. Add ‘!’ to the end of the variable and a calendar will pop up to select a date on the fly when saving the ACH file</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>ACH Status {ACHStatus}</td>
<td>Numeric value of the active account status. Values less than 1 indicate the record is inactive</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>ACH Total Amount {ACHTotAmnt}</td>
<td>Provides the calculated ACH total amount from all accounts for this check.</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

**Bank Variables**

The following is a list of variables associated with the Primary tab of a PrintBoss Bank Record.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Code</td>
<td>{BCode}</td>
<td>Code used to define record. This should match the bank name in your accounting software.</td>
<td>50-60</td>
</tr>
<tr>
<td>Bank Prompt {BPrompt}</td>
<td>Name given for user recognition. PrintBoss will automatically copy the information entered in the Bank Code field when this field is left blank</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Bank Name {BName}</td>
<td>Name of bank</td>
<td></td>
<td>40</td>
</tr>
<tr>
<td>Bank Address 1 {BAds1}</td>
<td>Address Line 1 of bank (usually city, state)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Bank Address 2 {BAds2}</td>
<td>Address Line 2 of bank (often left blank)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Bank Address 3 {BAds3}</td>
<td>Address Line 3 of bank (often left blank)</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Company Name {BCName}</td>
<td>Company Name as it is to appear on the checks</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Company Name 2 {BCName2}</td>
<td>2nd Company Name as it is to appear on the checks. This field is optional</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>Company Address 1 {BCAds1}</td>
<td>Company Address Line 1</td>
<td>40</td>
<td></td>
</tr>
</tbody>
</table>
### MICR Tab

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Address 2</td>
<td>(BCAds2)</td>
<td>Company Address Line 2</td>
<td>40</td>
</tr>
<tr>
<td>Company Address 3</td>
<td>(BCAds3)</td>
<td>Company Address Line 3. This may be used for a telephone number, fax number, or email address</td>
<td>40</td>
</tr>
<tr>
<td>Company Address 4</td>
<td>(BCAds4)</td>
<td>Company Address Line 4. This may be used for a telephone number, fax number, or email address</td>
<td>40</td>
</tr>
<tr>
<td>Alias</td>
<td>(BankAliasedFrom)</td>
<td>Identifies the Bank Code of the bank record used as the source for the Alias</td>
<td>50-60</td>
</tr>
<tr>
<td>Fractional Code</td>
<td>(BFrac)</td>
<td>Fractional Code</td>
<td>20</td>
</tr>
<tr>
<td>Next Check Number</td>
<td>(BChkNo)</td>
<td>Next Check Number Counter (only used if Check # is not sent from the accounting software)</td>
<td>10</td>
</tr>
</tbody>
</table>

The following is a list of variables associated with the MICR tab of a PrintBoss Bank Record.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing Number</td>
<td>(BMICRRoutNo)</td>
<td>Routing Number from bank</td>
<td>9</td>
</tr>
<tr>
<td>Account Number</td>
<td>(BMICRAcctNo)</td>
<td>Account Number from bank</td>
<td>20</td>
</tr>
<tr>
<td>Check Number</td>
<td>(BChkNo)</td>
<td>Check number pulled from bank record; also known as Next Check Number</td>
<td>10</td>
</tr>
<tr>
<td>Check Number</td>
<td>(CChkNo)</td>
<td>Check number printed from accounting software</td>
<td>10</td>
</tr>
<tr>
<td>Check Number</td>
<td>(DocNo)</td>
<td>Check number passed from accounting software (Does not appear in drop down menu of MICR tab)</td>
<td>10</td>
</tr>
<tr>
<td>MICR Line</td>
<td>(BMICR)</td>
<td>MICR Line (See #MICR in Chapter 8)</td>
<td>--</td>
</tr>
</tbody>
</table>

### Miscellaneous Tab

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>2nd Logo</td>
<td>(BMisc1)</td>
<td>Often used to place a 2nd Logo on a check</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 2</td>
<td>(BMisc2)</td>
<td>Miscellaneous Field 2</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 3</td>
<td>(BMisc3)</td>
<td>Miscellaneous Field 3</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 4</td>
<td>(BMisc4)</td>
<td>Miscellaneous Field 4</td>
<td>40</td>
</tr>
<tr>
<td>Misc Field 5</td>
<td>(BMisc5)</td>
<td>Miscellaneous Field 5</td>
<td>40</td>
</tr>
<tr>
<td>2nd Signature Line</td>
<td>(BFlag1)</td>
<td>Use for a 2nd signature line – YES if checked</td>
<td>1</td>
</tr>
<tr>
<td>Misc Flag 2</td>
<td>(BFlag2)</td>
<td>Miscellaneous Flag 2 – returns TRUE if checked</td>
<td>1</td>
</tr>
<tr>
<td>Misc Flag 3</td>
<td>(BFlag3)</td>
<td>Miscellaneous Flag 3 – returns TRUE if checked</td>
<td>1</td>
</tr>
<tr>
<td>Misc Flag 4</td>
<td>(BFlag4)</td>
<td>Miscellaneous Flag 4 – returns TRUE if checked</td>
<td>1</td>
</tr>
<tr>
<td>Misc Flag 5</td>
<td>(BFlag5)</td>
<td>Use for Date/Amount Box format – returns TRUE if checked</td>
<td>1</td>
</tr>
<tr>
<td>Canadian Style Date/Amount</td>
<td>(bCDN_CkStyle)</td>
<td>Returns TRUE if checked</td>
<td>1</td>
</tr>
</tbody>
</table>

The following is a list of variables associated with the Miscellaneous tab of a PrintBoss Bank Record.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo Properties</td>
<td>(BLogoFile)</td>
<td>Logo file name, Ex: Mycompany.jpg</td>
<td>40</td>
</tr>
<tr>
<td>Logo X</td>
<td>(BLogoX)</td>
<td>X Coordinate for logo</td>
<td>5</td>
</tr>
<tr>
<td>Logo Y</td>
<td>(BLogoY)</td>
<td>Y Coordinate for logo</td>
<td>5</td>
</tr>
<tr>
<td>Logo Options</td>
<td>(BLogoOp)</td>
<td>Optional properties for logo file</td>
<td>10</td>
</tr>
<tr>
<td>Logo Hi</td>
<td>(BLogoHi)</td>
<td>Maximum $ for AmountRange condition – typically used only if the logo is an additional signature</td>
<td>10</td>
</tr>
<tr>
<td>Field Name</td>
<td>Variable Name</td>
<td>Additional Description</td>
<td>Length</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Logo Lo</td>
<td>{BLogoLo}</td>
<td>Minimum $ for AmountRange condition – typically used only if the logo is an additional signature</td>
<td>10</td>
</tr>
<tr>
<td>Logo Width</td>
<td>{BLogoWd}</td>
<td>The Logo Width in inches</td>
<td>4</td>
</tr>
<tr>
<td>Logo Height</td>
<td>{BLogoHt}</td>
<td>The Logo Height in inches</td>
<td>4</td>
</tr>
<tr>
<td>Logo Percent</td>
<td>{BLogoSize}</td>
<td>Logo size adjusted by Percent from 10% - 300%</td>
<td>3</td>
</tr>
<tr>
<td>Signature Properties</td>
<td>{BSigFile}</td>
<td>Signature File Name, Ex: JohnSmith.sig</td>
<td>40</td>
</tr>
<tr>
<td>Signature X</td>
<td>{BSigX}</td>
<td>X Coordinate for signature</td>
<td>5</td>
</tr>
<tr>
<td>Signature Y</td>
<td>{BSigY}</td>
<td>Y Coordinate for signature</td>
<td>5</td>
</tr>
<tr>
<td>Signature Hi</td>
<td>{BSigHi}</td>
<td>Maximum $ for AmountRange condition (optional)</td>
<td>10</td>
</tr>
<tr>
<td>Signature Lo</td>
<td>{BSigLo}</td>
<td>Minimum $ for AmountRange condition (optional)</td>
<td>10</td>
</tr>
<tr>
<td>Signature Options</td>
<td>{BSigOp}</td>
<td>Optional properties for signature file</td>
<td>10</td>
</tr>
<tr>
<td>Signature Width</td>
<td>{BSigWd}</td>
<td>The Signature Width in inches</td>
<td>4</td>
</tr>
<tr>
<td>Signature Height</td>
<td>{BSigHt}</td>
<td>The Signature Height in inches</td>
<td>4</td>
</tr>
<tr>
<td>Signature Percent</td>
<td>{BSigSize}</td>
<td>Signature size adjusted by percent from 10% - 300%</td>
<td>3</td>
</tr>
<tr>
<td>Signature 2 Properties</td>
<td>{BSig2File}</td>
<td>Second Signature File Name; this signature will appear on the top signature line</td>
<td>40</td>
</tr>
<tr>
<td>Signature 2 X</td>
<td>{BSig2X}</td>
<td>X Coordinate for signature 2</td>
<td>5</td>
</tr>
<tr>
<td>Signature 2 Y</td>
<td>{BSig2Y}</td>
<td>Y Coordinate for signature 2</td>
<td>5</td>
</tr>
<tr>
<td>Signature 2 Options</td>
<td>{BSig2Op}</td>
<td>Optional properties for signature 2</td>
<td>10</td>
</tr>
<tr>
<td>Signature 2 Hi</td>
<td>{BSig2Hi}</td>
<td>Maximum $ for Amount Range condition (optional)</td>
<td>10</td>
</tr>
<tr>
<td>Signature 2 Lo</td>
<td>{BSig2Lo}</td>
<td>Minimum $ for Amount Range condition (optional)</td>
<td>10</td>
</tr>
<tr>
<td>Signature 2 Width</td>
<td>{BSig2Wd}</td>
<td>The Signature Width Size in inches</td>
<td>4</td>
</tr>
<tr>
<td>Signature 2 Height</td>
<td>{BSig2Ht}</td>
<td>The Signature Height Size in inches</td>
<td>4</td>
</tr>
<tr>
<td>Signature 2 Percent</td>
<td>{BSig2Size}</td>
<td>Signature size adjusted by percent from 10% - 300%</td>
<td>3</td>
</tr>
</tbody>
</table>

**ACH FILE HEADER RECORD FIELDS**

The following is a list of variables associated with the ACH Definitions tab of a PrintBoss Bank Record. These fields are used in the SignOn tab of the ACH File and are defined in the bank record. They apply to every record in the file.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Immediate Destination</td>
<td>{bACHImdDstNo}</td>
<td>Contains a space followed by the 9 digit routing number of the ACH Operator or receiving point where the file is being sent</td>
<td>10</td>
</tr>
<tr>
<td>Immediate Origin</td>
<td>{bACHImdOrgNo}</td>
<td>Contains a space followed by the 9 digit routing number of the ACH Operator or sending point that is sending the file</td>
<td>10</td>
</tr>
<tr>
<td>Immediate Destination Name</td>
<td>{bACHImdDstName}</td>
<td>Optional. The name of the ACH receiving point.</td>
<td>23</td>
</tr>
<tr>
<td>Immediate Origin Name</td>
<td>{bACHImdOrgName}</td>
<td>Optional. The name of the ACH sending point.</td>
<td>23</td>
</tr>
<tr>
<td>File Mode ID</td>
<td>{bACHFileIDMode}</td>
<td>Increments beginning at A for multiple files in a day</td>
<td>1</td>
</tr>
<tr>
<td>Pre-Note Override</td>
<td>{ACHPreNote}</td>
<td>Global override of the PreNote setting. This should only be used once, the first time an ACH batch is processed</td>
<td>1</td>
</tr>
</tbody>
</table>
**ACH Company Batch Record Fields**

These fields are used in the Header tab of the ACH File and are defined in the bank record. They apply to every record in a batch.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Entry Class</td>
<td>{bACHStdEntryClsCod}</td>
<td>This field holds various predefined character abbreviations representing standard descriptions. Ex: CCD (Corporate Credit or Debit).</td>
<td>3</td>
</tr>
<tr>
<td>Company Name</td>
<td>{bACHCompName}</td>
<td>Name of the Company or Payee</td>
<td>16</td>
</tr>
<tr>
<td>Company Discretionary Data</td>
<td>{bACHCompDisc}</td>
<td>Optional. Allows Company to include codes of significance only to them to enable specialized handling of all entries in the batch</td>
<td>20</td>
</tr>
<tr>
<td>Company Identification</td>
<td>{bACHCompID}</td>
<td>An alphanumeric code used to identify the Originator</td>
<td>10</td>
</tr>
<tr>
<td>Service Class Codes</td>
<td>{bACHSvcClassCode}</td>
<td>Identifies type of ACH file</td>
<td>3</td>
</tr>
<tr>
<td>Company Entry Description</td>
<td>{bACHCompEntry}</td>
<td>Provides a description for the purpose of the transaction. Ex: Payroll; Water Bill; etc.</td>
<td>10</td>
</tr>
<tr>
<td>Originating DFI Identification</td>
<td>{bACHOrgDFIID}</td>
<td>Bank routing number plus ABA number with no leading space</td>
<td>8</td>
</tr>
</tbody>
</table>

**ACH Balance Record Fields**

These fields are used in the Balance Record tab of the ACH File and are defined in the bank record.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced File</td>
<td>{bACHBalFile}</td>
<td>This is the checkbox that determines whether a balanced file is used for ACH. The value is either Y or N</td>
<td>1</td>
</tr>
<tr>
<td>Routing Number</td>
<td>{bACHBalRout}</td>
<td>Receiving DFI Bank Routing Number for balancing entry</td>
<td>8</td>
</tr>
<tr>
<td>Bank Account Number</td>
<td>{bACHBalAcct}</td>
<td>DFI (Bank) Account Number for balancing entry</td>
<td>17</td>
</tr>
<tr>
<td>Account Name</td>
<td>{bACHBalName}</td>
<td>Receiving Company Name for balancing entry</td>
<td>22</td>
</tr>
</tbody>
</table>

**Email Variables**

There are several e-mail variables PrintBoss automatically recognizes when they are Assigned. These variables are:

<table>
<thead>
<tr>
<th>Enterprise Only</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>{AttachmentCount}</td>
<td>Insert this variable in the email body to display the number of separate attachments. This variable can also be used in the Email Subject.</td>
</tr>
<tr>
<td></td>
<td>{EmailBCC}</td>
<td>The BCC address for sending the e-mail</td>
</tr>
<tr>
<td></td>
<td>{EmailBody}</td>
<td>The Message Body of the e-mail; overrides EmailBodyFile content when defined</td>
</tr>
<tr>
<td></td>
<td>{EmailBodyFile}</td>
<td>Assigns a file to be used for the Email Body in the form. When no path is present, PrintBoss points to the {PBDir}\Email\Body folder.</td>
</tr>
<tr>
<td></td>
<td>{EmailCC}</td>
<td>The CC address for sending the e-mail</td>
</tr>
<tr>
<td></td>
<td>{EmailFromAddress}</td>
<td>The From E-mail address</td>
</tr>
<tr>
<td></td>
<td>{EmailFromName}</td>
<td>The From Name</td>
</tr>
<tr>
<td></td>
<td>{EmailReplyAddress}</td>
<td>The Reply To e-mail address</td>
</tr>
<tr>
<td></td>
<td>{EmailReqReadRcpt}</td>
<td>Assign yes to request a Read Receipt for the e-mail</td>
</tr>
</tbody>
</table>
See Chapter 9, Form Files, for more information on #Assign.

**{EMAILATTACHMENTS}**

E-mail only attaches a PDF of the PrintBoss document by default.

PrintBoss Enterprise allows you to add other documents as attachments to the e-mail. The additional PDF attachments need to be entered in one of the Objects tabs of the Form Editor with an assignment command and may use variables. Two examples of the syntax for this assignment follows:

```
#Assign EmailAttachments, "L:\Legal\Invoicing\Payment Requirements.doc"
#Assign EmailAttachments, "S:\Customers\{DocRecip}\Terms.*"
```

**{EMAILCOMBINEPAGES}**

Standard e-mail does not combine attachments. Each document is sent in a separate e-mail with only 1 attachment.

PrintBoss Enterprise allows you to combine e-mails into one e-mail with one attachment containing multiple pages. The choices are:

- 0 – Never combine emails or attachments
- 1 – Combine attachments into one email when the email address is the same as the prior page
- 2 – Combine attachments into one email when the email address AND DocNo are the same as the prior page

An example of the syntax for this assignment follows:

```
#Assign EmailCombinePages, "1"
```

A condition can be used at the beginning of the assignment to determine when to combine pages.

```
#[Inu, ‘1’, {DelMethod}]Assign EmailCombinePages, "1"
```

**{EMAILPDFALIAS}**

The name of the PDF file attachment is the same as the PrintBoss Form file name by default.

PrintBoss Enterprise allows you to define the file name. The file name for the PDF attachment needs to be entered in one of the Objects tabs of the Form Editor with an assignment command and may use variables. Two examples of the syntax for this assignment follows:
#Assign EmailPDFAlias, "Invoice from Wellspring Software, Inc."
#Assign EmailPDFAlias, "Invoice #{DocNo}"

**{EMAILPDFNoEdit}**
The PDF file attachment may be edited by default when someone has the proper software.

PrintBoss Enterprise allows you to restrict editing the PDF file attachment. This is accomplished by assigning the value of EmailPDFNoEdit to "NO". This assignment command needs to be entered in one of the Object tabs of the Form Editor. The syntax for this assignment follows:

```
#Assign EmailPDFNoEdit, "NO"
```

**{EMAILPDFNoPrint}**
The PDF file attachment can be printed by default.

PrintBoss Enterprise allows you to restrict the printing of the PDF file attachment. This is accomplished by assigning the value of EmailPDFNoPrint to "NO". This assignment command needs to be entered in one of the Objects tabs of the Form Editor. The syntax for this assignment follows:

```
#Assign EmailPDFNoPrint, "NO"
```

**{EMAILOptions}**
The following options may be defined by assigning them to the EmailOptions variable. For example:

```
#Assign EmailOptions, "/FP /SD"
```

The following options are available:

- `/SS` Skip Sending e-mail
- `/SD` Skip Deleting the PDF attachment (only when PDF Alias is assigned)
- `/FP` Forces a Pause during emailing to allow additional e-mails or attachments
- `/OA` Omit Attachments

**{EMAILPDFPassWord}**
The PDF file attachment does not require a password to open by default.

PrintBoss Enterprise allows you to password protect the PDF attachment. The password for the PDF file needs to be entered in one of the Objects tabs of the Form Editor with an assignment command and may use variables. Two examples of the syntax for this assignment follows:

```
#Assign EmailPDFPassWord, "abracadabra"
#Assign EmailPDFPassWord, "{SSN}"  
```

**Fax Variables**

Variables may be assigned in a form to define values for the fax cover page and fax number. Assignments made in a specific form file will override the settings in the FAX SERVICE OPTIONS screen. These values will then be global for all users who access this form. Otherwise, PrintBoss will use the default values defined in the Wellspring Fax Service Options dialog. A description of the available variables follows.

<table>
<thead>
<tr>
<th>Enterprise Only</th>
<th>Variable Name</th>
<th>Additional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>{Current Date}</td>
<td>Displays the current date at the time the fax is sent. See the <code>Current Date</code> substitution function for more options.</td>
</tr>
<tr>
<td></td>
<td>{Current Time}</td>
<td>Displays the current time when the fax is sent. See the <code>Current Time</code> substitution function for more options.</td>
</tr>
<tr>
<td>Enterprise Only</td>
<td>Variable Name</td>
<td>Additional Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcAttachments}</td>
<td>Used to define the file path and name of other documents to fax along with the document sent to PrintBoss</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrAds1}</td>
<td>Defines the first address line for the SENDING entity on the fax cover. The default value is pulled from the Ads1 field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrAds2}</td>
<td>Defines the second address line for the fax cover. The default value is pulled from the Ads2 field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrAds3}</td>
<td>Defines the third address line for the fax cover. The default value is pulled from the Ads3 field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrCompany}</td>
<td>Defines the Company Name for the SENDING entity on the fax cover. The default value is pulled from the Name field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrFax}</td>
<td>Defines the fax number for the SENDING entity. The default value is pulled from the Fax field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrFile}</td>
<td>Defines the location for the Cover Page and applies to all faxes unless this variable is assigned in the form. The default value is pulled from the Cover Page File field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrFrom}</td>
<td>Defines the name for the SENDER. The default value is pulled from the From: field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrMsg}</td>
<td>Defines the Cover Page Message and applies to all faxes unless this variable is assigned in the form. The default value is pulled from the Cover Page Message field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrPhone}</td>
<td>Defines the Phone number used on the fax cover. The default value is pulled from the Phone field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrRe}</td>
<td>Defines the regarding message (subject) used on the fax cover. The default value is pulled from the Phone field on the WELLSPRING FAX SERVICE OPTIONS dialog.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcCvrTo}</td>
<td>Defines the name of the RECEIVING entity. The default value is pulled from the To: field on the WELLSPRING FAX SERVICE OPTIONS dialog unless it is assigned dynamically in the form.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcFaxNo}</td>
<td>Defines the fax number used to SEND the fax. {FaxSvcFaxNo} may be replaced with {DocMisc} if {DocMisc} is already assigned in the form to the correct fax number. Set the Fax Number Source field in the WELLSPRING FAX SERVICE OPTIONS dialog to the correct value.</td>
</tr>
<tr>
<td></td>
<td>{FaxSvcHeader}</td>
<td>Defines the Fax Header that is to appear at the top of all sent faxes. The default value is pulled from the Fax Header field on the WELLSPRING FAX SERVICE OPTIONS dialog unless this variable is assigned in the form.</td>
</tr>
</tbody>
</table>

Assignments made in a specific form file will override the settings in the WELLSPRING FAX SERVICE OPTIONS dialog. This value will then be global for all users who access the form.
### FORM VARIABLES

The following standard variables are related to the PrintBoss Form.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Override</td>
<td>{CapturedTextFontOverride}</td>
<td>Assigns the font specified in the Font Override field under the Captured Text Treatment section on the Settings tab of the form</td>
<td>--</td>
</tr>
<tr>
<td>Check Number</td>
<td>{CChkNo}</td>
<td>Returns the check number assigned in the form, similar to DocNo.</td>
<td>12</td>
</tr>
<tr>
<td>Copy Name</td>
<td>{CopyName}</td>
<td>Returns the name of the specified PrintBoss copy, such as Copy 0 or Copy 1. C,0 and C,1 may also be used.</td>
<td>--</td>
</tr>
<tr>
<td>Destination Device</td>
<td>{DestDevice}</td>
<td>Returns the name of the Destination for the specified copy</td>
<td>--</td>
</tr>
<tr>
<td>Destination Device Status</td>
<td>{DestDeviceStatus}</td>
<td>Returns the Status Log information from the Work File Edit window.</td>
<td>--</td>
</tr>
<tr>
<td>Document Amount</td>
<td>{DocAmnt}</td>
<td>Returns the amount, usually the check amount, assigned in the form.</td>
<td>--</td>
</tr>
<tr>
<td>Bank</td>
<td>{DocBank}</td>
<td>Used to assign values to allow PrintBoss to automatically select a bank record.</td>
<td>--</td>
</tr>
<tr>
<td>Duplex Enabled</td>
<td>{DuplexEnabled}</td>
<td>Use a condition with this variable to conditionally turn Duplex off and on. This may be set by User or some other value. Use with #ForceWinPrintJob.</td>
<td>--</td>
</tr>
<tr>
<td>Form Next Number</td>
<td>{FormNextNumber}</td>
<td>Provides an incremental value that can be accessed in the Footer Objects tab of the Form. Must be enabled on the Settings tab of the Form to be used.</td>
<td>--</td>
</tr>
<tr>
<td>Page Options</td>
<td>{PageOptions}</td>
<td>Assign this variable to /S to Suppress Block Mirrors. Use a condition such as C,1 to suppress by copy.</td>
<td>--</td>
</tr>
<tr>
<td>Positive Pay File Extension</td>
<td>{PosPayFileExt}</td>
<td>Displays the Positive Pay file extension</td>
<td>--</td>
</tr>
<tr>
<td>Positive Pay File Name</td>
<td>{PosPayFileName}</td>
<td>Displays the Positive Pay file name</td>
<td>--</td>
</tr>
<tr>
<td>Security Stamp String</td>
<td>{SecurityStamp}</td>
<td>Used to print information, such as Operator, Current Date, Current Time, etc., on the check as a security measure. The string is added on the Special Controls tab of the Form.</td>
<td>--</td>
</tr>
<tr>
<td>Set Destination Printer</td>
<td>{SetDestPrinter}</td>
<td>Use a condition with this variable and assign it on either the Footer Objects or RunTime Objects tab to the exact printer name. Set Pre-process Assignments on the Special Controls tab to Special.</td>
<td>--</td>
</tr>
<tr>
<td>Set Duplex Enabled</td>
<td>{SetDuplexEnabled}</td>
<td>Use a condition with this variable to turn the Duplex feature on or off. The values are Y for Yes and N for No.</td>
<td>--</td>
</tr>
<tr>
<td>Field Name</td>
<td>Variable Name</td>
<td>Additional Description</td>
<td>Length</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Sub Copy Number</td>
<td>{SubCopyNo}</td>
<td>Used to assign any number of copies to the Sub Copy Count function.</td>
<td>--</td>
</tr>
</tbody>
</table>

Example of the SetDuplexEnabled feature:

```plaintext
#If «>[DocNo],÷5250÷»
    #Assign SETDUPLEXENABLED, ÷Y÷
#Else
    #Assign SETDUPLEXENABLED, ÷N÷
#Endif
```

A #ForceWinPrintJob can be used to toggle this option between individual checks vs. the whole batch or to toggle to different copies. This command is added to the top of the RunTime Objects of the PrintBoss Form. If the #ForceWinPrintJob is not used, the second page will be printed on a separate piece of paper because the printer cannot toggle during a print job.

**NOTE:**

This feature can only be used with printer drivers. It does not work with the internal PrintBoss PDF file creator as this output is not accessed through a printer driver.

### MISCELLANEOUS VARIABLES

The following variables are miscellaneous variables available in PrintBoss.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>{Operator}</td>
<td>PrintBoss Login name or WinUserName when not logged in</td>
<td>--</td>
</tr>
<tr>
<td>PrintBoss Home Directory</td>
<td>{PBDir}</td>
<td>Returns the path of the PrintBoss Home Directory</td>
<td>--</td>
</tr>
<tr>
<td>Prev. and Next.</td>
<td>{Prev.DocXxx};</td>
<td>Prev. and Next. can be used with variable populated in the PrintBoss’ Work File to create a comparison condition. This has been used with DocNo to define when to use the ForceWinPrintJob function.</td>
<td></td>
</tr>
<tr>
<td>PrintBoss Serial Number</td>
<td>{PBSerialNo}</td>
<td>Returns the serial number for the current copy of PrintBoss</td>
<td>--</td>
</tr>
<tr>
<td>PrintBoss Version</td>
<td>{PBVersion}</td>
<td>Returns to version for the current copy of PrintBoss</td>
<td>--</td>
</tr>
<tr>
<td>Windows Computer Name</td>
<td>{WinComputerName}</td>
<td>Returns name of computer where PrintBoss is used.</td>
<td>--</td>
</tr>
<tr>
<td>Windows User Name</td>
<td>{WinUserName}</td>
<td>Returns Windows login name</td>
<td>--</td>
</tr>
</tbody>
</table>

### PAYEE LIST VARIABLES

The following variables are associated with the Payee List in PrintBoss.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>{ACHActive}</td>
<td>Resolved to Y when checked an N when not checked</td>
<td>1</td>
</tr>
<tr>
<td>Payment Type</td>
<td>{PLPaymentType}</td>
<td>Payment type entered in the Payee List</td>
<td>1</td>
</tr>
<tr>
<td>Field Name</td>
<td>Variable Name</td>
<td>Additional Description</td>
<td>Length</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Payee (Name)</td>
<td>{PLPayeeName}</td>
<td>Name of the Payee; defined by {DocRecip} in the form and is used to match a check with a Payee List entry.</td>
<td>50</td>
</tr>
<tr>
<td>Payee ID</td>
<td>{PLPayeeID}</td>
<td>ID for Payee; defined by DocPayeeID in the form and is used to match a check with a Payee List entry.</td>
<td>50</td>
</tr>
<tr>
<td>Payee Email Address</td>
<td>{PLEmail}</td>
<td>Email address entered in the Payee List</td>
<td>50</td>
</tr>
<tr>
<td>Payee Email Address #2</td>
<td>{PLEmail2}</td>
<td>This field is available for a 2nd Email Address if needed.</td>
<td>50</td>
</tr>
<tr>
<td>Payee Misc</td>
<td>{PLMisc}</td>
<td>This field is provided for Miscellaneous information that may need to be stored in this record.</td>
<td>50</td>
</tr>
<tr>
<td>Mode</td>
<td>{ACHMode}</td>
<td>Returns the numeric value of the Mode, i.e. 0 = Inactive; 1 = Remainder of Check, etc.</td>
<td>1</td>
</tr>
<tr>
<td>Receivers Name</td>
<td>{ACHRecvName}</td>
<td>Receiving individual/company name</td>
<td>22</td>
</tr>
<tr>
<td>Receivers ID</td>
<td>{ACHRecvID}</td>
<td>Optional ID for the receiving individual/company</td>
<td>15</td>
</tr>
<tr>
<td>Discretionary Data</td>
<td>{ACHRecvDisc}</td>
<td>Optional data that can be defined by the sender</td>
<td>2</td>
</tr>
<tr>
<td>Amount</td>
<td>{ACHAmount}</td>
<td>Returns the amount of the ACH after it is calculated or zero when PreNote is selected. This applies per account. See ACHTotAmnt for a total of all accounts.</td>
<td>10</td>
</tr>
<tr>
<td>Receiving DFI (Bank) ID</td>
<td>{ACHRecvBankID}</td>
<td>Routing and ABA Number for the receiving bank</td>
<td>9</td>
</tr>
<tr>
<td>DFI (Bank) Account Number</td>
<td>{ACHRecvBankAcct}</td>
<td>Account number for the receiving company or individual</td>
<td>17</td>
</tr>
<tr>
<td>Account Type / Transaction Code</td>
<td>{ACHTransCode}</td>
<td>Code indicates Credit or Debit to Checking or Savings account</td>
<td>2</td>
</tr>
<tr>
<td>ACH PreNote</td>
<td>{ACHPreNote}</td>
<td>PreNote may be set globally in the Bank Record or on an individual record in the Payee List. This field is Optional. The values are Y or N and the default is N (blank).</td>
<td>1</td>
</tr>
<tr>
<td>ACH PreNote Print Check</td>
<td>{ACHPreNotePrint}</td>
<td>Prints a check when PreNote AND Print Check are selected. The values are Y or N and the default is N (blank).</td>
<td>1</td>
</tr>
<tr>
<td>Bank Payee List</td>
<td>{BPayeeList}</td>
<td>Defines the Payee List associated with a bank record</td>
<td>--</td>
</tr>
</tbody>
</table>

**Positive Pay Variables**

The following variables are associated with the Positive Pay function in PrintBoss. These are Read Only variables and are only available in the Positive Pay File Editor.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Amount</td>
<td>{BatchAmnt}</td>
<td>Sum of all the checks in a batch or the sum of Credit ACH transactions in a batch</td>
<td>--</td>
</tr>
<tr>
<td>Batch Amount2</td>
<td>{BatchAmnt2}</td>
<td>Sum of the Debit ACH transactions in a batch</td>
<td>--</td>
</tr>
<tr>
<td>Batch Check Number Sum</td>
<td>{BatchChkNoSum}</td>
<td>Sum of all the check numbers in a batch</td>
<td>--</td>
</tr>
<tr>
<td>Field Name</td>
<td>Variable Name</td>
<td>Additional Description</td>
<td>Length</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>BatchCount</td>
<td>{BatchCount}</td>
<td>Count of all records in the batch</td>
<td>--</td>
</tr>
<tr>
<td>Destination Device Status Code</td>
<td>{DestDeviceStatusCode}</td>
<td>Returns the codes from the Printed column of the work file</td>
<td>8</td>
</tr>
<tr>
<td>File Amount</td>
<td>{FileAmnt}</td>
<td>Sum of all the checks in a file or the sum of Credit ACH transactions in the file</td>
<td>--</td>
</tr>
<tr>
<td>File Amount2</td>
<td>{FileAmnt2}</td>
<td>Sum of the Debit ACH transactions in the file</td>
<td>--</td>
</tr>
<tr>
<td>File Batches</td>
<td>{FileBatches}</td>
<td>Count of all batches in the file</td>
<td>--</td>
</tr>
<tr>
<td>File Check Number Sum</td>
<td>{FileChkNoSum}</td>
<td>Sum of all the check numbers in a file</td>
<td>--</td>
</tr>
<tr>
<td>File Count</td>
<td>{FileCount}</td>
<td>Count of all records in the file</td>
<td>--</td>
</tr>
<tr>
<td>Positive Pay File Counter</td>
<td>{PosPayFileCounter}</td>
<td>Provides a unique numeric value that increments with each new Positive Pay file. The format is PosPayFileCounter: '4', where the '4' represents the numeric value indicating number of digits for the counter</td>
<td>--</td>
</tr>
<tr>
<td>Positive Pay Line Count</td>
<td>{PosPayLineCount}</td>
<td>Increments with each new Positive Pay line in the file. The value starts over with each new file</td>
<td>--</td>
</tr>
<tr>
<td>Positive Pay Sequence Number</td>
<td>{PosPaySeqNo}</td>
<td>Provides a unique ascending value for each new Positive Pay line. This value does not start over until it reaches 9999999.</td>
<td>7</td>
</tr>
</tbody>
</table>

**WORK FILE VARIABLES**

The following table provides the field lengths for the Work File Browse window:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Variable Name</th>
<th>Additional Description</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>BankCode</td>
<td>{BCode}</td>
<td>PrintBoss automatically populates the Bank Code field in the work file.</td>
<td>50-60</td>
</tr>
<tr>
<td>Amount</td>
<td>{DocAmntStr}</td>
<td>Document amount string is the value of the check amount saved in the work file.</td>
<td>12</td>
</tr>
<tr>
<td>Misc (FaxNo)</td>
<td>{DocMisc}</td>
<td>Miscellaneous field that is sometimes used to store the Fax number printed from the accounting software</td>
<td>60</td>
</tr>
<tr>
<td>Misc2</td>
<td>{DocMisc2}</td>
<td>Additional miscellaneous field that is sometimes used to store the E-mail address printed from the accounting software</td>
<td>60</td>
</tr>
<tr>
<td>DocNo</td>
<td>{DocNo}</td>
<td>Document Number</td>
<td>12</td>
</tr>
<tr>
<td>PayeeID</td>
<td>{DocPayeeID}</td>
<td>ID number to use with the Payee List</td>
<td>12</td>
</tr>
<tr>
<td>Recipient</td>
<td>{DocRecip}</td>
<td>Payee Name</td>
<td>30-60*</td>
</tr>
</tbody>
</table>

**NOTE:**
The DocRecip length is set under the Options menu in PrintBoss. Select the Internal Tab to locate the DocRecip Length field.
FAQs

Can PrintBoss Print Canadian Cheques?
Yes! PrintBoss is distributed with standard forms that allow checks to be printed in both the standard American format and Canadian format as desired. In most cases, the only modification necessary is to check the Canadian Style Date/Amount box in the Special Items area on the Miscellaneous tab of the Bank. Please consult the Support Documents section on our website for a complete list of standard PrintBoss forms that have been modified to comply with the new standard.

See Chapter 9, Form Files, for more information on #CanadianDate.

Can PrintBoss Print Other Documents Besides Checks?
Yes! PrintBoss can print a variety of accounting forms such as invoices, picking slips, or statements. These forms are printed on blank paper. PrintBoss specializes in printing multiple part forms. Each copy of a form is printed on plain copy paper saving money over carbon-less forms and making it easier to disperse the form copies.

What Kind of Printer Is Needed to Print Documents With PrintBoss?
PrintBoss requires a PCL5 compatible Laser printer (100% HP Compatible). PrintBoss can access any font that is available to the printer. Either internal fonts or cartridge fonts can be used to improve the look of the form. Compatibility with MICR toner cartridges is important for check printing so PrintBoss can produce a MICR line readable by magnetic scanners. Be sure to investigate before purchasing a non-HP LaserJet printer.

Be sure to use the PCL5 driver for the printer you select.

How Should the PrintBoss Printer Driver Be Configured?
Install the PrintBoss printer driver through the PrintBoss setup program. This process will configure the driver properly for all systems. DO NOT change the properties of the PrintBoss printer driver.

Do not alter the Laser printer driver to use the PrintBoss driver.

Should PrintBoss Be the Default Printer?
NO. The only time the PrintBoss printer driver should be selected is for printing the specific documents required to pass through PrintBoss. PrintBoss may be set as the default only for your specific accounting software reports.

The PrintBoss printer driver SHOULD NOT be designated as the Windows system default nor should it be set as the accounting software’s default printer. The PrintBoss printer driver should also never be selected as the PrintBoss default printer since PrintBoss needs to print to an actual physical printer.

Can Different Copies Be Printed To Different Trays On The Same Printer?
Yes. This selection is made within the PrintBoss form. Edit the Form file and select the Multi-Parts & Printers tab. For each copy, including the original, there is a setting for the Source Tray. Select the desired tray from the drop down menu. The tray names are defined by the printer, so the tray names may change based on the printer model selected within PrintBoss.
**CAN DIFFERENT COPIES BE PRINTED TO DIFFERENT PRINTERS?**
Yes. This selection is made within the PrintBoss form. Edit the Form File and click on the Multi-Parts & Printers tab. Select a printer from the *Destination Printer/Device* drop down menu for the original and each copy. Choose <Form Printer> to use the Default PrintBoss Printer.

**CAN PRINTBOSS PRINT A SIGNATURE ON A CHECK?**
Yes. PrintBoss can add one or more .BMP, .JPG, or .PCX files as signatures to a check. Conditions can be added to the signature command to specify printing at a certain dollar amount or range. PrintBoss can also print a security protected signature on checks. This signature requires a special disk to be inserted into the computer to allow the signature to print. Contact Wellspring Software for more information on security protected signatures.

**CAN CUSTOM DESIGNED FORMS BE USED?**
Wellspring Software can create a custom form according to your specifications. Submit a sample or a description for a quote.

**HOW CAN I ADD A SECOND SIGNATURE LINE TO A CHECK?**
A second signature line can be added based on the bank account using a standard PrintBoss form. Edit the Bank List. Select the account requiring the second signature line. Check the 2nd Signature Line box on the Miscellaneous tab. Click OK. Repeat for any additional accounts requiring a second signature line.

**HOW CAN I PRINT A SIGNATURE ONLY FOR CERTAIN DOLLAR AMOUNTS?**
Use a condition on the command that prints the signature. See #AmountRange in *Chapter 9, Form Files*.

**HOW CAN I ADJUST THE MICR LINE?**
Click the Options menu in PrintBoss and select Configuration. The *MICR Offset Adjustment* feature in the Settings tab has two fields: Left/Right and Top/Bottom. The defaults are set to zero. Run the *MICR Adjust Wizard* to properly adjust the values.

This setting is workstation and user specific.

**WHAT LOGO FORMATS CAN PRINTBOSS READ?**
PrintBoss can accept logos formatted as .PCX, .JPG, or .BMP files. PCX files only print in black and white (shades of gray), so it is best to save logos as monochrome for this file type. BMP and JPG files will print color.

**HOW CAN I ADD A LOGO TO A FORM?**
Use a #BMP, #PIC, or #PCX command in the Form. If the same logo will appear on all documents regardless of the Company, reference the filename in the command. Otherwise, copy the logo to PRNTBOSS\LOGOS directory, reference the variable {BLogoFile} in the command on the Form, and enter the filename of the logo in the respective field of each bank record that will use the logo.

**WHAT IF THERE IS A LOGO FOR ONLY SOME COMPANIES?**
Logos are usually printed on the left side of a check and Company Information is printed to the right of the logo. Conditions can be placed on the logo and company information commands to specify when to exclude or print the logo and shift the company information. Most standard PrintBoss forms can handle these situations automatically.

Select EDIT/ BANK LIST in PrintBoss. Choose the appropriate bank record and click the Edit Bank button. Enter the logo file name in the Logo Properties field on the Signatures_Logos tab. The form will automatically add this logo when printing checks from this account and shift the company information accordingly. If there is no logo filename in the bank record, the company information will remain left justified and no logo will print.

**NOTE:**
For additional information, please visit our Support Documents page at [www.WellspringSoftware.com](http://www.WellspringSoftware.com).
Trouble Shooting

Be sure to review the special instructions (*Installation Notes*) for the accounting software. Go to the PRNTBOSS\DOC\ directory to get find the appropriate file and print it out.

**NOTE:**

For additional information, please visit our Support Documents page [www.WellspringSoftware.com](http://www.WellspringSoftware.com).

**Sage 300 ERP**

**Error Message:** The batch of documents sent to PrintBoss doesn’t have a flag appearing anywhere in the document.

There are two possible causes for this message. First, the Crystal Report sent to the PrintBoss printer driver does not contain a trigger line. PrintBoss cannot recognize the file without the trigger. Open Crystal Report and enter the trigger line. See the PrintBoss Specs for the appropriate accounting module for a sample. Second, the report sent to PrintBoss may contain a valid trigger line, but the trigger has become fragmented. Check the Allow Fragmented PBINFO line box on the Settings tab of the Options/Configuration dialog. This option must be checked for PrintBoss to recognize certain reports sent from Accpac.

**When printing a document to PrintBoss, there is a paragraph of information on the page.**

The PrintBoss printer driver needs to be selected within Accpac just before printing. Usually this is selected by clicking on the FILE menu in Accpac and selecting PRINT SETUP. Choose the PrintBoss printer driver.

If printing to Preview, Accpac will default back to the system’s default printer. The PrintBoss printer will need to be reselected each time.

**When printing checks, the check number is skipping.**

There is a setting to change within Accpac when this error occurs. Navigate to the Banks module and find the check stock used with PrintBoss. Set the number of advice lines to 999.

**Accpac won’t hold the PrintBoss printer in memory.**

When printing to Preview, Accpac will automatically use the default printer unless another one is reselected each time. We recommend setting the print destination to the PrintBoss 50 printer.

When printing to a printer, go into the Printer setup within the current Accpac window just before printing this type of document and choose the PrintBoss driver. Once selected here, Accpac should remember PrintBoss the next time this type of document is printed within this company.

**When printing checks, they go through PrintBoss but aren’t formatted properly.**

Go to the FILE / PRINT DESTINATION screen within Accpac. The Report Orientation and Report Paper Size must both be checked. The Use A4 instead of Letter must NOT be checked. If there is a choice between letter and
legal as the default paper size, choose letter. Current versions of PrintBoss generate a warning when there is a mismatch between the PrintBoss form and the paper orientation and size from Accpac.

**When printing a single check, it is incorrectly formatted and there are multiple pages printing.**
Select FILE / PRINT DESTINATION within Accpac. The options for Report Paper Size and Report Orientation must be selected. The option Use A4 instead of Letter should NOT be selected. If there is a choice for a default paper size of letter or legal, select letter. Current versions of PrintBoss generate a warning when there is a mismatch between the PrintBoss form and the paper orientation and size from Accpac.

**Microsoft Dynamics GP**

**The checks are still printing out as if using preprinted stock.**
Make sure the security has been turned on for this user / company / workstation combination. See the specific installation notes for Dynamics for details.

Review the settings within Named Printers to verify only documents intended for PrintBoss are sent to the PrintBoss printer driver.

**When printing checks, a pop up list is constantly appearing.**
Make sure the security has been turned on for this user / company / workstation combination. See the specific installation notes for Dynamics for details.

**QuickBooks**

**No company information is appearing on the checks.**
Make sure to turn on the option to print the Company Address within the QuickBooks printer setup.

**The check prints without the MICR line and bank information.**
Make sure the PrintBoss printer driver is selected for printing the checks.

**Error message: You have printed a document to PrintBoss that is NOT recognized by PrintBoss. Specifically, no entry in the "Form / Bank Request List" matches this format.**
Make sure the voucher style of check is selected within QuickBooks. Also make sure the check is worth at least $0.01. Zero dollar checks are not recognized by PrintBoss.

**NT/W2000/WXP Workstations**

**When installing PrintBoss on an NT/W2000/WXP workstation, I am unable to install the PrintBoss Printer Driver.**
Log in as ADMINISTRATOR before installing PrintBoss. Reboot the workstation after installing the printer driver.

**When running PrintBoss on an NT/W2000/WXP workstation, PrintBoss does not launch automatically.**
Log in as ADMINISTRATOR, rerun the workstation install, and restart the workstation. This should install the PB32stub.exe into the Windows\System32 directory. The PB32stub process should run in the background to allow PrintBoss to automatically load. PB32stub is listed in the Task Manager when it is running.
W2003 Server

When installing PrintBoss on a W2003 server for use with terminal services, I am unable to install the PrintBoss Printer Driver.
The newest version of PrintBoss will automatically install the PrintBoss 50 printer driver. If the PrintBoss NT40 printer is necessary, a group policy will need to be changed.

See Chapter 5, PrintBoss Printer Driver.

Vista / Windows 7 / Windows 8 Operating Systems

On a Vista / Windows 7 / Windows 8 Workstation I cannot access the PrintBoss driver settings.
Close the PrintBoss Program. You must RIGHT CLICK on the PrintBoss Program and Run as administrator. The settings on the PrintBoss Driver Settings screen will be available.

General

The Documents are Printing on the Wrong Printer.
Check the following areas:

- Make sure the accounting software is printing to the PrintBoss printer driver.
- Select FILE / PRINTER SETUP in the PrintBoss program. Choose the correct printer.
- Edit the PrintBoss Form File and check the Multi-Parts & Printers tab. The Destination Printer/Device should reflect the correct printer for each copy. The Default PrintBoss Printer is identified at the bottom of this tab. Select <Form Printer> to print to the default PrintBoss printer.

The Documents are Printing from the Wrong Tray.
Leave the printers set to their auto select / default tray choice.

Edit the PrintBoss Form File, select the Multi-Parts & Printers tab, and select the Source Tray for each copy. The tray choices listed are for the printer selected in the Destination Printer/Device column in PrintBoss. Test the different choices to find the correct tray name.

The Printer Requires a Manual Prompt on the Form Feed Button Between Each Page.
Make sure to choose the correct tray from within the PrintBoss Form (Multi-Parts & Printers) instead of the printer settings.

You have selected a Manual tray if you have chosen the tray within the PrintBoss Form. Choose a different setting for the tray you want.

The Signature Won’t Print.

- Make sure the signature disk is in the correct drive (if required).
- Make sure a copy of the *.sig file from the disk is placed into the PRNTBOSS\LOGOS directory.
- Make sure the PrintBoss Form references the signature file correctly.

The Signature Prints on Void Pages of Multiple Page Checks.
Add the following condition to the signature command in the PrintBoss Form:

[AmntRange, 0.01]

An example command would look like this:

# [AmntRange, 0.01] PIC 5.2, 9.85, "Your_Sig.Sig"
THE LOGO IS THE WRONG SIZE.
Go to EDIT / FORM FILES / <highlight the form> / VIEW if the logo will be printed on all documents for this Form. You will see a rough view of your form (no data). Double click on the logo. Select the Percent radio button and adjust the horizontal and vertical size in the Pic Command Properties dialog. Click on OK to view the adjusted logo.

Go to EDIT / BANK LIST / <highlight record> / EDIT BANK if the logo is printed according to the bank record. Select the Signatures_Logos tab. Adjust either the width and height or the percentage to change the size.

Changes will take affect the next time you print from this account.

MY SIGNATURE PRINTS ONLY ON SOME OF THE DOCUMENTS IN THE BATCH.
Check to see if there are any conditions on the command. If there are, this may be why it is not printing on some documents (i.e. signature with an amount range, etc.)

See Chapter 9, Form Files, for more information on Conditional Commands.

If there are no conditions on the graphic commands, you may need to update the driver for your printer or add more memory to the printer. Be sure to download the latest PCL5 driver for the printer and operating system if you are upgrading the printer driver.

THE MICR LINE IS CUT IN HALF
Download the latest driver for the LaserJet printer. Be sure that it is a PCL5 driver. If that doesn't work, adjust the MICR line by changing the MICR Offset Adjustment settings in the OPTIONS / CONFIGURATION window.

See Chapter 8, Bank Accounts.

THE COMPANY NAME AND ADDRESS LINES DO NOT FIT WITHIN THE ENVELOPE WINDOW
Edit the respective PrintBoss Form. Select EDIT / FORM FILES from the main PrintBoss screen. Highlight the appropriate Form and select View. Grab the Company Name and drag it to the desired location. The Company address will typically adjust accordingly if you are using one of our standard forms. Close the View and click Yes to save the changes. This adjustment applies to all companies using this Form.
Appendix

Glossary

ABA
American Banking Association

APOSTROPHE
'

BACKSLASH (a.k.a. reverse solidus)
\ 
This slash is NOT under the question mark on a standard keyboard.

BRACES
{ }
Hold the SHIFT key and type the brackets on a standard keyboard.

BRACKETS (a.k.a. square brackets)
[ ]

CA-RET REPORT
A Computer Associates (ACCPAC) Report for use with Accpac for Windows (prior to Accpac version 4.2). It determines the data sent to the printer and the specific layout. These reports are viewable and editable with the Report Design function within Accpac for Windows.

These reports are files with the .RET extension.

CAPTURED TEXT
This is text that is received from the accounting package.

COLON
:
Hold the SHIFT key and type a semicolon.

COMMENT
Enter a pipe symbol ( | ) in front of the command line to make PrintBoss skip that line.

Hold the SHIFT key and type a backslash on a standard keyboard.
CPA

Canadian Payments Association; L'Association Canadienne des Paiements (L'ACP)

CRYSTAL REPORT

A report used by several accounting packages (including Accpac for Windows) to determine the data and layout sent to the printer.

These reports are files with the .RPT extension.

DPI

DPI stands for Dots Per Inch.

DIVISON

÷

This special character is often used when there is a chance other delimiters appear within a string used in a variable. Hold CTRL and type the apostrophe (’ ) to generate this symbol within the PrintBoss Form Editor.

DUPLEX PRINTER

This is a printer that has the ability to print on both sides of the page in one pass.

FORM

The file used by PrintBoss to format data provided by the Host Accounting Software. This typically consists of elements traditionally preprinted.

Forms are files with the .PBF extension.

FORWARD SLASH (a.k.a. whack)

/

This is the key under the question mark on a standard keyboard.

HOME

This is the path to the PRNTBOSS folder. For example, HOME would be C:\program files\prntboss if the PrntBoss folder is in the program files list.

MICR / MICR LINE

Magnetic Ink Character Recognition – refers to the ABA characters at the bottom of a check.

MICR TONER

The toner used to print the MICR line at the bottom of checks so it can be read by magnetic scanning equipment. Check with your bank to determine whether MICR toner is required.

MODULUS 9

An asterisk placed at the end of a series of numbers (usually the check number) that will be replaced with Modulus 9 check sum.

NAMED PRINTERS

Named Printers is a Microsoft Great Plains module used with Dynamics and eEnterprise Accounting software packages. It is used to determine the output printer for each printing function. Named Printers setup is necessary for Dynamics (version 6.0 and higher) to print to PrintBoss.
**PARENTHESES**

( )

These characters are SHIFT 9 and 0 on a standard keyboard.

**PCL5**

**Printer Control Language 5** – PrintBoss uses this printer language to communicate with printer hardware. Most Hewlett-Packard LaserJet printers use this language. PCL translates the data and sends it in binary form to the printer.

**PCL6**

**Printer Control Language 6** – Some of the new Hewlett-Packard LaserJet printers are distributed with this newer PCL printer driver version. Be sure to download the newest version from the HP web site (www.hp.com) when using this driver. PCL translates the data and sends it in binary form to the printer.

**PIPE**

| |

Pipe is the symbol at the beginning of comments in the Form Editor.

Hold the SHIFT key and type a backslash on a standard keyboard to generate this symbol in the PrintBoss Form Editor.

**POUND**

#

The symbol at the beginning of all active PrintBoss commands in the Form Editor.

**PRINTER RECALL**

This is a separate PrintBoss module used only with Dynamics software. Dynamics 5.5 does not require the use of Printer Recall. Dynamics 6.0 and higher can NOT use Printer Recall. Users must use Named Printers.

**PS – POST SCRIPT**

Postscript printer drivers send a page description to a printer that is translated by the printer. We do NOT recommend using PostScript drivers with PrintBoss. See PCL5 or PCL6 listed above.

**QUOTE**

""

Hold the SHIFT key and type an apostrophe.

**REPORT**

A file used by the Host Accounting Software to generate documents to be printed.

**RET FILE**

See CA-RET Report

**SEMI COLON**

;

**TEXT INPUT FILE**

A text file generated by a Host Accounting Software that includes all of the document information. PrintBoss takes the data from this file and places it on the Form.
**TEXTCAPTURE SPECIFICATION FILE**

This is a file within PrintBoss that defines the structure of the Text Input File. It also defines the location(s) and name(s) of the file(s) to be processed. The PrintBoss Form and Bank selection are also defined.

**TILDE**

~

Hold the SHIFT key and type the graves symbol (`). This is above the Tab key on a standard keyboard.

**UNCOMMENT**

Remove the pipe symbol (|) from the beginning of the command line to activate the command.

**VIEW or INSTALLATION NOTES**

These are notes referencing a specific accounting package. These should be printed during the installation of PrintBoss. They can also be found as *.rtf files in the PRNTBOSS/DOC directory.

**WORK FILE**

Work Files are a database of documents printed through PrintBoss. The work file has the same name as the PrintBoss Form used at the time of printing. Options for retaining, deleting, or archiving completed work files can be found on the Setting tab of the Form Editor.